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1 General Specifications
Dimensions and Weight

2 (Dimensions given with floating keyboard stowed and display tilted for transport)
3 Depth 885 mm, 34.8"
4 Height 1250-1800 mm, 49 - 71"
5 Weight 85 kg (187.4 Ib)

. 530 mm, 20.9" (Caster),
6 |Width 565 mm, 22.2" (Monitor)
7 Electrical Power
8 Voltage: 100 - 240 Vac
9 Frequency: 50/60 Hz
10 Power consumption maximum of 0.9 kVA with peripherals

11 Console Design

12 4 active probe ports

13 1 inactive probe storage port

14 Integrated SSD (1 TB)

15 Integrated DVD-R Multi Drive

16 On-board storage of thermal printer

17 Integrated speaker

18 Integrated locking mechanism that provides rolling lock and caster swivel lock
19 Integrated cable management

20 Front and rear handles

21 Easily removable air filters

22 Windows 10 64-bit
X3 User Interface
24 Operator Keyboard

25 Operating keyboard adjustable in height and rotation

26 Ergonomic hard key layout

27 Interactive back-lighting

28 Integrated recording keys for remote control of up to 4 peripheral devices or DICOM® devices
29 Integrated gel warmer

30 Touch Screen

31 12.1" High-resolution, color, touch, display screen

32 Interactive dynamic software menu

33 Brightness adjustment

34 User-configurable layout

35 Monitor

36 23.8" Wide screen high-resolution HDU display

37 Display translation (independent of console)

38 350 mm, (13.7 in) horizontal (both directions)

39 150 mm, (5.9 in) vertical

40 90° swivel (both directions)

41 Fold-down and lock mechanism for transportation

42 Resolution: 1920 X 1080

43 Anti-glare

44 Viewing angle 89/89/89/89°

45 Contrast Ratio: >20,000:1
I System Overview
47 Applications

48 Abdominal

49 Obstetrical

50 Gynecological

51 Breast




52 Small Parts
53 Peripheral Vascular
54 Transcranial (adult and neonatal)
55 Pediatric and neonatal
56 Musculoskeletal (general and superficial)
57 Urological
58 Cardiac (adult and pediatric)
59 Interventional
60 Pleural
61 Operating Modes
62 B-Mode
63 M-Mode
64 Color Flow Mode (CFM)
65 B-Flow (Option)
66 Extended Field of View (LOGIQView)
67 Power Doppler Imaging (PDI)
68 PW Doppler
69 CW Doppler (Option)
20 Volume Modes (3D/4D)
(Option)
71 Anatomical M-Mode
72 Coded Contrast Imaging (Option)
73 Strain elastography (Option)
74 B Steer+ (Option)
75 Shear wave elastography (Option)
76 UGAP (Option) - Ultrasound Guided Attenuation Parameter Imaging
77 Scanning Methods
78 Electronic sector
79 Electronic convex
80 Electronic linear
81 Mechanical volume sweep
82 Probe Types
83 Sector phased array
84 Convex array
85 Microconvex array
86 Linear array
87 Matrix array
88 Volume probes (4D)
89 Split crystal
90 System Standard Features
91 Advanced user interface with high-resolution 12.1" display touch panel
92 Automatic optimization
93 CrossXBeam™ compounding
94 Speckle Reduction Imaging (SRI-HD, Advanced SRI Type 1)
95 Fine angle steer
96 Coded harmonic imaging
97 Virtual convex
98 Patient information database
99 Image archive on integrated CD/DVD and hard drive
100 [Advanced 3D
101 |Raw data analysis
102 |Real-time automatic Doppler calculations
103  |OB calculations
104 [Fetal trending
105 |Multi gestational calculations
106 |Hip dysplasia calculations
107 |Gynecological calculations
108 |Vascular calculations
109 |Urological calculations
110 [Renal calculations
111 [Cardiac calculations
112  [InSite™ capability
113 |On-board electronic documentation
114  [Auto Doppler Assist




115 [Privacy and security, including user and rights management

116 |LOGIQView

117 |External USB printer connection

118 [Network printer support

119  [HDMI output (available for compatible devices)

120 |System Options

121 [Tricefy®

122 DICOM

123 B-Flow

124 [Compare Assistant

125 |Auto IMT

126 |Scan Assistant

127 |Breast productivity package

128 [Thyroid productivity package

129 |OB measure assistant

130 [Quantificative Flow Analysis available with Color Flow/PDI

131 |[Breast Measure Assistant

132 |B Steer+

133 [Strain elastography

134 [Elastography Quantification

135 [Advanced privacy and security (vulnerability scan)

136 [Power assistant and scan on battery

137 [Storage bins

138 [Shear wave Elastography

139 [Volume Navigation

140 |UGAP

141 |Hepatic Assistant

142 [Coded Contrast Imaging

143  |Stress echo

144  |Cardiac Strain (Automatic Function Imaging)

145 [On-board reporting

146 |TVI

147 [Wireless LAN

148 CW

149 DVR

150 |[Table tools

151 |Advanced probes

152 |Breast Assistant, Powered by Koios DS™

153  |SonoNT SonolT

154 |Advanced SRI Type 2

155 |[Peripheral Options

156 [Integrated Option for Digital Color thermal Printer

157 |Digital A6 color thermal printer

158 [Foot switch, with programmable functionality

159 [CRF-200U card reader support (Japan Only)

160 |Console protective cover

161 [LOGIQ smart device apps * Photo Assistant
+ Remote Control

162 |Display Modes

163 |Live and stored display format « Full siz.e and split screen - both w/ thumbnails.

For still and CINE
164 |Review image format »4x4, arwd thumbnails.
For still and CINE

« Independent Dual B or CrossXBeam/PW Display

165 |Time line display ) CW
« Display formats top/bottom selectable format
- Side/side selectable format

166  [Virtual convex

167 |Simultaneous capability

168 [B or CrossXBeam/PW

169 [B or CrossXBeam/CW (Option)

170 [Bor CrossXBeam/CFM or PDI

171 B/M

172 |B/CrossXBeam

173 B-Flow/PW




Real-time Triplex Mode -

174 B or CrossXBeam + CFM or PDI/PW
175 [Selectable alternating modes
176 [B or CrossXBeam/PW
177 [Bor CrossXBeam + CFM (PDI)/PW
178 |B/CW (Option)
179 [Multi-image (split/quad screen)
180 |Live and/or frozen
181 |Bor CrossXBeam + B or CrossXBeam/CFM or PDI or B-Flow (Option)
182 PW/M
183 [Independent Cine playback
184 [Display Annotation
185 |Patient name: first, last and middle
186 [Patient ID
187 [Alternate patient ID
188 |Age, sex and date of birth
189 [Hospital name
+ MM/DD/YY
190 [Date format: three types selectable « DD/MM/YY
+ YY/MM/DD
191 Time format: + 24 hours
2 types selectable + 12 hours
<LMP
. - GA
192 [Gestational age from «EDD
-BBT
193  |Probe name
194 |Map names
195 |Probe orientation
196 |Depth scale marker
197 |Lateral scale marker
198 |Focal zone markers
199 [Image depth
200 |[Zoom depth
« Gain
+ Dynamic range
201 |B-Mode + Imaging frequ.ency
» Frame averaging
» Gray map
* SRI
« Gain
202  [M-Mode + Dynamic range
« Time scale
« Gain
+ Angle
» Sample volume depth and width
« Wall filter
203 [Doppler Mode « Velocity and/or frequency scale
« Spectrum inversion
« Time scale
« PRF
« Doppler frequency
« Line density
« Frame averaging
« Color scale, 3 types: Power, directional PDI and symmetrical velocity
imaging
» Color velocity range and baseline
204  |Color Flow Doppler Mode . Color threshold marker
» Color gain
- PDI
« Spectrum inversion
- Doppler frequency
205 [Digital TGC with 8 independent controls

206

Acoustic frame rate




207 |CINE gage, image number/frame number
208 |Body pattern: multiple human and animal types
209 |Application name
210 Measurement results
211 |Operator message
« TIS: Thermal Index Soft Tissue
. . « TIC: Thermal Index Cranial (Bone)
212 [Displayed acoustic output - TIB: Thermal Index Bone
+ MI: Mechanical Index
213 % of maximum power output
214 |Biopsy guide line and zone

215

Heart rate




A General System Parameters

217 |System Setup

218 |Pre-programmable categories

219 |User programmable preset capability

220 |Factory default preset data

Languages: English, French, German, Spanish, Italian, Brazilian,
Portuguese, Russian, Greek, Swedish, Danish, Dutch, Finnish, Norwegian
222 |OB Report Formats including Tokyo Univ., Osaka Univ., USA, Europe and ASUM and WHO
223 |User defined annotations

224  |Body patterns

225 |Customized comment home position

226 |EZImaging: Simplified user interface for high volume workflow

227 |Complete user manual available on board through Help (F1)

228 |User manual and service manual are included in USB stick with each system. A printed manual is available upon request.
229 |CINE Memory/Image Memory

230 |1 GB of CINE memory

231 |Selectable CINE sequence for CINE review

232  |Prospective CINE mark

233 |Measurements/calculations and annotations on CINE playback

234 |Scrolling timeline memory

235 [Dual Image CINE display

236 |Quad Image CINE display

237  |CINE gauge and CINE image number display

238 |CINE review loop

239 [CINE review speed

240 |Ilmage Storage

241 |On-board database of patient information from past exams

221

- Compressed/uncompressed
« Single/multi-frame

+ Enhanced (3D/4D)

« With/without raw data

242  |Storage formats: DICOM

243 |Export JPEG, JPEG 2000, WMV (MPEG 4) formats

« USB memory stick: 64 MB to 64 GB
(for exporting individual images/clips)

244 [Storage devices: + CD-R storage: 700 MB

+ DVD storage: -R (4.7 GB)

+ Hard drive image storage: ~830GB

245 |[Compare previous exam images with current exam

246 |Reload of archived date sets

247 |Network storage support for import, export, DICOM read, SaveAs, MPEGVue
248 |Connectivity

249  |Ethernet network connection

250 |Wireless LAN 802.11ac/a/b/g/n (Option)

« Verify

« Print

- Store

» Modality worklist

251 [DICOM 3.0 « Storage commitment

» Modality performed procedure step (MPPS)
+ Media exchange

« Off network/mobile storage queue

» Query/retrieve

252  [Public SR template

253 |Structured Reporting - compatible with vascular and OB, cardiac and breast standard
254  |InSite capability

255 |Advanced privacy and security (Option)




256 |Physiological input panel (Option)
« ECG, 1 channel
« PCG, 1 channel
« AUX, 1 channel
+ Dual R-Trigger
» Pre-settable ECG R delay time
257  [Physiological input « Pre-settable ECG position
+ Adjustable ECG gain control
« Pre-settable PCG position
» Adjustable PCG gain control
« Pre-settable AUX position
» Adjustable AUX gain control
258 |Automatic heart rate display
259 |Auto Ejection Fraction
260 |Report writer (Option)
261 |On-board reporting package automates report writing
262 |Formats various exam results into a report suitable for printing or reviewing on a standard PC
Exam results include patient info, exam info, measurements, calculations, images,
263 and comments Standard templates provided
264  |Customizable templates
265 |Scanning Parameters
266 |cSound™ Imageformer: Infinite number of effective channels
267 Frame rate: 9,675 Hz maximum
268 [Displayed imaging depth: 0 - 100 cm
269  |Minimum depth of field: 0 - 2 cm (zoom) (probe dependent)
270 |Maximum depth of field: 0 - 100 cm (probe dependent)
271 |Continuous dynamic receive focus
272 |Continuous dynamic receive aperture
273 |Adjustable dynamic range, inifinite upper level
274 |Adjustable field of view (FOV)
275 |System Frequency Range: 0.7-24 MHz
276 |Image reverse: right/left
277 Image rotation of 0°, 90°, 180°, 270°
278 |8 bits stored per color
279 |256 shades of gray
280 [256 color tones
281 |Digital B-Mode
« Acoustic power
« Gain
« Dynamic range
« Frame averaging
« Gray scale map
» Frequency
- Speed of sound (application dependent)
282  |Adjustable « Framerate
+ Scanning size (FOV or Angle)
- Depending on the probe, see probe specifications
» CrossXBeam
« B colorization
* Reject
« Suppression
* SRI
283 |Digital M-Mode
« Acoustic power
+ Gain
« Dynamic range
« Gray scale map
284  [Adjustable « Frequency
+ Sweep speed
+ M colorization
» M display format
- Rejection
285 |Anatomical M-Mode
286 [M-mode cursor adjustable at any plane




Can be activated from a CINE loop from a live or stored image

288

M & A capability

289

Available with Color Flow Mode

290

Digital Spectral Doppler Mode

291

Adjustable

« Acoustic power

+ Gain

« Dynamic range

« Gray scale map

+ Transmit frequency
» Wall filter

+ PW colorization

« Velocity scale range
» Sweep speed

« Sample volume length
+ Angle correction

« Steered linear

« Spectrum inversion
+ Trace method

« Baseline shift

+ Doppler auto trace
« Time resolution

« Compression

« Trace direction

« Trace sensitivity

292

Digital Color Flow Mode

Adjustable

« Acoustic power

+ Color maps, including velocity-variance maps
« Gain

+ Velocity scale range

« Wall filter

+ Packet size

« Line density

« Spatial filter

« Steering angle

+ Baseline shift

» Frame average

» Threshold

« Auto ROl placement and steering on linear
+ Accumulation mode

« Flash suppression

» Shortcuts

294

Digital Power Doppler Imaging

295

Adjustable

e Acoustic power

e Color maps, velocity-variance maps
e Gain including

¢ Velocity scale range
o Wall filter

¢ Packet size

e Line density

e Spatial filter

e Steering angle

* Frame average

e Threshold

e Accumulation mode
e Flash suppression

o Shortcuts

296

Continuous Wave Doppler (Option)

Available on M5Sc-D, 6S-D, 6Tc-RS, P2D and P6D probes

298

Steerable CW mode included




« Acoustic power

+ Gain

« Dynamic range

« Gray scale map

+ Transmit frequency
» Wall filter

+ CW colorization

« Velocity scale range

299 [Adjustable + Sweep speed
 Angle correction
« Spectrum inversion
+ Trace method
» Baseline shift
+ Doppler auto trace
« Compression
« Trace direction
« Trace sensitivity
300 |Automatic Optimization
301 |Optimize B-Mode image to help improve contrast resolution with one button press
302 |Selectable amount of contrast resolution improvement (low, medium, high)
303 |CTO (Continuous Tissue Optimization) - continuously adjusts B-Mode axial and lateral gain uniformity and overall gain level suppressing the noise
304 |Auto-spectral optimize - adjusts baseline, invert, PRF (on live image), and angle correction with one button press
305 |Auto CF and PW positioning - adjusts ROI position, sample volume position and steering with one button press
306 |Coded Harmonic Imaging
307 |Available on all 2D and 4D probes
308 |B-Flow (Option)
309 Available on the following probes: C1-6-D, C1-6VN-D, C2-7-D, C2-7VN-D, C2-9-D, C2-9VN-D, C3-10-D, L2-9-D, L2-9VN-D, L3-12-D, L6-24-D
ML6-15-D, M5Sc-D, L8-18i-D
310 |Background
311 |Sensitivity/PRI
312 |Acoustic power
313 [Frequency
314 |Line density
315 |Frame average
316 |Gray scale map
317 [Tint map
318 [Dynamicrange
319 [Rejection
320 |Gain
321 |Suppression
322 |SRI
323 |Accumulation
324  |Visualization
325 |Radiantflow™
326 |Easy, fast visualization of tiny vessels, displaying as a 3D effect
327 |Available in Color Doppler, Power Doppler and MVI
328 |B Steer+ (Option)
329 |Available on the following probes: L2-9-D, ML6-15-D, L8-18i-D, L3-12-D, L2-9VN-D
330 |Coded contrast imaging (Option)
331 Available on the following probes: C1-6-D, C1-6VN-D, C2-9-D, C2-9VN-D, C2-7-D, C2-7VN-D, C3-10-D, IC5-9-D, L2-9-D, L2-9VN-D, L3-12-D, M5Sc-D, ML6-15-D,
RAB6-D, RIC5-9-D, L6-24-D
332 |2 contrast timers
333 [Timed updates: 0.05 - 10 seconds
334 |Accumulation mode, seven levels
335 [Maximum enhance mode
336 |Flash
337 |Time intensity curve (TIC) analysis
338 |Parametric imaging
339 |Ability to save still image during clip acquisition




The LOGIQ Fortis is designed for compatibility with most commercially available ultrasound contrast agents.
Because the availability of these agents is subject to government regulation and approval, product features

340 [|intended for use with these agents may not be commercially marketed nor made available before the contrast
agent is cleared for use.

Contrast related product features are enabled only on systems for delivery to an authorized country or region of use.

341 |LOGIQView

342 |Extended field of view Imaging

343 |Upto 160 cm (63") scan length

344 |Available on all 2D imaging probes

345 |For use in B-Mode

346 |CrossXBeam is available on linear probes

347  |Auto detection of scan direction

348 |Pre-or post-process zoom

349 |Rotation

350 [Auto best fit on monitor

351 Measurements in B-Mode

352 |3D

353 |Allows unlimited rotation and planar translation

354 |3D reconstruction from CINE sweep

355 [Easy 3D available on all probes

356 |Advanced 3D

357 |Acquisition of color data

358 |Automatic rendering

359 |3D landscape technology

360 |[3D movie

361 |Real-time 4D (Option)

* Real Time 4D
362 [Acquisition modes « Spatio-Temporal Image Correlation (Option)
» Static 3D

« 3D rendering (diverse surface and intensity projection modes)
« Sectional planes (3 section planes perpendicular to each other)
» Omniview (Option)
+ Volume contrast imaging - Static (Option)
+ Volume contrast imaging - Omniview (Option)
» Tomographic ultrasound imaging (Option)
+ Volume Analyses
- VOCAL: semi-auto/manual segmentation tool
(segmentation using touch screen) (Option)
- 3D Static only
- Threshold Volume: measure
volume below and above a threshold

363  [Visualization modes

« Surface texture, surface smooth, max-, min-
and X-ray (average intensity projection),
mix mode of two render modes

* HDlive ™

364 |Render mode

365 [SonoRenderlive

366 [Curved 3 point Render start

367 |3D Movie

368 [Scalpel: 3D cut tool

« Quad: A-/B-/C-Plane/3D
369 |Display format: - Dual: A-Plane/3D
« Single: 3D or A- or B- or C-Plane

370 [Automated Volume Calculation - VOCAL Il

371 [Betaview

372 |Volume navigation (Option)

373 |Available on the following probes: C1-6VN-D, C2-9VN-D, C2-7VN-D, C3-10-D, L2-9VN-D, ML6-15-D, IC5-9-D, L8-18i-D, M5Sc-D

374 |Sensor-based acquisition

375 |Position markers

376 [Needle tip tracking

377 |Virtual tracking

378 |Autoimage registration

379 [Tru3D feature includes

380 |Render modes: gray surface, texture, min-, max-, average-intensity




381 [Measurements: distance, angle, area, volume

382 |3D Movie

383 |Scan assistant (Option)

384 [Factory programs

385 |User-defined programs

386 |Stepsinclude image annotations, mode transitions, basic imaging controls and measurement initiation

387 |Compare Assistant (Option)

388 |Allows side-by-side comparison of previous ultrasound and other modality exams during live scanning

389 |Breast productivity package

390 |Auto measurement

391 |Worksheet summary includes measurements and locations for lesions and lymph nodes

392 Feature assessment

393 |BI-RADS™ assessment

394 |User editable

395 |Thyroid productivity package (Option)

396 |Auto measurement

397 |Worksheet summary includes measurements and locations for nodule, parathyroid and lymph nodes

398 Feature assessment

399 BI-RADS™ assessment

400 |User editable

401 |Start Assistant

402 |Automatically select category, probe, preset, or scan assistant from worklist exam description

403 |Learn the category, probe, preset, and scan assistant based on exam description

404 |Shear Wave Elastography (Option)

405 |Available on the following probes: C1-6-D, C1-6VN-D, L2-9-D, L2-9VN-D, IC5-9-D, L8-18i-D, ML6-15-D, L3-12-D

406 |User programmable measurement display in kPa and meters per second

407 |Single and dual view display

408 |Applications: Abdominal, Breast, Musculoskeletal, Small Parts, Prostate

409 |Strain elastography (Option)

410 |Available on the following probes: ML6-15-D, L2-9-D, L2-9VN-D, L3-12-D, IC5-9-D, C2-9-D, C2-9VN-D, C1-6-D, C1-6VN-D, L8-18i-D, BE9CS-D

411  |Relative analysis tool

412 |Applications: Abdominal, Breast, Musculoskeletal, Small Parts, Prostate, Thyroid

413 |UGAP (Option)

414  |Available on the following probes: C1-6-D, C1-6VN-D, C2-9-D, C2-9VN-D

415 [Measures liver attenuation* (attenuation coefficient [dB/cm/MHz]) by auto measure algorithm with reference B-mode

416 |Simple and 2D color map (attenuation color map and Measurement Position Indicator Map)

417 |Quantitative flow analysis (Option)

418 |Available in color and power Doppler

419 |TVI(Option)

420 |Available on the following probes: M5Sc-D, 6Tc-RS, 6S-D probes

421 |Myocardial Doppler imaging with color overlay on tissue image

422 |Tissue color overlay can be removed to show just the 2D image, still retaining the tissue velocity information

423 |Curved anatomical M-Mode: free (curved) drawing of M-Mode generated from the cursor independent from the axial plane

424 |Q-Analysis: multiple time-motion trace display from selected points in the myocardium

425 |Stress echo (Option)

426 |Advanced and flexible stress echo examination capabilities

427 |Provides exercise and pharmacological protocol templates

428 |6 default templates

429 |Template editor for user configuration of existing templates or creation of new templates

430 |Reference scan display during acquisition for stress level comparison (dual screen)

431 |Baseline level/previous level selectable

432 |Raw data continuous capture

433 |Over 100 sec. available

434 |Wall motion scoring (bulls-eye and segmental)

Smart stress: Automatically set up various scanning parameters (e.g. geometry, frequency, gain)

435 . L .
according to same projection on previous level

436 |Auto EF (Option)

437  |Allows semi-automatic measurement of the global EF (Ejection Fraction)

438 |User editable

439 |Cardiac AFI (Option)

Allows assessment of the complete left ventricle with all segments at a glance by combining three longitudinal views

440 |. . .
into one comprehensive bulls-eye view

441 |2D strain based data moves into clinical practice




442 |Virtual Convex
443 |Provides a convex field of view
444  |Compatible with CrossXBeam
445  |Available on all linear and sector probes
446 |SRI-HD and Advanced SRI
447  |Speckle reduction imaging
448  |Provides multiple levels of speckle reduction
449  [Compatible with side-by-side DualView display
«Typel
450 Advanced SRI: - Compatible with all linear, convex and sector probes
two types selectable « Type 2 (Option)
- Compatible with OB/GYN application
451 |CrossXBeam
452 |Provides variable angle spatial compounding
453 |Live side-by-side DualView display
» Color mode
«PW
454 |Compatible with *SRI
+ Coded harmonic imaging
« Virtual convex
455  |Available on all curved and linear probes
456 |Controls available while “live”
457  |Magnification Zoom: Magnifies the entire image on the screen without zoom ROI, 20x maximum zoom factor
458  |Pan Zoom: Magnifies the display of the data within the ROI
459 |HD Zoom: Magnifies the image within the zoom ROI, with higher spatial resolution than original images
- Gain
«TGC
« Dynamic range
460 |B/M/CrossXBeam-Mode « Acoustic output
+ Framerate control
» Sweep speed for M-Mode
» CrossXBeam angle
- Gain
+ Dynamic range
« Acoustic output
« Transmission frequency
461 |PW-Mode » PRF
 Wall filter
* Spectral averaging
« Sample volume gate: length, depth
« Velocity scale
« CFM gain
« CFM velocity range
« Acoustic output
+ Wall echo filter
462  |Color Flow-Mode  Packet size
« Frame rate control
« CFM spatial filter
+ CFM frame averaging
+ CFM line resolution
« Frequency/velocity baseline shift
463 |Controls available on “freeze” or recall
464  |Automatic optimization
465 SRI
466 |CrossXBeam - display non-compounded and compounded image simultaneously in split screen
467 |3D reconstruction from a stored CINE loop
» Gray map optimization
+TGC
468 |B/M/CrossXBeam-Mode + Colorized Band M
« Frame average (loops only)
- Dynamic range
469 |Anatomical M-Mode
470 |Magnification zoom
471 |Pan zoom

472

Maximum read zoom to 8x




473  |Baseline shift

474 |Sweep speed
» Gray map
« Post gain
» Baseline shift
+ Sweep speed
« Invert spectral wave form
« Compression

475  |PW mode « Rejection
« Colorized spectrum
» Display format
+ Doppler audio
+ Angle correct
« Quick angle correct
» Auto angle correct
» Overall gain (loops and stills)
« Color map
« Transparency map

476  |Color flow + Frame averaging (loops only)
« Flash suppression
« CFM display threshold
« Spectral invert for color/Doppler

477 |Anatomical M-Mode on cine loop
« Gray map, colorize
+ Post gain

478 14D + Change display - single, dual, quad sectional

or rendered

479 ea eme z atio

480 |General B-Mode

481 |Depth and distance

482 [Circumference (ellipse/trace)

483  |Area (ellipse/trace)

484  |Volume (ellipsoid)

485 |% Stenosis (area or diameter)

486 |Angle between two lines

487 |Dual B-mode capability

488 |General M-Mode

489 |M-Depth

490 |Distance

491 |Time

492 |Slope

493 [Heartrate

494 |General Doppler measurements/calculations

495 |Velocity

496 |Time

497 |A/Bratio (velocities/frequency ratio)

498  [PS (Peak Systole)

499 |ED (End Diastole)

500 |PS/ED (PS/ED Ratio)

501 |ED/PS (ED/PS Ratio)

502 |AT (Acceleration Time)

503 |ACCEL (Acceleration)

504 |TAMAX (Time Averaged Maximum Velocity)

505 [Volume flow (TAMEAN and vessel area)

506 [Heartrate

507 [Pl (Pulsatility Index)

508 [RI (Resistivity Index)

509 |Real-time Doppler Auto Measurements/Calculations

510 |PS (Peak Systole)

511 [ED (End Diastole)

512 |MD (Minimum Diastole)

513 [Pl (Pulsatility Index)

514 [RI (Resistivity Index)

515 |AT (Acceleration Time)




516 |ACC (Acceleration)
517 PS/ED (PS/ED Ratio)
518 ED/PS (ED/PS Ratio)
519 [HR (Heart Rate)
520 |TAMAX (Time Averaged Maximum velocity)
521 |PVAL (Peak Velocity value)
522 |Volume flow (TAMEAN and vessel area)
523 |Abdominal measurements/calculations
524 |Shear Elasto velocity
525 [Shear Elasto stiffness
526 |Attenuation rate
527 |Attenuation coefficient
528 [Summary reports
529 |Small Parts measurements/calculations
530 [BreastLesion
531 |Thyroid
532 [Parathyroid
533 [Lymph Node
534 [Nodule
535 |Isthmus AP
536 |Shear Elasto velocity
537 [Shear Elasto stiffness
538 |Summary reports
539 |OB measurements/calculations
« GS (Gestational Sac)
+ CRL (Crown Rump Length)
+ FL (Femur Length)
+ BPD (Biparietal Diameter)
+ AC (Abdominal Circumference)
« HC (Head Circumference)
« APTD x TTD (Anterior/Posterior Trunk
Diameter by Transverse Trunk Diameter)
« FTA (Fetal Trunk Cross-sectional Area)
+ HL (Humerus Length)
+ BD (Binocular Distance)
540 |[Gestational age by « FT (Foot Length)
« OFD (Occipital Frontal Diameter)
« TAD (Transverse Abdominal Diameter)
- TCD (Transverse Cerebellum Diameter)
+ THD (Thorax Transverse Diameter)
+ TIB (Tibia Length)
+ ULNA (Ulna Length)
+ 00D (Outer Orbital Diameter)
+ 10D (Inner Orbital Diameter)
« FIB (Fibula length)
« Radius (Radius length)
« LV (Lateral Ventricle width) (= SL)
- AC,BPD
« AC, BPD, FL
« AC, BPD, FL, HC
541 Estimated Fetal Weight +AC, FL
(EFW) by: « AC, FL, HC
«AC,HC
- BPD, APTD, TTD, FL
- BPD, APTD, TTD, SL
542 |Fetal graphical trending
543  [Growth percentiles
544  [Multi-gestational calculations (4)
545 |Fetal qualitative description (anatomical survey)
546 |Fetal environmental description (biophysical profile)
547 |Programmable OB tables
548 |Over 20 selectable OB calculations
549 |Expanded worksheets
550 |Summary Reports




551 |OB Calculations and ratios

552 FL/BPD

553 FL/AC

554 FL/HC

555 HC/AC

556 [ClI (Cephalic Index)

557 |AFI (Amniotic Fluid Index)

558 |CTAR (Cardio-Thoracic Area Ratio)
Measurements/calculations by: Alexander, ASUM, ASUM 2001, Bahlmann, Baschat, Berkowitz, Bertagnoli, Brenner, Campbell, CFEF, Chervenak, Chitty, Doubilet,

559 |Ebing, Eik-Nes Goldstein, Hadlock, Hansmann, Hellman, Hill, Hohler, Jeanty, JSUM, Kramer, Kurmanavicius, Kurtz, Mari, Mayden, Mercer, Merz, Moore, Nelson,
Osaka University, Paris, Pexsters, Rempen, Robinson, Shepard, Shepard/Warsoff, Sonek, Tokyo University, Tokyo/Shinozuka, WHO, Williams, Yarkoni

560 |OB measure assistant

561 |Allows automatic measurement of BPD, HC, FL and AC

562 |User editable

563 [SonoNT and SonolT

564 |SonoNT measures the contour detection of the NT border

565 |SonolT is a system supported measurement for Intracranial Translucency

566 |GYN measurements/calculations

567 |Right ovary length, width, height

568 |Left ovary length, width, height

569 [Uterus length, width, height

570 [Cervix length, trace

571 [Ovarian volume

572 |ENDO (Endometrial thickness)

573 [OvarianRI

574 |Uterine RI

575 |Follicular measurements

576 |Fibroid measurements

577 |Qualitative description (anatomical survey)

578 |Mean Uterine Artery (Gomez) Doppler Measurement

579 [Summary reports

580 [Vascular measurements/calculations

581 |SYS DCCA (Systolic Distal Common Carotid Artery)

582 |DIAS DCCA (Diastolic Distal Common Carotid Artery)

583 [SYS MCCA (Systolic Mid Common Carotid Artery)

584 |DIAS MCCA (Diastolic Mid Common Carotid Artery)

585 |SYS PCCA (Systolic Proximal Common Carotid Artery)

586 |DIAS PCCA (Diastolic Proximal Common Carotid Artery)

587 |SYS DICA (Systolic Distal Internal Carotid Artery)

588 |DIAS DICA (Systolic Distal Internal Carotid Artery)

589 [SYS MICA (Systolic Mid Internal Carotid Artery)

590 |DIAS MICA (Diastolic Mid Internal Carotid Artery)

591 |SYS PICA (Systolic Proximal Internal Carotid Artery)

592 |DIAS PICA (Diastolic Proximal Internal Carotid Artery)

593 |SYS DECA (Systolic Distal External Carotid Artery)

594 [DIAS DECA (Diastolic Distal External Carotid Artery)

595 |SYS PECA (Systolic Proximal External Carotid Artery)

596 |DIAS PECA (Diastolic Proximal External Carotid Artery)

597 |VERT (Systolic Vertebral Velocity)

598 |SUBCLAV (Systolic Subclavian Velocity)

599 |Auto IMT (Option)

600 |Summary reports

601 [Urological measurements/calculations

602 |Bladder volume

603  |Prostate volume

604 [Left/right renal volume

605 |Generic volume

606 |Post-void bladder volume

607 |Pelvic floor measurements

608 |Summary reports

609 |TCD measurements/calculations

610 MCA, ACA, PCA, ICA

611 AComA, PCom A

612

Vert




613 |Basilar

614 MCA/ICA Ratio

615 |Summary reports

616 |Pediatric and Neonatal measurements/calculations

617 |Hipangle

618 |Hip orientation

619 |Summary reports

(] Probes (All Optional)

621 |6S-D, sector probe

622 |Applications Pediatric cardiac, pediatric abdomen

623 [Bandwidth 2.0-8.0 MHz

624 |Number of elements 96

625  |Field of view (max.) 115°

626  |Physical foot print 15x9 mm

627 |B-Mode frequency 40,4.2,5.0,5.5,6.5 MHz

628 Harmonic frequency 47,49,5.3,5.7,6.1,6.3 MHz

629 |PW Doppler frequency 2.8,3.1,3.6,4.2 MHz

630 |Color Doppler frequency 2.7,3.1,4.2,5.0 MHz

631 |6Tc-RS, trans-esophageal probe

632 |Applications Adult cardiac

633 [Bandwidth 2.0-8.0 MHz

634 |Number of elements 64

635 |Field of view (max.) 90°

636  |Physical foot print 37 x13x10 mm

637 |B-Mode frequency 5.0,6.0,6.5 MHz

638 |Harmonic frequency 6.0 MHz

639 |PW Doppler frequency 3.1,3.6,4.2,5.0,6.3 MHz

640 |Color Doppler frequency 3.3,4.1,4.7,5.5 MHz

641 BE9CS-D

642  |Applications Urology

. . Single angle, disposable (E8387M);

643 |Biopsy guide Single angle, reusable (E8387MA)

644 Bandwidth 3.0-12.0 MHz

645 |Number of elements 64

646 |Field of view (max.) 133°

647 |Physical foot print 19 x 19 mm

648 |B-Mode frequency 6.0,7.0,8.0,9.0 MHz

649  |Harmonic frequency 7.0,8.0,9.0, 10.0 MHz

650 |PW Doppler frequency 4.2,5.0,6.3 MHz

651 |Color Doppler frequency 4.3,6.3,8.2 MHz

652 |C1-6-D, XDclear™ convex probe

653  |Applications Abdomen, OB/GYN, pediatric, peripheral vascular, general
musculoskeletal

654  |Biopsy guide Multi-angle, disposable with a reusable bracket (H4917VB)

655 [Bandwidth 1.0 - 6.0 MHz

656 |Number of elements 192

657 |Field of view (max.) 80°

658  |Physical foot print 67 x 11 mm

659 |B-Mode frequency 2.0,2.5,3.0,40 MHz

660 |Harmonic frequency 1.5,2.5,3.0,4.5,6.0,6.5 MHz

661 |PW Doppler frequency 1.7,2.1,2.5,3.6 MHz

662 |Color Doppler frequency 1.8,2.1,25,2.8,3.0 MHz

663 |C1-6VN-D, VNav inside XDclear convex probe

664 |VNav sensor inside probe for Volume Navigation tracking without sensor cables

665 |Applications Abdomen, OB/GYN, pediatric, peripheral vascular, general
musculoskeletal

666 |Biopsy guide Multi-angle, disposable with a reusable bracket (H4917VB)

667 [Bandwidth 1.0 - 6.0 MHz

668 |Number of elements 192

669 |Field of view (max.) 80°

670 |Physical foot print 67 x11 mm

671 |B-Mode frequency 2.0,2.5,3.0,40MHz

672 Harmonic frequency 1.5,2.5,3.0,4.5,6.0,6.5 MHz

673 |PW Doppler frequency 1.7,2.1,2.5,3.6 MHz

674 |Color Doppler frequency 1.8,2.1,2.5,2.8, 3.0 MHz




675 |C2-7-D, micro convex biopsy probe

676 |Applications Abdomen, pediatric

677 |Biopsy guide Multi-angle, disposable with a reusable bracket (H40482LK),
Multi-Angle, reusable stainless bracket (H40482LL)

678 [Bandwidth 1.0 - 6.0 MHz

679 |Number of elements 144

680 |Field of view (max.) 110°

681 |Physical foot print 31x10 mm

682 |B-Mode frequency 2.5,4.0,6.0 MHz

683 Harmonic frequency 3.0,4.0,5.0,6.0 MHz

684 |PW Doppler frequency 1.8,2.1,2.5,3.1 MHz

685 |Color Doppler frequency 2.1,2.4,3.1,3.7 MHz

686 |C2-7-VN-D, VNav inside XDclear convex probe

687 |VNav sensor inside probe for Volume Navigation tracking without sensor cables

688 |Applications Abdomen, pediatric

639 |Biopsy guide Multi-angle, disposable with a reusable bracket (H40482LK),
Multi-Angle, reusable stainless bracket (H40482LL)

690 [Bandwidth 1.0- 6.0 MHz

691 [Number of elements 144

692 |Field of view (max.) 110°

693  |Physical foot print 31x10 mm

694 |B-Mode frequency 2.5,4.0,6.0 MHz

695 [Harmonic frequency 3.0,4.0,5.0,6.0 MHz

696 |PW Doppler frequency 1.8,2.1,2.5,3.1 MHz

697 |Color Doppler frequency 2.1,2.4,3.1,3.7 MHz

698 |C2-9-D, XDclear convex probe

699 |Applications Abdomen., OB/GYN, pediatric, peripheral vascular, neonatal, neonatal
transcranial, general musculoskeletal

700 |Biopsy guide Multi-angle, disposable with a reusable bracket (H4913BA)

701 |Bandwidth 2.0 -9.0 MHz

702  [Number of elements 192

703  |Field of view (max.) 80°

704 |Physical foot print 52 x9 mm

705 [B-Mode frequency 3.0,4.5,6.0,7.0 MHz

706 Harmonic frequency 2.5,35,5.0,7.0,9.0 MHz

707 PW Doppler frequency 2.5,3.1,36,4.2,5.0,6.3 MHz

708 [Color Doppler frequency 3.1,4.2,4.6,5.4 MHz

709 [C2-9-VN-D, VNav inside XDclear convex probe

710 |VNav sensor inside probe for Volume Navigation tracking without sensor cables

711 |Applications Abdomen.v OB/GYN, pediatric, peripheral vascular, neonatal, neonatal
transcranial, general musculoskeletal

712  |Biopsy guide Multi-angle, disposable with a reusable bracket (H4913BA)

713  |Bandwidth 2.0-9.0 MHz

714 [Number of elements 192

715 |Field of view (max.) 80°

716 |Physical foot print 52x9 mm

717 |B-Mode frequency 3.0,4.5,6.0, 7.0 MHz

718 [Harmonic frequency 2.5,3.5,5.0,7.0,9.0 MHz

719 [PW Doppler frequency 2.5,3.1,3.6,4.2,5.0,6.3 MHz

720 [Color Doppler frequency 3.1,4.2,4.6,5.4 MHz

721 [C3-10-D, XDclear micro convex probe

722 |Applications Abdomen, neonatal, pediatric, peripheral vascular, neonatal transcranial,
small part

723 Bandwidth 2.0-11.0MHz

724 [Number of elements 192

725  [Field of view (max.) 95°

726  |Physical foot print 26 x5 mm

727  |B-Mode frequency 4.0,6.0,8.0 MHz

728 Harmonic frequency 6.0, 8.0,10.0 MHz

729 |PW Doppler frequency 3.1,4.2,6.3,7.1 MHz

730 [Color Doppler frequency 3.9,5.3,6.6 MHz

731 [1C5-9-D, micro convex probe

732 |Applications OB/GVYN, urology

733 |Biopsy guide Single angle, disposable with a disposable bracket (E8385MJ)

or reusable bracket (H40412LN)




734 Bandwidth 3.0 - 10.0 MHz

735 |[Number of elements 192

736 |Field of view (max.) 180°

737  |Physical foot print 26 X 6 mm

738 |B-Mode frequency 45,5.0,5.5,6.0,7.0,8.0 MHz

739 Harmonic frequency 6.0, 6.5,7.0,9.0 MHz

740 |[PW Doppler frequency 3.6,4.2,5.0 MHz

741 [Color Doppler frequency 4.6,5.9,6.7 MHz

742 |L2-9-D, XDclear linear probe
Peripheral vascular, pediatric, abdomen, OB/GYN, general

743  |Applications musculoskeletal, superficial musculoskeletal, neonatal, neonatal
transcranial and small parts inculding breast, thyroid and scrotal

744  [Biopsy guide Multi-angle, disposable with a reusable bracket (H44901AM)

745 Bandwidth 2.0 -10.0 MHz

746  [Number of elements 192

747  |Field of view (max.) 44 mm

748  |Physical foot print 53 x 14 mm

749 B-Mode frequency 4.0,4.5,5.0, 6.0, 7.0 MHz

750 [Harmonic frequency 5.0,6.0,7.0,8.0,9.0,9.4 MHz

751 PW Doppler frequency 2.5,2.8,3.1,36,4.2,5.0 MHz

752 |Color Doppler frequency 3.1,4.0,4.6,5.3 MHz

753 |L2-9VN-D, VNav inside XDclear linear probe

754  |VNav sensor inside probe for Volume Navigation tracking without sensor cables
Peripheral vascular, pediatric, abdomen, OB/GYN, general

755  |Applications musculoskeletal, superficial musculoskeletal, neonatal, neonatal
transcranial and small parts inculding breast, thyroid and scrotal

756 |Biopsy guide Multi-angle, disposable with a reusable bracket (H44901AM)

757 Bandwidth 2.0 -10.0 MHz

758 [Number of elements 192

759 [Field of view (max.) 44 mm

760 |Physical foot print 53 x 14 mm

761 B-Mode frequency 4.0,4.5,5.0, 6.0, 7.0 MHz

762 [Harmonic frequency 5.0,6.0,7.0,8.0,9.0,9.4 MHz

763 PW Doppler frequency 2.5,28,3.1,36,4.2,5.0MHz

764 |Color Doppler frequency 3.1,4.0,4.6,5.3 MHz

765 |L3-12-D, linear probe
Abdomen, OB, general musculoskeletal,

766  |Applications superficial musculoskeletal, neonatal, neonatal transcranial, small parts,
vascular

767 |Biopsy guide Multi-angle, disposable with a reusable bracket (H78652PA)

768 Bandwidth 3.0-11.0 MHz

769  [Number of elements 256

770 |Field of view (max.) 51 mm

771  |Physical foot print 51 x4 mm

772 |B-Mode frequency 6.0, 8.0,10.0, 12.0 MHz

773 [Harmonic frequency 4.0, 6.0, 8.0,10.0,12.0 MHz

774  |PW Doppler frequency 4.2,5.0,6.3,8.3 MHz

775 |Color Doppler frequency 4.3,49,54,6.1,7.2,8.0MHz

776 |L6-24-D, linear probe

777 | Applications General musculoskel.etal., superﬁc.ial
musculoskeletal, pediatrics, thyroid

778 [Bandwidth 6.0 - 20.0 MHz

779  [Number of elements 192

780 [Field of view (max.) 26 mm

781 |Physical foot print 26 x 2 mm

782 [B-Mode frequency 12.0,16.0,21.0 MHz

783 Harmonic frequency 12.0, 18.0, 24.0 MHz

784  |PW Doppler frequency 8.3,10.0,12.5 MHz

785 [Color Doppler frequency 9.2,11.2,12.2 MHz

786 |L8-18i-D, linear probe

787 | Applications Small parts, peripheral va§cular, neonatal, neqnatal transFraniaI, general
musculoskeletal, superficial musculoskeletal, intraoperative

788 Bandwidth 4.0-15.0 MHz

789  [Number of elements 168




790 |Field of view (max.) 25 mm

791 [Physical foot print 35x 10 mm

792 |B-Mode frequency 7.0,9.0,13.0,16.0 MHz

793 Harmonic frequency 14.0, 16.0, 18.0 MHz

794  |PW Doppler frequency 5.0,6.3,7.1,8.3 MHz

795 [Color Doppler frequency 6.3,6.7,9.6, 10.5 MHz

796 |M5Sc-D, XDclear sector probe

797  |Applications Adult cardiac, pediatric cardiac, adult cephalic, abdominal

798 [Biopsy guide Multi-angle, disposable with a reusable bracket (H45561FC)

799 |Bandwidth 1.0 - 5.0 MHz

800 |Number of elements 288

801 [Field of view (max.) 120°

802 |Physical foot print 28 x 17 mm

803  |B-Mode frequency 2.0,2.5,3.5,45MHz

804 [Harmonic frequency 2.4,3.0,3.2,3.3,3.7,4.0, 4.5 MHz

805 |PW Doppler frequency 16,1.7,1.8,1.9,62.1,25,3.1,3.6 MHz

806 |Color Doppler frequency 1.7,18,19,2.2,2.4,25,3.0,3.1,3.7,3.8 MHz

807 |ML6-15-D, matrix array linear probe
Abdomen, peripheral vascular, neonatal, pediatric, neonatal transcranial,

808 |Applications general musculoskeletal, superficial musculoskeletal and small parts
inculding breast, thyroid and scrotal

809 |[Biopsy guide Multi-angle, disposable with a reusable bracket (H40432LJ)

810 [Bandwidth 4.0-16.0 MHz

811 |[Number of elements 1008

812 |Field of view (max.) 50 mm

813  |Physical foot print 50 x 10 mm

814 |B-Mode frequency 7.0,9.0,10.0,11.0,12.0,15.0 MHz

815 Harmonic frequency 10.0,12.0, 14.0, 15.0 MHz

816 |PW Doppler frequency 5.0,6.3,8.3 MHz

817 Color Doppler frequency 5.1,6.1,7.3,8.2,9.2,10.3,11.4,12.4 MHz

818 |P2D, CW split crystal probe

819 |Applications Adult cardiac, pediatric cardiac, peripheral vascular, adult cephalic

820 |Frequency 2.1 MHz

821 |P6D, CW split crystal probe

822 |Applications Adult cardiac, pediatric cardiac, peripheral vascular, adult cephalic

823 |Frequency 6.3 MHz

824 |RAB6-D, convex volume probe

825 |Applications Abdomen, OB/GYN, pediatric, neonatal

826  |Biopsy guide Single angle, reusable bracket (H46701AE)

827 Bandwidth 2.0 -8.0MHz

828 |Number of elements 192

829 |Field of view (max.) 80°

830 |Physical foot print 62 x 34 mm

831 |B-Mode frequency 3.5,5.0,8.0 MHz

832 Harmonic frequency 4.0,5.0,6.5,8.0 MHz

833 |PW Doppler frequency 3.1,4.2,5.0 MHz

834 |Color Doppler frequency 2.8,3.5,3.8 MHz

835 |RIC5-9-D, convex volume probe

836 |Applications OB/GVYN, urology

837 |Biopsy guide Single angle, reusable (H46721R)

838 |Bandwidth 3.0 - 10.0 MHz

839 |Number of elements 192

840 |Field of view (max.) 180°

841 |Physical foot print 32x27 mm

842 |B-Mode frequency 5.0,5.5,6.0,6.5,7.0,8.0 MHz

843  |Harmonic frequency 6.0, 6.5,7.0,9.0 MHz

844 |PW Doppler frequency 3.6,4.2,5.0 MHz

845 |Color Doppler frequency 4.3,6.1,7.3 MHz

846 External Inputs and outputs

(not including on-board peripherals)

847 HDMI

848 |Ethernet

849  |Multiple USB 3.0 ports

gl Safety Conformance




851 |The LOGIQ Fortis is:

852 |Classified to UL 60601-1 by a Nationally Recognized Test Lab

853 |Certified to CAN/CSA-C22.2 No. 60601.1-M90 by an SCC accredited test lab

854 |CE Marked to EU Medical Device Regulation MDR 2017/745

855 |Compliant to Council Directive 2011/65/EU for RoHS
+ EMC Emissions group 1 class A device requirements as per sub clause
4.2 of CISPR 11
+ |[EC 60601-1 Medical electrical equipment - Part 1: General
requirements for safety
+ |[EC 60601-1-2 Medical electrical equipment - Part 1-2: General
requirements for basic safety and essential performance - Collateral
standard: Electromagnetic disturbance - Requirements and tests
+ [EC 60601-1-6 Medical electrical equipment Part 1-6 general

856 |Conforms to the following standards for safety (including national deviations) requirements for basic safety and essential performance - Collateral

standard: usability

+ |[EC 60601-2-37 Medical electrical equipment - Part 2-37: Particular
requirements for the safety of ultrasonic medical diagnostic and
monitoring equipment

+ IEC 62366 Medical devices - Application of usability engineering to
medical devices

+ [IEC62366-1 Medical device software - Software life-cycle processes
+1SO 10993-1 Biological evaluation of medical devices - Part 1: Evaluation
and testing within a risk management process




EYAll Supplement: cardiac measurements/calculations

858 B-Mode measurements

« Aortic Root Diameter (Ao Root Diam)
« Aortic Arch Diameter (Ao Arch Diam)
+ Ascending Aortic diameter (Ao Asc)
» Descending Aortic Diameter (Ao Desc Diam)
« Aorta Isthmus (Ao Isthmus)
- Aorta (Ao st junct)
» Aortic Valve Cusp Separation (AV Cusp)
« Aortic Valve Area Planimetry
(AVA Planimetry)
- (Trans AVA)
« Left Atrium Diameter (LA Diam)
+ LA Length (LA Major)
« LA Width (LA Minor)
« Left Atrium Diameter to AoRoot Diameter Ratio (LA/Ao ratio)
« Left Atrium Area (LAA(d), LAA(s))
« Left Atrium Volume, Single Plane, Method of Disk (LAEDV A2C, LAESV
A2C) (LAEDV A4C, LAESV A4C), (LAEDV A-L, LAEDV Index A-L, LAESV A-L,
LAESV Index A-L)
. Left Ventricle Mass (LVPWd, LVPWs)
« Left Ventricle Volume, Teichholz/Cubic (LVIDd, LVI Ds)
« Left Ventricle Internal Diameter (LVIDd, LVI Ds) Left Ventricle Length
(LVLd, LVLs)
» Left Ventricle Outflow Tract Diameter (LVOT Diam)
« Left Ventricle Posterior Wall Thickness (LVPWd, LVPWs)
» Left Ventricle Length (LV Major)
862 |Leftventricle » Left Ventricle Width (LV Minor)
- Left Ventricle Outflow Tract Area (LVOT)
« Left Ventricle Area, Two Chamber/Four Chamber/Short Axis (LVA (d),
LVA (s))
« Left Ventricle Endocardial Area, Width (LVA (d), LVA(s))
« Left Ventricle Epicardial Area, Length (LVAepi (d), LVAepi (s))
« Left Ventricle Mass Index (LVPWd, LVPWSs)
« Ejection Fraction, Teichholz/Cube (LVIDd, LVIDs)

859 |Aorta

860 |Aortic valve

861 |Leftatrium

« Left Ventricle Posterior Wall Fractional Shortening (LVPWd, LVPWs)

- Left Ventricle Stroke Index, Teichholz/Cube (LVIDd, LVIDs and Body
Surface Area)

» Left Ventricle Fractional Shortening (LVIDd, LVIDs)

« Left Ventricle Stroke Volume, Teichholz/Cubic (LVIDd, LVIDs)

« Left Ventricle Stroke Index, Single Plane, Two Chamber, Method of Disk
(LVI Dd, LVIDs, LVSd, LVSs)

« Left Ventricle Stroke Index, Single Plane, Four Chamber, Method of Disk
(LVI Dd, LVIDs, LVSd, LVSs)

« Left Ventricle Stroke Index, Bi-Plane,

Bullet, Method of Disk (LVAd, LVAs)

- Interventricular Septum (IVS)

« Left Ventricle Internal Diameter (LVI D)

- Left Ventricle Posterior Wall Thickness (LVPW)

863 |Left ventricle continued

« Mitral Valve Annulus Diameter (MV Ann Diam)

864  |Mitral valve « E-Point-to-Septum Separation (EPSS)

« Mitral Valve Area Planimetry (MVA Planimetry)

« Pulmonic Valve Area (PV Planimetry)

+ Pulmonic Valve Annulus Diameter
(PV Annulus Diam)

» Pulmonic Diameter (Pulmonic Diam)

+ Right Atrium Diameter, Length (RAD Ma)

» Right Atrium Diameter, Width (RAD Mi)

« Right Atrium Area (RAA)

« Right Atrium Volume, Single Plane, Method of Disk (RAAd)

+ Right Atrium Volume, Systolic, Single Plane, Method of Disk
(RAAS)

865  [Pulmonic valve

866 |Right atrium




867

Right ventricle

« Right Ventricle Outflow Tract Area (RVOT Planimetry)
» Left Pulmonary Artery Area (LPA Area)

« Right Pulmonary Artery Area (RPA Area)

« Right Ventricle Internal Diameter (RVIDd, RVIDs)

« Right Ventricle Diameter, Length (RVD Ma)

» Right Ventricle Diameter, Width (RVD Mi)

« Right Ventricle Wall Thickness (RVAWd, RVAWs)

» Right Ventricle Outflow Tract Diameter (RVOT Diam)
« Left Pulmonary Artery (LPA)

+ Main Pulmonary Artery (MPA)

« Right Pulmonary Artery (RPA)

868

System inferior vena cava

« Systemic Vein Diameter (Systemic Diam)

« Patent Ductus Arterosis Diameter (PDA Diam)

» Pericard Effusion (PEs)

« Patent Foramen Ovale Diameter (PFO Diam)

« Ventricular Septal Defect Diameter (VSD Diam)

» Interventricular Septum (IVS) Fractional Shortening (1VSd, IVSs)

869

Tricuspid valve

« Tricuspid Valve Area (TV Panimetry)
- Tricuspid Valve Annulus Diameter (TV Annulus Diam)

870

M-Mode measurements

871

Aorta

« Aortic Root Diameter (Ao Root Diam)

« Aortic Valve

- Aortic Valve Diameter (AV Diam)

« Aortic Valve Cusp separation (AV Cusp)
» Aortic Valve Ejection Time (LVET)

872

Left atrium

« Left Atrium Diameter to AoRoot Diameter Ratio (LA/Ao Ratio)
« Left Atrium Diameter (LA Diam)

873

Left ventricle

« Left Ventricle Volume, Teichholz/Cubic (LVIDd, LVI Ds)

« Left Ventricle Internal Diameter (LVIDd, LVI Ds)

« Left Ventricle Posterior Wall Thickness (LVPWd, LVPWs)
« Left Ventricle Ejection Time (LVET)

» Left Ventricle Pre-Ejection Period (LVPEP)

« Interventricular Septum (IVS)

« Left Ventricle Internal Diameter (LVI D)

- Left Ventricle Posterior Wall Thickness (LVPW)

874

Mitral valve

« E-Point-to-Septum Separation (EPSS)

« Mitral Valve Leaflet Separation (D-E Excursion)

« Mitral Valve Anterior Leaflet Excursion (D-E Excursion)
- Mitral valve D-E Slope (D-E Slope)

« Mitral Valve E-F Slope (E-F Slope)

« Mitral Annular Plane Systolic Excursion (MAPSE)

875

Pulmonic valve

-+ QRS Complex to End of Envelope (Q-PV close)

876

Right ventricle

« Right Ventricle Internal Diameter (RVIDd, RVIDs)

* Right Ventricle Wall Thickness (RVAWd, RVAWS)

+ Right Ventricle Outflow Tract Diameter (RVOT Diam)
* Right Ventricle Ejection Time (RVET)

« Right Ventricle Pre-Ejection Period (RVPEP)

877

System

« Pericard Effusion (PE (d))

878

Tricuspid valve

+ QRS Complex to End of Envelope (Q-TV close)
« Tricuspid Annular Plane Systolic Excursion (TAPSE)




879

Doppler Mode measurements

880

Aortic valve

« Aortic Insufficiency Mean Pressure Gradient (AR Trace)
« Aortic Insufficiency Peak Pressure Gradient (AR Vmax)
« Aortic Insufficiency End Diastole Pressure Gradient (AR Trace)
» Aortic Insufficiency Mean Velocity (AR Trace)

« Aortic Insufficiency Velocity Time Integral (AR Trace)

« Aortic Valve Mean Velocity (AV Trace)

+ Aortic Valve Velocity Time Integral (AV Trace)

« Aortic Valve Mean Pressure Gradient (AV Trace)

+ Aortic Valve Peak Pressure Gradient (AR Vmax)

« Aortic Insufficiency Peak Velocity (AR Vmax)

« Aortic Insufficiency End-Diastolic Velocity (AR Trace)

» Aortic Valve Peak Velocity (AV Vmax)

« Aortic Valve Peak Velocity at Point E (AV Vmax)

881

Aortic valve continued

« Aorta Proximal Coarctation (Coarc Pre-Duct)

« Aorta Distal Coarctation (Coarc Post-Duct)

« Aortic Valve Insufficiency Pressure Half Time (AR PHT)

« Aortic Valve Flow Acceleration (AV Trace)

« Aortic Valve Pressure Half Time (AV Trace)

« Aortic Valve Acceleration Time (AV Acc Time)

« Aortic Valve Deceleration Time (AV Dec Time)

« Aortic Valve Ejection Time (AVET)

« Aortic Valve Acceleration to Ejection Time Ratio (AV Acc Time, AVET)
+ Aortic Valve Area(VTI): AVA (Vmax)

882

Left ventricle

» Left Ventricle Outflow Tract Peak Pressure Gradient (LVOT Vmax)
- Left Ventricle Outflow Tract Peak Velocity (LVOT Vmax)

» Left Ventricle Outflow Tract Mean Pressure Gradient (LVOT Trace)
- Left Ventricle Outflow Tract Mean Velocity (LVOT Trace)

» Left Ventricle Outflow Tract Velocity Time Integral (LVOT Trace)

» Left Ventricle Ejection Time (LVET)

883

Mitral valve

- E' Early diastolic mitral valve annular velocity (E')

+ E’ Avg Averaged early diastolic mitral valve annular velocity
(E' Avg)

« E’ Lat Early diastolic mitral valve lateral annular velocity (E’ Lat)

« E' Medial Early diastolic mitral valve medial annular velocity
(E’ Medial)

« E' Sept Early diastolic mitral

« Mitral inflow E velocity to E’ ratio (E/E’)

» Mitral inflow E velocity to E’ Avg ratio (E/E’ Avg)

« Mitral inflow E velocity to E’ Lat ratio (E/E’ Lat)

« Medial Mitral inflow E velocity to E’ Medial ratio (E/E’)

« Mitral inflow E velocity to E’ Sept ratio (E/E’ Sept)

« Mitral Valve Regurgitant Flow Acceleration (MR Trace)

» Mitral Valve Regurgitant Mean Velocity (MR Trace)

884

Mitral valve continued

+ Mitral Regurgitant Mean Pressure Gradient (MR Trace)
« Mitral Regurgitant Velocity Time Integral (MR Trace)

« Mitral Valve Mean Velocity (MV Trace)

« Mitral Valve Velocity Time Integral (MV Trace)

+ Mitral Valve Mean Pressure Gradient (MV Trace)

» Mitral Regurgitant Peak Pressure Gradient (MR Vmax)
+ Mitral Valve Peak Pressure Gradient (MV Vmax)

» Mitral Regurgitant Peak Velocity (MR Vmax)

« Mitral Valve Peak Velocity (MV Vmax)

« Mitral Valve Velocity Peak A (MV A Velocity)

» Mitral Valve Velocity Peak E (MV E Velocity)
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Mitral valve continued

» Mitral Valve Area According to PHT (MV PHT)

« Mitral Valve Flow Deceleration (MV DecT)

« Mitral Valve Pressure Half Time (MV PHT)

« Mitral Valve Flow Acceleration (MV AccT)

- Mitral Valve E-Peak to A-Peak Ratio (A-C and D-E) (MV E/ARatio)

« Mitral Valve Acceleration Time

+(MV Acc Time)

« Mitral Valve Deceleration Time (MV Dec Time)

» Mitral Valve Ejection Time ((MVET)

« Mitral Valve A-Wave Duration (MV A Dur)

« Mitral Valve Time to Peak (MV TTP)

« Mitral Valve Acceleration Time/Deceleration Time Ratio
(MVAcc/Dec Time)

» Stroke Volume Index by Mitral Flow (MVA Planimetry, MVTrace)

886

Pulmonic Valve

« Pulmonic Insufficiency Peak Pressure Gradient (PR Vmax)

+ Pulmonic Insufficiency End-Diastolic Pressure Gradient (PRTrace)
+ Pulmonic Valve Peak Pressure Gradient (PV Vmax)

+ Pulmonic Insufficiency Peak Velocity (PR Vmax)

« Pulmonic Insufficiency End-Diastolic Velocity (Prend Vmax)

+ Pulmonic Valve Peak Velocity (PV Vmax)

« Pulmonary Artery Diastolic Pressure (PV Trace)

« Pulmonic Insufficiency Mean Pressure Gradient (PR Trace)

887

Pulmonic valve continued

+ Pulmonic Valve Mean Pressure Gradient (PV Trace)
« Pulmonic Insufficiency Mean Square Root Velocity (PR Trace)
+ Pulmonic Insufficiency Velocity Time Integral (PR Trace)
« Pulmonic Valve Mean Velocity (PV Trace)
+ Pulmonic Valve Velocity Time Integral (PV Trace)
« Pulmonic Insufficiency Pressure Half Time (PR PHT)
+ Pulmonic Valve Flow Acceleration (PV Acc Time)
+ Pulmonic Valve Acceleration Time (PV Acc Time)
+ Pulmonic Valve Ejection Time (PVET)
+ QRS Complex to End of Envelope (Q-to-PV Close)
+ Pulmonic Valve Acceleration to Ejection TIme Ratio
(PV Acc Time, PVET)

888

Right ventricle

» Right Ventricle Outflow Tract Peak Pressure Gradient

(RVOT Vmax)
« Right Ventricle Outflow Tract Peak Velocity (RVOT Vmax)
« Right Ventricle Outflow Tract Velocity Time Integral (RVOTTrace)
» Right Ventricle Ejection Time (RV Trace)
« Stroke Volume by Pulmonic Flow (RVOT Planimetry, RVOTTrace)
» Right Ventricle Stroke Volume Index by Pulmonic Flow

(RVOT Planimetry, RVOT Trace)

889

System

« Pulmonary Artery Peak Velocity (PV Vmax)

« Pulmonary Vein Velocity Peak A (Reverse) (P Vein A)

« Pulmonary Vein Peak Velocity (P Vein D, P Vein S)

« Systemic Vein Peak Velocity (PDA Diastolic, PDA Systolic)
« Ventricular Septal Defect Peak Velocity (VSD Vmax)

- Atrial Septal Defect (ASD Diastolic, ASD Systolic)

« Pulmonary Vein A-Wave Duration (P Vein A Dur)

» IsoVolumetric Relaxation Time (IVRT)

« IsoVolumetric Contraction Time (IVCT)

- Pulmonary Vein S/D Ratio (P Vein D, P Vein S)

« Ventricular Septal Defect Peak Pressure Gradient (VSD Vmax)
» Pulmonic-to-Systemic Flow Ratio (Qp/Qs)

890

Tricuspid valve

» Tricuspid Regurgitant Peak Pressure Gradient (TR Vmax)
« Tricuspid Valve Peak Pressure Gradient (TV Vmax)

» Tricuspid Regurgitant Peak Velocity (TR Vmax)

« Tricuspid Valve Peak Velocity (TV Vmax)

« Tricuspid Valve Velocity Peak A (TV A Velocity)

« Tricuspid Valve Velocity Peak E (TV E Velocity)

» Tricuspid Regurgitant Mean Pressure Gradient (TR Trace)
» Tricuspid Valve Mean Pressure Gradient (TV Trace)
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Tricuspid valve continued

» Tricuspid Regurgitant Mean Velocity (TR Trace)

» Tricuspid Regurgitant Velocity Time Integral (TR Trace)

« Tricuspid Valve Mean Velocity (TV Trace)

» Tricuspid Valve Velocity Time Integral (TV Trace)

« Tricuspid Valve Time to Peak (TV TTP)

» Tricuspid Valve Ejection Time (TV Acc/Dec Time)

« Tricuspid Valve A-Wave Duration (TV A Dur)

+ QRS Complex to End of Envelope (Q-TV Close)

« Tricuspid Valve Pressure Half Time (TV PHT)

» Stroke Volume by Tricuspid Flow (TV Planimetry, TV Trace)
- Tricuspid Valve E-Peak to A-Peak Ratio (TV E/A Velocity)
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Color Flow Mode measurements

893

Aortic valve

« Proximal Isovelocity Surface Area:
Regurgitant Orifice Area (AR Radius)

« Proximal Isovelocity Surface Area:
Radius of Aliased Point (AR Radius)

« Proximal Isovelocity Surface Area:
Regurgitant Flow (AR Trace)

« Proximal Isovelocity Surface Area:
Regurgitant Volume Flow (AR Trace)

« Proximal Isovelocity Surface Area:
Aliased Velocity (AR Vmax)

894

Mitral valve

« Proximal Isovelocity Surface Area:
Regurgitant Orifice Area (MR Radius)

« Proximal Isovelocity Surface Area:
Radius of Aliased Point (MR Radius)

« Proximal Isovelocity Surface Area:
Regurgitant Flow (MR Trace)

« Proximal Isovelocity Surface Area:
Regurgitant Volume Flow (MR Trace)

« Proximal Isovelocity Surface Area:
Aliased Velocity (MR Vmax)

895

Combination Mode measurements

896

Aortic valve

« Aortic Valve Area (Ao Root Diam, LVOT Vmax, AV Vmax)
« Aortic Valve Area by Continuity Equation by Peak Velocity
(Ao Root Diam, LVOT Vmax, AV Vmax)
» Stroke Volume by Aortic Flow (AVA Planimetry, AV Trace)
« Cardiac Output by Aortic Flow (AVA Planimetry, AV Trace, HR)
« Aortic Valve Area by Continuity Equation VTI
(Ao Root Diam, LVOT Vmax, AV Trace)

897

Left ventricle

« Cardiac Output, Teichholz/Cubic (LVIDd, LVI Ds, HR)
» Cardiac Output Two Chamber, Single Plane,
Area-Length/Method of Disk (Simpson) (LVAd, LVAs, HR)
» Cardiac Output Four Chamber, Single Plane,
Area-Length/Method of Disk (Simpson) (LVAd, LVAs, HR)
« Ejection Fraction Two Chamber, Single Plane,
Area-Length/Method of Disk (Simpson) (LVAd, LVAs)
« Ejection Fraction Four Chamber, Single
Plane, Area-Length/Method of Disk (Simpson) (LVAd, LVAs)
« Left Ventricle Stroke Volume, Single Plane,
Two Chamber/Four Chamber, Area-Length (LVAd, LVASs)

898

Left ventricle continued

» Left Ventricle Stroke Volume, Single Plane,
Two Chamber/Four Chamber, Method of Disk (Simpson)
(LVIDd, LVIDs, LVAd, LVAs)
« Left Ventricle Volume, Two Chamber/Four Chamber,
Area-Length (LVAd, LVAs)
« Ejection Fraction, Bi-Plane,
Method of Disk (LVAd, LVAs, 2CH, 4CH)
« Left Ventricle Stroke Volume, Bi-Plane,
Method of Disk (LVAd, LVAs, 2CH, 4CH)
« Left Ventricle Volume, Bi-Plane,
Method of Disk (LVAd, LVAs, 2CH, 4CH)
« Left Ventricle Stroke Index, Single Plane,
Two Chamber/Four Chamber, Area-Length (LVSd, LVSs and BSA)
« Left Ventricle Volume, Single Plane,
Two Chamber/Four Chamber, Method of Disk (LVAd, LVAs)
« Left Ventricle Volume, Apical View,
Long Axis, Method of Disk (LVAd, LVAs)
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Mitral valve

« Stroke Volume by Mitral Flow (MVA Planimetry, MV Trace)
« Cardiac Output by Mitral Flow (MVA Planimetry, MV Trace, HR)

900

Pulmonic valve

« Stroke Volume by Pulmonic Flow (PV Planimetry, PV Trace)
« Cardiac Output by Pulmonic Flow (PV Planimetry, PV Trace, HR)

901

Tricuspid valve

» Cardiac Output by Tricuspid Flow (TV Planimetry, TV Trace, HR)

902

Combination Mode measurements

903

Parameter: lists the mode, the measurement folder and the specific measurement




904 |Measured Value: Up to six measurement values for each item. Average, maximum, minimum or last
905 |Generic study in cardiology

906 |Stroke Volume (SV)

907 |Cardiac Output (CO)
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LOGIQ Fortis’

Data sheet

The LOGIQ Fortis is GE’'s premium ultrasound imaging system designed for general
imaging applications including abdominal, vascular, obstetric, gynecologic, neonatal,
pediatric, urological, transcranial, cardiac, and small parts applications.
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General specifications

Dimensions and weight

(Dimensions given with floating keyboard stowed and
display tilted for transport)

Height 1250 - 1800 mm, 49 - 71"

Width 530 mm, 20.9" (Caster)
565 mm, 22.2" (Monitor)

Depth 885 mm, 34.8"

Weight 85 kg (187.4 Ib)

Electrical power
Voltage 100 - 240 VAC
Frequency 50/60 Hz

Power consumption maximum of 0.9 KVA with peripherals

Console design

4 active probe ports

1inactive probe storage port
Integrated SSD (1 TB)

Integrated DVD-R Multi Drive
On-board storage of thermal printer
Integrated speaker

Integrated locking mechanism that provides rolling lock and
caster swivel lock

Integrated cable management
Front and rear handles

Easily removable air filters

User interface

Operator keyboard

Operating keyboard, adjustable in height and rotation
Ergonomic hard key layout
Interactive back-lighting

Integrated recording keys for remote control of up to 4
peripheral or DICOM® devices

Integrated gel warmer

Touch screen

12.1" High-resolution, color, touch display screen
Interactive dynamic software menu
Brightness adjustment

User-configurable layout

Display monitor

23.8" Widescreen high-resolution HDU Display
Display translation (independent of console)

350 mm (13.7") horizontal (both directions)

120 mm (4.7") vertical

90° swivel (both directions)

Fold-down and lock mechanism for transportation
Resolution: 1920 x 1080

Anti-glare

Viewing angle 89/89/89/89°

System overview

Applications

Abdominal

Obstetrical

Gynecological

Breast

Small Parts

Peripheral Vascular

Transcranial (adult and neonatal)
Pediatric and Neonatal
Musculoskeletal (general and superficial)
Urological

Cardiac (adult and pediatric)
Interventional

Pleural



System overview (cont)

Operating modes

B-Mode

M-Mode

Color Flow Mode (CFM)

B-Flow™ (Option)

Extended Field of View (LOGIQ View)
Power Doppler Imaging (PDI)

PW Doppler

CW Doppler (Option)

« 3D Static
« 4D Real Time

Volume Modes (3D/4D)
(Option)

Anatomical M-Mode

Coded Contrast Imaging (Option)
Strain Elastography (Option)
B-Steer+ (Option)

Shearwave Elastography (Option)
UGAP (Option)

Scanning methods

Electronic sector
Electronic convex
Electronic linear

Mechanical volume sweep

Probe types

Sector phased array
Convex array

Micro convex array
Linear array

Matrix array
Volume probes (4D)

Split crystal

System standard features

Advanced user interface with high-resolution 12.1" display
touch panel

Automatic optimization

CrossXBeam”

Speckle Reduction Imaging (SRI-HD, Advanced SRI Type 1)
Fine angle steer

Coded harmonic imaging

Virtual convex

Patient information database

Image archive on integrated CD/DVD and hard drive
Advanced 3D

Real-time automatic Doppler calculations

OB calculations

Fetal trending

Multigestational calculations

Hip dysplasia calculations

Gynecological calculations

Vascular calculations

Urological calculations

Renal calculations

Cardiac calculations

InSite™ capability

On-board electronic documentation

Auto CF/PW positioning feature

Privacy and security, including user and rights management
LOGIQView

Breast productivity package (Option)

Thyroid productivity package (Option)

External USB printer connection

Network printer support

HDMI output (available for compatible devices)



System overview (cont)

Tricefy®

DICOM

B-Flow

Auto IMT

Compare assistant

Scan assistant

OB measure assistant

Color quantification

Strain Elastography

Elastography quantification
Advanced privacy and security (vulnerability scan)
Power assistant and scan on battery
Storage bins

Shear wave elastography

Volume navigation

UGAP

Hepatic assistant

Coded Contrast Imaging

Stress echo

Cardiac Strain (Automatic Function Imaging)
On-board reporting

TVI

Wireless LAN

CW

DVR

Tablet tools

Advanced probes

KOIOS

SonoNT SonolT

Advanced SRI Type 2

Peripheral options

Integrated options for =« Digital B&W thermal printer
+ DVD video recorder

Digital color thermal printer

Digital A6 color thermal printer

Foot switch with programmable functionality
Console protective cover

» Photo Assistant
« Remote Control

LOGIQ smart
device apps

CRF-200U card reader (for Japan)

Display modes

Live and stored
display format

« Full size and split screen - both w/
thumbnails. For still and CINE.

Review image format < 4x4, and thumbnails. For still and CINE.

+ Independent Dual B or CrossXBeam/
PW Display

+ CW

« Top/bottom selectable display format

+ Side/side selectable format

Timeline display

Virtual convex

Simultaneous capability

B or CrossXBeam/PW

B or CrossXBeam/CW (Option)
B or CrossXBeam/CFM or PDI
B/M

B/CrossXBeam

B-Flow/PW

Real-time Triplex Mode

B or CrossXBeam + CFM or PDI/PW

Selectable alternating modes
B or CrossXBeam/PW

B or CrossXBeam + CFM (PDI)/PW
B/CW (Option)



System overview (cont)

Multi-image (split/quad screen)

Live and/or frozen
B or CrossXBeam + B or CrossXBeam/CFM or PDI
PW/M

Independent CINE playback

Display annotation

Patient name: first, last, and middle
Patient ID

Alternate patient ID

Age, sex, and date of birth

Hospital name

Date format: three  « MM/DD/YY - DD/MM/YY
types selectable + YY/MM/DD
Time format: two « 24 hours - 12 hours

types selectable

Gestational age « LMP + GA
from - EDD « BBT
Probe name
Map names

Probe orientation
Depth scale marker

Lateral scale marker

Image depth

Zoom depth

B-Mode + Gain + Dynamic range
+ Imaging frequency < Frame averaging
» Gray map * SRI-HD

M-Mode + Gain « Dynamic range
« Time scale

Doppler Mode + Gain  Angle

+ Sample volume « Wall filter

depth and width  « Velocity and/or
« Spectrum inversion  frequency scale

« Time scale - PRF
« Doppler frequency

Display annotation (cont.)

Color Flow Doppler - Line density
Mode + Frame averaging
« Color Scale, 3 types: power, directional
PDI, and symmetrical velocity imaging
« Color velocity range and baseline
+ Color threshold marker
+ Color gain
- PDI
* Spectrum inversion
+ Doppler frequency

TGC curve

Acoustic frame rate

CINE gage, image number/frame number

Body pattern: multiple human and animal types
Application name

Measurement results

Operator message

Displayed acoustic < TIS:Thermal Index Soft Tissue
output « TIC: Thermal Index Cranial (Bone)
« TIB: Thermal Index Bone
+ MI: Mechanical Index

% of maximum power output
Biopsy guideline and zone

Heart rate

General system parameters

System setup

Pre-programmed categories
User programmable preset capability
Factory default preset data

Languages: English, French, German, Spanish, Italian, Brazilian
Portuguese, Russian, Greek, Swedish, Danish, Dutch, Finnish,
Norwegian

OB report formats including Tokyo Univ., Osaka Univ., USA,
Europe, ASUM, and WHO

User defined annotations
Body patterns
Customized comment home position

EZ Imaging: Simplified user interface for high volume workflow



General system parameters (ont)

Complete user manual available on-board
through Help (F1)

User manual and service manual are included on USB with
each system. A printed manual is available upon request.

CINE memory/image memory

1 GB of CINE memory

Selectable CINE sequence for CINE review

Prospective CINE mark

Measurements/calculations and annotations on CINE playback
Scrolling timeline memory

Dual Image CINE display

Quad Image CINE display

CINE gauge and CINE image number display

CINE review loop

CINE review speed

Image storage

On-board database of patient information from past exams

« Compressed/uncompressed
» Single/multi-frame

« Enhanced (3D/4D)

« With/without raw data

Storage formats:
DICOM

Export JPEG, JPEG 2000, WMV (MPEG 4) formats

« USB memory stick: 64 MB to 64 GB
(for exporting individual images/clips)

- CD-R storage: 700 MB

- DVD storage: -R (4.7 GB)

« Hard drive image storage: ~730GB

Storage devices

Compare previous exam images with current exam

Reload of archived data sets

Connectivity
Ethernet network connection
Wireless LAN 802.11ac/a/b/g/n (Option)

DICOM 3.0 « Verify

* Print

- Store

+ Modality worklist

« Storage commitment

« Modality performed procedure step (MPPS)
+ Media exchange

« Off network/mobile storage queue

« Query/retrieve
Public SR template

Structured Reporting - compatible with vascular, OB, cardiac,
and breast standard

InSite capability

Advanced privacy and security (Option)

Physiological input panel (Option)

Physiological * ECG, 1 channel

input « PCG, 1 channel
« AUX, 1 channel
+ Dual R-Trigger
« Pre-settable ECG R delay time
« Pre-settable ECG position
+ Adjustable ECG gain control
+ Pre-settable PCG position
« Adjustable PCG gain control
* Pre-settable AUX position
« Adjustable AUX gain control

Automatic heart rate display

Auto Ejection Fraction

Report writer (Option)

On-board reporting package automates report writing

Formats various exam results into a report suitable for
printing or reviewing on a standard PC

Exam results include patient info, exam info, measurements,
calculations, images, and comments with standard templates
provided

Customizable templates



General system parameters (ont)

Scanning parameters

Displayed imaging depth: 0 - 100 cm
Minimum depth of field: 0 - 2 cm (zoom) (probe dependent)
Maximum depth of field: 0 - 100 cm (probe dependent)

Continuous dynamic receive focus/continuous dynamic
receive Aperture
Adjustable dynamic range Adjustable field of view (FOV)
Image reverse: right/left

Image rotation of 0°, 90°, 180°, 270°

Digital B-Mode

« Gain

 Frame averaging
« Frequency

« Frame rate

Adjustable « Acoustic power
« Dynamic range
+ Gray scale map

+ Speed of sound

(application + CrossXBeam

dependent) « B colorization
- Scanning size * Reject

(FOV or Angle) + Suppression

- Probe type + SRI-HD

dependent; consult
individual probe
specifications

Digital M-Mode

+ Gain

+ Gray scale map
+ Sweep speed

+ M display format

Adjustable « Acoustic power
+ Dynamic range
 Frequency

+ M colorization

« Rejection

Anatomical M-Mode

M-Mode cursor adjustable at any plane
Can be activated from a CINE loop from a live or stored image
M & A capability

Available with Color Flow Mode

Digital Spectral Doppler Mode

Adjustable « Acoustic power + Gain

« Dynamic range « Gray scale map

« Transmit frequency « Wall filter

« PW colorization « Velocity scale

- Sweep speed range

+ Sample volume « Angle correction
length « Steered linear

« Spectrum inversion « Trace method

« Baseline shift « Doppler auto trace

« Time resolution « Compression

« Trace direction - Trace sensitivity

Digital Color Flow Mode

Adjustable « Acoustic power + Color maps,
- Gain including
« Velocity scale range  velocity-variance
» Wall filter maps

« Packet size « Line density

« Spatial filter « Steering angle
 Frame average « Threshold

+ Accumulation mode « Auto ROI

+ Flash suppression  placement and
« Shortcuts steering on

linear

Digital Power Doppler Imaging

Adjustable  Acoustic power + Color maps,
» Gain including
« Velocity scale range  velocity-variance
« Wall filter maps

« Packet size « Line density

« Spatial filter « Steering angle

» Frame average « Threshold

+ Accumulation mode + Flash suppression

» Shortcuts

Continuous Wave Doppler (Option)

Available on the following probes: M5Sc-D, P2D, P6D ,6S-D,
6Tc -RS

Steerable CW mode included

Adjustable + Acoustic power + Gain
« Dynamic range + Gray scale map
« Transmit frequency « Wall filter

« CW colorization  « Velocity scale

+ Sweep speed range

+ Angle correction  « Spectrum

+ Trace method inversion

« Baseline shift  Doppler auto
« Compression trace

» Trace direction « Trace sensitivity

Automatic optimization
Optimize B-Mode image to help improve contrast resolution

Selectable amount of contrast resolution improvement
(low, medium, high)

CTO (Continuous Tissue Optimization) - continuously adjusts
B-Mode axial and lateral gain uniformity and overall gain level,
suppressing the noise

Auto-spectral optimize - adjusts baseline, invert, PRF
(on live image), and angle correction

Auto CF and PW positioning - adjusts ROI position, sample
volume position, and steering



General system parameters (ont)

Coded Harmonic Imaging

Available on all 2D and 4D probes

B-Flow (Option)

Available on the following probes: C1-6-D, C1-6VN-D, C2-7-D,
C2-7VN-D, C2-9-D,C2-9VN-D, C3-10-D, L2-9-D, L2-9VN-D,
L3-12-D, ML6-15-D,M5Sc-D, L8-18i-D, L6-24D

Background
Sensitivity/PRI
Acoustic power
Frequency

Line density
Frame average
Gray scale map
Tint map
Dynamic range
Rejection

Gain

Flash suppression
SRI-HD
Accumulation

Visualization

Radiantflow”

Easy, fast visualization of tiny vessels, displaying as a 3D effect

B Steer+

Available on the following probes: L2-9-D, L3-12-D, ML6-15-D,
L8-18i-D, L2-9VN-D, L6-24

Coded contrast imaging (Option)

Available on the following probes: C1-6-D, C1-6VN-D,
C2-9-D, C2-9VN-D, C2-7-D, C2-7VN-D, C3-10-D, IC5-9-D,
L2-9-D, L2-9VN-D, L3-12-D, M5Sc-D, ML6-15-D, RAB6-D,
RIC5-9-D

2 contrast timers

Timed updates: 0.05 - 10 seconds

Accumulation mode, seven levels

Maximum enhance mode

Flash

Time intensity curve (TIC) analysis

Parametric imaging

The LOGIQ Fortis is designed for compatibility with most
commercially available ultrasound contrast agents. Because
the availability of these agents is subject to government
regulation and approval, product features intended for use
with these agents may not be commercially marketed nor
made available before the contrast agent is cleared for use.
Contrast related product features are enabled only on systems
for delivery to an authorized country or region of use.

LOGIQView

Extended field of view Imaging

Up to 160 cm (63") scan length

Available on all 2D imaging probes

For use in B-Mode

CrossXBeam is available on linear probes
Auto detection of scan direction

Pre-or post-process zoom

Rotation

Auto best fit on monitor

Measurements in B-Mode

Allows unlimited rotation and planar translations

3D reconstruction from CINE sweep

Advanced 3D
Acquisition of color data
Automatic rendering

3D landscape technology

3D movie



General system parameters (cont)

Real Time 4D (Option)

Acquisition modes - Real Time 4D + Spatio-Temporal
« Static 3D Image Correlation

+ 3D rendering (diverse surface and

intensity projection modes)

Sectional planes (3 section planes

perpendicular to each other)

Omniview

Volume contrast imaging - static

Volume contrast imaging - Omniview

Tomographic ultrasound imaging

Volume Analyses

- VOCAL: semi-auto/manual
segmentation tool (segmentation
using touch screen)

- 3D static only

- Threshold Volume: measure volume
above and below a threshold

Visualization modes

Surface texture, surface smooth, max-
min- and X-ray (average intensity projection),
mix mode of two render modes

+ HDlive"

Render mode

SonoRenderlive

Curved 3-point render start
3D movie

Scalpel: 3D cut tool

« Quad: A-/B-/C-Plane/3D
« Dual: A-Plane/3D
« Single: 3D or A- or B- or C-Plane

Display format

Automated volume calculation - VOCAL Il

Betaview

Volume navigation (Option)

Available on the following probes: C1-6VN-D, C2-9VN-D,
C2-7VN-D, C3-10-D, L2-9VN-D, ML6-15-D, IC5-9-D, L8-18i-D,
M5Sc-D

Sensor-based acquisition
Position markers

Needle tip tracking
Virtual tracking

Auto image registration

Tru3D feature
includes:

Display of data in: main-, parallel-,
angular-mode

Render modes: gray surface, texture, min-, max-, average-intensity
Measurements: distance, angle, area, volume

3D movie

Scan assistant (Option)

Factory programs
User-defined programs

Steps include image annotations, mode transitions, basic
imaging controls, and measurement initiation

Compare assistant (Option)

Allows side-by-side comparison of previous ultrasound
and other modality exams during live scanning

Breast productivity package

Auto measurement

Worksheet summary includes measurements and locations
for lesions and lymph nodes

Feature assessment
BI-RADS® assessment

User editable

Thyroid productivity package
Auto measurement

Worksheet summary includes measurements and locations
for nodule, parathyroid, and lymph node

Feature assessment
TI-RADs assessment

User editable

Start Assistant

Automatically select category, probe, preset, or scan assistant
from worklist exam description

Learn the category, probe, preset, and scan assistant based
on exam description

Shear Wave Elastography (Option)

Available on the following probes: C1-6-D, C1-6VN-D, IC5-9-D,
L2-9-D, L2-9VN-D,L3-12D, ML6-15-D, L8-18D

User programmable measurement display in kPa and meters
per second

Single and dual view display



General system parameters (cont)

Strain Elastography (Option)

Available on the following probes: ML6-15-D, L2-9-D,
L2-9VN-D, L3-12-D, IC5-9-D, C2-9-D, C2-9VN-D, C1-6-D,
C1-6VN-D, L8-18i-D, BE9CS-D

Relative analysis tool

UGAP (Option)

Available on the following probes: C1-6-D, C1-6VN-D, C2-9D,
C2-9VN-D

Measures liver attenuation” (attenuation coefficient [dB/cm/
MHz]) by auto measure algorithm with reference B-mode

Simple and 2D color map (attenuation color map and
Measurement Position Indicator Map)

Quantitative flow analysis (Option)

Available in color and power Doppler

TVI (Option)
Available on the following probes: M5Sc-D, 6S-D, 6TC-RS, 6Tc-RS
Myocardial Doppler imaging with color overlay on tissue image

Tissue color overlay can be removed to show just the 2D
image, still retaining the tissue velocity information

Curved anatomical M-Mode: free (curved) drawing of M-Mode
generated from the cursor independent of the axial plane

Q-Analysis: multiple time-motion trace display from selected
points in the myocardium

Stress echo (Option)

Advanced and flexible stress echo examination capabilities
Provides exercise and pharmacological protocol templates
6 default templates

Template editor for user configuration of existing templates
or creation of new templates

Reference scan display during acquisition for stress level
comparison (dual screen)

Baseline level/previous level selectable

Raw data continuous capture

Over 100 sec. available

Wall motion scoring (bulls-eye and segmental)

Smart stress: Automatically set up various scanning
parameters (e.g. geometry, frequency, gain) according to
same projection on previous level

Auto EF (Option)

Allows semi-automatic measurement of the global EF
(Ejection Fraction)

User editable

Cardiac AFI (Option)

Allows assessment of the complete left ventricle with all
segments at a glance by combining three longitudinal views
into one comprehensive bulls-eye view

2D strain-based data moves into clinical practice

Virtual convex

Provides a convex field of view
Compatible with CrossXBeam

Available on all linear and sector probes

SRI-HD and Advanced SRI

Speckle reduction imaging
Provides multiple levels of speckle reduction

Compatible with side-by-side DualView display

Advanced SRI: « Type 1
two types - Compatible with all linear, convex,
selectable and sector probes

« Type 2 (Option)
- Compatible with OB/GYN application

CrossXBeam

Provides variable angle spatial compounding

Live side-by-side DualView display

Compatible with + Color mode « PW
+ SRI-HD + Coded harmonic
« Virtual convex imaging

Available on all curved and linear probes

Controls available while “live”

Magnification Zoom: Magnifies the entire image on the screen
without zoom ROI

Pan Zoom: Magnifies the display of the data within the ROI

HD Zoom: Magnifies the image within the zoom ROI with
higher spatial resolution than original images

B/M/CrossXBeam-
Mode

- Gain - TGC

» Dynamic range « Acoustic output
 Framerate control < Sweep speed for
+ CrossXBeam angle M-Mode



General system parameters (cont)

Controls available while “live” (cont.)

PW-Mode + Gain « Dynamic range
« Acoustic output  « Transmission
+ PRF frequency
« Wall filter « Spectral averaging

+ Sample volume « Velocity scale

gate: length, depth

Color Flow Mode « CFM gain

» Acoustic output range

« Wall echo filter « Packet size

« Frame rate control « CFM spatial filter

« CFM frame « CFM line
averaging resolution

« Frequency/velocity baseline shift

« CFM velocity

Controls available on “freeze” or recall

Automatic optimization
SRI-HD

CrossXBeam - display non-compounded and compounded
image simultaneously in split screen

3D reconstruction from a stored CINE loop

B/M/CrossXBeam
mode

+ Gray map optimization

- TGC

+ Colorized Band M

« Frame average (loops only)
+ Dynamic range

Anatomical M-Mode
Magnification zoom
Pan zoom

Baseline shift

Sweep speed

PW mode - Gray map « Post gain
« Baseline shift + Sweep speed
« Invert spectral « Compression
wave form « Display format
« Colorized spectrum « Angle correct
+ Quick angle correct « Auto angle correct
Color flow « Overall gain (loops and stills)

+ Color map

« Transparency map

« Frame averaging (loops only)

« CFM display threshold

« Spectral invert for color/Doppler

Anatomical M-Mode on CINE loop

4D + Gray map, colorize
+ Post gain
+ Change display - single, dual, quad
sectional or rendered

Measurements/calculations

General B-Mode

Depth and distance
Circumference (ellipse/trace)
Area (ellipse/trace)

Volume (ellipsoid)

% Stenosis (area or diameter)
Angle between two lines

Dual B-Mode capability

General M-Mode

M-Depth
Distance
Time
Slope

Heart rate

General Doppler measurements/calculations
Velocity

Time

A/B ratio (velocities/frequency ratio)

PS (Peak Systole)

ED (End Diastole)

PS/ED (PS/ED Ratio)

ED/PS (ED/PS Ratio)

AT (Acceleration Time)

ACCEL (Acceleration)

TAMAX (Time Averaged Maximum Velocity)
Volume flow (TAMEAN and vessel area)
Heart rate

Pl (Pulsatility Index)

RI (Resistivity Index)

Real-time Doppler auto measurements/calculations
PS (Peak Systole)

ED (End Diastole)

MD (Minimum Diastole)

Pl (Pulsatility Index)

RI (Resistivity Index)



Measurements/calculations (cont)

Real-time Doppler auto measurements/calculations (cont.) OB measurements/calculations

AT (Acceleration Time) Gestational ageby  + GS (Gestational Sac)
+ CRL (Crown Rump Length)

ACC (Acceleration) « FL (Femur Length)

PS/ED (PS/ED Ratio) - BPD (Biparietal Diameter)
. « AC (Abdominal Circumference)
ED/PS (ED/PS Ratio) « HC (Head Circumference)

« APTD x TTD (Anterior/Posterior Trunk
Diameter by Transverse Trunk Diameter)

TAMAX (Time Averaged Maximum Velocity) « FTA (Fetal Trunk Cross-sectional Area)

+ HL (Humerus Length)

« BD (Binocular Distance)

Volume Flow (TAMEAN and Vessel Area) » FT (Foot Length)

+ OFD (Occipital Frontal Diameter)

» TAD (Transverse Abdominal Diameter)

Abdominal measurements/calculations + TCD (Transverse Cerebellum Diameter)

+ THD (Thorax Transverse Diameter)

- TIB (Tibia Length)

HR (Heart Rate)

PVAL (Peak Velocity Value)

Shear Elasto velocity

Shear Elasto stiffness + ULNA (Ulna Length)
) + OOD (Outer Orbital Diameter)
Attenuation rate + 10D (Inner Orbital Diameter)

« FIB (Fibula length)
+ Radius (Radius length)
Summary reports « LV (Lateral Ventricle width) (= SL)

Attenuation coefficient

Fetal graphical trending
Small Parts measurements/calculations

Growth percentiles

Breast Lesion . . .
Multi-gestational calculations (4)

Thyroid Fetal qualitative description (anatomical survey)
Parathyroid Fetal environmental description (biophysical profile)
Lymph Node Programmable OB tables

Nodule Over 20 selectable OB calculations

Isthmus AP

Expanded worksheets
Shear Elasto velocity

Shear Elasto stiffness Estimated fetal weight (EFW) by:
Summary reports AC, BPD

AC, BPD, FL

AC, BPD, FL, HC

AC, FL

AC, FL, HC

AC, HC

BPD, APTD, TTD, FL

BPD, APTD, TTD, SL



Measurements/calculations (cont)

Calculations and ratios

FL/BPD

FL/AC

FL/HC

HC/AC

Cl (Cephalic Index)

AFIl (Amniotic Fluid Index)

CTAR (Cardio-Thoracic Area Ratio)

Measurements/calculations by: Alexander, ASUM, ASUM 2001,
Bahlmann, Baschat, Berkowitz, Bertagnoli, Brenner, Campbell,
CFEF, Chervenak, Chitty, Doubilet, Ebing, Eik-Nes Goldstein,
Hadlock, Hansmann, Hellman, Hill, Hohler, Jeanty, JSUM, Kramer,
Kurmanavicius, Kurtz, Mari, Mayden, Mercer, Merz, Moore,
Nelson, Osaka University, Paris, Pexsters, Rempen, Robinson,
Shepard, Shepard/Warsoff, Sonek, Tokyo University,
Tokyo/Shinozuka, WHO, Williams, Yarkoni

OB measure assistant

Allows automatic measurement of BPD, HC, FL, AC, and HL

User editable

SonoNT and SonolT

SonoNT measures the contour detection of the NT border

SonolT is a system supported measurement for Intracranial
Translucency

GYN measurements/calculations
Right ovary length, width, height
Left ovary length, width, height
Uterus length, width, height

Cervix length, trace

Ovarian volume

ENDO (Endometrial thickness)
Ovarian Rl

Uterine RI

Follicular measurements

Fibroid measurements

Summary reports

Mean Uterine Artery (Gomez) Doppler Measurement and graph

Qualitative description (anatomical survey)

Vascular measurements/calculations

SYS DCCA (Systolic Distal Common Carotid Artery)
DIAS DCCA (Diastolic Distal Common Carotid Artery)
SYS MCCA (Systolic Mid Common Carotid Artery)

DIAS MCCA (Diastolic Mid Common Carotid Artery)
SYS PCCA (Systolic Proximal Common Carotid Artery)
DIAS PCCA (Diastolic Proximal Common Carotid Artery)
SYS DICA (Systolic Distal Internal Carotid Artery)

DIAS DICA (Systolic Distal Internal Carotid Artery)

SYS MICA (Systolic Mid Internal Carotid Artery)

DIAS MICA (Diastolic Mid Internal Carotid Artery)

SYS PICA (Systolic Proximal Internal Carotid Artery)
DIAS PICA (Diastolic Proximal Internal Carotid Artery)
SYS DECA (Systolic Distal External Carotid Artery)
DIAS DECA (Diastolic Distal External Carotid Artery)
SYS PECA (Systolic Proximal External Carotid Artery)
DIAS PECA (Diastolic Proximal External Carotid Artery)
VERT (Systolic Vertebral Velocity)

SUBCLAV (Systolic Subclavian Velocity)

Automatic IMT

Summary reports

Urological calculations

Bladder volume

Prostate volume
Left/right renal volume
Generic volume
Post-void bladder volume

Pelvic floor measurements



Probes (All Optional)

BE9CS-D

Applications: urology

Biopsy guide: single angle, disposable (E8387M);
single angle, reusable (E8387MA)

6S-D, sector probe

Applications: cardiac, pediatric cardiac

6Tc-RS, trans-esophageal probe
Applications: cardiac

TEE RS-DLP Adapter (H46352LK)

C1-6-D, XDclear™ convex probe

Applications: abdomen, OB/GYN, pediatric, peripheral
vascular, general musculoskeletal

Biopsy guide: multi-angle, disposable with a reusable bracket
(H4917VB)

C1-6VN-D, VNav inside XDclear convex probe

VNav sensor inside probe for Volume Navigation tracking
without sensor cables

Applications: abdomen, OB/GYN, pediatric, peripheral
vascular, general musculoskeletal

Biopsy guide: multi-angle, disposable with a reusable bracket
(H4917VB)

C2-7-D, micro convex biopsy probe

Applications: abdomen, pediatric

Biopsy guide: multi-angle, disposable with a reusable
bracket (H40482LK); multi-angle, with a reusable stainless
bracket (H40482LL)

C2-7VN-D, VNav inside micro convex biopsy probe

VNav sensor inside probe for Volume Navigation tracking
without sensor cables

Applications: abdomen, pediatric

Biopsy guide: multi-angle, disposable with a reusable
bracket (H40482LK); multi-angle, with a reusable stainless
bracket (H40482LL)

C2-9-D, XDclear convex probe

Applications: abdomen, OB/GYN, pediatric, peripheral vascular,
neonatal, neonatal transcranial, general musculoskeletal

Biopsy guide: multi-angle, disposable with a reusable bracket
(H4913BA)

C2-9VN-D, VNav inside XDclear convex probe

VNav sensor inside probe for Volume Navigation tracking
without sensor cables

Applications: abdomen, OB/GYN, pediatric, peripheral vascular,
neonatal, neonatal transcranial, general musculoskeletal

Biopsy guide: multi-angle, disposable with a reusable bracket
(H4913BA)

C3-10-D, XDclear micro convex probe

Applications: abdomen, neonatal, pediatric, peripheral vascular,
neonatal transcranial, small parts

IC5-9-D, micro convex probe

Applications: OB/GYN, urology

Biopsy guide: single angle, disposable with a disposable
bracket (E8385MJ) or a reusable bracket (H40412LN)

L2-9-D, XDclear linear probe

Applications: peripheral vascular, small parts, pediatric,
abdomen, OB/GYN, general musculoskeletal, superficial
musculoskeletal, neonatal, neonatal transcranial

Biopsy guide: multi-angle, disposable with a reusable bracket
(H44901AM)

L2-9VN-D, VNav inside XDclear linear probe

VNav sensor inside probe for Volume Navigation tracking
without sensor cables

Applications: peripheral vascular, small parts, pediatric,
abdomen, OB/GYN, general musculoskeletal, superficial
musculoskeletal, neonatal, neonatal transcranial

Biopsy guide: multi-angle, disposable with a reusable bracket
(H44901AM)

L3-12-D, linear probe

Applications: abdomen, OB, general musculoskeletal,
superficial musculoskeletal, neonatal, neonatal transcranial,
small parts, vascular

Biopsy guide: multi-angle, disposable with a reusable bracket
(H78652PA)

L6-24-D, linear probe

Applications: general musculoskeletal, superficial
musculoskeletal, pediatrics, thyroid



Probes (ont) Safety conformance

L8-18i-D, linear probe

The LOGIQ Fortis is:

Applications: small parts, peripheral vascular, neonatal, Classified to ANSI/AAMI ES60601-1 2005 R1 2012 Medical
neonatal transcranial, general musculoskeletal, superficial Electrical Equipment, Part 1: General Requirements for Safety
musculoskeletal, intraoperative by a Nationally Recognized Test Lab

Certified to CSA CAN/CSA-C22.2 NO. 60601-1:14 General

M5Sc-D, XDclear sector probe requirements for safety
Applications: adult cardiac, pediatric cardiac, adult cephalic, CE Markedto EU - IEC/EN 60601-1 Edition 3.1 Medical electrical
abdominal Medical Device equipment - Part 1: General requirements

Regulation MDR for basic safety and essential performance

Biopsy guide: multi-angle, disposable with a reusable bracket 2017-745 and « IEC/EN 60601-1-2 Medial electrical
(H45561FC) Council Directive  equipment - Parts 1-2: General
93/42/EEC on requirements for safety - Collateral
ML6-15-D, matrix array linear probe Medical Devices stant;lard: Electromagnetic compatibility -
and conforms requirements and tests
Applications: abdomen, small parts, peripheral vascular, to the following  « IEC/EN 60601-1-6 Medical electrical
neonatal, pediatric, neonatal transcranial, general standards for equipment Parts 1 -6: General requirements
musculoskeletal, superficial musculoskeletal safety: for basic safety and essential performance -

Collateral standard: usability

IEC/EN 60601-2-37 Medical electrical
equipment - Parts 2-37: Particular
requirements for the

P2D, CW split crystal probe safety ofultrasqnic medical diagnostic and
monitoring equipment

Applications: adult cardiac, pediatric cardiac, peripheral IEC 61157 (Standard means for the reporting
vascular, adult cephalic of the acoustic output of medical diagnostic
ultrasonic equipment)

IEC/EN 62366 Application of usability
engineering to medical devices

IEC/EN 62304 Software life cycle processes
IEC/EN 62359 Ultrasonic - Field
characterization - Test methods for the
determination of thermal and mechanical
RAB6-D, convex volume probe indices related to medical diagnostic
ultrasonic fields

ENISO 15223-1: Symbols to be used
Biopsy guide: single angle, reusable bracket (H46701AE) with medical device labels, labelling, and
information to be supplied

ISO 10993-1 Biological evaluation of medical
RIC5-9-D, convex volume probe devices - Part 1: Evaluation and testing
ISO14971:2012 (Medical devices -
Application of risk management to

Biopsy guide: single angle, reusable (H46721R) medical devices)

EMC Emissions Group 1, Class A device

requirements as per sub-clause 4.2 of
External Inputs and outputs CISPR 11

(not including on-board peripherals) WEEE (Waste Electrical and Electronic

Biopsy guide: multi-angle, disposable with a reusable bracket
(H40432LJ)

P6D, CW split crystal probe

Applications: adult cardiac, pediatric cardiac, peripheral
vascular, adult cephalic

Applications: abdomen, OB/GYN, pediatric, neonatal

Applications: OB/GYN, urology

HDMI Equipment) . . .
« ROHS according to 2011/65/EU including
Ethernet national deviations

« Wireless equipment shall be certified to
FCC, RED, and Japan Radio Law.

+ Medical Device Good Manufacturing Practice
Manual issued by the FDA (Food and Drug
Administration, Department of Health, USA)

Multiple USB 3.0 ports



Supplement: cardiac
measurements/calculations

B-Mode measurements B-Mode measurements (cont.)

Aorta « Aortic Root Diameter (Ao Root Diam) Left ventricle « Left Ventricle Mass (LVPWd, LVPWs)
- Aortic Arch Diameter (Ao Arch Diam) - Left Ventricle Volume, Teichholz/Cubic
+ Ascending Aortic Diameter (Ao Asc Diam) (LVIDd, LVI Ds)
- Descending Aortic Diameter (Ao Desc Diam) » Left Ventricle Internal Diameter (LVIDd,
« Aorta Isthmus (Ao Isthmus) LVI Ds) Left Ventricle Length (LVLd, LVLs)
« Aorta (Ao st junct) « Left Ventricle Outflow Tract Diameter
. , , (LVOT Diam)
Aortic valve . Aort!c Valve Cusp Sepgratlon (AV Cusp) « Left Ventricle Posterior Wall Thickness
- Aortic Valye Area Planimetry (LVPWd, LVPWs)
(AVA Planimetry) « Left Ventricle Length (LV Major)
0 LS5 « Left Ventricle Width (LV Minor)
Left atrium « Left Atrium Diameter (LA Diam) * Left Ventricle Outflow Tract Area (LVOT)
« LA Length (LA Major) « Left Ventricle Area, Two Chamber/Four
« LA Width (LA Minor) Chamber/Short Axis (LVA (d), LVA (s))
« Left Atrium Diameter to AoRoot Diameter « Left Ventricle Endocardial Area, Width
Ratio (LA/Ao ratio) (LVA (d), LVA(s))
. Left Atrium Area (LAA(d), LAA(s)) « Left Ventricle Epicardial Area, Length
« Left Atrium Volume, Single Plane, Method (LVAepi (d), LVAepi (s))
of Disk (LAEDV A2C, LAESV A2C) (LAEDV « Left Ventricle Mass Index (LVPWd, LVPWs)
A4C, LAESV A4C), (LAEDV A-L, LAEDV « Ejection Fraction, Teichholz/Cube (LVIDd,
Index A-L, LAESV A-L, LAESV Index A-L) LVIDs)

« Left Ventricle Posterior Wall Fractional
Shortening (LVPWd, LVPWs)

- Left Ventricle Stroke Index, Teichholz/
Cube (LVIDd, LVIDs and Body Surface Area)

« Left Ventricle Fractional Shortening
(LVIDd, LVIDs)

- Left Ventricle Stroke Volume, Teichholz/
Cubic (LVIDd, LVIDs)

« Left Ventricle Stroke Index, Single Plane,
Two Chamber, Method of Disk (LVI Dd,
LVIDs, LVSd, LVSs)

« Left Ventricle Stroke Index, Single Plane,
Four Chamber, Method of Disk (LVI Dd,
LVIDs, LVSd, LVSs)

« Left Ventricle Stroke Index, Bi-Plane,
Bullet, Method of Disk (LVAd, LVAS)

« Interventricular Septum (IVS)

« Left Ventricle Internal Diameter (LVI D)

« Left Ventricle Posterior Wall Thickness
(LVPW)



Supplement: cardiac
measurements/calculations (ont)

B-Mode measurements (cont.) M-Mode measurements

Mitral valve « Mitral Valve Annulus Diameter (MV Ann Aorta + Aortic Root Diameter (Ao Root Diam)
Diam) « Aortic Valve
« E-Point-to-Septum Separation (EPSS) « Aortic Valve Diameter (AV Diam)
« Mitral Valve Area Planimetry (MVA « Aortic Valve Cusp separation (AV Cusp)
Planimetry) + Aortic Valve Ejection Time (LVET)
Pulmonicvalve  « Pulmonic Valve Area (PV Planimetry) Left atrium + Left Atrium Diameter to AoRoot
« Pulmonic Valve Annulus Diameter Diameter Ratio (LA/Ao Ratio)
(PV Annulus Diam) « Left Atrium Diameter (LA Diam)
o [Fmen L8 IS A e i) Left ventricle « Left Ventricle Volume, Teichholz/Cubic
Right atrium « Right Atrium Diameter, Length (RAD Ma) (LVIDd, LVI Ds)
« Right Atrium Diameter, Width (RAD Mi) - Left Ventricle Internal Diameter (LVIDd,
« Right Atrium Area (RAA) LVI Ds)
« Right Atrium Volume, Single Plane, « Left Ventricle Posterior Wall Thickness
Method of Disk (RAAd) (LVPWd, LVPWSs)
« Right Atrium Volume, Systolic, Single « Left Ventricle Ejection Time (LVET)
Plane, Method of Disk (RAAS) « Left Ventricle Pre-Ejection Period (LVPEP)

« Interventricular Septum (IVS)
« Left Ventricle Internal Diameter (LVI D)
- Left Ventricle Posterior Wall Thickness

Right ventricle * Right Ventricle Outflow Tract Area
(RVOT Planimetry)

« Left Pulmonary Artery Area (LPA Area) (LVPW)

* Right Pulmonary Artery Area (RPA Area)

« Right Ventricle Internal Diameter Mitral valve « E-Point-to-Septum Separation (EPSS)
(RVIDd, RVIDs) - Mitral Valve Leaflet Separation (D-E

» Right Ventricle Diameter, Length (RVD Ma) Excursion)

« Right Ventricle Diameter, Width (RVD Mi) « Mitral Valve Anterior Leaflet Excursion

» Right Ventricle Wall Thickness (RVAWA, (D-E Excursion)
RVAWSs) « Mitral Valve D-E Slope (D-E Slope)

» Right Ventricle Outflow Tract Diameter « Mitral Valve E-F Slope (E-F Slope)
(RVOT Diam) « Mitral Annular Plane Systolic Excursion

« Left Pulmonary Artery (LPA) (MAPSE)

 Main Pulmonary Artery (MPA)

« Right Pulmonary Artery (RPA) Pulmonicvalve < QRS Complexto End of Envelope (Q-PV close)

System inferior  « Systemic Vein Diameter (Systemic Diam) Right ventricle * Right Ventricle Internal Diameter

vena cava « Patent Ductus Arterosis Diameter :QRV:]D?/’ RV'PIS) Wall Thick (RVAWd

(PDA Diam) . Rlng\;/S?ntrlc e Wall Thickness ,

« Pericard Effusion (PEs) . . .

+ Patent Foramen Ovale Diameter ’ Fé\g/rg_rvsgtr:ile Quifieey et Dimmeiay
PFO Diam '

. i/entricular) Septal Defect Diameter ’ Right Ventr'icle Eject'ion'Time (BVET)
(VSD Diam) « Right Ventricle Pre-Ejection Period (RVPEP)

« Interventricular Septum (IVS) Fractional System « Pericard Effusion (PE (d))

Shortening (IVSd, IVSs)
Tricuspid valve » QRS Complex to End of Envelope
Tricuspid valve  « Tricuspid Valve Area (TV Panimetry) (Q-TV close)

« Tricuspid Valve Annulus Diameter « Tricuspid Annular Plane Systolic Excursion
(TV Annulus Diam) (TAPSE)



Supplement: cardiac
measurements/calculations (ont)

Doppler Mode measurements Doppler Mode measurements (cont.)

Aortic valve « Aortic Insufficiency Mean Pressure Mitral valve + Mitral inflow E velocity to E' ratio (E/E)
Gradient (AR Trace) (cont.) « Mitral inflow E velocity to E’ Avg ratio
« Aortic Insufficiency Peak Pressure (E/E’ Avg)
Gradient (AR Vmax) « Mitral inflow E velocity to E’ Lat ratio
« Aortic Insufficiency End Diastole Pressure (E/E’ Lat)
Gradient (AR Trace) + Medial Mitral inflow E velocity to E’ Medial
« Aortic Insufficiency Mean Velocity (AR Trace) ratio (E/E’)
« Aortic Insufficiency Velocity Time Integral « Mitral inflow E velocity to E’ Sept ratio
(AR Trace) (E/E’ Sept)
« Aortic Valve Mean Velocity (AV Trace) » Mitral Valve Regurgitant Flow Acceleration
« Aortic Valve Velocity Time Integral (AV Trace) (MR Trace)
« Aortic Valve Mean Pressure Gradient « Mitral Valve Regurgitant Mean Velocity
(AV Trace) (MR Trace)
« Aortic Valve Peak Pressure Gradient « Mitral Regurgitant Mean Pressure Gradient
(AR Vmax) (MR Trace)
» Aortic Insufficiency Peak Velocity (AR Vmax) « Mitral Regurgitant Velocity Time Integral
« Aortic Insufficiency End-Diastolic Velocity (MR Trace)
(AR Trace) - Mitral Valve Mean Velocity (MV Trace)
« Aortic Valve Peak Velocity (AV Vmax) « Mitral Valve Velocity Time Integral
- Aortic Valve Peak Velocity at Point E (MV Trace)
(AV Vmax) « Mitral Valve Mean Pressure Gradient
« Aorta Proximal Coarctation (Coarc Pre-Duct) (MV Trace)
« Aorta Distal Coarctation (Coarc Post-Duct) « Mitral Regurgitant Peak Pressure
« Aortic Valve Insufficiency Pressure Half Gradient (MR Vmax)
Time (AR PHT) « Mitral Valve Peak Pressure Gradient
« Aortic Valve Flow Acceleration (AV Trace) (MV Vmax)
« Aortic Valve Pressure Half Time (AV Trace) « Mitral Regurgitant Peak Velocity (MR Vmax)
« Aortic Valve Acceleration Time (AV Acc Time) « Mitral Valve Peak Velocity (MV Vmax)
« Aortic Valve Deceleration Time (AV Dec Time) - Mitral Valve Velocity Peak A (MV A Velocity)
« Aortic Valve Ejection Time (AVET) + Mitral Valve Velocity Peak E (MV E Velocity)
« Aortic Valve Acceleration to Ejection Time + Mitral Valve Area According to PHT (MV PHT)
Ratio (AV Acc Time, AVET) - Mitral Valve Flow Deceleration (MV DecT)
« Aortic Valve Area(VTI): AVA (Vmax) « Mitral Valve Pressure Half Time (MV PHT)
. . « Mitral Valve Flow Acceleration (MV AccT)
Left ventricle « Left Ventricle Outflow Tract Peak

« Mitral Valve E-Peak to A-Peak Ratio (A-C
and D-E) (MV E/ARatio)

« Mitral Valve Acceleration Time
(MV Acc Time)

- Mitral Valve Deceleration Time (MV Dec Time)

« Mitral Valve Ejection Time ((MVET)

- Mitral Valve A-Wave Duration (MV A Dur)

- Mitral Valve Time to Peak (MVTTP)

« Mitral Valve Acceleration Time/Deceleration
Time Ratio (MV Acc/Dec Time)

« Stroke Volume Index by Mitral Flow (MVA

Mitral valve « E’ Early diastolic mitral valve annular Planimetry, MVTrace)
velocity (E')
« E' Averaged Early diastolic mitral valve
annular velocity (E’ Avg)
« E' Lat Early diastolic mitral valve lateral
annular velocity (E’ Lat)
« E' Medial Early diastolic mitral valve

Pressure Gradient (LVOT Vmax)

« Left Ventricle Outflow Tract Peak Velocity
(LVOT Vmax)

« Left Ventricle Outflow Tract Mean
Pressure Gradient (LVOT Trace)

« Left Ventricle Outflow Tract Mean
Velocity (LVOT Trace)

« Left Ventricle Outflow Tract Velocity
Time Integral (LVOT Trace)

« Left Ventricle Ejection Time (LVET)

Pulmonic valve « Pulmonic Insufficiency Peak Pressure
Gradient (PR Vmax)
« Pulmonic Insufficiency End-Diastolic
Pressure Gradient (PR Trace)
 Pulmonic Valve Peak Pressure Gradient

dial | loci ' Medial (PVVmax)
n?e arannuiarve O.CltyﬁE Medial) « Pulmonic Insufficiency Peak Velocity
« E’' Sept Early diastolic mitral valve septal (PR Vmax)

annular velocity (E'Sept)



Supplement: cardiac
measurements/calculations (ont)

Doppler Mode measurements (cont.) Doppler Mode measurements (cont.)

Pulmonicvalve  « Pulmonic Insufficiency End-Diastolic System (cont.) + Pulmonary Vein S/D Ratio (P Vein D, P Vein S)
(cont.) Velocity (Prend Vmax) « Ventricular Septal Defect Peak Pressure
« Pulmonic Valve Peak Velocity (PV Vmax) Gradient (VSD Vmax)
» Pulmonary Artery Diastolic Pressure + Pulmonic-to-Systemic Flow Ratio (Qp/Qs)
(PV Trace)

Tricuspid valve « Tricuspid Regurgitant Peak Pressure
Gradient (TR Vmax)
» Tricuspid Valve Peak Pressure Gradient

« Pulmonic Insufficiency Mean Pressure
Gradient (PR Trace)
« Pulmonic Valve Mean Pressure Gradient

(PV Trace) (TTV Vmi)j()R . BeakVelog
« Pulmonic Insufficiency Mean Square Root © IMEVETpITe] RS ITEmE HEE] < e 0eie)
(TR Vmax)

Velocity (PR Trace)
 Pulmonic Insufficiency Velocity Time
Integral (PR Trace)
« Pulmonic Valve Mean Velocity (PV Trace)
+ Pulmonic Valve Velocity Time Integral

» Tricuspid Valve Peak Velocity (TV Vmax)

» Tricuspid Valve Velocity Peak A (TV A
Velocity)

» Tricuspid Valve Velocity Peak E (TV E

(PV Trace) ‘\|'/?IOCIt¥()j " o Mean

« Pulmonic Insufficiency Pressure Half Time v UAIEME R0 gl F U ISR FIEss s
(PR PHT) Gradient (TR Trace)

« Pulmonic Valve Flow Acceleration » Tricuspid Valve Mean Pressure Gradient
(PV Acc Time) (TVTrace) . _

« Pulmonic Valve Acceleration Time - Tricuspid Regurgitant Mean Velocity
(PV Acc Time) (TR Trace)

. Pulmonic Valve Ejection Time (PVET) « Tricuspid Regurgitant Velocity Time

» QRS Complex to End of Envelope In'Fegra! (TR Trace) i
(Q-to-PV Close) » Tricuspid Valve Mean Velocity (TV Trace)

 Pulmonic Valve Acceleration to Ejection * Tricuspid Valve Velocity Time Integral

Time Ratio (PV Acc Time, PVET) (TVrace) _
» Tricuspid Valve Time to Peak (TVTTP)
Right ventricle « Right Ventricle Outflow Tract Peak « Tricuspid Valve Ejection Time (TV Acc/
Pressure Gradient (RVOT Vmax) Dec Time)
« Right Ventricle Outflow Tract Peak » Tricuspid Valve A-Wave Duration (TV A Dur)
Velocity (RVOT Vmax) » QRS Complex to End of Envelope
« Right Ventricle Outflow Tract Velocity (Q-TV Close)
Time Integral (RVOT Trace) » Tricuspid Valve Pressure Half Time (TV PHT)
« Right Ventricle Ejection Time (RV Trace) « Stroke Volume by Tricuspid Flow (TV
« Stroke Volume by Pulmonic Flow (RVOT Planimetry, TV Trace)
Planimetry, RVOT Trace) « Tricuspid Valve E-Peak to A-Peak Ratio
« Right Ventricle Stroke Volume Index by (TV E/A Velocity)

Pulmonic Flow (RVOT Planimetry, RVOT Trace)

System » Pulmonary Artery Peak Velocity (PV Vmax) Color Flow Mode measurements

+ Pulmonary Vein Velocity Peak A (Reverse) ] ) ]
(P Vein A) Aortic valve « Proximal Isovelocity Surface Area:

+ Pulmonary Vein Peak Velocity (P Vein D, Regurgitant Orifice Area (AR Radius)
P Vein S) « Proximal Isovelocity Surface Area: Radius

« Systemic Vein Peak Velocity (PDA Diastolic, of Alﬁased Point (A.R Radius)
PDA Systolic) « Proximal Isovelocity Surface Area:

- Ventricular Septal Defect Peak Velocity Regurgitant Flow (AR Trace)

« Proximal Isovelocity Surface Area:
(VSD Vmax) Regurgitant Volume Flow (AR Trace)
« Atrial Septal Defect (ASD Diastolic, esurgitant Volume Flow racel
. « Proximal Isovelocity Surface Area: Aliased
B SR Velocity (AR Vmax)
« Pulmonary Vein A-Wave Duration 4
(P Vein A Dur)

« |soVolumetric Relaxation Time (IVRT)
« |soVolumetric Contraction Time (IVCT)



Supplement: cardiac
measurements/calculations (ont)

Color Flow Mode measurements (cont.)

Mitral valve « Proximal Isovelocity Surface Area:

Regurgitant Orifice Area (MR Radius)

« Proximal Isovelocity Surface Area: Radius
of Aliased Point (MR Radius)

« Proximal Isovelocity Surface Area:
Regurgitant Flow (MR Trace)

« Proximal Isovelocity Surface Area:
Regurgitant Volume Flow (MR Trace)

« Proximal Isovelocity Surface Area: Aliased
Velocity (MR Vmax)

Combination Mode measurements

Aortic valve - Aortic Valve Area (Ao Root Diam, LVOT
Vmax, AV Vmax)

« Aortic Valve Area by Continuity Equation
by Peak Velocity (Ao Root Diam, LVOT
Vmax, AV Vmax)

« Stroke Volume by Aortic Flow (AVA
Planimetry, AV Trace)

«Cardiac Output by Aortic Flow (AVA
Planimetry, AV Trace, HR)

« Aortic Valve Area by Continuity Equation
VTI (Ao Root Diam, LVOT Vmax, AV Trace)

Left ventricle « Cardiac Output, Teichholz/Cubic (LVIDd,
LVI Ds, HR)

« Cardiac Output Two-Chamber, Single Plane,
Area-Length/Method of Disk (Simpson)
(LVAd, LVAs, HR)

« Cardiac Output Four-Chamber, Single
Plane, Area-Length/Method of Disk
(Simpson) (LVAd, LVAs, HR)

« Ejection Fraction Two-Chamber, Single
Plane, Area-Length/Method of Disk
(Simpson) (LVAd, LVAs)

« Ejection Fraction Four-Chamber, Single
Plane, Area-Length/Method of Disk
(Simpson) (LVAd, LVAs)

« Left Ventricle Stroke Volume, Single
Plane, Two-Chamber/Four-Chamber,
Area-Length (LVAd, LVAS)

« Left Ventricle Stroke Volume, Single Plane,
Two-Chamber/Four-Chamber, Method of
Disk (Simpson) (LVIDd, LVIDs, LVAd, LVAS)

- Left Ventricle Volume, Two-Chamber/
Four-Chamber, Area-Length (LVAd, LVAs)

Combination Mode measurements (cont.)

Left ventricle « Ejection Fraction, Bi-Plane, Method of
(cont.) Disk (LVAd, LVAs, 2CH, 4CH)
- Left Ventricle Stroke Volume, Bi-Plane,
Method of Disk (LVAd, LVAs, 2CH, 4CH)
- Left Ventricle Volume, Bi-Plane, Method
of Disk (LVAd, LVAs, 2CH, 4CH)
« Left Ventricle Stroke Index, Single Plane,
Two-Chamber/Four-Chamber, Area-Length
(LVSd, LVSs and BSA)
« Left Ventricle Volume, Single Plane, Two-
Chamber/Four-Chamber, Method of Disk
(LVAd, LVASs)
+ Left Ventricle Volume, Apical View, Long
Axis, Method of Disk (LVAd, LVASs)

Mitral valve « Stroke Volume by Mitral Flow (MVA
Planimetry, MV Trace)
» Cardiac Output by Mitral Flow
(MVA Planimetry, MV Trace, HR)

Pulmonicvalve  « Stroke Volume by Pulmonic Flow (PV
Planimetry, PV Trace)
« Cardiac Output by Pulmonic Flow (PV
Planimetry, PV Trace, HR)

Tricuspid valve « Cardiac Output by Tricuspid Flow (TV
Planimetry, TV Trace, HR)

Cardiac worksheet

Parameter: lists the mode, the measurement folder, and the
specific measurement

Measured Value: Up to six measurement values for each item.
Average, maximum, minimum, or last

Generic study in cardiology

Stroke Volume (SV)
Cardiac Output (CO)

© GE, 2021

GE Healthcare reserves the right to make changes in specifications and features shown
herein, or discontinue the product described at any time without notice or obligation. Contact
your GE Healthcare representative for the most current information. GE, the GE Monogram,
LOGIQ Fortis, InSite, B-Flow, CrossXBeam, XDclear, Radiantflow and HDlive are trademarks
of GE. DICOM is the registered trademark of the National Electrical Manufacturers
Association for its standards publications relating to digital communications of medical
information. Tricefy trademarks are trademarks of Trice Imaging Inc. BI-RADS is a
trademark of the American College of Radiology. GE Healthcare, a division of GE. GE
Medical Systems, Inc., doing business as GE Healthcare.
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LOGIQ Fortis’

Probe Guide

The LOGIQFortis is GE's premium
ultrasound imaging system designed
for abdominal, vascular, obstetric,
gynecologic, neonatal, pediatric,

Featu ring XDC|ea I'm TECh nOIOgy urological, transcranial, cardiac, and

small parts applications.

gehealthcare.com
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Description

CONVEX

XDclear broad-spectrum
convex probe

XDclear broad-spectrum
convex probe

XDclear broad-spectrum
convex probe

Broad-spectrum
micro-convex
intra-cavitary probe

Broad spectrum
convex probe

Applications ‘

Abdominal, Obstetrics,
Gynecology, Vascular,
Musculoskeletal

Abdominal, Obstetrics,
Gynecology, Pediatrics,
Vascular, Musculoskeletal

Neonatal, Pediatrics,
Vascular, Small Parts

Obstetrics, Gynecology,
Urology

Abdominal

80°

80°

95°

180°

110°

Bandwidth

1-6MHz

2-9MHz

2-11MHz

3-10MHz

1-6MHz

Biopsy Guide ‘

Multi-angle
disposable with a
reusable bracket

Multi-angle
disposable with a
reusable bracket

No

Single-angle
disposable or
single-angle
reusable

Multi-angle
disposable with
reusable bracket
options

Volume
Navigation

Yes

* Internal VNav
sensor, does not
require an
external bracket

Yes

* Internal VNav
sensor, does not
require an
external bracket

Yes

Yes

Yes

* Internal VNav
sensor, does not
require an
external bracket

LINEAR

XDclear broad-spectrum
linear probe

Broad-spectrum
linear probe

Broad-spectrum
linear probe

Broad-spectrum
linear probe

Broad-spectrum linear
matrix array probe

Vascular, Small Parts,
Musculoskeletal, Neonatal
Cephalic, Pediatric,
Abdominal, Obstetrical

Abdominal, Obstetric,
Vascular, Musculoskeletal,
Small Parts, Pediatric,
Neonatal

Musculoskeletal

Small Parts, Vascular,
Intraoperative, Neonatal

Vascular, Small Parts,
Neonatal, Pediatrics

44
mm

51

50
mm

2 -10MHz
2-11MHz
6 - 20 MHz
4-15MHz
4 -16 MHz

Multi-angle
disposable with a
reusable bracket

Multi-angle
disposable with a

disposable bracket

No

No

Multi-angle
disposable with a
reusable bracket

Yes

* Internal VNav
sensor, does not
require an
external bracket

Yes

No

Yes

Yes
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Description

SECTOR

XDclear broad-spectrum

sector probe

Broad-spectrum
sector probe

Applications

Cardiac, Transcranial,

Abdominal

Cardiac

FOV

120°

115°

Bandwidth

1-5MHz

2-8MHz

Volume

SopsyDRice Navigation

Multi-angle
disposable with a Yes
reusable bracket

REAL-TIME 4D

Broad-spectrum
real-time 4D probe

Broad-spectrum
real-time 4D
micro-convex probe

SPECIALTY

Abdominal, Obstetrics,
Gynecology, Pediatrics

Obstetrics, Gynecology,

Urology

80°

180°

2-8MHz

3-10MHz

Single-angle
disposable with a No
reusable bracket

Single-angle

No
reusable

CW split crystal
pencil probe

CW split crystal
pencil probe

TEE probe

Wideband bi-plane
micro-convex probe

Cardiac, Vascular

Cardiac, Vascular,
Transcranial

Cardiac

Urology, Endocavity

N/A

N/A

90°

133°

1-3MHz

5-7MHz

2-8MHz

3-12MHz

No No
No No
No No

Single-angle

disposable

bracket or No

reusable bracket

For probe care and cleaning information, visit www.gehealthcare.com/transducers.
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www.gehealthcare.com/promotional-locations.

Data subject to change.

© GE, 2021

GE, the GE Monogram, LOGIQ Fortis and XDclear are trademarks of GE.

Reproduction in any form is forbidden without prior written permission from GE. Nothing in this
material should be used to diagnose or treat any disease or condition. Readers must consult a
healthcare professional.

September 2021

DOC2621716
Global



LOGIQ Fortis

Proprietary Service Manual

5874372 Rev. 3

PROPRIETARY SERVICE DOCUMENTATION.
© 2021 GENERAL ELECTRIC COMPANY.
GE CONFIDENTIAL.

UNLICENSED USE BY NON-GE PARTIES IS STRICTLY
PROHIBITED






GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

Important Precautions

TTRANSLATION POLICY

WARNING

This Service Manual is available in English only.

English

™
2
f—
L ]

e Ifa customer’sservice providerrequires alanguage otherthan English, it
is the customer’s responsibility to provide translation services.

Do not attempt to service the equipment unless this Service Manual has
been consulted andis understood.
Failure to heed this Warning may result in injury to the service provider,

operatoror patient from electric shock, mechanical or otherhazards.

AVERTISSEMENT

Ce manuel de maintenance est disponible en anglais uniquement.

ADVERTENCIA

Este Manual de servicio esta disponible en idioma inglés unicamente.

# Siunclient de la personne responsable de lamaintenance demande une E * Sjun proveedorde servicio del cliente requiere unidioma distinto, es
langue autre que |'anglals, il estde la responsabilité du client de fournirles ‘% responsabilidad delcliente ofrecer servicios de traduccion.
services de traduction. o * Nointente repararel equipo a menos que haya consultado y comprendido

* N'essayezpasd'effectuervous-méme lamaintenance de I'équipement Lﬂ este Manual de servicio.
avant d'avoir préalablement lu et compris le manuel de maintenance. * Sino prestaatencidn a esta Advertencia, se pueden ocasionar lesiones al

* Le non-respectcet avertissement peut entrainer des blessures duesaun (Es) proveedor de servicio, al operador o al paciente por descarga eléctrica,
choc électrique, une défaillance mécanique ou a d'autres éléments por riesgos mecanicos o de otra indole.
dangereux chezlapersonne en charge de la maintenance, l'opérateur ou
le patient.

WARNUNG AVVERTENZA
Dieses Wartungshandbuch ist nur auf Englisch verfigbar. Il presente Manuale diassistenza & disponibile solo in inglese.
¢ Wennder Kundendiensttechniker eines Kunden eine andere Sprache als 5 ¢ Seil fornitore di servizidi un cliente ne richiede una copia in una lingua
5 Englisch bendtigt, unterliegt es der Verantwortung des Kunden eine c diversadallinglese, & responsabilita del cliente fornire il servizio di
0 Ubersetzung anfertigen zulassen. g traduzione.
a * Warten Sie das Gerat nur, wenn Sie dieses Wartungshandbuch gelesen © » Nontentare diriparare 'apparecchio se questo Manuale di assistenzanon
0O undverstanden haben. = & statoletto e compreso.

* Die Nichtbeachtung dieses Warnhinweises kann zu Verletzungen des (™ » Il mancato rispetto di questaavvertenza pud compaortare il rischio di
Kundendiensttechnikers, Anwenders oder Patienten durch Stromschlage, lesioni al fornitore di servizi, alloperatore o al paziente causate da scosse
mechanische oderandere Gefahren fihren. elettriche o da pericoli di origine meccanica o dialtro tipo.

WAARSCHUWING ADVERTENCIA
Deze servicehandleiding is alleen beschikbaar in hetEngels. Este Manual de Manutengio esta disponivel apenas em Inglés.

wn * Als de serviceleveranciervan eenklantvraagt om een andere taaldan n * Casoum prestador de servicos do cliente solicite o manual emidioma

'E Engels, is het de verantwoordelijkheid van de klant om een vertaalde g diferente do inglés, & de responsabilidade do cliente o fornecimento de
© versie te bieden. o servicos de tradugdo.

E * Probeergeenonderhoud aan de apparatuur uit te voeren tenzijdeze é * Niotenterealizara manutengdo do equipamento antesde lere

k= servicehandleiding is geraadpleegd en begrepen. =} compreender este Manual de manutengio.

% * Het niet opvolgen van deze waarschuwing kan bij de serviceleverancier,de o * O ndo cumprimento desta adverténcia pode resultar em danos por choque
NU operator of de patiént leiden tot letsel door elektrische schokken, (PT-BR) elétrico e riscos mecanicos para o prestador de servigos, operadorou

mechanische of andere gevaren. paciente.
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OPOZORILO

Ta servisni priroénik je na voljo samov angleséini.

+ e ponudnik servisnih storitev za stranko potrebuje navodilav drugem
jeziku, morastranka sama poskrbetiza prevajanje.

+* Ne poskuiajte servisiratiopreme, ne da bi prej prebrali in razumeli servisni
priroénik.

« Cetega opozorila ne upostevate, obstaja nevarnost elektricnega udara,
mehanskih ali drugih nevarnostiin posledi¢nih po3kodb ponudnika
servisnih storitev, uporabnika opreme ali pacienta.
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NPEAYNPEXAEHME

[aHHOE PYHOBOACTBO NO 06CAYHUBAHMID AOCTYNHO TONLKO HA AHTAMACKOM
A3bIKE.
*  ECAVW CNeuManiicTy No TEXHUYECKOMY oBCnyMuBaHMio KnneHTaTpebyetca

AOKYMEHTALMA Ha KAKOM-NMBO APYrOM A3bIKE, OTBETCTBEHHOCTL 33
BbINDNHEHWE NepeB0aa BO3NaraeTcA Ha KnneHTa.

* MpucTynaite K 06CnywuBaHW0 060pYA0BaHWA TONBKO NOCNE TOTO, KaK

M3Y4MTE JaHHOR PYKOBOACTBO N0 OBCAYKUBAHMIO U NONHOCTBIO NOAMETE
erocofgpsanHue.

* HecofnoaeHWe JaHHOTO Tpe GoBaHWMA MOMET N PHMBECTH K TPABMUPOBAHMIO

CNeLManucTa No TEXHUYECKOMY 0BCNYHMBAHWIO, NONBIOBATENA UK
NaLMeHTa BCNEACTBME NOPAKE HUA 318 KTPUUE CKUM TOKOM, MEXAHWUECKMX
M NPOUMX NOBPEMOEHUA,

VAROVANIE

Tato servisnd prirucka je dostupna iba v anglickom jazyku.

* AkposkytovatelsluZieb zakaznikom vyZaduje iny jazyk ako anglicky jazyk,
jeho povinnostou je zabezpeéit prekladatelské sluZby.

* Zariadenie nepouiivajte bez preéitaniaa porozumenia tejto servisnej
prirucky.

* Nedodrianie tejtovystrahy méZe viestk zraneniu poskytovatelasluieb,
operatora alebo pacienta sposobeného elektrickym Sokom, mechanickym
aleboinym nebezpedenstvom.
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VARNING

Den hér servicehandboken finns endast pa engelska.

*  Om en kunds servicetekniker krdver ett annat sprik &n engelska ar det
kundens ansvar att tillhandahalla en dversattversion.

* Férsokinte att utforaservice pa utrustningen omdu inte har last
igenom och farstitt den hir servicehandboken.

* Omduinte tar hansyntill den hér varningen kan serviceteknikern,
operattren eller patienten utsattas for elektriska stotar eller
mekaniska eller andra faror, vilket kan leda till personskador.
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OSTRZEZENIE

Niniejszy podrecznik serwisowy jest dostepny wylacznie w jezyku angielskim.

* Jezelidostawcaustugklienta postuguje sie jezykiem innym niz angielski, za
zapewnienie ustug ttumaczeniowych odpowiada klient.

* Przed przystapieniem do czynnosciserwisowych nalezy zapoznacsie z
informacjamizawartymi w niniejszym podreczniku serwisowymije
zrozumiec.

* W przeciwnym wypadku dostawca ustug, operator lub pacjent moga
odnies¢ obratenia spowodowane porateniem pradem elektrycznym,
dziataniem elementéw mechanicznych lub innymi zagrozeniami.

FIGYELMEZTETES

A szervizkézikonyv kizardlag angol nyelven érhetd el

* Amennyiben az dgyfélszolgaltatéjanak nemfelel megaz angol nyelvi
dokumentécid, gy a forditasrdl az igyfélnek kell gondoskodnia.

®  Kizérolag ugy lasson hozzd a berendezés karbantartasahoz, hogy elolvasta
ésmegértette aszervizkézikdnyvben foglaltakat.

+ Ezenfigyelmeztetés figyelmen kiviil hagydsa esetén aszolgéltato, a kezeld
vagy a paciens dramiitést, mechanikus sérillést vagy mas veszély sltal
okozottszemelyiseériilest szenvedhet.
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VYSTRAHA

Tato servisnipfirutka je k dispozici pouze v anglicting.

* Pokud poskytovatelsluzby zakaznikovi poZaduje jiny jazyk neZ anglictinu,
je odpovédnosti zakaznika poskytnout sluZby prekiadu.

*  Nepokousejte se provadét servis zafizeni, dokud sineprostudujete a
neporozumite servisnipfirucce.

*  Nevénovéni pozornostitéto vystraze mlie zplsobit poskytovatelisluieb,
obsluze nebo pacientoviuraz elektrickym proudem, mechanicka nebo jind
nebezpedi.

ADVARSEL

Denne servicehandboken er bare tilgjengelig pa engelsk.

*  Hvis en kundes tjenestetilbyder krever et annet sprak enn engelsk, erdet
kundens ansvar a tilby oversettelsestjenester.

* Ikke forsek 3 utfere service pd utstyret fer denne servicehandboken erlest
og forstatt.
Dersom detikke tas hensyn til denne advarselen, kan det fere til skader pd
tjenestetilbyderen, operatgren eller pasienten fra elektrisk stot,
mekaniske eller andre farer.

VAKAVA VAROITUS

Tama huolto-opas on saatavana vain englanniksi.

* Josasiakkaan palveluntarjoajatarvitsee oppaan jollain muulla kielells,
kaanndspalveluiden hankkiminen on asiakkaan vastuulla.

* Laitetta ei saa huoltaa ellei huolto-oppaaseen ole sitd ennen tutustuttu
huolellisesti.

* Jostata varoitusta ei noudateta, palveluntarjoaja, kayttsja tai potilas
saattaa saada sahkoiskun, ja saattaa aiheutua mekaanisia tai muita
vaurioita.

ISPEJIMAS

Sis priedidiros vadovas galimas tik angly kalba.

* Jeikliento paslaugy teikéjas reikalauja kitos kalbos nei angly, klientas
atsako uZ vertimo paslaugos teikima.

* Atlikite jrangos priefilra tik gerai susipaZine su priefiGros vadovu ir jj
suprate.

* Nesilaikant Sio jspejimo galimas paslaugos teikéjo, operatoriausar
paciento suZeidimas del elektros Soko, mechaninio ar kito pavojaus.

UPOZORENIJE

Ovaj prirutnik za servisiranje dostupan je samo na engleskom jeziku.

* Akoklijentov serviser zahteva jezik koji nije engleski, odgovornost je na
klijentuda pruZi usluge prevodenja.

* Nemojte da pokusavate da servisirate opremu ako prethodno niste
proéitali i razumeli ovaj priruénik.

* Akone poitujete ovo upozorenje, moie docido povredivanjaservisera,
operateraili pacijenta uzrokovanog elektricnim udarom, mehanickimi
drugim opasnostima.

Latviski Romaéana Dansk

< Portugués
(Portugal)

=
©
=

UYARI

Servis Kilavuzu yalnizca ingilizce olarak mevcuttur,

*  Misterinin servis saglayicist igin kilavuzun ingilizee diginda bagka bir dile
cevrilmesigerekiyorsa geviri hizmetisaglamak misterinin sorumiulugudur.

*  Bu Servis Kilavuzu'na bakip talimatlar anlamadan ekipmanikullanmaya
calgmaymn.

* Bu Uyannin goz ardi edilmesiservis saglayicisinin, operatoriinveya
hastanin, elektrik carpmasi, mekanik aniza ya da diger tehlikeler nedeniyle
yaralanmasina neden olabilir.

ADVARSEL

Denne servicemanual fas kun pa engelsk.

* Hvis en kundestjenesteudbyder kraeveretandet sprog end engelsk, er det
kundens ansvar at sorge for oversattelsesydelserne.

* Forsegikke at udfore service pd udstyret, medmindre denne
servicemanualer laest og forstdet.

* Manglende overholdelse af denne advarsel kan medfore skade pd
serviceudbyderen, operateren eller patienten som folge af elektrisk stod,
mekaniske eller andre farer.

AVERTISMENT

Acest manual de service este disponibil doar in engleza.

* Daca furnizorul de servicii al unui client solicitd alta limba decitengleza,
este responsabilitatea clientuluisa ofere servicii de traducere.

* Nuincercati s3 efectuatilucrari de service asupra echipamentului, in afard
de cazul cind ati consultat acest manual de service 5i l-ati inteles.

* Nerespectareaacestuiavertisment poate aveacarezultat rinirea
furnizorului de servicii, a operatoruluisau a pacientuluica urmare a
electrocutarii, pericolelor mecanice sau a altor pericole.

BRIDINAJUMS

&1 apkalpes rokasgramata ir pieejama tikai anglu valoda.

* Jaklienta pakalpojumu sniedzéjam ir nepieciesama cita valoda, kas nav
anglu valoda, klienta pienakums ir nodrosinat tulkojumu.

. éginiet apkalpot aprikoj , jaapkalpes rokasgramata nav izlasita un
izprasta.

* Ja3is bridindjums netiek ievérots, pakalpojumu sniedz&js, operators vai
pacients var gut traumas no elektro3oka vaivar rasties mehanisks vai cita
veidaapdraudéjums.

AVISO

Este manual de assisténcia estadisponivelapenas em inglés.

* Seo prestadorde servigos de assisténcia do cliente necessitar do manual
noutro idioma, a disponibilizagio dos servigos de tradugdo é da
responsabilidade do cliente.

* N3otente reparar o equipamento se ndo tiver consultado e compreendido
este manual de assisténcia.

* 0 ndo cumprimento das instrugdes constantes neste aviso pode resultar
em ferimentos no prestador de servigos de assisténcia, no operadorou no
paciente devido a choques eléctricos, perigos mecanicos ou outros
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NONEPEAMEHHA PERINGATAN

Lie# NociGHMK i3 TeXHIYHOro 06CNYroBYBaHHA AOCTYNHMA NULIE GHINIACEKOKD Panduan Servisini hanya tersedia dalam Bahasa Inggris.

MOBOI. @ * lika penyedialayanan pelanggan memerlukan bahasa di luar Bahasa

*  AKWO NOCTa4aNnBHUKY NOCAYT i3 TexHiYHoro oBcnyrosyeaHHA NoTpiGHa © % Inggris, maka pelanggan bertanggung jawab untuk memberikan layanan
g iH$pOpMaLA MOBOID, BIAMIHHOK BiA aHINIACHKOI, BIANOBIaNbHICTL 33 g C tersebut.
6 HaJaHHA NoCAYr Nepexnany Hece KOPWCTyBaY, B o _g + Jangan mencobamenyervis peralatan ini, kecuali Panduan Servis ini telah
= *  TexHiuHe oBcnyrosyeaHHA 061aAHaHHA MOMHE BUKOHYBATH NMLLE NiCAA g i dijadikan rujukan dan dipahami dengan baik.
g O3HAMOMARHHA 3 NOCIGHMKOM i3 TeXHIYHOro 0BCAYroByBaHHATA (D Kelalaian memperhatikan Peringatan ini dapat menyebabkan cedera
= YCBIAOMARHHA HOTD 3MICTY. terhadap penyedia layanan, operator, atau pasien akibat bahaya kejutan
{?K] *  HeAOTPMMAaHHA LbOTO NONEPE MKEHHA MOME NPUIBECTH A0 TPABM listrik, mekanik, dan bahayalainnya.

NOCTa4anbHWKa NOCAYT, onepaTopa abo NauieHTa, CNpUYMHEHMK SiE0
ENEKTPUUHOTO CTPYMY, MEXAHIUHMX 260 IHLWMX NOWKOLHEHD.

- 3 o
nuaou CANH BAO
5 ; Huwdng din sir dung dich vy nay chi sin ding bingtiéng Anh.
AUDFDNU MM D NG WY & *  NE&unha cungcdp dich vy cla khidch hangyéu ciu ngdn ngir khac ngoai
. oy 2 = - ti€ng Anh, thi khach hang phai cé trach nhiém cung cip cac dich vu dich
o1 ¢ wnglimssasgnmdaimsaiunnauienimiieanmnaingy s e ' g phel SR Ep e e o
= anArAauiludivansaulunsiniaaagiadaniigaatunla _E +  Khéngduoc tim céch sira chira thiét bi trir khi d3 tham khao va higur
o Tusnadrdaanirpaunsailnglifinm wasianadrlagiadaaniinil = Hudngdan stedyng cich wyindy.. : ; &
{TH) oy " * * (V1) *  BO qua & canh bdo nay co thé gdy thuongtich cho nha cung cip dich vy,
o winlaidpdamarndauiatadaraligiusnns dliigunanl nhanvién van hanh hodc bénh nhan do séc dién, nhitng nguy hiém v& méy
wiadlhglasuumaduaanivihian dunsigainnalnrasginsni mochodeyeu th khac,
WiaauAsEaL 9
ECKEPTY BABALA
Ocbl KbI3MET KEPCETY HYCKAYNbIFbl TEK aFblLWbIH TINIHAE KONMKeTIMA). Available lamang sa Ingles ang Manwal ng Serbisyongito.
% *  Erep TyTbiHYLWbINADAbIH KbI3METTE P MeTKizywicl aFbinwwbiH TiniHeH Backa * Kungang kailangan lamang ng tagabigay ng serbisyo ng kustomerng wika
£ Tingi Tanan eTce, ay4apy Kbi3METTEDIMEH KAMTAMACHI3 ETY TYTHIHYLILIHGIH, an maliban sa Ingles, responsibilidad ng kustomer na magbigay ng serbisyo sa
= wayankepwiniride Kipegj. o pagsasalin wika nito.
X & Ochl KBIIMET HEPCETY HYCKAYABIFBIH TYCIHIN, 0N TYpansi KeHeC anmaiibiHwa ©  * Huwagsubukannaiserbisyoang mga kasangkapan maliban kung
§ #aBABIKKA KBIZMET KEPCETYre ThiPbiCNaHbI3. ﬁ nakonsuita ang nauunawaan itong Manwal ng Serbisyo.
5% e Ocbl ecKepTyAl OPbIHAMAY 3NEKTP TOTbIHBIH COFYbI, MEXaHMKANbIK Hemece m * Angpagkabigong maunawaan ang Babalang ito ay maaring maging resulta
(KK) BacKa Aa KayinTep canaapbiHaH Kbi3METTE P HETRIZYWICIHIH, onepaTopapiy ng pinsala sa tagabigay ng serbisyo, nagpapagana o pasyente mulasa
HeMeCce eMARNYLIHIH MAPAKATTaHybIHa 3NbiIN KeAYi MYMKIH, pagkakakoryente, mekanikal o iba pang peligro.
HOIATUS! NPOEIAONOIHZIH
Service Manual (Hooldusjuhend) on saadaval ainult ingliskeelsena. To napov Eyyswpibio oéppg SuariBetar povo ota Ayyhikd.
*  Kuikliendi teenusepakkuja ndue on, etjuhend oleks ménes muus keeles, h=] * Edvond O Tou MENGTN anaitel yAbooa eXTOG Twv AyyAxkwv,
i pakkuja ] v poxocoeppig n ¥ S Yy n
7] korraldab juhenditdikimise klient. = napoyr pETadpacTikuy UTNpEoww anotedel euBivn Tou nehdTn.
@ e Tutvuge enne seadme hooldustdéde tegemist kindlasti juhendiga Service c *  Mnveny OETE VA EMLOKEUACETE Tov eEomALopO edv mpuwTa Sev
w B g nv EMLELD nip
Manual (Hooldusjuhend). ﬁ oupPoulsuteite kankatavoioets To mapdv Eyxepibio ofppuc,
¢ Selle ndude eiramise korral vdi ja, kasutajaviip saada *  Iemepintwon un tipnongng napoloagnpoebonoinong, evbéyetalva
(ET) selle ndude eiramise korral v8ib teenindaja, kasutaja vBi patsient saad w Ze mepi f i wSomol 5¢
elektrilbdgi, samuti viivad kaasneda muud ohud. (EU npokhnBel tpavpaTiopos otov ndpoxo ofpPig, To EwPLoTA i Tov aoBevr
efartiagnhextpomhndiac kaBuws kot pnyavikwy r GAAwv kS ivwy,
NPEAYMPEXAEHUE UPOZORENJE
HacToAwoTo CepemaHo PHKOBO/ACTEO CB NPEANETa CAMO Ha BHINKIACKH e3MK. Ovaj servisnipriruénik dostupan je samo na engleskom jeziku.
®  AKOADCTEBYWKBT HE CEPBMIHM YCAYTM Ha KAMEHTE MICKBA PHHOBOACTED = * Akoklijentov serviser zahtijeva jezik koji nije engleski, odgovornost klijenta
g Ha E3MK, KOWTO Ce Pa3NMYaBa OT SHIMMACKMA, KAMEHTHT MMa OTFOBOPHOCT [ je prutiti usluge prijevoda.
a A3 OCUIYpY aAeKBaTeH Npesos, © * Nemojte pokuiavatiservisiratiopremu ako niste proditali i razumjeli
£ . he npaeeTe onuTH 3a cepeua Ha obopyasaneTo, Gesaa nposepuTe U da c servisni p’“’“‘vf“ik' )
5 pa3bepeTe cuBeTUTE B CEPBMIHOTO PHKOBOACTED. I * Akone pOg.t_l.I]etﬁ OVO Upozo rer":je, mo!e_ d_otrdo ozljede se fvisera, )
1] *  Hecna3ssaHeTo Ha TOBA NPeAynpesaeHIe MoKe 43 40BEde A0 (HR) ope raterai ili pacijenta prouzroéene strujnim udarom, mehanickim i drugim
(BG) apaHABaHe Ha AocT Ha cep YCAYTW, ONepaTopa uam opasnostima.

NauneHTa BCNeACTBME HA TOKOB Y A3D, MEXAHWWHAE MAW ADYIH ONAcHOCTH.
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DAMAGE IN TRANSPORTATION

All packages should be closely examined at time of delivery. If damage is apparent write “Damage In
Shipment” on ALL copies of the freight or express bill BEFORE delivery is accepted or “signed for” by
a GE representative or hospital receiving agent. Whether noted or concealed, damage MUST be
reported to the carrier immediately upon discovery, or in any event, within 14 days after receipt, and the
contents and containers held for inspection by the carrier. A transportation company will not pay a claim
for damage if an inspection is not requested within this 14 day period.

CERTIFIED ELECTRICAL CONTRACTOR STATEMENT - FOR USA ONLY

All electrical Installations that are preliminary to positioning of the equipment at the site prepared for the
equipment shall be performed by licensed electrical contractors. Other connections between pieces of
electrical equipment, calibrations and testing shall be performed by qualified GE personnel. In
performing all electrical work on these products, GE will use its own specially trained field engineers. All
of GE’s electrical work on these products will comply with the requirements of the applicable electrical
codes.

The purchaser of GE equipment shall only utilize qualified personnel (i.e., GE’s field engineers,
personnel of third-party service companies with equivalent training, or licensed electricians) to perform
electrical servicing on the equipment.

OMISSIONS & ERRORS

If there are any omissions, errors or suggestions for improving this documentation, please contact the
GE Global Ultrasound Documentation Group with specific information listing the system type, manual
title, part number, revision number, page number and suggestion details.

Mail the information to:

Service Documentation
9900 Innovation Drive (RP-2156)
Wauwatosa, Wl 53226, USA.

GE employees should use Post-market Quality Management (PQM) to report service documentation
issues. These issues will then be in the internal problem reporting tool and communicated to the writer.

SERVICE SAFETY CONSIDERATIONS

/A DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING AND
ADJUSTING.

& WARNING Use all Personal Protection Equipment (PPE) such as gloves, safety shoes, safety
glasses, and kneeling pad, to reduce the risk of injury.

For a complete review of all safety requirements, see the Chapter 1, Safety Considerations section in
the Service Manual.
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LEGAL NOTES

The contents of this publication may not be copied or duplicated in any form, in whole or in part, without
prior written permission of GE.

GE may revise this publication from time to time without written notice.

PROPRIETARY TO GE

Permission to use this Advanced Service Software and related documentation (herein called the
Material) by persons other than GE employees is provided only under an Advanced Service Package
License relating specifically to this Proprietary Material. This is a different agreement from the one under
which operating and basic service software is licensed. A license to use operating or basic service
software does not extend to or cover this software or related documentation.

If you are a GE employee or a customer who has entered into such a license agreement with GE to use
this proprietary software, you are authorized to use this Material according to the conditions stated in
your license agreement.

However, you do not have the permission of GE to alter, decompose or reverse-assemble the software,
and unless you are a GE employee, you may not copy the Material. The Material is protected by
Copyright and Trade Secret laws; the violation of which can result in civil damages and criminal
prosecution.

If you are not party to such a license agreement or a GE Employee, you must exit this Material now.

TRADEMARKS

All products and their name brands are trademarks of their respective holders.

COPYRIGHTS

© 2021 by General Electric Company Inc. All Rights Reserved.

DECLARATION OF CONFORMITY

The radio equipment used in the LOGIQ Fortis (if present) conforms to the Radio Equipment
Directive 2014/53/EU (RED). The declaration of conformity can be found at the following link:

https://www.intel.com/content/dam/support/us/en/documents/network-and-i-o/wireless-networking/
9260NGW-EU-RED-DoC.pdf

Search under Current or Legacy Adapters for: Intel® 9260
Figure WLAN Label for Intel 9260 Module
THIS SYSTEM COMTAING THE

FOLLAYING WIRELESS
EOAULE | INTEL 9260M0LW

vi
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Revision History
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Chapter 1
Introduction

Section 1-1
Overview

1-1-1 Purpose of this chapter

This chapter describes important issues related to safely servicing the LOGIQ Fortis. The service
provider must read and understand all the information presented here before installing or servicing the
LOGIQ Fortis.

NOTE: The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

1-1-2 Contents in this chapter

1-1 OVEIVIBW. .« . 1-1

1-2 Service Manual OVerview. . . ... .. 1-2

1-3 Important Conventions . . . . ... ... 1-11
1-4 Labels/lcons onthe system . .. ... ... .. .. 1-14
1-5 Safety Considerations . .. ...... ... . 1-15
1-6 Dangerous Procedure Warnings . ... ... ...t 1-24
1-7 Lockout/Tagout (LOTO) . . ..ot e e e 1-25
1-8 Returning/Shipping Probes and RepairParts. . . .. ... .. ... ... ... .. ... ..., 1-29
1-9 Electromagnetic Compatibility (EMC). .. ... ... .. . . 1-30
1-10 Customer ASSiStance . . . ... ... 1-32
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Section 1-2
Service Manual Overview

1-2-1

Contents in this section

1-2-1 At ENtioN . ... e 1-2
1-2-2 Contents inthis service manual ........... .. ... . . . . . . . . . . . . . ... 1-3
1-2-3 Typical users of LOGIQ Fortis documentation ............. ... ... ... .......... 1-4
1-2-4 LOGIQ Fortis models covered inthismanual . . . .............................. 1-4
1-2-5 Product description . . .. ... 1-10
Attention

This manual provides installation and service information for the LOGIQ Fortis. Advanced equipment
training may be provided by factory trained Field Service trainers for the agreed-upon time period.
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1-2-2

Contents in this service manual

The service manual is divided into ten chapters.

In the beginning of the manual, before Chapter 1, you will find the revision overview, the important
precautions including translation policy, damage in transportation, certified electrical contractor
statement, omission & errors, service safety considerations and legal notes, and the Table of
Contents (TOC).

An index has been included after Chapter 10.

Table 11 Contents in this Service Manual
CHAPTER
NUMBER CHAPTER TITLE DESCRIPTION

1 Introduction Contains a content summary and warnings.

2 Site Preparations Contains pre-setup requirements for the LOGIQ Fortis.

3 LOGIQ Fortis Setup Contains setup procedure with procedure checklist.

4 Functional Checks Qontaing functional chgcks thgt must be performed as pgrt of the
installation, or as required during servicing, care and maintenance.

5 Components and Functions (Theory) Contain§ block diagrams and functional explanations of the
electronics.

6 Service Adjustments Contains instrugtions on how to make any available adjustments to
the LOGIQ Fortis.

7 Diagnostics/Troubleshooting Provides prgcedures for running diagnostic or related routines for the
LOGIQ Fortis.
Provides disassembly procedures and reassembly procedures for all

8 Replacement Procedures changeable FRUs, available option installation instructions, and
upgrade installation instructions.

9 Renewal Parts Contains a complete list of replacement parts for the LOGIQ Fortis.

10 Care & Maintenance Provides care and maintenance procedures for the LOGIQ Fortis.

N/A Index Provides a quick way to find a topic.

Chapter 1 Introduction 1-3
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1-2-3 Typical users of LOGIQ Fortis documentation

The information needed to service the LOGIQ Fortis is collected in the Service Manual.

NOTE: Dates on screenshots are represented in MM/DD/YYYY format throughout the manual.
Information on how to change the LOGIQ Fortis’s date can be found in Chapter 10, Customizing
Your System, of the LOGIQ Fortis User Manual.

Typical users of the Basic Service Manual

» Service personnel (setup, maintenance, etc.)

* Hospital’s service personnel

» Architectural planners/installation planners (some parts of Chapter 2 - Site Preparations)
Typical users of the Proprietary Service Manual

*  GE Service personnel (setup, maintenance, etc.)
*  GE Online Center personnel

» Licensed hospital's service providers

* GE Repair Center Personnel

1-2-4 LOGIQ Fortis models covered in this manual

Table 1-2 LOGIQ Fortis Software Configuration and Hardware

Destination N"fj?w[;i"R DESCRIPTION S\‘/’E;‘Q:gﬁ'i
GLOBAL 6601000 LOGIQ Fortis LCD monitor, 100-240 VAC R3.x.
(except China) 6602000 LOGIQ Fortis HDU Display, 100-240 VAC R3.X.X
5876352 LOGIQ Fortis HDU Display console R3.x.x
5876353 LOGIQ Fortis Pro HDU Display R3.x.x
5876354 LOGIQ Fortis Express HDU Display R3.x.x
CHINA Only 5876355 LOGIQ Fortis Super HDU Display R3.X.X
5876356 LOGIQ Fortis Expert LCD Monitor R3.x.x
5876357 LOGIQ Fortis Plus LCD Monitor R3.x.X
5876358 LOGIQ Fortis Power LCDMonitor R3.X.X

1-4 Section 1-2 - Service Manual Overview
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1-2-4-1

LOGIQ Fortis Standards/Options

LOGIQ Fortis Global Configuration

‘Description

|Adv. Security
|Coded Contrast
|Parametric Imaging
|Cardiac AFI
|Report Writer

Stress Echo

Tricefy

LOGIQ Apps

[KOIOS sW

'LOGIQ Exx KOIOS Thyroid
'Scan Assistant

/Advanced Probes

|AUTO IMT

B Steer+

BFLOW
Compare Assistant

DICOM

[FLOW QA

SOFTWARE
OPTIONS

Measure Assist Breast

Measure Assist OB

ELASTOGRAPHY

[ELASTO QA
|SRI HD Type2

Shear Wave Elastgraphy

\UGAP
Hepatic Assistant - SWE-UGAP

SonoNT SonolT

|LOGIQ Exx DVR

LOGIQ Exx SRI HD Type 2

ILOGIQ Exx VNAV Image
[EZImaging

|Omni View

'sTIC

TUI

\VCl-Static
VOCAL_II

Thyroid Productivity

\Breast Productivity
VITA on Demand

CW Doppler Option Collector Swallow

|Realtime 4D

ECG

\Gel Warmer
Scan on battery Option kit T1.

HARDWARE
OPTIONS

Power Assistant Option kit T1

'Volume Navigation for V-Nav Inside Fortis

\Volume Navigation
|Wireless

S-Video

|Pencil CW HW Kit Swallow
|DVD Drive

|Standard(s)/Option(0)
HDU console | LCD console
(o] o

U\OU:OOOO:OU\O o000 000000 |w O 0000|000 OOOOOUOOOG'OOOU:OOOOfOOO

w o000 000|w0O O0C0O00000|0|wO 0000 000 0O0C0O0OC0O0OCODOO0O0ODOO0O00ODO

Chapter 1 Introduction
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1-2-4

1

_Description

|USB FOOTSWITCH 3 BUTTON
|SONY UPD25MD COLOR PRINTER
Powervar144k120v MG UPS

230V UPS

|BW Printer

PERIPHERAL |
OPTIONS

LOGIQ Exx Protective Cover

|LOGIQ Exx Inkjet Printer

Barcode Reader USBee1000A
Magnetic Card Reader
High Cabinet installation kit

\Low Cabinet installation kit
|Side Cabinet Installation kit
'Option Sinch bay installation kit
\Alpha numeric board assembly
\GERMAN AN Key board Assy

KEYBOARD
OPTIONS

[FRENCH AN Key board Assy
\GREEK AN Key board Assy

\NORWEGIAN AN Key board Assy

RUSSIAN AN Key board Assy

' SWEDISH AN Key board Assy

FC389,ECG CABLE SET

\VNav Stand (Offboard)

\VNav NEEDLE TRACKING

VNav VirtuTRAX Starter Kit

|[ECG Cables IEC Style

\VNav Virtual Tracker

\VMav Active Tracker kit

'VNav Needle Tracking storage insert

\VNav Needle Tracking Kit - 18/20g or less |

ACCESSORIES |

VMav ETRAX 12 14G ST KT
VMav ETRAX 14 16G ST KT
Mav Probe sensors

VNav MR Active Tracker

LOGIQ E10 KOIOS INSTALL
\KOIOS Thyroid INSTALL

|Small Probe Holder

\VERTICAL TV PROBE HOLDER

TVTR Probe Holder

PROBE CABLE HANGER
|Ethernet Protection Cable

OPTION TRAY BOX

OPTION TRAY Bracket

Option Tray

LOGIQ Fortis Standards/Options (cont’d)

HDU console | LCD console

o
o

oo OCODQOODCODCOOICDODODO0OOODOICQI0OC|O|0|O0|0|C|O|C
oojojojojoojojooojojojojojoOODOC0OCDODOODIOODOOODIOICOIDI0O|DO|0|O|O|O|O|OQ

Section 1-2 - Service Manual Overview



Direction 5874372, Rev. 3

GE CONFIDENTIAL

LOGIQ Fortis Proprietary Service Manual

1-2-4-1

LOGIQ Fortis Global Configuration

PROBES

TEE PROBE
ITEMS

Description

IC5-9-D Probe
MLB-15-D Probe
L8-18I-D Probe
C2-9-D Probe
C1-6-D Probe
C1-8VN-D Probe
C2-9VN-D Probe
C3-10-D Probe
M5Sc-D Probe
L2-9-D Probe
L2-9VN-D Probe
6Tc-RS Probe
TEE RS-DLP Adapter
C2-7-D Probe
C2-7VN-D Probe
C2-7D-LC Probe
P2D Probe
RIC5-9-D 4D Probe
RAB6-D Probe
PED Probe
BE9SCS-D Probe
L3-12-D Probe

|6S-D Probe

KZ200687 BITE GUARD

\KZ693 BITE GUARD OPR.CLIP ON
KZ808 TEE SCANH. PROTECT.COVER
|086A0016 BITE GUARD AD.16"27MM
|KZ800,BITE HOLE INDICATOR

\TEE STORAGE RACK

LOGIQ Fortis Standards/Options (cont’d)

|Standard(s)/Option(0)
HDU console LCD console
o] o

OO'OOO_OOODOOOOOOOEOOO_OUOOOOOOO

ooolojojcjojoiojoDjOD|OODOCOQO|0OCIO|O O |O|O|O
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LOGIQ Fortis China Configuration

LOGIQ Fortis China Configuration

Standard(S)/Option(O)/Not applicable(NA)

Description

Fortis

Fortis
Pro

Fortis
Express

Fortis
Super

Fortis
Expert

Fortis
Plus

Fortis
Power

SOFTWARE
OPTIONS

Adv. Security

(o)

[0)

o

(o]

Coded Contrast

Parametric Imaging

Cardiac AFI

Report Writer

Stress Echo

Tricefy

LOGIQ Apps

Scan Assistant

Advanced Probes

AUTO IMT

B Steer+

B-FLOW

Compare Assistant

DICOM

FLOW QA

Measure Assist Breast

Measure Assist OB

ELASTOGRAPHY

ELASTO QA

Shear Wave Elastgraphy

Qv v O0jvIOLIO|Lu|nw|0O|0O|0O|0O|nw|0|0|0

O|0|0Ojnw|O|0O|O|O|O|O|O|O|O|O|O O |O|O|O

Oo|0O|0O|0O|0O|0|O|O|O|O|O|O|O|O|O|O|nn (OO |0

UGAP

2
>

z
>

Hepatic Assistant - SWE-UGAP

p=4
>

z
>

SonoNT SonolT

LOGIQ Exx DVR

O |0

O |0

LOGIQ Exx SRIHD Type 2

(@]

(@]

LOGIQ Exx VNAV Image

=2
>

2
>

EZ Imaging

Omni View

STIC

TUI

VCI-Static

VOCAL_I

Thyroid Productivity

Breast Productivity

VITA on Demand

HARDWARE
OPTIONS

CW Doppler Option Collector Swallow

Realtime 4D

ECG

Gel Warmer

Scan on battery Option kit T1

Power Assistant Option kit T1

Volume Navigation for V-Nav Inside Fortis

O|0O|O|nw|O |O|0O|0O|O0|0O|O|0|0O|O|0|w»n

O|0|O|nw|O |O|0O|0O|0O|0O|O|0O|0O|O |0 |w»n

Ol0O|0O|»w|O |O|O|O|O|O|O|O|O|O|O|wn

Volume Navigation

2
>

2
>

=4
>

Wireless

S-Video

Pencil CW HW Kit Swallow

DVD Drive

PERIPHERAL
OPTIONS

USB FOOTSWITCH 3 BUTTON

BW Printer

LOGIQ Exx Protective Cover

High Cabinet installation kit

Option 5inch bay installation kit

KEYBOARD
OPTIONS

Alpha numeric board assembly

O |0O0O/0O|0|0 |[»w|lO|O|O|O|O|O|O|ww|O |O|O|O|O|O|O|O|O|O|O||O|O|O|0O0O|0|I0|V|VLIVIOO|VIO|LO|LILIOIOIOIO|Vw|O|O|O (O

O |0O0O/0O|0|0 [»w|O|O|O|O|O|O|O|nw|O |O|O|O|O|O|O|O|O|O|O|nW|O|O|O|O|O|O|O|O|O|O|O|O|W|O|O|O|O|WO|O|O|O|w|O|O|O |O

O |0O0/0O|0|0 [»w|O|O|O|O|O|O|O|w|O |O|O|O|O|O|O|O|O|O|O|W|O|O|O|O|O|O|O|O|O|O|O|0O|W|VWIOOWOO|IO|O|O|n|O|O|0O

O |0O|l0O|0|0|0 [w|O|O|O|O|O|O|O|w|O |O|O|O|O|O|O|O|O|O|O|0w|O|O|O|O|O|O|O|O|O|O|O|O|nw|O|O|O|O|O|O|O|O|O|nn|O|O|0O

O |[0O|O|O|O|O0 |»w|O|0O |0

O |[0O|O|O|O|O0 |»w|O|0O |0

O |0j0|0|0|0 |»w|O|0O |0
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1-2-4-2 LOGIQ Fortis China Configuration (cont’d)
LOGIQ Fortis China Configuration Standard(S)/Option(0)/Not applicable(NA)
Fortis Fortis Fortis Fortis Fortis Fortis Fortis
Description Pro Express Super Expert Plus Power
FC389,ECG CABLE SET o 0 [s] 0 0 [s] 0
VNav Stand (Offboard) o 0 o ) NA NA NA
VNav NEEDLE TRACKING 6] 0 o 0 NA NA NA
VNav VirtuTRAX Starter Kit [o] 0 o} [o] NA NA NA
ECG Cables IEC Style o 0 o 0 0 o 0
VNav Virtual Tracker [o] 0 (e} [o] NA NA NA
VNav Active Tracker kit [o] 0 0 [o] NA NA NA
VNav Needle Tracking storage insert o o o 0 NA NA NA
VNav Needle Tracking Kit - 18/20g or less [o] 0 o} [o] NA NA NA
VNav ETRAX 12 14G ST KT o 0 [¢] 0 NA NA NA
ACCESSORIES |\/Nav ETRAX 14 16G ST KT 0 0 o 0 NA NA NA
VNav Probe sensors (o] 0 e} [o] NA NA NA
VNav MR Active Tracker o 0 o] o] NA NA NA
Small Probe Holder [o] 0 e} [o] 0 [o} [o]
VERTICAL TV PROBE HOLDER 0 0 o 0 0 o 0
TVTR Probe Holder o 0 o 0 0 o 0
PROBE CABLE HANGER 0 0 o] 0 0 [s] 0
OPTION TRAY BOX o 0 o o o o 0
OPTION TRAY Bracket o] 0 [s] 0 0 [s] 0
Option Tray [o] 0 [o} o] 0 [o]} 0
IC5-9-D Probe 0 0 [s] 0 0 [¢] 0
ML6-15-D Probe o 0 [¢] 0 0 [¢] 0
L8-18I-D Probe o | 0 [¢] c | o | o | o
C2-9-D Probe (o] 0 o} [o] o] [e} 0
C1-6-D Probe o 0 o] 0 0 8] 0
C1-6VN-D Probe 0 0 [s] 0 NA NA NA
C2-9VN-D Probe (8] 8] o 8] NA NA NA
C3-10-D Probe (o] 0 0 o] o] [o} [o]
M5Sc-D Probe [o] 0 e} o] 0 (o} [o]
L2-9-D Probe [o] 0 e} [o] 0 o} 0
L2-9VN-D Probe o 8] o 8] MNA NA MNA
PROBES  |6Tc-RS Probe o 0 o] 0 o] o] 0
TEE RS-DLP Adapter [o] 0 e} [o] 0 [e} 0
C2-7-D Probe [o] 0 (e} o] 0 e} [o]
C2-7VN-D Probe. o o o o NA NA NA
C2-7D-LC Probe NA MNA NA NA NA NA NA
P2D Probe o 0 [s] 0 0 o 0
RIC5-9-D 4D Probe o 0 o] 0 0 [¢] 0
RABE-D Probe [o] 0 o} [e] o] o} 0
PED Probe 0 ) 0 0 ) 0 0
BE9CS-D Probe o 0 o] 0 0 o] 0
L3-12-D Probe o] 0 e} [o] 0 [o} [o]
6S-D Probe 0 0 o 0 0 o 0
KZ200687 BITE GUARD ¢] 0 [¢] 0 0 [¢] 8]
KZ693 BITE GUARD OPR.CLIP ON 0 0 [o] 0 0 [¢] o]
TEE PROBE KZ808 TEE SCANH. PROTECT.COVER o 0 [¢] 0 0 [¢] 0
ITEMS 086A0016 BITE GUARD AD.16*27MM 0 0 [s] 0 0 [¢] 0
KZ800,BITE HOLE INDICATOR 0 0 [¢] 0 o] [¢] 0
TEE STORAGE RACK ¢] 0 [¢] 0 0 [e] 0
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1-2-5

1-2-5-1

1-2-5-2

1-2-5-3

Product description
Overview
The LOGIQ Fortis is a high performance digital ultrasound imaging system with total data management.

The fully digital architecture of the LOGIQ Fortis allows optimal usage of all scanning modes and probe
types throughout the full spectrum of operating frequencies.

The LOGIQ Fortis is a digital beamforming Ultrasound system. The Ultrasound signal flows from the
probe through the Ultrasound system where it is processed and finally displayed as a diagnostic image
on the monitor. Images and patient data can be sent to peripheral devices to be stored, printed, or
displayed.

System configuration is stored on the internal drive.
All necessary software is loaded from the internal drive on power up.
For more information on:

» Installed software versions, see "Software Status" on page 7-19

» Installed hardware, see Section 7-4 "Service Desktop" on page 7-11

+ Connected probes, see Section 7-4 "Service Desktop" on page 7-11

+ Compatible software, hardware, peripherals, and probes, see "Software" on page 9-4

FRUs for the ultrasound system
Refer to Chapter 9 in this manual.

Purpose of the user manual
The user manual should be fully read and understood before operating the LOGIQ Fortis.

The online versions of the user manual is available through the Help function on the LOGIQ Fortis’s
operator panel.

User manual documentation is provided through electronic Instructions For Use (elFU).
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Section 1-3
Important Conventions

1-3-1

& DANGER

A WARNING

& CAUTION

A

NOTICE

NOTE:
NOTE:

Contents in this section

1-3-1 Conventions used iNn booK . . .. .. 1-11
1-3-2 Standard hazard iCONS . . . . ... .. 1-12
Conventions used in book

Model designations

This manual covers the LOGIQ Fortis models listed in 7-2-4 "LOGIQ Fortis models covered in this
manual” on page 1-4.

Icons

Pictures, or icons, are used wherever they will reinforce the printed message. The icons, labels, and
conventions used on the product and in the service information are described in this chapter.

Safety precaution messages

Various levels of safety precaution messages may be found on the equipment and in the service
information. The different levels of concern are identified by a flag word that precedes the precautionary
message. Known or potential hazards to personnel are labeled in one of three ways:

+  DANGER
+  WARNING
+ CAUTION

When a hazard is present that can cause property damage, but has absolutely no personal injury risk,
a NOTICE is used.

DANGER IS USED TO INDICATE THAT A SPECIFIC HAZARD IS KNOWN TO
EXIST WHICH, THROUGH INAPPROPRIATE CONDITIONS OR ACTIONS, WILL
CAUSE SEVERE OR FATAL PERSONAL INJURY.

WARNING IS USED TO INDICATE THAT A SPECIFIC HAZARD IS KNOWN TO EXIST
WHICH, THROUGH INAPPROPRIATE CONDITIONS OR ACTIONS, MAY CAUSE MINOR
PERSONAL INJURY AND/OR SUBSTANTIAL PROPERTY DAMAGE.

CAUTION IS USED TO INDICATE THAT A POTENTIAL HAZARD MAY EXIST WHICH, THROUGH
INAPPROPRIATE CONDITIONS OR ACTIONS, WILL OR CAN CAUSE PROPERTY DAMAGE.

Notice is used when a hazard is present that can cause property damage but has absolutely no
personal injury risk.

Notice Example: Disk drive may crash.
Notes are used to provide important information about an item or a procedure.

Be sure to read the notes; the information contained in a note can often save you time or effort.
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1-3-2

Standard hazard icons

Important information will always be preceded by the exclamation point & contained within a triangle,
as seen throughout this chapter. In addition to text, several different graphical icons (symbols) may be
used to make you aware of specific types of hazards that could possibly cause harm. Even if a symbol
is not used in this manual, it may be included for your reference.

Table 1-3 Standard Hazard Icons

Icon Meaning Icon Meaning

Biological Hazard Explosion Hazard

Describes precautions necessary to prevent the risk Describes precautions necessary to prevent

of disease transmission or infections. the risk of injury through explosion hazard!

« Patient/user infection due to contaminated * Risk of explosion if used in the presence of
equipment. flammable anesthetics.

Electrical Hazard Fire and Smoke Hazard

Describes precautions necessary to prevent the risk + Patient/user injury or adverse reaction from

of injury through electric hazards. * fire or smoke.

« Electrical micro-shock to patient, e.g., ventricular « Patient/user injury from explosion and fire.

Moving Hazard
Describes precautions necessary to prevent the risk
of injury through moving or tipping hazard!
» Console, accessories or optional storage devices Caution: HOT
that can fall on patient, user, or others. Be careful not to burn yourself
» Collision with persons or objects may result in injury
while maneuvering or during system transport.
* Injury to user from moving the console.

.;(\(R((..ns

Pinch point
Watch your fingers. This symbol indicates that serious
injury to the hand may occur.

Pinch point
Watch your fingers
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1-3-2 Standard hazard icons (cont’d)

Other icons make you aware of specific procedures or requirements that should be followed.

Table 1-4 Standard Icons for Specific Procedures or Requirements

Icon Meaning

AVOID STATIC ELECTRICITY
Use grounding devices.

WEAR HAND PROTECTION to WEAR FOOT PROTECTION to
protect from electrical dangers, cuts, prqtect from.electn.cal hazards,

. falling or rolling objects or from
punctures, fractures and amputations, f . .
otc crushing or penetrating materials,

LOCKOUT/TAGOUT (LOTO)
before performing the procedure

etc.

WEAR EYE PROTECTION to protect
eye from dust, liquid, piece of metal,
etc.
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Contents in this section

1-4-1 Label Location. . . .. ... . 1-14
1-4-2 LOGIQ Fortis used in a veterinary environment . . .. ......... .. ... .. .. . 1-14
1-4-1 Label Location
For information on label locations, refer to the appropriate version of the Basic User Manual or the latest
version of the Release Notes.
Table 1-5 Basic User Manual and Release Notes for the LOGIQ Fortis
ENGLISH BASIC ENGLISH
MODEL USER MANUAL RELEASE NOTES
NUMBER DIRECTION NUMBER DIRECTION NUMBER
Running R3.x.x 5855997-1EN 58707681EN
software
1-4-2 LOGIQ Fortis used in a veterinary environment

There are different handling instructions for a LOGIQ Fortis used in a veterinary environment.

This table lists the labels (and locations) required on the LOGIQ Fortis when it is used in a veterinary
environment.

For specific information about label placement, see Table 8-34 "LOGIQ Fortis used in a Veterinary
Environment Label Placement" on page 8-69.
Table 1-6

Product Labels on the LOGIQ Fortis in a Veterinary Environment
Label

Location

b e

@@

& @ Probe cable(s) near the

connector

\
GRS

NN
\\\\\\\\\\\
O

Side covers

4

Monitor arm

or

A® @
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Section 1-5
Safety Considerations

1-5-1

1-5-2

& DANGER

A\

& DANGER

A\

A DANGER

A DANGER

Contents in this section

1-5-1 INtroducCtioNn. . . . .. 1-15
1-5-2 Human safety . . ... ... 1-15
1-5-3 Mechanical safety. . . ... 1-19
1-5-4 Electrical safety . ... ... . . . . 1-22
1-5-5 Battery safety . . ... 1-23

Introduction

The following safety precautions must be observed during all phases of operation, service, and repair
of this equipment. Failure to comply with these precautions or with specific warnings elsewhere in this
manual violates safety standards of design, manufacture, and intended use of the equipment.

Human safety

*  Operating personnel must not remove the Ultrasound system covers.
Servicing should be performed by authorized personnel only.

Only personnel who have participated in a LOGIQ Fortis Training Seminar are authorized to service the
equipment.

DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING AND
ADJUSTING.

WITH THE POWER ASSISTANT OPTION, DANGEROUS VOLTAGES, CAPABLE
OF CAUSING DEATH, ARE PRESENT IN THIS EQUIPMENT. DO NOT REMOVE
THE COVER.

TILTING THE LOGIQ Fortis REQUIRES TWO PEOPLE IN ORDER TO AVOID
INJURY TO SERVICE PERSONNEL AND DAMAGE TO THE EQUIPMENT.

USE EXTREME CAUTION AS LONG AS THE LOGIQ Fortis IS UN-STABLE,
NOT RESTING ON ALL FOUR CASTERS.
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1-5-2 Human safety (cont’d)

& DANGER DO NOT USE UNAPPROVED DEVICES.

IF DEVICES ARE CONNECTED WITHOUT THE APPROVAL OF GE, THE WARRANTY WILL BE
INVALID.

ANY DEVICE CONNECTED TO THE ULTRASOUND SYSTEM MUST CONFORM TO ONE OR
MORE OF THE REQUIREMENTS LISTED BELOW:

- IEC standard or equivalent standards appropriate to devices.
- The devices shall be connected to protective earth (ground).

A DANGER RISK OF ELECTRICAL SHOCK, THE LOGIQ Fortis MUST BE TURNED OFF AND
DISCONNECTED FROM POWER SOURCE. CORD MUST BE CONTROLLED AT ALL TIMES.

ﬁ DISCONNECT THE BATTERIES FROM THE BACKPLANE.

BEWARE THAT THE MAIN POWER SUPPLY, THE POWER ASSIST BATTERIES OR POWER
MODULE AND BEPS MAY BE ENERGIZED EVEN IF THE POWER IS TURNED OFF IF THE
CORD IS STILL PLUGGED INTO THE AC OUTLET.

& DANGER Be sure to have read and understood control explanations for each mode used before
attempting to adjust the Acoustic Output control or any control that can affect Acoustic
Output. During a screening and diagnostic ultrasound examination, high frequency sound
penetrates and interacts with tissue in and around the area of anatomy to be imaged. Only a
small portion of this sound energy is reflected back to the transducer for use in constructing
the image, while the remainder is dissipated within the tissue. The interaction of sound
energy with tissue at sufficiently high levels can produce biological effects (aka bioeffects)
of either a mechanical or thermal nature. Although the generation of bioeffect is intentional
with therapeutic ultrasound, it is generally undesired in screening and diagnostic
applications and may be harmful in some conditions.

Use the minimum necessary acoustic output (the principle of ALARA (As Low As Reasonably
Achievable)) to get the best diagnostic image or measurement during an examination. Begin
the exam with the probe that provides an optimum focal depth and penetration.

| =»
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1-5-2 Human safety (cont’d)

/\ WARNING IF THE COVERS ARE REMOVED FROM AN OPERATING LOGIQ Fortis, SOME METAL
SURFACES MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD IF
TOUCHED, EVEN WHILE IN SHUTDOWN MODE.

/\\ WARNING USE ALL PERSONAL PROTECTION EQUIPMENT (PPE) SUCH AS GLOVES, SAFETY
SHOES, SAFETY GLASSES, AND KNEELING PADS TO REDUCE THE RISK OF INJURY.

A WARNING EXPLOSION WARNING

DO NOT OPERATE THE EQUIPMENT IN AN EXPLOSIVE ATMOSPHERE.
OPERATION OF ANY ELECTRICAL EQUIPMENT IN SUCH AN ENVIRONMENT
CONSTITUTES A DEFINITE SAFETY HAZARD.

& WARNING For console Ultrasound systems and Ultrasound systems mounted on a cart, when
the top console is in its locked position, the gas shock is compressed and stores
mechanical energy. During normal operation the top console, the weight of the main
monitor and the mechanical force of the gas shock are in balance. Take care if/when
you activate this gas shock. Personal injury can occur after the panel is removed and
the shock pressure is released. Take care when you repair the elevation assembly.

/\ WARNING BEWARE OF POSSIBLE SHARP EDGES ON ALL MECHANICAL PARTS. IF SHARP
EDGES ARE ENCOUNTERED, THE APPROPRIATE PPE SHOULD BE USED TO
REDUCE THE RISK OF INJURY.
THE APPROPRIATE PPE IS REQUIRED PER EHS POLICIES AND SRAS.

/\ WARNING WEAR ALL PPE INCLUDING GLOVES AS INDICATED IN THE CHEMICAL SDS.

& WARNING HAVE TWO PEOPLE AVAILABLE TO DELIVER AND UNPACK THE LOGIQ FORTIS.
ATTEMPTS TO MOVE THE LOGIQ FORTIS CONSIDERABLE DISTANCES OR ON AN
INCLINE BY ONE PERSON COULD RESULT IN INJURY OR DAMAGE OR BOTH.
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1-5-2 Human safety (cont’d)

& CAUTION BECAUSE OF THE LIMITED ACCESS TO CABINETS AND EQUIPMENT IN THE FIELD, PLACING
PEOPLE IN AWKWARD POSITIONS, GE HAS LIMITED THE LIFTING WEIGHT FOR ONE PERSON
IN THE FIELD TO 16 KG (35 LBS). ANYTHING OVER 16 KG (35 LBS) REQUIRES 2 PEOPLE.

& CAUTION DO NOT SUBSTITUTE PARTS OR MODIFY EQUIPMENT

BECAUSE OF THE DANGER OF INTRODUCING ADDITIONAL HAZARDS, DO NOT INSTALL

SUBSTITUTE PARTS OR PERFORM ANY UNAUTHORIZED MODIFICATION OF THE
EQUIPMENT.
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1-5-3 Mechanical safety

/\ DANGER ULTRASOUND PROBES ARE HIGHLY SENSITIVE MEDICAL INSTRUMENTS
THAT CAN EASILY BE DAMAGED BY IMPROPER HANDLING. USE CARE WHEN
HANDLING AND PROTECT FROM DAMAGE WHEN NOT IN USE. DO NOT USE A
DAMAGED OR DEFECTIVE PROBE. FAILURE TO FOLLOW THESE
PRECAUTIONS CAN RESULT IN SERIOUS INJURY AND EQUIPMENT DAMAGE.

A\ DPANGER WHEN THE LOGIQ FORTIS IS RAISED FOR A REPAIR OR MOVED ALONG ANY
INCLINE, USE EXTREME CAUTION SINCE IT MAY BECOME UNSTABLE AND
TIP OVER.

A\ DANGER THE LOGIQ FORTIS WEIGHS 85KG (178 LBS) AND UP TO 95 KG (209 LBS),
DEPENDING ON INSTALLED PERIPHERALS. USE CARE WHEN MOVING
IT OR REPLACING ITS PARTS. FAILURE TO FOLLOW THE PRECAUTIONS
LISTED BELOW COULD RESULT IN INJURY, UNCONTROLLED MOTION,
AND COSTLY DAMAGE. ALWAYS:

- BE SURE THE PATHWAY IS CLEAR.
- USE SLOW, CAREFUL MOTIONS.

- USE TWO PEOPLE WHEN MOVING ON INCLINES OR LIFTING MORE
THAN 16 KG (35 LBS).

/\ WARNING WHILE THE SOFTWARE INSTALL PROCEDURE IS DESIGNED TO PRESERVE DATA,
YOU SHOULD SAVE ANY PATIENT DATA, IMAGES, AND SYSTEM SETUPS TO A
MEDIA OR HARDCOPY BEFORE DOING A SOFTWARE UPGRADE. FAILURE TO
FOLLOW INSTRUCTIONS COULD RESULT IN LOSS OF PATIENT DATA.

/\ WARNING NEVER USE A PROBE THAT HAS FALLEN TO THE FLOOR. EVEN IF IT LOOKS OK, IT
MAY BE DAMAGED.

/\ WARNING TO AVOID INJURY WHEN YOU MOVE THE MAIN MONITOR AND THE MONITOR ARM,
DO NOT PUT YOUR FINGER, HAND, OR OBJECT IN THE JOINT OF THE MAIN MONITOR
OR THE MONITOR ARM.

/\ WARNING TO AVOID INJURY OR DAMAGE TO THE MAIN MONITOR, MAKE SURE THERE IS
NOTHING WITHIN RANGE OF THE MAIN MONITOR BEFORE MOVING THE MAIN
MONITOR AND MONITOR ARM. THIS INCLUDES PEOPLE AND OTHER OBJECTS.

& CAUTION THE LOGIQ FORTIS SHOULD NOT BE MOVED WITH THE OPERATOR PANEL EXTENDED.
MOVE THE OPERATOR PANEL TO ITS CENTERED AND LOCKED POSITION. LOWER THE
OPERATOR PANEL AS MUCH AS POSSIBLE BEFORE MOVING THE LOGIQ FORTIS.
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1-5-3

A

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

Mechanical safety (cont’d)

TO PREVENT SYSTEM DAMAGE WHILE NOT IN USE AND/OR BEFORE MOVING THE SYSTEM,
FLIP DOWN THE MONITOR AND LOCK THE MONITOR ARM AND OPERATOR PANEL FIRMLY
IN PLACE.

TO AVOID INJURY WHEN YOU MOVE THE MAIN MONITOR AND THE MONITOR ARM, DO NOT
PUT YOUR FINGER, HAND, OR OBJECT ON THE JOINT OF THE MAIN MONITOR OR THE
MONITOR ARM.

IF THE FRONT CASTER SWIVEL LOCK IS ENGAGED FOR TRANSPORTATION, PRESSING THE
RELEASE PEDAL ONCE DISENGAGES THE SWIVEL LOCK. YOU MUST DEPRESS THE
RELEASE PEDAL A SECOND TIME TO ENGAGE THE BRAKE.

PRIOR TO ELEVATING THE LOGIQ FORTIS, VERIFY THE FOLLOWING:

- KEYBOARD IS LOCKED IN ITS LOWEST POSITION

- FRONT BRAKE IS LOCKED SO THE LOGIQ FORTIS IS UNABLE TO SWIVEL
- REAR BRAKES ARE IN THE LOCKED POSITION

BEFORE YOU MOVE OR TRANSPORT THE LOGIQ FORTIS, MAKE SURE TO FIRMLY LOCK THE
MONITOR ARM AND FLIP DOWN THE MAIN MONITOR TO PREVENT DAMAGE TO THE LOGIQ
FORTIS.

DO NOT MOVE THE ULTRASOUND SYSTEM IF THE OPERATING PANEL IS IN THE UNLOCKED
POSITION.

DO NOT TRANSPORT LOGIQ FORTIS IN A VEHICLE WITHOUT LOCKING THE CASTERS
(WHEELS) AND SECURING IT AS DESCRIBED IN CHAPTER 4.

USE PROTECTIVE GLASSES DURING DRILLING, FILING, AND DURING ALL
OTHER WORK WHERE EYES PROTECTION IS NEEDED.

USE SAFETY SHOES WHEN DOING WORK WHERE THERE IS ANY CHANCE OF
FOOT DAMAGE.

USE PROTECTIVE GLOVES WHEN DRILLING, CUTTING, AND WHEN REACHING
INTO CONFINED OR BLIND SPACES.
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1-5-3 Mechanical safety (cont’d)
NOTE: Special care should be taken when transporting the Ultrasound system in a vehicle:

» Before transporting, place the Ultrasound system in its special storage case.
» Ensure that the Ultrasound system is firmly secured while inside the vehicle.
+  Secure Ultrasound system with straps or as directed otherwise to prevent motion during transport.

* Prevent vibration damage by driving cautiously. Avoid unpaved roads, excessive speeds, and
erratic stops or starts.

& CAUTION BE CAREFUL NOT TO PINCH ANY OF THE CABLES.
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1-5-4

& CAUTION

& CAUTION

Electrical safety

Safe practices

RISK OF DAMAGE TO EQUIPMENT

CONNECTING THE LOGIQ FORTIS TO THE WRONG VOLTAGE LEVEL WILL MOST LIKELY
DESTROY IT.

RISK OF DAMAGE TO EQUIPMENT

USE THE POWER CORD EXCLUSIVELY ON THE LOGIQ FORTIS. DO NOT USE THE POWER
CORD TO MAKE ANY OTHER ELECTRICAL CONNECTIONS.

Follow these guidelines to minimize shock hazards whenever you are using the LOGIQ Fortis:

+ To minimize shock hazard, the equipment chassis must be connected to an electrical ground.

* The LOGIQ Fortis is equipped with a three-conductor AC power cable. This must be plugged into
an approved electrical outlet with safety ground. A separate power outlet with a 20 amp circuit
breaker for 120 VAC for 120V area, 7.5 amp circuit breaker for 220-240 VAC for 220/240V area or
15 amp circuit breaker for 100 VAC for Japan.

+ The power outlet used for this equipment should not be shared with other types of equipment.

+ Both the LOGIQ Fortis power cable and the power connector must meet international electrical
standards.

Probes
Follow these guidelines before connecting a probe to the LOGIQ Fortis:

* Inspect the probe prior to each use for damage or degradation to the:
- housing
- cable strain relief
- lens
- seal
- connectors
- locking mechanism
» Do not use a damaged or defective probe.
* Never immerse the probe connector or adapter into any liquid.

+ The LOGIQ Fortis has more than one type of probe port. Use the appropriate probe port designed
for the probe you are connecting.

Peripherals

» Refer to the “Peripherals used in the patient environment” in Chapter 2 of the User Manual for
peripheral isolation information.
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1-5-5

NOTE:

Battery safety
The LOGIQ Fortis is supplied with lithium ion batteries.

The lithium ion technology is significantly less hazardous to the environment than the lithium metal
technology used in some other batteries (such as watch batteries). Used batteries should not be placed
with common household waste products. Contact local authorities for the location of a chemical waste
collection program nearest you.

Regulations vary for different countries. Dispose of used batteries in accordance with local
regulations.

/\ WARNING THE LOGIQ Fortis BATTERIES HAVE A SAFETY DEVICE.

A CAUTION

A CAUTION

NOTE:

DO NOT ATTEMPT TO DIS-ASSEMBLE OR ALTER THE BATTERIES!
ALWAYS OBSERVE THE FOLLOWING PRECAUTIONS:

+ DO NOT short-circuit the batteries by directly connecting the negative terminals with metal objects.
+ DO NOT heat batteries or discard them into a fire.

DO NOT expose batteries to temperatures over 50 °C. Keep batteries away from fire and other heat
sources.

+ DO NOT charge batteries near a heat source, such as, a fire or heater.
+ DO NOT leave batteries in direct sunlight.

+ DO NOT pierce batteries with a sharp object, hit it, or step on it.
DO NOT use damaged batteries.

+ DO NOT apply solder to batteries.

+ DO NOT connect batteries to an electrical power outlet.

+ DO NOT immerse batteries in water or allow them to get wet.

USE ONLY BATTERIES APPROVED BY GE AS SUITABLE FOR USE WITH THE LOGIQ Fortis
ULTRASOUND SYSTEM.

TO PREVENT BATTERIES FROM BURSTING OR IGNITING, OR FUMES FROM THE BATTERIES
CAUSING EQUIPMENT DAMAGE, ALWAYS OBSERVE THE FOLLOWING PRECAUTIONS:

DO NOT place batteries into a microwave oven or pressurized container.
+ If a battery leaks or emits an odor, remove it from all possible flammable sources.

» If a battery emits an odor or heat, is deformed or discolored, or in a way appears abnormal during
use, recharging or storage, immediately remove it and stop using it.

If you have any questions about the batteries, consult your local GE representative.

+  Store the battery pack between -10 °C (14 °F) and 50 °C (122 °F).

When charging batteries for the first time after long-term storage, recover the battery pack to original
performance through repeating several cycles of full charging and discharging.
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Section 1-6
Dangerous Procedure Warnings

Warnings, such as the example below, precede potentially dangerous procedures throughout this
manual. Instructions contained in the warnings must be followed.

/A DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING AND

CE ADJUSTING.

/\ WARNING IF THE COVERS ARE REMOVED FROM AN OPERATING LOGIQ Fortis, SOME METAL
SURFACES MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD IF
TOUCHED, EVEN WHILE IN SHUT DOWN MODE.

A WARNING EXPLOSION WARNING

DO NOT OPERATE THE EQUIPMENT IN AN EXPLOSIVE ATMOSPHERE. OPERATION
OF ANY ELECTRICAL EQUIPMENT IN SUCH AN ENVIRONMENT CONSTITUTES A
DEFINITE SAFETY HAZARD.

/\ WARNING DO NOT SUBSTITUTE PARTS OR MODIFY EQUIPMENT.

BECAUSE OF THE DANGER OF INTRODUCING ADDITIONAL HAZARDS, DO NOT
INSTALL SUBSTITUTE PARTS OR PERFORM ANY UNAUTHORIZED MODIFICATION
OF THE EQUIPMENT.
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Section 1-7
Lockout/Tagout (LOTO)

1-71

Contents in this section

1-7-1 Lockout/tagout requirements . ... ... ... 1-25
1-7-2 Lockout/tagout procedure. . . . ... ... 1-26

Lockout/tagout requirements

Read and understand the lockout/tagout (LOTO) requirements before performing any replacement
procedures. Keep these instructions for future reference. Follow all of the safety measures and
procedures listed in this service manual.

Lockout/tagout requirements ensure you are in total control of the AC power plug at all times during the
service process.

Table 1-7 Preparations

Preparations - you must perform the following steps

& DANGER

Risk of dangerous voltage within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

Follow Lockout/Tagout requirements by ensuring you are in total control of the AC power plug at all times
during the service process.

¢ Plan and prepare for shutdown.

Completely power down the LOGIQ Fortis.

Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
Isolate the equipment.

Remove/disconnect the battery, if present.

Apply lockout/tagout devices to maintain exclusive control of the power cable.
Control all stored and residual energy.

Verify isolation.

All potentially hazardous stored or residual energy is relieved.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.

e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.

¢ "Disconnect battery power" on page 1-28.

P>

/\ DANGER Risk of electrical shock, system must be turned off.
Avoid all contact with electrical contacts, conductors and components. Always use non-conductive han-
dles designed for the removal and replacement of ESD sensitive parts. All parts that have the potential for
f storing energy must be discharged or isolated before making contact.
/\ DANGER Risk of damage to equipment.
DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE NECESSARY ESD PRECAU-

TIONS:

1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED TO ONE OF THE TWO
RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY FOR THAT PURPOSE.

2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE EQUIPMENT.
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1-7-2 Lockout/tagout procedure

1-7-2-1 Power down the LOGIQ Fortis
Apply lockout and tagout (LOTO) before servicing the Ultrasound system. Applying LOTO ensures a
safe environment when working on the LOGIQ Fortis. Follow all recommended safety procedures when
servicing and working near energy sources. Follow LOTO requirements by ensuring you are in total
control of the AC power plug at all times during the service process.

Table 1-8 Power Down the LOGIQ Fortis

Step Corresponding Graphic

1. |Set the caster brake.
Use the operator panel movement controls to set the panel height as required for this procedure.
Lock the panel in place.

2.
To completely power down the LOGIQ Fortis:
Lightly press the ON/OFF button on the operator
panel to display the System - Exit menu.

3.

SYSTEM - EXIT

Change Password

Select Shutdown to completely power down the
LOGIQ Fortis.

Shutdown Cancel

4. |wait for the ON/OFF button to turn from blue to white.
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1-7-2-2

Table 1-9

Disconnect Power to the LOGIQ Fortis

Disconnect Power to the LOGIQ Fortis

Step

Corresponding Graphic

A DANGER

Dangerous voltages exist within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist in the LOGIQ Fortis.

Always disconnect the power cable from the wall before disconnecting it from the LOGIQ Fortis.

To remove the energy supply from the
LOGIQ Fortis, do the following:

1. Turn off the breaker on the back of the LOGIQ
Fortis.

2. From the wall outlet, disconnect the power
cable.

3. Disconnect the power cable from the LOGIQ
Fortis.

4. To prevent unexpected re-energization,

maintain exclusive control over the power cable.

5. Confirm that the ON/OFF button turns OFF.

Disconnect and store any probes attached to the LOGIQ Fortis.

Disconnect any external I/0O cabling.
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1-7-2 Lockout/tagout procedure (cont’d)

Disconnect battery power

Table 1-10 Disconnect Battery Power

Step Corresponding Graphic

A DANGER

Dangerous voltages exist within the LOGIQ Fortis.
There are no test points to verify isolation.
If the power cable is plugged into an AC outlet, be aware that the main power supply, batteries, power module may be

energized even if power is turned OFF.
Ty
o @

DR DL wet
Cre

1. Remove 5 screws and rear cover.

AN
an a.t‘-‘.‘:«:iu

Remove BBG2 Signal Cable and BBG2 Power Cable
and 1 screw.

3. |Confirm that all of these steps have been completed to verify isolation.
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Section 1-8
Returning/Shipping Probes and Repair Parts

NOTE:

NOTE:

NOTE:

Equipment being returned must be clean and free of blood and other infectious substances.

GE policy states that body fluids must be properly removed from any part or equipment prior to
shipment. GE employees, as well as customers, are responsible for ensuring that parts/equipment have
been properly decontaminated prior to shipment. Under no circumstance should a part or equipment
with visible body fluids be taken or shipped from a clinic or site (for example, body coils or an ultrasound
probe).

The purpose of the regulation is to protect employees in the transportation industry, as well as the
people who will receive or open this package.

The US Department of Transportation (DOT) has ruled that “items that were saturated and/or
dripping with human blood that are now caked with dried blood; or which were used or intended
for use in patient care” are “regulated medical waste” for transportation purposes and must be
transported as a hazardous material.

For a LOGIQ Fortis used in a veterinary environment the same restrictions apply.

Return used/unused spare parts from a veterinary environment with the purple recycling label
(regardless of its actual condition) and add a description on the label stating that the items were
removed from a LOGIQ Fortis Vet in a veterinary environment. This applies for probes and
covers labeled as Vet used.

The USER/SERVICE staff should dispose of all the waste properly, per federal, state, and local
waste disposal regulations.

If the purple recycling label is not used in your region, use the local recycling label.

The LOGIQ Fortis is not meant to be used for long-term storage of patient data or images. The user is
responsible for the data on the LOGIQ Fortis and a regular backup is highly recommended.

If the LOGIQ Fortis is sent for repair, please ensure that any patient information is backed up and erased
from the LOGIQ Fortis before shipping. It is always possible during system failure and repair to lose
patient data. GE is not responsible for the loss of this data.

If PHI (Patient Healthcare Information) data needs to be sent to GE employees for service purposes,
GE will ascertain agreement from the customer. Patient information shall only be transferred by
approved service processes, tools and devices restricting access, protecting or encrypting data where
required, and providing traceability in the form of paper or electronic documents at each stage of the
procedure while maintaining compliance with cross-border restrictions of patient information transfers.
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Section 1-9
Electromagnetic Compatibility (EMC)

Contents in this section

1-9-1 Whatis EMC 2 . . ... 1-30
1-9-2 ComplianCe . . . ... 1-30
1-9-3 Electrostatic discharge (ESD) prevention. . .............. . .. 1-31
1-9-1 What is EMC?
Electromagnetic compatibility describes a level of performance of a device within its electromagnetic
environment. This environment consists of the device itself and its surroundings including other
equipment, power sources and persons with which the device must interface. Inadequate compatibility
results when a susceptible device fails to perform as intended due interference from its environment or
when the device produces unacceptable levels of emission to its environment. This interference is often
referred to as radio—frequency or electromagnetic interference (RFI/EMI) and can be radiated through
space or conducted over interconnecting power of signal cables. In addition to electromagnetic energy,
EMC also includes possible effects from electrical fields, magnetic fields, electrostatic discharge and
disturbances in the electrical power supply.
For more information, refer to the appropriate version of the LOGIQ Fortis Basic User Manual Chapter
2, or the appropriate LOGIQ Fortis Release Notes.
1-9-2 Compliance
LOGIQ Fortis conforms to all applicable conducted and radiated emission limits and to immunity from
electrostatic discharge, radiated and conducted RF fields, magnetic fields and power line transient
requirements.
Applicable standards are: IEC60601-1-2:2014 (Ed.4).
NOTE: For CE Compliance, it is critical that all covers, screws, shielding, gaskets, mesh, and clamps
are in good condition and installed tightly without skew or stress. Proper installation following
all comments noted in this service manual is required in order to achieve full EMC performance.
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1-9-3 Electrostatic discharge (ESD) prevention

/\ DANGER DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE
NECESSARY ESD PRECAUTIONS:
1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED
TO ONE OF THE TWO RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY
FOR THAT PURPOSE.
2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE
EQUIPMENT.

A\ DANGER RISK OF ELECTRICAL SHOCK. THE LOGIQ FORTIS MUST BE TURNED OFF.
AVOID ALL CONTACT WITH ELECTRICAL CONTACTS, CONDUCTORS AND
COMPONENTS. ALWAYS USE NON-CONDUCTIVE HANDLES DESIGNED FOR
THE REMOVAL AND REPLACEMENT OF ESD SENSITIVE PARTS. ALL PARTS
THAT HAVE THE POTENTIAL FOR STORING ENERGY MUST BE DISCHARGED
OR ISOLATED BEFORE MAKING CONTACT.

/\ WARNING RISK OF HEAT HAZARD. IF THE COVERS ARE REMOVED FROM AN OPERATING
LOGIQ FORTIS SOME METAL SURFACES (FOR EXAMPLE, THE GPU HEAT SINK ON
THE BEPS) MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD EVEN
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Section 1-10
Customer Assistance

1-10-1

NOTE:

Contact information

If this equipment does not work as indicated in this service manual or in the user manual, or if you
require additional assistance, please contact the local distributor or appropriate support resource as
listed in Table 1-11.

Before you call, identify the following information, and acquire an image (Alt+D) to send to the Customer
Care team:

1.) Ultrasound system ID serial number

2.) Software version

3.) Date and time of occurrence

4.) Sequence of events leading to issue

5.) Whether the issue is repeatable

6.) Imaging mode, probe, preset/application

7.) Media brand, speed, capacity, type

8.) Save secondary image capture, cine loop, 4D multi-volume loop
9.) Detailed description of any problem encountered

10.)Where applicable, save the appropriate log files. Remember to save the log files for each day on a
separate media with labels.

Restart the application before resuming clinical scanning.

Section 1-10 - Customer Assistance



Direction 5874372, Rev. 3

GE CONFIDENTIAL

LOGIQ Fortis Proprietary Service Manual

1-10-1

1-10-2

Contact information (cont’d)

Table 1-11

Phone Numbers for Customer Assistance

LOCATION

NUMBER

USA

GE Healthcare

Ultrasound Service Engineering
9900 Innovation Drive (RP-2156)
Wauwatosa, WI 53226

Service

TEL: 1-800-437-1171

Service Parts

TEL: 1-800-558-2040

Online Center

TEL: 1-800-321-7937

Application Support

TEL: 1-800-682-5327

TEL: 1-262-524-5698

Canada

Service

TEL: 1-800-668-0732

Application Support

TEL: 1-262-524-5698

Latin America

Service

TEL: 1-262-524-5300

Application Support

TEL:1-262-524-5698

Europe TEL: +49 (0) 212-2802-652
GE Ultraschall Deutschland GmbH
Beethovenstrasse 239 Support
Postfach 11 05 60, D-42655 Solingen FAX: +49 (0) 212-2802-431
Germany

Algeria TEL: 213-2179-1212

Egypt Service Center TEL: 0020-2322-1252
EAGM

Saudi Service Center

TEL: +(966) 800 429 2222

UAE Service Center

TEL: 0097-1800-3646

Asia (Singapore)

GE Ultrasound Asia

Service Department - Ultrasound
298 Tiong Bahru Road #15-01/06
Central Placa

Singapore 168730

Service Department

TEL:+65 6291-8528

FAX: +65 6291-7006

TEL: +81 42-846-9011

New Zealand

Japan Online Center
FAX: +81 42-648-2905
. ) TEL: +86 800-810 8188
China Technical Support
TEL: +86 400-812 8188
TEL: 1-800-425-8025
India Technical Support TEL: 1-800-425-7255
TEL: 1-800-102-7750
Australia

Service Support

TEL: +61 1800 659 465

Korea

Technical Support

TEL: +82 1544-6119

Ultrasound system manufacturer

Information about system manufacturer is located in the Basic User Manual (appropriate revision).
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Chapter 2
Site Preparations

Section 2-1

Overview

2-1-1

NOTE:

2-1-2

Purpose of this chapter

This chapter provides the information required to plan and prepare for the setup of a LOGIQ Fortis.
Included are descriptions of the facility and electrical needs to be met by the purchaser of the
LOGIQ Fortis.

The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

Contents in this chapter

2-1 OVEIVIBW. .« . 2-1
2-2 General LOGIQ Fortis Requirements. . . ... .. ... .. 2-2
2-3 Facility Needs. . . ... 2-9
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Section 2-2
General LOGIQ Fortis Requirements

Contents in this section

2-2-1 LOGIQ Fortis environmental requirements . . . ........... ... .. i 2-2
2-2-2 Electrical requirements . . . .. ... . e 2-4
2-2-3 EMIimitations. . . ... .. e 2-6
2-2-4 Probe environmental requirements. . . ........ .. .. 2-8
2-2-5 Time and manpower requIrements . . . ... ... 2-8
2-2-1 LOGIQ Fortis environmental requirements
If the LOGIQ Fortis is very cold or hot
A CAUTION RISK OF DAMAGE TO EQUIPMENT
IF THE ULTRASOUND SYSTEM IS VERY COLD OR HOT, DO NOT TURN ON ITS POWER UNTIL
IT HAS HAD A CHANCE TO ACCLIMATE TO ITS OPERATING ENVIRONMENT.
When unpacking the LOGIQ Fortis, allow the temperature to stabilize before powering up.
Refer to Table 2-1 for guidelines on reaching operational temperatures from storage or transport
temperatures.
Table 2-1 LOGIQ Fortis Acclimate Time
°c | 50 | 45 | 40 | 35 | 30 | 25 | 20 | 15 | 10 | 5 0 | -5 |-10
OF | 122 113|104 | 95 | 86 | 77 | 68 | 59 | 50 | 41 | 32 | 23 | 14
Hrs | 4 2 0 0 0 0 0 0 0 2 4 6 8
Environmental specifications
The LOGIQ Fortis should be operated, stored, and transported according to the listed environmental
requirements.
NOTE: Probe environmental specifications may be different than the LOGIQ Fortis.
Refer to Table 2-2 for environmental specifications.
Table 2-2 Environmental Specifications for the LOGIQ Fortis
Operational Storage Transport (< 16 hrs.)
T ) 10° - 35°C -10°-50°C -10°-50°C
emperature 50° - 95°F 14° - 122°F 14° - 122°F
Humidity 30 - 80% non-condensing 30 - 80% non-condensing 30 - 80% non-condensing
Pressure 70 - 106kPa 70 - 106kPa 70 - 106kPa
Heat Dissipation 3070 Btu/hour n/a n/a
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2-2-1 LOGIQ Fortis environmental requirements (cont’d)
Cooling

The cooling requirement for the LOGIQ Fortis with monitor and onboard peripherals is up to 3070 Btu/
hr. This figure does not include cooling needed for lights, people, or other equipment in the room. Each
person in the room places an additional 300 Btu/hr. demand on the cooling system.

Lighting

Bright light is needed for LOGIQ Fortis set up, updates, and repairs. However, operator and patient
comfort may be optimized if the room light is subdued and indirect. Therefore a combination lighting
system (dim/bright) is recommended. Keep in mind that lighting controls and dimmers can be a source
of EMI which could degrade image quality. These controls should be selected to minimize possible
interference.
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2-2-2

Electrical requirements

General requirements

NOTE: GE requires a dedicated power and ground for the proper operation of its ultrasound equipment. This
dedicated power shall originate at the last distribution panel before the LOGIQ Fortis.
The LOGIQ Fortis will function on voltages from 100-240 volts and 50 or 60 Hz. However, if using 220
volt power, then a center tapped power source is required.
Sites with a mains power system with defined neutral and live:
The dedicated line shall consist of one phase, a neutral (not shared with any other circuit), and a full
size ground wire from the distribution panel to the LOGIQ Fortis outlet.
Sites with a mains power system without a defined neutral:
The dedicated line shall consist of one phase (two lines), not shared with any other circuit, and a full
size ground wire from the distribution panel to the LOGIQ Fortis outlet.
NOTE: Please note that image artifacts can occur, if at any time within the facility, the ground from the
main facility’s incoming power source to the Ultrasound system is only a conduit.
Electrical requirements for LOGIQ Fortis
In Table 2-3, the electrical specifications for the LOGIQ Fortis include monitor and on board peripherals.
Table 2-3 Electrical Specifications for the LOGIQ Fortis
POWER
PART NUMBER DESCRIPTION VOLTAGE TOLERANCES CONSUMPTION FREQUENCY
6601000/6602000 |LOGIQ Fortis, 100-240 VAC 100-240 VAC +-10% 0.9 KVA 50/60 Hz
Inrush current
During power on, an inrush circuit prevents the current from increasing above the stated values.
Refer to Table 2-4 for inrush currents at various main voltages.
Table 2-4 Inrush Current at Different Mains Voltages
VOLTAGE Inrush Current
110 VAC 25 A max
120 VAC (with UPS
ABCE1442-11MED) 60 A max
230 VAC 50 A max
NOTE: These values are estimations.
Inrush current with UPS
During power on, the inrush current is higher than the one documented in the LOGIQ Fortis manuals
due to the use of the UPS. The inrush current value is measured by UPS input point.
Power Supply 230V 50Hz
UPS ABCE1442-22MED
Inrush Current 70A max
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2-2-2 Electrical requirements (cont’d)

& CAUTION

Site circuit breaker

RISK OF POWER OUTAGE

THE LOGIQ Fortis REQUIRES A DEDICATED SINGLE BRANCH CIRCUIT. TO AVOID CIRCUIT
OVERLOAD AND POSSIBLE LOSS OF CRITICAL CARE EQUIPMENT, MAKE SURE YOU DO NOT
HAVE ANY OTHER EQUIPMENT OPERATING ON THE SAME CIRCUIT.

It is recommended that the branch circuit breaker for the LOGIQ Fortis be readily accessible.
Site power outlets

A dedicated AC power outlet must be within reach of the LOGIQ Fortis without extension cords. Other
outlets adequate for the external peripherals, medical and test equipment needed to support this
LOGIQ Fortis must also be present within 1 m (3.2 ft.) of the LOGIQ Fortis. Electrical installation must
meet all current local, state, and national electrical codes.

LOGIQ Fortis power plug

If the LOGIQ Fortis arrives without a power plug, or with the wrong plug, you must contact your GE
dealer or the installation engineer must supply what is locally required.

Power stability requirements
Voltage drop-out
Max 10 ms.
Power transients (all applications)

Less than 25% of nominal peak voltage for less than 1 ms for any type of transient, including line
frequency, synchronous, asynchronous, or aperiodic transients.
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2-2-3

EMI limitations

Ultrasound machines are susceptible to Electromagnetic Interference (EMI) from radio frequencies,
magnetic fields, and transients in the air or wiring. Ultrasound machines also generate EMI. The
LOGIQ Fortis complies with limits as stated on the EMC label. However there is no guarantee that
interference will not occur in a particular installation.

Possible EMI sources should be identified before the LOGIQ Fortis is installed.

Electrical and electronic equipment may produce EMI unintentionally as the result of a defect. These
sources include:

* medical lasers

* scanners

» cauterizing guns

* computers

*  monitors

+ fans

* gel warmers

* microwave ovens

* light dimmers

* mobile phones

* in-house wireless phones (DECT phones)
» wireless computer keyboard and mouse

* air conditioning system

» High Frequency (HF) surgery equipment
» general AC/DC adapters

The presence of a broadcast station or broadcast van may also cause interference.
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2-2-3 EMI limitations (cont’d)

See Table 2-5 for EMI prevention and abatement tips.

Table 2-5

EMI Prevention/Abatement

EMI Rule

Detail

Be aware of RF sources

» Keep the LOGIQ Fortis at least 5 meters or 15 feet away from other EMI sources.

 Special shielding may be required to eliminate interference problems caused by high frequency,
high powered radio or video broadcast signals.

Ground the LOGIQ Fortis

Poor grounding is the most likely reason a LOGIQ Fortis will have noisy images. Check grounding
of the power cord and power outlet.

Replace all screws, RF
gaskets, covers, cores

« After you finish repairing or updating the LOGIQ Fortis, replace all covers and tighten all screws.
» Any cable with an external connection requires a magnet wrap at each end.

« Install the card rack cover over the card rack. Loose or missing covers or RF gaskets allow radio
frequencies to interfere with the ultrasound signals.

Replace broken RF
gaskets

If more than 20% or a pair of the fingers on an RF gasket are broken, replace the gasket. Do not
turn on the LOGIQ Fortis until any loose metallic part is removed.

Do not place labels where
RF gaskets touch metal

Never place a label where RF gaskets meet the LOGIQ Fortis. Otherwise, the gap created will
permit RF leakage. Or, if a label has been found in such a position, move the label.

Use GE specified
harnesses and peripherals

The interconnect cables are grounded and require ferrite beads and other shielding. Also, cable
length, material, and routing are all important; do not change from what is specified.

Take care with cellular
phones

Cellular phones may transmit a 5 V/m signal; that could cause image artifacts.

Properly dress peripheral
cables

Do not allow cables to lie across the top of the card rack or hang out of the peripheral bays. Loop
the excess length for peripheral cables inside the peripheral bays. Attach the monitor cables to
the frame.
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2-2-4

NOTE:

A NOTICE

2-2-5

& CAUTION

Probe environmental requirements

Probes should be operated, stored, and transported according to the listed environmental requirements.
For specific information on environmental requirements for the probes, see “Environmental
Requirements” in Chapter 3 of the Basic User Manual (latest revision).

LOGIQ Fortis environmental specifications may be different than the probes.

STORAGE TEMPERATURES VARY DEPENDING ON THE TYPE OF PROBE. WHEN EXPOSED TO
LARGE TEMPERATURE VARIATIONS, THE LOGIQ Fortis AND PROBES SHOULD BE KEPT AT
ROOM TEMPERATURE BEFORE USE.

Refer to the table in "If the LOGIQ Fortis is very cold or hot" on page 2-2 to determine the needed
settlement time.

Time and manpower requirements

RISK OF INJURY OR DAMAGE TO EQUIPMENT

HAVE TWO PEOPLE AVAILABLE TO DELIVER AND UNPACK THE LOGIQ FORTIS.
ATTEMPTS BY ONE PERSON TO MOVE THE LOGIQ Fortis CONSIDERABLE DISTANCES,
OR ON AN INCLINE, COULD RESULT IN INJURY, DAMAGE, OR BOTH.

Time requirement

Site preparation takes time. Begin pre-installation checks as soon as possible. If possible, begin pre-
installation six weeks before delivery to allow enough time to make any changes.

Manpower requirement

Two persons for delivery and unpacking.
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Section 2-3
Facility Needs

2-3-1

NOTE:

Contents in this section
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Purchaser responsibilities

The work and materials needed to prepare the site are the responsibility of the purchaser. Delay,
confusion, and waste of manpower can be avoided by completing pre-installation work before delivery.
Purchaser responsibility includes:

»  Procuring the materials required.
+ Completing the preparations before delivery of the LOGIQ Fortis.
» Paying the costs for any alterations and modifications not specifically provided in the sales contract.

All electrical installations that are preliminary to the positioning of the equipment at the site
prepared for the equipment must be performed by licensed electrical contractors. Other
connections between pieces of electrical equipment, calibrations, and testing must also be
performed by qualified personnel. The products involved (and the accompanying electrical
installations) are highly sophisticated and special engineering competence is required. All
electrical work on these products must comply with the requirements of applicable electrical
codes. The purchaser of GE equipment must only utilize qualified personnel to perform
electrical servicing on the equipment.

The desire to use a non-listed or customer provided product or to place an approved product further
from the LOGIQ Fortis than the interface kit allows, presents challenges to the installation team. To
avoid delays during installation, such variances should be made known to the individuals or group
performing the installation at the earliest possible date (preferably prior to the purchase).

The ultrasound suite must be clean prior to delivery of the machine. Carpet is not recommended
because it collects dust and creates static. Potential sources of EMI (electromagnetic interference)
should also be investigated before delivery. Dirt, static, and EMI can negatively impact LOGIQ Fortis
reliability.
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2-3-2 Required facility needs
NOTE: GE requires a dedicated power and ground for the proper operation of its ultrasound equipment. This
dedicated power shall originate at the last distribution panel before the LOGIQ Fortis.
The LOGIQ Fortis will function on voltages from 100-240 volts and 50 or 60 Hz. However, if using 220
volt power, then a center tapped power source is required.
Sites with a mains power system with defined neutral and live:
The dedicated line shall consist of one phase, a neutral (not shared with any other circuit), and a full
size ground wire from the distribution panel to the ultrasound outlet.
Sites with a mains power system without a defined neutral:
The dedicated line shall consist of one phase (two lines), not shared with any other circuit, and a full
size ground wire from the distribution panel to the ultrasound outlet.
+ Dedicated single branch power outlet of adequate amperage (see Table 2-3 "Electrical
Specifications for the LOGIQ Fortis" on page 2-4) meeting all local and national codes which is
located less than 2.5 m (8 ft.) from the LOGIQ Fortis’s proposed location.
» Door opening is at least 76 cm (30 in) wide.
* Proposed location for LOGIQ Fortis is at least 0.46 m (1.5 ft) from the wall or objects for cooling.
» Power outlet and place for any external peripheral are within 2 m (6.5 ft.) of each other with
peripheral within 1 m (3.2 ft.) of the LOGIQ Fortis to connect cables.
+ Power outlets for other medical equipment and gel warmer.
»  Power outlets for test equipment within 1 m (3.2 ft.) of the LOGIQ Fortis.
+ Clean and protected space to store transducers (in their cases or on a rack).
* Material to safely clean probes (done with a plastic container, never metal).
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2-3-3

2-3-4

Desirable features

In addition to the floor plan suggestions shown in Figure 2-1 and Figure 2-2, a nearby waiting room and
a receptacle for bio—hazardous waste, like used probe sheaths is suggested. Grid represents 30.5 x
30.5 cm (1 x 1 foot).

Minimal floor plan suggestions
Figure 2-1 Floor Plan Suggestion 4.27 x 5.18 m (14 x 17 foot)

T Pelle

Floor Plan Suggestion 4.27 x 5.18 m (14 x 17 foot) Key

Item Description Item Description

1. | Secretary or doctors desk 2 Lockgble cabinet ordered by GE for its software and
proprietary manuals

3. | Film viewer 4. | Counter top

5. | Counter top and sink with hot and cold water 6. | Overhead light dimmer — dual level lighting (bright/dim)

7. | Emergency oxygen 8. | Suction line

9. Ded.lcated poyver outlet — circuit breaker protected and 10. |LOGIQ Fortis

easily accessible

11. | Network interface 12. 45.,7 cm (1.5 ft) distance of LOGIQ Fortis from wall or
objects

13. | Stool 14. | Footswitch

15. | Storage for linens and equipment 16. | Examination table — 193 x 61 cm (76 x 24 inches)

17. | Lavatory and dressing room 18. | Door — at least 76 cm (30 inches)
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2-3-4 Minimal floor plan suggestions (cont’d)
Figure 2-2 Floor Plan Suggestion 2.44 x 3.05 m (8 x 10 foot)

Ultrazound
{ S!.lsem

._..1.--.. - [

Floor Plan Suggestion 2.44 x 3.05 m (8 x 10 foot) Key

ltem Description Item Description
1. |Door — at least 76 cm (30 inches) 2. |Film viewer
3. Counter top, sink with hot and cold water, and supplies 4. |Linen supply
storage
5. |Probes/supplies 6. |Examination table — 193 x 61 cm (76 x 24 inches)
7. |Footswitch 8. |Stool
9. |External peripherals 10. |LOGIQ Fortis

1 Dedicated power outlet — circuit breaker protected and 12

) . Network interface
easily accessible

13 45,7 cm (1.5 ft) distance of LOGIQ Fortis from wall or 14, |Lockable cabinet ordered by GE for its software and
" |objects " | proprietary manuals

2-12 Section 2-3 - Facility Needs



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

2-3-5

Networking setup requirements

Stand alone scanner (without network connection)

None.

Scanner connected to hospital’s network

For supported networks, a 10/100/1000 Mbps Ethernet/DICOM network connection is required.
InSite™ requirements

Need internet access on the outbound port to GE’s remote service platform (Insite), which is only
opened on request by the user and through a secure HTTPS connection on port 443.

Insite requires an Ethernet connection with a 10/100 Mbps or 10/100/1000 Mbps interface.
Purpose of the DICOM network function

DICOM services provide the operator with clinically useful features for moving images and patient
information over a hospital network. Inbound and outbound connections through port 104 are for
DICOM connectivity. Examples of DICOM services include the transfer of images to workstations for
viewing or transferring images to remote printers. As an added benefit, transferring images in this
manner frees up the on-board monitor and peripherals, enabling viewing to be done while scanning
continues. With DICOM, images can be archived, stored, and retrieved faster, easier, and at a lower
cost.

DICOM option setup requirements

To configure the LOGIQ Fortis to work with other network connections, the site’s network administrator
must provide information to complete the form in Figure 2-3 "Worksheet for DICOM Network
Information" on page 2-14. Ensure that there are no spaces in any field of the form.

Entries must include:

* A host name, local port number, AE Title, IP address and Net Mask for the LOGIQ Fortis.

+ The IP addresses for the default gateway and other routers at the site for ROUTING
INFORMATION.

» The host name, IP address, port and AE Title for each device the site wants connected to the
LOGIQ Fortis for DICOM APPLICATION INFORMATION. A field for the make (manufacturer) and
the revision of the device, is also included. This information may be useful for troubleshooting.

For connectivity setup information, see the current revision of the LOGIQ Fortis Basic User

Manual (latest revision). See 7-4-1 "Label Location" on page 1-14.
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2-3-5

Networking setup requirements (cont’d)

Figure 2-3 Worksheet for DICOM Network Information

LOGIQ
Fortis
Host Name | IP Address | || || || | Local Port I:l
AETitle | | Netmask [ [ ][ [ |
Network | |
Speed Default Gateway | | | || || |
once [
DICOM APPLICATION
OTHER
NAME MAKE/ AE TITLE IP PORT CONFIGURATION
Store1 |- ----------oflooo el __Raw Data
__Allow Multiframe
__Structured
Reporting
Compression
e e | | __Raw Data
__Allow Multiframe
__Structured
Reporting
Compression
Store3 |- --------- | e
__Raw Data
__Allow Multiframe
__Structured
Reporting
Compression
DICOM
Print |~~~ "~~~ """}~ “~"“"~"~"“"“"“"“"“"“"“"}{~ ~“~"“"""“""~"""""/"7° Vendor:
Print Size:
Medium:
Copies:
Orientation:
Color
Worklist |- - - - - - - - - - - oo e e
Storage Associated
(0771111 11 I | Storage AE
10 [0 ] e e
MPPS
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2-3-6

2-3-7

Privacy and security

Since the LOGIQ systems are integrated into your IT-network, GE wants to make sure that you are
aware of the proactive measures we are taking to secure the LOGIQ Fortis.

For more information on privacy and security, see “Privacy and Security Manual” (latest revision).

Environmental dangers

Commercial devices such as laser cameras, printers, VCRs and external monitors, usually exceed
allowable leakage current limits and, when plugged into separate AC outlets, are in violation of patient
safety standards. Suitable electrical isolation of such external AC outlets, or providing the device with
extra protective earth, will be required in order to meet ANSI/AAMI ES60601-1 and IEC60601-
1standards for electrical leakage.
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2-3-7 Environmental dangers (cont’d)
Patient Vicinity UL60601-1 (USA)

2.12.20DV (UL60601-1:2003)

In area in which patients are normally cared for, the patient vicinity is the space with surfaces likely to
be contacted by the patient or attendant who can touch the patient. This encloses a space within the
room 1.83 m (6 ft.) beyond the perimeter of the bed (examination table, dental chair, treatment booth,
and the like) in its intended location, and extending vertically 2.29 m (7.5 ft.) above the floor.

Figure 2-4 Patient Vicinity
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Patient Environment IEC60601-1 (IEC60601-1-1) and ANSI AAMI ES60601-1

Sub Clause 2.202 and figure 201 (IEC60601-1-1:2000)

Sub Clause 3.79 and figure A.9 (IEC60601-1:2005 and ANSI AAMI ES60601-1:2005)

Such an area is an environment in which medical diagnosis, monitoring or treatment is carried out. It is
very difficult to attach unique dimensions to the PATIENT ENVIROMENT.

In practice, a distance of 2,5 m (8.2 ft.) above the floor on which the medical personnel stand and a
horizontal distance of 1,5 m (4.9 ft.) have justified themselves as indicative of the dimensions of the
Patient Environment.

The patient environment/vicinity will be depicted as a dashed line in this procedure. See example below.

Figure 2-5 Patient Environment

Item

Description

Patient environment
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Chapter 3

LOGIQ Fortis Setup

Section 3-1

Overview

3-1-1

NOTE:

3-1-2

Purpose of this chapter

This chapter contains information needed to set up the LOGIQ Fortis. Also included in this section are
guidelines for transporting the unit to a new site.

The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

Contents in this chapter

3-1
3-2
3-3
3-4
3-5
3-6
3-7
3-8

OVEIVIBW. .« . 3-1
Setup Reminders . . ... .. 3-2
Receiving and Unpacking the Equipment. . . ... ... ... .. ... i 3-4
Preparing for Setup. . . . . ... 3-10
Completingthe Setup. . .. ... 3-13
Configuring the LOGIQ Fortis. . .. .. .. e 3-35
CoNNECtiVIty . .. 3-54
Setting Up Paperwork. . ... ... 3-55
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Section 3-2
Setup Reminders

Contents in this section

3-2-1 Average setup time . . . ... 3-2
3-2-2 Setup Warnings . . . . ... 3-2
3-2-1 Average setup time
Table 3-1 Average Setup Time
AVERAGE SETUP
DESCRIPTION TIME COMMENTS
UNPACK THE LOGIQ Fortis 0.5 HOUR
SET UP THE LOGIQ Fortis (without OPTIONS) 4 HOURS DEPENDENT ON THE CONFIGURATION
CONFIGURE DICOM NETWORK 2 HOURS OR MORE | DEPENDENT ON THE CONFIGURATION
INSTALL INSITE 0.5 HOUR
3-2-2 Setup warnings
/) DANGER WHEN USING ANY TEST INSTRUMENT THAT IS CAPABLE OF OPENING THE
AC GROUND LINE (FOR EXAMPLE, THE METER’S GROUND SWITCH IS OPEN),
DO NOT TOUCH THE LOGIQ FORTIS!
/\ DANGER DO NOT WEAR THE ESD WRIST STRAP WHEN YOU WORK ON LIVE CIRCUITS
AND MORE THAN 30V PEAK IS PRESENT.
/A DANGER TO PREVENT ELECTRICAL SHOCK, CONNECT THE LOGIQ FORTIS TO A
PROPERLY GROUNDED POWER OUTLET. DO NOT USE A THREE-TO-TWO
PRONG ADAPTER. THIS DEFEATS SAFETY GROUNDING.
A CAUTION DO NOT OPERATE THE LOGIQ FORTIS UNLESS ALL BOARD COVERS AND FRAME PANELS
ARE SECURELY IN PLACE. LOGIQ FORTIS PERFORMANCE AND COOLING REQUIRE THIS.
cAUTION NEVER REVERSE POLARITY ON ANY METER THAT INTERCEPTS THE POWER CORD WITH
& POWER CONNECTED TO THE LOGIQ Fortis.
EVEN IN THE OFF STATE, REVERSING POLARITY ON THE POWER CAN SERIOUSLY DAMAGE
THE POWER SUPPLY.
& CcAUTION IF THE LOGIQ FORTIS IS VERY HOT OR COLD, ALLOW THE TEMPERATURE TO STABILIZE
BEFORE POWERING UP. FOR GUIDELINES ON REACHING OPERATIONAL TEMPERATURES
FROM STORAGE OR TRANSPORT TEMPERATURES, SEE 2-2-1 "LOGIQ Fortis environmental
requirements" on page 2-2.
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3-2-2 Setup warnings (cont’d)

& CAUTION OPERATOR MANUAL(S)

THE USER MANUAL(S) SHOULD BE FULLY READ AND UNDERSTOOD BEFORE OPERATING
THE LOGIQ FORTIS AND KEPT NEAR THE LOGIQ FORTIS FOR QUICK REFERENCE.

A CAUTION ACOUSTIC OUTPUT HAZARD
ALTHOUGH THE ULTRASOUND ENERGY TRANSMITTED FROM THE LOGIQ FORTIS PROBE IS
WITHIN AIUM/NEMA STANDARDS, AVOID UNNECESSARY EXPOSURE. ULTRASOUND
f ENERGY CAN PRODUCE HEAT AND MECHANICAL DAMAGE.
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Section 3-3
Receiving and Unpacking the Equipment

Contents in this section

3-3-1 Purpose of thissection . . ... . . . . 3-4
3-3-2 Receiving and unpacking warnings. . . .. ... ... . 3-4
3-3-3 Tilt Watch Indicator . . . .. ... 3-5
3-34 Transportation box label . .. ... .. .. . . . . 3-6
3-3-5 Receiving the LOGIQ Fortis . . . .. ... e 3-7
3-3-6 Unpacking the LOGIQ Fortis. . . .. ... e 3-8
3-3-7 Packing materials - recycling information . . . ......... .. ... .. .. L 3-9
3-31 Purpose of this section

This section describes how to receive and unpack the LOGIQ Fortis.

3-3-2 Receiving and unpacking warnings
A CAUTION TWO PEOPLE ARE NEEDED TO UNPACK THE LOGIQ FORTIS BECAUSE OF ITS
WEIGHT.

ATTEMPTS TO MOVE THE LOGIQ FORTIS CONSIDERABLE DISTANCES OR ON AN
INCLINE BY ONE PERSON COULD RESULT IN INJURY OR DAMAGE OR BOTH.

TWO PEOPLE ARE REQUIRED WHENEVER A PART WEIGHING 16 KG (35 LBS) OR
MORE MUST BE LIFTED.

& CAUTION REMEMBER TO USE RELEVANT PERSONAL PROTECTING EQUIPMENT (PPE) DURING
PACKING/UNPACKING. CHECK WITH YOUR LOCAL EHS REPRESENTATIVE.
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3-3-3

3-3-341

Tilt Watch Indicator

Improper handling during transportation may harm the equipment inside the package even if the
package itself is undamaged.

To make it easier to detect if the handling during transportation has been improper, a set of Tilt Watch
Indicator have been attached to the transportation box.
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Figure 3-1 Tilt Watch Indicator (example)

If Tilt Watch Indicator has triggered or is missing

The purpose of the Tilt Watch Indicator label is to alert people handling a product that it is sensitive to
tipping and it must remain upright at all times. It is basically an active “Up Arrow” that changes color if
the package is tipped 89 degrees or more from horizontal. These labels can be false activated if tipped
less than 89 degrees, and shocked or vibrated at the same time. This event does occur, but is
considered uncommon. If a package is received with an activated Tilt Watch Indicator label, there is high
degree of certainty it tipped 89 degrees or more from horizontal during shipment.

An activated Tilt Watch Indicator label does not indicate if the package was simply “Tipped” (laid down
with no impact shock) or “Tipped Over” (free fall, with an impact shock). Using both shock indicator
labels and Tilt Watch Indicator labels will help identify if a Tip Over impact shock occurred.

Table 3-2 Tilt Watch Indicator has triggered or is missing

Step Task

If the Tilt Watch Indicator is missing:

1 Note on the shipping papers at the time of receipt that the Tilt Watch Indicator label is missing.
' If the Tilt Watch Indicator has triggered:

Note on the shipping papers at the time of receipt that the Tilt Watch Indicator label was activated.

2. Inspect the product for possible concealed damage.
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3-3-3-2 Position of the Tilt Watch Indicators
Before cutting the straps, check the indicator to make sure they have not been triggered. If damaged,
report it to the carrier. If not, then cut the straps around the crate.

The Tilt & Shock indicators have been attached to the transportation box as illustrated in the figure
below.

3-3-4 Transportation box label

Figure 3-2 Transportation box label

Table 3-3 LOGIQ Fortis Transportation Box Labeling

SYMBOL DEFINITION SYMBOL DEFINITION

RECYCLING TOP, UPRIGHT - Transportation FRAGILE, Handle with
Recyclable Wood and Storage Care

¢ 4
B AT
E DO NOT STACK . E KEEP DRY. /Y Thermal management
(protect from moisture)

ATE -~ BT I Slerage
.~ 90 In Trammperintion

hir Pressure Range of Air Pressure RECYCLING
700~1060hPa 9 Recyclable Wood
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3-3-5

Receiving the LOGIQ Fortis

Improper handling during transportation may harm the equipment inside the package even if the
package itself is undamaged.

Examine package

Examine package closely at time of delivery.

Damage in transportation

Follow this procedure if damage is apparent:

Table 3-4 Damage in Transportation
STEP TASK
1. Write “Damage In Shipment” on ALL copies of the freight or express bill BEFORE delivery is accepted or “signed
for“ by a GE representative or hospital receiving agent.
2. Take pictures of any damage to the packaging and the LOGIQ Fortis. These pictures will be needed if a claim
against the carrier is applied.
3.

Report the damage to the carrier.

*  Whether noted or concealed, damage MUST be reported to the carrier immediately upon discovery, or in
any event, within 14 days after receipt, and the contents and containers held for inspection by the carrier.

»  Atransportation company will not pay a claim for damage if an inspection is not requested within this 14 day

period.
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3-3-6 Unpacking the LOGIQ Fortis

The instruction manual describes the best method for unpacking the LOGIQ Fortis ultrasound scanning
unit. Images are ONLY for reference; wear proper PPE when handling packaging (gloves, safety shoes,

etc....).
Table 3-5 Unpacking Procedure
Step Task Corresponding graphic
1. Cut the straps around the crate.
2. Remove the top cover.
3.
Remove three P-Joint, then remove the out sleeve.
4. Remove the option box.
5. Carefully remove foam packing material and plastic bag
from the ultrasound unit and monitor
6.
Remove the box bottom assy.
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Table 3-5 Unpacking Procedure

Step Task Corresponding graphic

Unlock the casters and align the orientation of the 4 caster's
direction (refer to 4-3-3 "Brakes and direction lock functional
checks" on page 4-15) and then using the incline plane of

the box bottom assy., slowly move the system from the box.

Note: Place all of the filling inside the Transportation Box. Close the box, and store the filling for possible future use.

3-3-7 Packing materials - recycling information
The packing materials for the LOGIQ Fortis are recyclable:

» The transportation box is made of cardboard.

» Lever locking (hinges) is made of zinc plated steel.

» The inner reinforcements are made of Ethafoam (Polyethylene foam).
» The plastic wrap is made of LDPE (Low Density Polyethylene).
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Section 3-4

Preparing for Setup

Contents in this section
3-4-1 Verify customer order . . .. ... . 3-10
3-4-2 Physical inspection . . ... ... .. e 3-10
3-4-3 Location of Multi Caution label and rating label ... ......... .. ... .. ... .. ....... 3-11
3-4-4 EMI protection. . . ... .. 3-12

3-4-1 Verify customer order
Compare items received by the customer to what is listed on the delivery order. Report any items that
are missing, back ordered, or damaged.

3-4-2 Physical inspection
Verify that the LOGIQ Fortis arrived intact (visual inspection). If the LOGIQ Fortis has been damaged,
see 3-3-5 "Receiving the LOGIQ Fortis" on page 3-7.
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3-4-3 Location of Multi Caution label and rating label

Figure 3-3 Multi Caution Label

Figure 3-4 Rating Label (OPIO arm)
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3-4-3 Location of Multi Caution label and rating label (cont’d)
Figure 3-5 Rear Cover Label
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3-4-4 EMI protection

The LOGIQ Fortis has been designed to minimize the effects of Electro-Magnetic Interference (EMI).

Many of the covers, shields, and screws are provided primarily to protect the LOGIQ Fortis from image
artifacts caused by this interference. For this reason, it is imperative that all covers and hardware are

installed and secured before the LOGIQ Fortis is put into operation.

See 2-2-3 "EMI limitations" on page 2-6 for more information about EMI protection.
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Purpose of this section

This section describes how to complete the set up of LOGIQ Fortis.

LOGIQ Fortis specification verification

Verification of the LOGIQ Fortis requirements

+ Verify that the site meets the requirements listed in (see Section 2-3 "Facility Needs" on page 2-9).

»  Verify that the specifications (physical dimensions, mass, and acoustic noise output) below do not
conflict with any on-site conditions.

Physical dimensions

* Height: 1250 - 1800 mm, 49 - 71 in (HDU display), 1210 - 1760 mm, 48 - 69 in (LCD Monitor)

*  Width: 530mm, 20.9 inch (Caster), 545mm, 21.5 inch (LCD Monitor), 565mm, 22.2 inch (HDU
display)

*  Depth: 885mm, 34.8 inch

*  Weight: 85 kg (187.4 Ib.)

Acoustic noise output

The acoustic noise output is less than 48 dB(A) at 20 degrees Celsius at a distance of 1 meter at all four
sides and 1 meter above the floor.
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3-5-3

& CAUTION

Electrical specification verification

CONNECTING A LOGIQ FORTIS TO THE WRONG VOLTAGE LEVEL WILL MOST LIKELY

DESTROY IT.

Verification of the LOGIQ Fortis voltage setting

Verify that the mains voltage specified for the LOGIQ Fortis is available on-site.

The voltage setting for the LOGIQ Fortis is found on the rating label on the back of the LOGIQ Fortis on

the lower rear frame.

Figure 3-6 Rating Label - LOGIQ Fortis

“ GE ULTRASOUND KOREA, Ltd.

100-240V~, 50/60Hz, 900-900VA

M 202001

SIS, MEDICAL-

E355835

9, Sunhwan-ro 214beon-gil, Jungwon-gu,
SEONGNAM-SI, GYEONGGI-DO, Republic of Korea

LOGIQ Fortis HDU

501 123456789 [Ton) (01/00000000000000
uﬁ (11)000000(21)000000000

ULTRASOUND EQUIPMENT AS TO ELECTRICAL
SHOCK, FIRE AND MECHANICAL HAZARDS ONLY IN

C US ACCORDANCE WITH ANSI/AAMI ES60601-1:2005/[RI2012
AND A1:2012, C1:2009/RI2012 AND A2:2010/[RI2012

CSA CAN/CSA-C22.2 NO. 60601-1:14

LOGIQ Fortis
121kg
6601000
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3-5-4

NOTE:

Connections on the rear I/O panel

Accessory equipment connected to the analog and digital interfaces must be certified according
to the respective IEC standards (e.g. IEC60950-1 or IEC62368-1 for data processing
equipment and IEC60601-1 for medical equipment). Furthermore, all complete configurations
shall comply with the valid version of the LOGIQ Fortis standard IEC60601-1-1. Everybody who
connects additional equipment to the signal input part or signal output part of LOGIQ Fortis,
configures a medical system, and is therefore responsible that the LOGIQ Fortis complies with
the requirements of the valid version of IEC60601-1-1. If in doubt, consult the technical service
department or your local representative for GE.

Connect Ethernet

Connect the Ethernet cable to the Ethernet connector on the external I/O (rear side of LOGIQ Fortis).

Figure 3-7 1/0 Rear Panel

1.) USB 3.0 Port
2.) Ethernet connector (RJ-45 modular, 8-pin)

3.) S-Video Option (NTSC (720x480i, 60Hz) and
PAL (720x576i, 50Hz))

4.) HDMI Port (1920x1080 is the only supported
resolution)

Connect USB Flash Drive

For information, see “USB Hard Disk Drive and USB Flash Drive” in Chapter 9 of the LOGIQ Fortis Basic
User Manual (latest revision).
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3-5-5

3-5-6

& CAUTION

NOTE:

& CAUTION

& CAUTION

Connections on the patient I/O panel
Connect ECG

For information on the ECG, see “Patient Cardiac and ECG Connections” in Chapter 3 of the Basic User
Manual (appropriate version).

Connecting probes

Probes can be connected at any time, whether the LOGIQ Fortis is on or off.

DO NOT CONNECT A PROBE WHILE THE LOGIQ FORTIS IS POWERING UP.

The LOGIQ Fortis has four DLP probe ports (Figure 3-8). This is the only type of probe port on the
LOGIQ Fortis

Figure 3-8 Probe Connectors, Four DLP Probe Ports

To connect a probe:

It is not necessary to turn OFF power to connect or disconnect a probe. However, it is a good
idea to select a different probe or to freeze the image when removing a probe to avoid
disconnecting a live probe.

DO NOT ALLOW THE PROBE HEAD TO HANG FREELY. EXCESSIVE IMPACT TO THE PROBE
WILL RESULT IN IRREPARABLE DAMAGE.

KEEP THE PROBE CABLES AWAY FROM THE WHEELS.
DO NOT BEND THE PROBE CABLES.
DO NOT CROSS CABLES BETWEEN PROBES.

1.) Before connecting the probe:

a.) Perform a visual check of the probe and LOGIQ Fortis sockets.

b.) Remove any dust or foam rests from the probe.

c.) Verify the probe and the probe cable for any visual damage.
2.) Hold the probe connector vertically with the cable pointing upward.
3.) Turn the connector locking handle counter-clockwise to the horizontal position.
4.) Align the connector with the probe port and carefully push into place.
5.) Turn the locking handle clockwise to the full vertical position to lock in place.
6.) Position the probe cable so that it is not resting on the floor.
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3-5-6 Connecting probes (cont’d)

To disconnect a probe:

1.

2)
3)
4)

Select a different probe or freeze the image before removing a probe to avoid disconnecting a live
probe.

Rotate the lock handle counter-clockwise to the horizontal position to unlock the connector.
Remove the connector from the port.

Ensure that the probe head is clean before placing the probe in its storage case. For cleaning
instructions, see “Probe Cleaning Process” in Chapter 11 of the LOGIQ Fortis Basic User
Manual (latest revision).
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3-5-7

A DANGER

& DANGER

A DANGER

& CAUTION

A CAUTION

NOTE:

Power on/boot up

Warnings

ALWAYS CONNECT THE ULTRASOUND SYSTEM TO A FIXED POWER SOCKET
WHICH HAS THE PROTECTIVE GROUNDING CONNECTOR. FAILURE TO
FOLLOW THESE INSTRUCTION COULD LEAD TO ELECTRICAL SHOCK.

NEVER USE A THREE-TO-TWO PRONG ADAPTER; THIS DEFEATS THE
SAFETY GROUND. FAILURE TO FOLLOW THESE INSTRUCTION COULD LEAD
TO ELECTRICAL SHOCK.

ENSURE THAT THE POWER CORD AND PLUG ARE INTACT AND THAT THE
POWER PLUG IS THE PROPER HOSPITAL-GRADE TYPE (WHERE REQUIRED).
FAILURE TO FOLLOW THESE INSTRUCTION COULD LEAD TO ELECTRICAL
SHOCK.

LOGIQ FORTIS REQUIRES ALL COVERS.

ONLY OPERATE THE LOGIQ FORTIS WHEN ALL OF THE BOARD COVERS AND FRAME
PANELS ARE SECURELY IN PLACE. THE COVERS ARE REQUIRED FOR SAFE OPERATION,
GOOD PERFORMANCE AND COOLING PURPOSES.

USE ONLY POWER SUPPLY CORDS, CABLES, AND PLUGS PROVIDED BY OR DESIGNATED
BY GE.

Do not cycle the circuit breaker ON-OFF-ON in less than five seconds. When turning OFF the
circuit breaker, WAIT until the ON/OFF button is no longer lit. The LOGIQ Fortis should de-
energize completely before turning the circuit breaker ON.
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3-5-7

NOTE:

Power on/boot up (cont’d)

Connect AC (mains) power to the LOGIQ Fortis

Connecting AC power to the LOGIQ Fortis involves preliminary checks of the power cord, voltage level
and compliance with electrical safety requirements.

The LOGIQ Fortis will function on voltages from 100-240 volts and 50 or 60 Hz. However, if
using 220 volt power, then a center tapped power source is required (North America Only).

1.) Ensure that the wall outlet is of appropriate type, and that the circuit breaker is turned off.
2.) Uncaoil the power cable, allowing sufficient slack so that the LOGIQ Fortis can be moved slightly.
3.) Verify that the:

- power cable is without any visible scratches, any sign of damage or tangled.

- on-site mains voltage is within the limits indicated on the rating label near the circuit breaker
on the rear of the LOGIQ Fortis.

4.) Connect the female plug of the power cable to the power inlet at the rear of the LOGIQ Fortis.

5.) Verify that the mains power circuit breaker is in OFF position, If not, switch it to OFF.
Figure 3-9 Circuit Breaker

6.) Connect the other end (male plug) of the power cable to a hospital grade mains power outlet with
the proper rated voltage, and the LOGIQ Fortis is ready for power ON/boot up.
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3-5-7 Power on/boot up (cont’d)
Switch ON the AC power to LOGIQ Fortis

1.) Switch ON the circuit breaker at the rear of the LOGIQ Fortis. The ON/OFF button turns white.
Figure 3-10 ON/OFF Button

You should hear a click from the relays in the AC power and the LOGIQ Fortis is ready to boot. This
indicates that there is power to the PS, but the LOGIQ Fortis is OFF.

2.) Press once on the ON/OFF button on the Operator Panel to boot the LOGIQ Fortis. The ON/OFF
button turns blue when it is pressed.

During a normal boot, you may observe that:

a.) The ventilation fans start on full speed, but slow down after a few seconds (listen to the fan).
b.) Power is distributed to the peripherals, operator panel, monitor, front end and back end.
c.) Back end and rest of the LOGIQ Fortis starts with the sequence listed in the next steps:

1.) Back end is turned ON and starts to load the software.

2.) The Start screen is displayed on the monitor.

3.) A start-up bar indicating the time used for software loading, is displayed on the monitor.
4.) The software initiates and sets up the front end electronics and the rest of the instrument.
5.) The backlight in the keyboard is lit.

6.) As soon as the software has been loaded, either a B-Mode screen is displayed on the
screen, indicating that a probe has been connected, or a No Mode screen is displayed,
indicating that no probe has been connected.

NOTE: Total time used for start-up is typically less than 170 seconds.

After the B-Mode screen is displayed and any function is touched, the LOGIQ Fortis will prompt a
password protected Login.
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3-5-8

NOTE:

Default security level

The Default Security Level dialog box displays when the software is initially installed and whenever the
software is reloaded. When the ADM user logs onto the LOGIQ Fortis, the password level dialog will
display. This dialog will display every time the ADM user logs on until a level selection is made. If they
make a selection and then reload software, the level will be cleared and they will need to select the level
again.

To set the login security level:

» After boot up, log in as ADM (no password required) and, when prompted, select Lowest for the
security level.

Select the Lowest security level and then continue with installation and testing.

After installation and testing is complete, transfer the LOGIQ Fortis to the Site Administrator who can
reset the security level for the site.

The security level can be reset through Utility > Admin > Logon.

Refer to “Initial Login to the LOGIQ Fortis® in the Basic User Manual (latest revision) for more
information.

Figure 3-11 Default Security Level Dialog Box

Apply Changs
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3-5-9 Password policies

To create password policies:

1.) Navigate to Utility > Admin > Logon.
2.) Select Enable Password Policies. The LOGIQ Fortis prompts the user for a password at logon.

Figure 3-12 Policies Window

Policies

User Name Policies

Password Policies

3.) Under Password Policies, use the drop down selection beside each feature to set the rules for
passwords.
4.) Click Save.
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3-5-10

NOTE:

NOTE:

NOTE:

Users

See the Basic User Manual (appropriate version) for more information.
To add users:

1.) Navigate to Utility > Admin > Users.

2.) Select Add and enter the user details.

You will need to edit the ID field from NewUser default. Do not push “Add” again until adding
another user.

Touch Keyboard is available with User Defined Key. Please use it if you need to type any texts.

DO NOT include the following characters in a user ID: slash (/), dash (-), asterisk (*), question mark (?),
an underscore (_), ampersand (&), or blank spaces. Also, DO NOT set up Users with the same
initials/signifier.

3.) Enter password using the defined policies.

4.) If needed, select User Must Change Password. The user will be prompted to change the
password on the next logon.

5.) Under Group Membership, select the groups for the new user.

The user password is system specific. If the user needs to access multiple systems the
password will need to be entered manually on each system.

Figure 3-13 Users Window

6.) Allow the system administrator to specify whether the user account is active, blocked or requires a
password change.

7.) Allow the system administrator to remove a user by highlighting the user ID, selecting Remove to
mark the user as inactive, and then selecting Remove again to remove user from the list.
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3-5-11

NOTE:

Groups
To use groups:

You can use predefined groups or create new groups. Assign groups to a user from Users and under
Group Memberships.

1.) Navigate to Utility > Admin > Groups.
Figure 3-14 Groups Window

T

2.) To use a pre-defined group:
a.) Under Group List, select from the list of groups with pre-determined access is available to
select for each new user.

b.) To view access rights for these groups, highlight a group and then, under Group Rights, view
the access rights.

3.) To create a new group and assign access rights:

a.) Select Add.

b.) Under Name and Description, type in the name and a description.

c.) Under Group Rights, select the boxes according to the users access needs.
d.) Select Exit and then select Admin before trying to assign new groups to a user.

Admin has full system access rights.
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3-5-12

NOTE:

Lock out and log on

To set lock out and log on:

1.) Navigate to Utility > Admin > Logon.
Figure 3-15 Logon Window
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2.) Under Policies, select Enable Session Timeout.

3.) Under Password Policies, in Session Lock Screen Timeout, select the system idle time for
timeout (lock screen) in minutes. The screen will appear completely black when locked (timeout).

4.) Click Save.

5.) Press or move any button/trackball on the operator panel to display Login window.

6.) On the Login window, enter the user ID, enter the password, and then select Ok.
The user will have access according to the rights in their assigned group.

To set auto logon:

Auto LOGON only works when password policies are disabled and if there is no password assigned to
the user.

1.) Navigate to Utility > Admin > Logon.
2.) Select Auto Logon. The LOGIQ Fortis will start by using the ID of the last operator.

Auto LOGON only works when password policies are disabled and if there is no password assigned
to the user.
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3-5-13

Disk encryption

The LOGIQ Fortis supports full disk encryption. Both system partition and user partitions can be
encrypted. GE requires the SSD (System partitions) to be encrypted to protect Intellectual property and
safe system performance. The SSD (Patient archive) can be encrypted or decrypted based on user
preference. GE highly recommends to keep Encryption on/automatically unlocked at the minimum to
ensure privacy and security.

Encryption OFF (Initialize System Encryption not selected)

This is how the Disk Encryption tab appears when first opened and before any initialization has
been selected. (after a software installation).

Figure 3-16 Encryption OFF (Initialize System Encryption not selected)

Measure Report Scan Assistant Managelmaging Preset Managel DiékEriéry'pt

Initialize System Encryption

yption ¢

These are the values for the encryption fields:

- Conversion status: Fully decrypted (data drives)
- Protection status: Unprotected (data drives)

- System Drives: 0%

- Data Drives: 0%
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3-5-13 Disk encryption (cont’d)
Encryption OFF
1.) Select Initialize System Encryption.
2.) Select Choose Encryption Policy and set it to Encryption OFF. This only affects data drives.

3.) View System Drive as it continues to encrypt up to 100%.
This is how the Disk Encryption tab appears once initialization and a policy has been selected.

Figure 3-17 Disk Encryption - Encryption OFF

These are the values for the encryption fields (The % values are examples and will not always
display as shown):

- Conversion status: Fully decrypted (data drives)

- Protection status: Unprotected (data drives)

- System Drives: 19% - once initialized, the SSD drive will be encrypted.

- Data Drives: 0% - once initialized, the use data drive will be encrypted. If the encryption policy
is changed to OFF, the data drive will be unencrypted.
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3-5-13 Disk encryption (cont’d)
Encryption Suspended

NOTE: Suspend is a service only option. SSA or Class M is required. If SW reload is initiated from the
Class A/Class C CSD the suspension happens automatically but there is no way to manually
trigger it without service options/key.

1.) Once Initialize System Encryption has started, encryption can be suspended on the data drives
if needed.

2.) Select Choose Encryption Policy and set it to Encryption Suspended.

This is how the Disk Encryption tab appears once initialization has been selected and encryption
has begun, but the policy has been changed to suspend encryption.

Figure 3-18 Disk Encryption - Encryption Suspended

Audit Report

These are the values for the encryption fields (The % values are examples and will not always
display as shown):

- Conversion status: Encryption in progress (data drives)

- Protection status: Unprotected (data drives)

- System Drives: 47%

- Data Drives: 3%
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3-5-13 Disk encryption (cont’d)
Encryption ON. Disks are unlocked automatically

1.) Select Initialize System Encryption.

2.) Select Choose Encryption Policy and set it to Encryption ON. Disks are unlocked
automatically.

This is how the Disk Encryption tab appears once initialization and a policy has been selected and

encryption has been to run through completion.

Figure 3-19 Disk Encryption - Encryption ON

These are the values for the encryption fields:

- Conversion status: Fully encrypted (data drives)
- Protection status: Protected (data drives)

- System Drives: 100%

- Data Drives: 100%
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3-5-13 Disk encryption (cont’d)
Encryption Suspended after encryption

This is how the Disk Encryption tab appears once initialization and a policy has been selected and
encryption has been to run through completion, but has then been suspended.

Figure 3-20 Disk Encryption - Encryption Suspended

These are the values for the encryption fields:

Conversion status: Fully encrypted (data drives)
Protection status: Unprotected (data drives)
System Drives: 100%

- Data Drives: 100%
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3-5-14

A

NOTICE

NOTE:

Login

At login, you are notified that “You are accessing a diagnostic medical device that is provided by
authorized usage only. Data stored on this device may be subject to various regulations including but
not limited to regulations which govern disclosure and privacy of this data. By using this device you are
acknowledging that you are authorized to do so and are trained in appropriate use and regulatory
guidelines.”

The System Administrator manages system groups, users, and permissions. After you have been
added as a valid user, the System Administrator assigns you a temporary password. When you log into
the LOGIQ Fortis for the first time, you will be prompted to change your password.

Touch Keyboard pop-ups automatically when edit boxes are focused. Please use it if you need
to type any texts.

Figure 3-21 Login Window

Current User

After you have established your password, follow these steps to login.

1.) Type your user name in the Operator field.

2.) Type your password in the Password field.

3.) Press OK to login, or Cancel to cancel login.

You can change the password when first logging onto the LOGIQ Fortis.
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3-5-14 Login (cont’d)
To change your password:

1.) In Operator, enter your name.
2.) Select Change Password. The Change Password dialog box displays.

Figure 3-22 Change Password Dialog Box

Change Password

Cancel

3.) Type the following:
- Password: Type your current password.
- New Password: Type your new password.
- Confirm Password: Retype your new password.
4.) Press OK to confirm your changes, or Cancel to cancel your changes.

3-32 Section 3-5 - Completing the Setup



GE CONFIDENTIAL
Direction 5874372, Rev. 3

LOGIQ Fortis Proprietary Service Manual

3-5-15 Logoff/Power shut down

You can use the SYSTEM - EXIT menu to log off, shut down, and exit.

1.) Press once on the ON/OFF button on the operator panel to display the SYSTEM - EXIT menu.
2.) Select Logoff to logoff the system, select Shutdown to shutdown the system.

Table 3-6 SYSTEM - EXIT Menu

Corresponding Graphic

The SYSTEM - EXIT menu, used when switching OFF the LOGIQ Fortis, gives you these
choices:

Logoff:

Use this button to log off the current user.

The Ultrasound system remains ON and ready for a new user to log on.

If the Logoff button is dimmed, it indicates that no user is logged on to the LOGIQ Fortis at the
moment.

Shutdown:

Use this button to shut down the Ultrasound system. The entire system will shut down. It is
recommended to perform a full shutdown at least once a week.

If the Shutdown button is dimmed, press the ON/OFF button or Alt+F10 to shut down the
LOGIQ Fortis.

Cancel:

Use this button to exit from the SYSTEM - EXIT menu and return to the previous operation.
Exit (Only available when logged in as GE Service with an SSA key):

Select this button when you want to exit to the Windows desktop.

Change Password

Exit

S ks
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3-5-16 Complete power down

1.) Press once on the ON/OFF button on the operator panel to display the SYSTEM - EXIT menu
2.) Select Shutdown to do a complete power down of the LOGIQ Fortis.

The back end will first turn off the LOGIQ Fortis activity and print the message “Please wait -
Shutdown in progress” in the display on the operator panel.

Next, it starts to shut down. The time to turn down the LOGIQ Fortis, including the back end, may
vary from 10 seconds up to approximately 1 minute.

The last thing that shuts down, is the light on the operator panel, indicating that you can continue
with the next step.

/\ WARNING RISK OF LOSING DATA. BE SURE TO WAIT UNTIL THE LOGIQ FORTIS HAS FINISHED
ITS SHUT-DOWN. FAILING TO DO SO MAY CORRUPT DATA ON THE HDD, MAKING
THE LOGIQ FORTIS FAIL.

3.) Switch off the Mains Power Circuit Breaker, located on the rear of the LOGIQ Fortis. This will cut
power distribution within the LOGIQ Fortis.

3-34 Section 3-5 - Completing the Setup



GE CONFIDENTIAL
Direction 5874372, Rev. 3

LOGIQ Fortis Proprietary Service Manual

Section 3-6
Configuring the LOGIQ Fortis

Contents in this section

3-6-1 Purpose of this section. . . ... ... e 3-35
3-6-2 LOGIQ Fortis configuration. . . .. ... .. 3-35
3-6-3 Optional peripherals/peripheral connection . ........ ... ... ... .. .. ............ 3-36
3-6-4 Software options configuration . .. ... .. .. 3-37
3-6-5 Breast Assistant and Thyroid Assistant, Powered by KoiosDS................... 3-39
3-6-6 Imaging Insights . . . . ... 3-42
3-6-7 Device Management (Device Mgmt) . ........... .. . . i 3-44
3-6-8 GE Backoffice Connectivity ... ... ... . 3-46
3-6-9 Service settings . ... ... e 3-48
3-6-10 Magstripe card reader . ... ... ... 3-49
3-6-11  Barcode reader. . .. ... . 3-50
3-6-12  Cable hook direction. . . .. ... ... . 3-51
3-6-13  LAN Protection Cable (Option). . . ... e 3-52
3-6-14  Network printers . . .. ... 3-53

After completing configuration, the next step is to control/adjust connectivity settings starting with

Section 3-7 "Connectivity"” on page 3-54.

3-6-1 Purpose of this section

This section describes how to configure the LOGIQ Fortis.

3-6-2 LOGIQ Fortis configuration

For complete instructions, see the appropriate version of the LOGIQ Fortis Basic User Manual or LOGIQ

Fortis Release Notes.
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3-6-3 Optional peripherals/peripheral connection

Approved internal peripherals (optional)

This list covers the internal peripherals available for the LOGIQ Fortis. All of these internal peripherals
should be connected already when the LOGIQ Fortis is delivered.
» 4D Option

+  CW Option

*  Volume Navigation (V Nav) Option

» Patient /O ECG Option

» Printer (Digital Graphic) Option

» Power Assistant Option

» Scan on Battery Option

»  Pencil CW Option

+  S-Video Option

*  Wireless LAN Option

Approved external peripherals (optional)

This list covers the external peripherals available for the LOGIQ Fortis. The external printers are network
DICOM devices. The inkjet printer is USB connected.

*  Customer-supplied USB Flash Drives/Hard Drives

»  Color Inkjet Printer

+ USB Hard Disk Drives

* Report Printer

+ Footswitch

+ DICOM Printers

* Rolling Volume Navigation Stand

*  Option Tray

*  Probe Holder Option

Additional information

See Section 9-15 "Options" on page 9-25 for replacement units.
Printer checks

Check to see if the printer works as described in Table 3-7.

Table 3-7 Peripheral Checks

Step Task Note

1. |Press Freeze. Stops image acquisition.

5 |Press (Print 1), (Print 2), (Print 3) or (Print 4) |Prints image displayed on the screen on a black and white or color
" |on the control panel. printer, depending on the key assignment configuration.
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3-6-4

NOTE:

Software options configuration
Software option installation

A password (Software Option String) enables a software option or a combination of software options.
This password is specific for each LOGIQ Fortis.

Installing a software option
Before you install a software option, you must login.

After you have established your password, follow these steps to login.

1.) Type your user name in the Operator field.
2.) Type your password in the Password field.

3.) Press OK to login, or Cancel to cancel login.
Figure 3-23 Login Window

Current User

4.) From the touch panel, select Utility > Admin > System Admin.
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3-6-4 Software options configuration (cont’d)

5.) Enter the new option key code in the SW Option Key section.
Figure 3-24 System Admin Window - Add Button

6.) Select the Add button.

A CAUTION INCORRECT PASSWORD ENTRY WILL RESULT IN LOSS OF SYSTEM OPTIONS.
IF PASSWORD IS INCORRECT, PLEASE CONTACT YOUR LOCAL GE SERVICE
REPRESENTATIVE OR THE ONLINE CENTER.

7.) Import the Option String from the media.
Figure 3-25 SW Option Import

SW Option Import

Option keys file can be imported from Media (CD/DVD,
USB) or the Service Folder.

There is an Import button on the Utility > Admin >
System Admin menu.

Cancel

8.) Press Save to save the new setting.
9.) Restart to save and activate the settings and adjustments you have done so far.
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3-6-5

NOTE:

Breast Assistant and Thyroid Assistant, Powered by Koios DS

Breast Assistant, Powered by Koios DS

In LOGIQ Fortis, integration with Breast Assistant, Powered by Koios DS is available. Breast Assistant,
Powered by Koios DS is a breast lesion diagnostic assessment tool and is an option.

Some options are not available in all areas.

Breast Assistant, Powered by Koios DS is integrated with the LOGIQ Fortis through DICOM and is
configured similar to a DICOM service. The user can accept/reject analysis results. If accepted, these
results are included in DICOM Structured Reporting. These are the related HCATSs for the Breast
Assistant, Powered by Koios DS option:

H4919KO - This required HCAT allows the activation of Koios communication on a compatible
scanner (LOGIQ Fortis, for example), with this option the scanner can communicate with the Koios
Medical software/application which is installed on the network.

H4919KI - This required HCAT allows for the installation and configuration of the Koios web server
on a customer networked virtual machine. The installation is performed by Koios Medical and is
required for accessing Koios capabilities from a compatible scanner (Breast Assistant on the
LOGIQ Fortis, for example.) and/or a compatible PACS system.

In addition, one of the following is required:

H4919S0 — This optional HCAT to use Breast Assistant, Powered by Koios DS on the
LOGIQ Fortis only. This catalog item is for the initial term of a subscription to the Koios
software (breast lesion diagnostic assessment tool) which automatically renews annually.
The subscription provides access from compatible Ultrasound scanners (Breast Assistant on
LOGIQ Fortis, for example). Koios manages the activation of the subscription on the Koios
web server installed on a customer networked virtual machine.

H4919SP — This is the HCAT to use Breast Assistant, Powered by Koios DS with PACs.
This catalog item is for the initial term of a subscription to the Koios software (breast

lesion diagnostic assessment tool) which automatically renews annually. The subscription
provides access from compatible ultrasound scanners (Breast Assistant on the

LOGIQ Fortis, for example) and compatible PACS systems. Koios manages the activation of
the subscription on the Koios web server installed on a customer networked virtual machine.
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3-6-5

NOTE:

Breast Assistant and Thyroid Assistant, Powered by Koios DS (cont’d)

Thyroid Assistant, Powered by Koios DS

In LOGIQ Fortis, integration with Thyroid Assistant, Powered by Koios DS is available. Thyroid
Assistant, Powered by Koios DS is a thyroid lesion diagnostic assessment tool and is an option.

Some options are not available in all areas.

Thyroid Assistant, Powered by Koios DS is integrated with the LOGIQ Fortis through DICOM and is
configured similar to a DICOM service. The user can accept/reject analysis results. If accepted, these
results are included in DICOM Structured Reporting. These are the related HCATSs for the Thyroid
Assistant, Powered by Koios DS option:

H4920KT - This required HCAT allows the activation of Koios communication on a compatible
scanner (LOGIQ Fortis, for example), with this option the scanner can communicate with the Koios
Medical software/application which is installed on the network.

H4921KY - This required HCAT allows for the installation and configuration of the Koios web server
on a customer networked virtual machine. The installation is performed by Koios Medical and is
required for accessing Koios capabilities from a compatible scanner (Thyroid Assistant on the
LOGIQ Fortis, for example.) and/or a compatible PACS system.

In addition, one of the following is required:

H4921TL — This optional HCAT to use Thyroid Assistant, Powered by Koios DS on the
LOGIQ Fortis only. This catalog item is for the initial term of a subscription to the Koios
software (thyroid lesion diagnostic assessment tool) which automatically renews annually.
The subscription provides access from compatible Ultrasound scanners (Thyroid Assistant on
LOGIQ Fortis, for example). Koios manages the activation of the subscription on the Koios
web server installed on a customer networked virtual machine.

H4919TP — This is the HCAT to use Thyroid Assistant, Powered by Koios DS with PACs.
This catalog item is for the initial term of a subscription to the Koios software (thyroid

lesion diagnostic assessment tool) which automatically renews annually. The subscription
provides access from compatible ultrasound scanners (Thyroid Assistant on the

LOGIQ Fortis, for example) and compatible PACS systems. Koios manages the activation of
the subscription on the Koios web server installed on a customer networked virtual machine.
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3-6-5 Breast Assistant and Thyroid Assistant, Powered by Koios DS (cont’d)
Checklist for Breast Assistant and Thyroid Assistant, Powered by Koios DS

Use Table Table 3-8 to determine the steps needed to set up, test, and check the Breast Assistant and
Thyroid Assistant, Powered by Koios DS options.

For more information, refer to "Koios DS Configuration" in the Basic User Manual (appropriate version).

Table 3-8 Checklist for the Breast Assistant/Thyroid Assistant, Powered by Koios DS Option

Topic

Steps

Notification of the LOGIQ Fortis with Breast
Assistant, Powered by Koios DS or Thyroid
Assistant, Powered by Koios DS.

Confirm that the Breast Assistant, Powered by Koios DS or Thyroid Assistant,
Powered by Koios DS option is installed in the customer network.

Confirm the option is enabled on the
LOGIQ Fortis.

Navigate to Utility > Admin > System Admin and enter the option string (if not
already present) to enable the option.

Set up and test the Breast Assistant,
Powered by Koios DS or Thyroid Assistant,
Powered by Koios DS connection.

1. For a new installation contact your commercial project leader or your
Applications leader in the region to confirm that the system is ready to be set
up for Breast Assistant, Powered by Koios DS or Thyroid Assistant, Powered
by Koios DS. Do not proceed until obtaining that confirmation. If this is a set
up after reloading the software and assuming that the system was already set
up for Breast Assistant, Powered by Koios DS or Thyroid Assistant, Powered
by Koios DS, this step is not necessary.

2. Navigate to Utility > Connectivity > Koios.

3. In IP Address, enter the IP address for the Koios DS server.

4. Select Activate. You will receive notification that you have successfully

connected to the Koios DS server and the required device, service, and
printflows will be automatically created.

5. In the confirmation dialog box, select Ok.

6. Navigate to Utility > Connectivity > Device and ping the Koios DS server
to confirm that the connection was successful.

7. Navigate to Utility > Connectivity > Service and ping the
Koios_Assessment service to confirm that the service is running.

Create an image.

Confirm that the results are received. Refer to the Basic User Manual (appropriate version) for complete instructions.

Perform the functional tests for Koios.
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3-6-6 Imaging Insights
In LOGIQ Fortis, a log file for Imaging Insights has been added. Enabling Imaging Insights appends
analytics information to DICOM images and, at the end of each exam, creates a summary DICOM
object. The Imaging Insights log file uses common data format (CDF) logging and is sent to the DICOM
server and then on to the back office through an autofile transfer.
To access Imaging Insights, navigate to Utility > Connectivity > Miscellaneous.
Figure 3-26 Miscellaneous > Imaging Insights
TCPIP Davice Sarvic Button Removable Media Miscellaneous Tricafy
Print and Sto
Exit Search Cancel
This table shows all the elements available under Imaging Insights with descriptions.
Table 3-9 Imaging Insights
Element Description
Store incremental analytic data in each Determines whether analytics information is appended to individual DICOM
image images. Default value is enabled.
Determines whether consolidated analytics data [Between exam start and end
Send consolidated analytic data to server or data collected for a time period] that will get sent to the configured DICOM
server (Connectivity >Device Image Storage Server). Default value is disabled
Time duration (in hours) that elapses before the collected consolidated
Trigger interval outside an exam (hours) analytics data is sent to the selection made in Server (normally configured on
99 Connectivity > Device as the Image Storage Server). These are the valid
values available are OFF, 1,2,3,5. Default value is OFF.f
Name of the DICOM server. This server is located on premise at the hospital
and parses the DICOM tags to provide the customer with Clinical Performance
Server Management insights.
The DICOM server is configured as a device on Connectivity > Device. All of
the configured devices are available except MyComputer. Default value is “-“.
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3-6-6 Imaging Insights (cont’d)
To configure Imaging Insights:

1.) Navigate to Utility > Connectivity > Device and add a DICOM device.

2.) Navigate to Utility > Connectivity > Service and add a DICOM Storage service and Modality
Performed Step service against the added DICOM device.

3.) Save and exit the configuration.

4.) Navigate to Utility > Connectivity > Miscellaneous.
5.) Enable Imaging Insight.

6.) Enable Imaging Insight Service

7.) Trigger interval as appropriate.

8.) In Imaging Insights Server, select the device configured for DICOM image store and DICOM
Performed Procedure services.

9.) Save the configuration.
10.)Reboot the LOGIQ Fortis.
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3-6-7

NOTE:

Device Management (Device Mgmt)

Device Mgmt is a way to back up and restore presets to and from the back office. Use Device Mgmt to
do the following:

+ Send presets from the LOGIQ Fortis to the back office (using Manual Backup)

+ Send presets from the LOGIQ Fortis to the back office (using Backup Automatically)

+ Send presets from the LOGIQ Fortis to the back office (using Upload For Fleet)

» Restore presets from the back office to the LOGIQ Fortis (using Download from the tool bar)

These timeout fields (editable when Device Mgmt is active) were added:
- Upload/Download Timeout (sec)
- Query Timeout (sec) - This is a query for Device management updates.

The support email has been updated to: dc.support@ge.com.

For more information, refer to the Basic User Manual (appropriate version).

To access Device Connect, navigate to Utility > Connectivity > Device Mgmt.

Figure 3-27 Device Management (Device Mgmt)
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3-6-7 Device Management (Device Mgmt) (cont’d)

This table shows all the elements available on Device Mgmt with descriptions.

Table 3-10 Device Management

Element Description

Indicates whether Device Management is active or not. Valid values are
Inactive or Active.

Status NOTE: This field will be Inactive only the right after the Activate was failed.
Otherwise the field will be empty. if you never activated or activated and then
deactivated, this field will be empty.

Account Email Email address for the Device Management account.

Registration key for the Device Management account. Product specific key

Registration Key strings, pre-populated by the device (can be overwritten if necessary).

URL of registration server strings, pre-populated by the device (can be

Server URL ) .
overwritten if necessary).

Name of the proxy server IP provided by the customer. This field is optional

Proxy Server unless required by the customer facility infrastructure.

Number of the proxy server port provided by the customer. This field is optional

Proxy Port unless required by the customer facility infrastructure.

Name of the proxy user provided by the customer. This field is optional unless

Proxy User Name required by the customer facility infrastructure.

Password for the proxy user name provided by the customer. This field is

Proxy Password optional unless required by the customer facility infrastructure.

Runs for the set number of seconds when the upload, (Auto Backup, Manual
Backup, and Upload for Fleet) or download (Install) operation begins. When the
timeout occurs, an error displays indicating you should attempt the operation
again.

Upload/Download Timeout (sec)

For Device Management updates, runs for the set number of seconds when the
New Patient and End Current Patient, logging off, logging on, or unlocking the
lock screen operations begin. When the timeout occurs, an error displays
indicating you should attempt the operation again.

Query Timeout (sec)

Verify Select to verify a connection with the service.
Activate/Deactivate Select to activate/deactivate Device Management.
Update Connection Configuration Select to update changes made on the Device Mgmt page.

Select to download the certificate for Device Management from the backoffice

Device Management Service Certificate
server.

Chapter 3 LOGIQ Fortis Setup 3-45



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

3-6-8

NOTE:

GE Backoffice Connectivity

A connection between the LOGIQ Fortis to the GE back office (InSite RSVP) allows for a direct link with
GE Service (either through a GE Online Service Engineer or Applications Support Engineer).

A connection to the back office is only reversible by reloading the base image full load software.

To disable GE back office (InSite RSVP)

When the customer does not want to connect to the GE back office (InSite RSVP), use Disable Remote
Connectivity to uninstall remote connectivity items like Agent Configuration, SSH and Virtual
Console Observation (VCO) from the Service desktop.

To access Disable Remote Connectivity, select Utility (second page) > Service > Utilities > Disable
Remote Connectivity. For more information, refer to Disable Remote Connectivity in "Utilities" on page
7-52.

If the InSite agent is disabled, these are some additional results:

* Remote Connectivity is no longer available.
* Remote service can no longer connect to the LOGIQ Fortis to diagnose system issues.

+ The customer will not be able to initiate a Request for Service or Clinical Support Request using the
GE InSite icon located at the bottom of the monitor display.

To connect to the GE back office (InSite RSVP)
When the customer wants to connect to the GE back office (InSite RSVP), use Agent Configuration.

To access Agent Configuration, navigate to Utility (second page) > Service > Agent Configuration.
For more information, refer to "Agent Configuration" on page 7-82.
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3-6-8

NOTE:

GE Backoffice Connectivity (cont’d)
GE back office (InSite) wizard

In LOGIQ Fortis, there is a GE Backoffice Connectivity Troubleshooting wizard that can be used to set
up a connection to the InSite back office.

You can perform all required functions from this tool. For example, you have to start the agent
from Agent Configuration.

For more information, see the latest revision of the LOGIQ Fortis Basic User Manual.

Figure 3-28 GE Backoffice Connectivity Troubleshooting

/& GE Backoffice Connectivity Troubleshooting

" Agent Configuration

Ensure the CRM Number displayed is cormect. Ifnot, update with the correct CRM and save changes. If the Serial and CRM Numbers are
correct, proceed to next step,
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3-6-9 Service settings
When the InSite agent is activated, you can edit some service settings (shown in Figure 3-29 and
Table 3-11).
NOTE: Ifthe InSite agent is disabled, the Service section will be removed from the System Admin page.

To access Service settings, navigate to Utility > System Admin.

Figure 3-29 System Admin > Service

Service

Enable Automatic Request for Service
Transfer Machine Logs to GE

Transfer Operator Information to GE

Enable Automatic Probe Diagnostics

Transfer Images (captured without patient information) to GE
Include Annotations with Image Transfer to GE

This table shows all the elements available under Service with descriptions.

Table 3-11  Service Settings

Element

Description

Enable Automatic Request for Service

Allows system-generated requests for service to be sent without user
intervention.

Transfer Machine Logs to GE

Allows transfer of monitoring errors and status log files to the GE back office for
data analytics.

Transfer Operator Information to GE

When Transfer Machine Logs to GE is enabled, allows the transfer of
operator information to the GE back office for usage analytics.

Enable Automatic Probe Diagnostics

When Transfer Machine Logs to GE is enabled, allows the VITA Tool to
gather information about probes used and put that information into a VITA
dump file. Once enabled, the VITA routine will run once at system startup to
generate this dump file. The VITA dump file is then transferred to the data lake
like the other log files.

Transfer Images (captured without patient
information) to GE

When Transfer Machine Logs to GE is enabled, allows the transfer of images
for analysis.

Include Annotations with Image Transfer to
GE

Allows transfer of operator information to the GE back office for usage analytics.
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3-6-10 Magstripe card reader
The Magstripe card reader can be used to populate the following:

+ Patient screen: Patient ID, First Name, Last Name, Middle Name, Perf. Physician, Ref. Physician.
»  Worklist: Patient ID, Search String.
* Image Display: Comments (Annotation)

To connect the card reader:

1.) Connect the card reader to any USB port. For example, on the user USB ports on the left side of
the upper operator panel Boot up the Ultrasound system.

2.) Scan the card that comes with the card reader to activate device.

NOTE: Consult the card reader manufacturer’s instructions. This configuration process will vary based
on the card reader model/manufacturer and the keyboard language set on the Ultrasound
system.

Once the configuration process is complete, the card reader is ready to use to start a new patient.

You do not need to repeat this process if software is reloaded, this card reader can be used on any
scanner as long as they have the same keyboard language selection.
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3-6-11 Barcode reader

The barcode reader can be used to populate the following:

+ Patient screen: Patient ID, First Name, Last Name, Middle Name, Perf. Physician, Ref. Physician.
*  Worklist: Patient ID, Search String.

* Image Display: Comments (Annotation)

To connect the barcode reader:

1.) Connect the barcode reader to any USB port. For example, on the user USB ports on the left side
of the upper operator panel (shown below).

2.) Boot up the Ultrasound system.
3.) Scan the bar code that comes with the barcode reader to activate device.

NOTE: Consult the barcode reader manufacturer’s instructions. This configuration process will vary
based on the barcode reader model/manufacturer and the keyboard language set on the
Ultrasound system.

Once the configuration process is complete, the barcode reader is ready to use to start a new
patient.

You do not need to repeat this process if software is reloaded, this barcode reader can be used on
any scanner as long as they have the same keyboard language selection.
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3-6-12

Cable hook direction
Cable hook direction can be changed depending on Customer preference.
With keyboard option,

Loosen
screw

Remove screw and change :
direction of cable hook.
Tighten screws to fix.

Default

Without keyboard option,

Loosen
screw

Remove screw and change
direction of cable hook.
Tighten screws to fix.
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3-6-13 LAN Protection Cable (Option)
NOTE: To prevent claw breakage of LAN cable, use LAN protection cable as below.

If LAN cable is pulled away from the console, the connection will be unplugged first preventing damage
to the LAN connector in the unit.

- L'é'--.'?l a4 r N 2 .}I.' .-‘:‘I..I"u o

Figure 3-30 LAN protection cable

Figure 3-31 LAN cable with protection cable (example)
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3-6-14

NOTE:

Network printers

In R3.x.x, you can add a network printer when logged on to the system as an administrator.

It is solely the customer’s responsibility to determine printer and network settings and
configuration to enable and ensure the specific network printer usage and functionality.

To add a network printer, navigate to Utility > System > Peripherals, and then under Network Printer,
select Add Network Printer.

Refer to “Network Printer” in the Basic User Manual (appropriate version) for more information. See
Section 1-4 "Labels/Icons on the system" on page 1-14 for a list of the available user documentation.

Technical details:

» The only supported driver for the network printer is Microsoft Enhanced Point and Print
Compeatibility driver.

+ Adding a network printer requires the user is logged in with Admin group rights.

* You cannot use the same IP address for two printer names.

+ Adding a network printer logs an event to both the main log and the audit log.
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Section 3-7
Connectivity

NOTE:

3-7-1

If you are new or unfamiliar to connectivity on the LOGIQ Fortis, see “Customizing Your System” in
Chapter 10 of the LOGIQ Fortis Basic User Manual (latest revision) before you continue with the next
descriptions and procedures.

Physical connection

Stand-alone LOGIQ Fortis

No network connection needed.

Sneaker Net environment

No network connection needed.

Wired Ethernet from LOGIQ Fortis to a workstation

For a direct cable connection from the LOGIQ Fortis to a workstation, you will only need a crossover
cable for network use to connect the two units this way.

1.) Connect one end of the crossed network cable to the network connector on the LOGIQ Fortis.

2.) Connect the other end to the network connector to the workstation, see the Workstation Service
Manual.

Connection through a peer-to-peer network
You will need a network switch and one network cable for each unit connected to the switch.
Connection through the hospital network

You will need one network cable to connect the LOGIQ Fortis to a wall outlet on the hospital’s network.
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Section 3-8
Setting Up Paperwork

NOTE:

3-8-1

3-8-2

NOTE:

During and after setup, the documentation (for example, removable medias with

documentation, user manuals, and installation manuals) for the peripheral units must be kept

as part of the original system documentation. This will ensure that all relevant safety and user
information is available during the operation and service of the complete system.

User manual(s)

Check that the correct user manual (or removable media with user manuals) for the software revision
and language of the LOGIQ Fortis is included.

Product locator card/UDI
The product locator card shown may not be the same as the provided product locator card.

The UDI of the medical device must be captured when any work is performed on that device. Refer to
your local procedures on the actual capturing of the UDI.

Figure 3-32 Product Locator Card (Example)

GIB, European Central Admin Product Locator Card
GEHC - Americas Product Locator Cards Asia Service Operation
Mailing Product Locator - W523 XEROX Office N No. 1, Yongchang North Road
Address  P.O. Box 414 VAKUUMTECHNOLOGIAI GEPGYAR Beijing Economic and
Milwaukee, Wl 53201-0414 FOTIUT 141 Technologic Development Area
1046 Budapest Hungary Beijing 100176 China
DESCRIPTION FDA  MODEL REV/ SERIAL
ocP BS ORD
DISTRICT CUSTOMER NO. DATE (MO - DA - YR)
DESTINATION
NAME AND

SHIPMENT

ZIP CODE

46-303268P1 Rev 14

GIB, European Central Admin Product Locator Card
GEHC - Americas Product Locator Cards Asia Service Operation
Maiing  Product Locator - W523 XEROXOffice o No. 1, Yongchang North Road
Address P.O. Box 414 V/}KUEJMTECHNDLOGIAI GEPGYAR Beijing Economic and
= Milwaukee, W1 53201-0414 FOTIUT 141 Technologic Development Area
1046 Budapest Hungary Beijing 100176 China
DESCRIPTION FDA  MODEL REV SERIAL
SYSTEMLTD. ocP BS ORD EMPLOYEE NO.
DISTRICT ROOM DATE (MO-DA-YR)
CUSTOMERNO

INSTALLATION &

2IP CODE

46-303268P1 Rev 14
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Chapter 4
Functional Checks

Section 4-1
Overview

4-1-1 Purpose of this chapter

This chapter provides procedures for quickly checking major functions of the LOGIQ Fortis Ultrasound
system and diagnostic instructions using the built-in service software.

NOTE: The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

4-1-2 Contents in this chapter
4-1 OV BIVIBW. . . o 4-1
4-2 General Procedures . . .. ... e 4-3
4-3 Functional Checks . .. ... . . e 4-11
4-4 SIte LOg - 4-32
4-1-3 Special equipment required

This is the special equipment you may need to complete functional checks:

*  An empty (blank) DVD-R disk.

» At least one probe (ideally you should check all of the site probes that will be used with the
Ultrasound system.) For available probes, see Section 9-14 "Probes" on page 9-20.

+ Ifthe ECG option is present, ECG cables (AHA or IEC) and pads. For part numbers, see Section 9-
15 "Options" on page 9-25.

» Test phantom. See 4-1-4 "Recommended test phantoms” on page 4-2.
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4-1-4 Recommended test phantoms

GE recommends the RMI 430GS phantom is preferred, but it is not required. It is the most current
phantom recommended to our field service personnel and provides the necessary targets and extended
life necessary for consistent Ultrasound system testing.

Figure 4-1 Performance Tests
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Section 4-2
General Procedures

Contents in this section

4-2-1 General safety information . . . ... . 4-4
4-2-2 General system functional checks ... ........ . . .. ... . .. 4-5
4-2-3 Power ON/BOOt Up . . . ..o e 4-7
4-2-4 Power shut down . .. ... 4-10
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4-2-1

General safety information

Table 4-1 Energy Control and Power Lockout for LOGIQ Fortis

Preparations - you must perform the following steps

& DANGER

LOCKOUT

Risk of dangerous voltage within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
¢ Plan and prepare for shutdown.

e Completely power down the LOGIQ Fortis.

¢ Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
e Apply lockout/tagout devices to maintain exclusive control of the power cable.
¢ Relieve all potentially hazardous stored or residual energy (batteries).

e Verify isolation.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.

e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.

¢ "Disconnect battery power" on page 1-28.

La

/\ DANGER Risk of electrical shock, system must be turned off.
Avoid all contact with electrical contacts, conductors and components. Always use non-conductive han-
dles designed for the removal and replacement of ESD sensitive parts. All parts that have the potential for
é storing energy must be discharged or isolated before making contact.
& CAUTION |THE ULTRASOUND SYSTEM REQUIRES ALL COVERS.
Operate the LOGIQ Fortis only when all board covers and frame panels are securely in place. The
covers are required for safe operation, good system performance and cooling purposes.
cAuUTION |Risk of damage to equipment.
A DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE NECESSARY ESD PRE-

CAUTIONS:

1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED TO ONE OF THE TWO
RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY FOR THAT PURPOSE.

2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE EQUIPMENT.

Section 4-2 - General Procedures



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

4-2-2

NOTE:
NOTE:

General system functional checks

After setting up the Ultrasound system, performing an upgrade, or replacing hardware, perform all
appropriate functional checks before returning a system to the customer. Include the functional check
information in the service dispatch.

For a service call with FRU replacement:

» Perform the functional checks and include the debrief script found at the end of the respective
replacement procedure in Chapter 8.

For a service call with no FRU replacement or when installing the LOGIQ Fortis:
+ Perform the following general functional tests. If all are successful, include the debrief script
provided below.

Some procedures are used more often than others. The intention with this section is to keep the most
used procedures in one place.

In case of replacing hardware, refer to related section in Chapter 8.

NOT ALL functional checks will have to be repeated or performed if not all options are present.
If ONLY a particular option is present, perform the functional checks for that particular option
and the options installed.

Table 4-2 General System Functional Checks

See
Section Functional Check Debrief Script

4-2-3  |Power ON/Boot Up

4-3-8 B-Mode functional checks

4-3-10 |System CFM and PWD functional checks

4-3-20 |Basic measurement functional checks

10-6-7  |Grounding continuity

10-6-8 |Chassis leakage current test

Power shut down
4-2-4  |DO NOT POWER SHUT DOWN until ALL
functional checks have been performed

Leakage Current measured at (record the value) and meets

In addition: Perform the following functional checks if the |allowable limits. Equipment passed all required checks and is
option was or options were removed during backplane ready for use.
replacement.

4D

4-3-23 |4D option functional checks
Perform a 4D sweep

Pedof CW

4-3-14 |PW/CW Doppler mode functional checks
use pencil probes

GCw

4-3-15 |CW Doppler mode functional checks
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Table 4-2 General System Functional Checks (Continued)
See
Section Functional Check Debrief Script
VSIO (ECG)
ECG Checks
Active ECG:
Utility > Applications > Settings > ECG >
Show ECG Tools.
4-3-22 | Connect cables. Press Display ECG Tab on
TP. Verify ECG signal displayed on monitor.
Plug in the ECG cables with nothing attached | Leakage Current measured at (record the value) and meets
so they pick up noise. allowable limits. Equipment passed all required checks and is
Diagnostics ready for use.
Power Assistant/
4-3-25 |Power Assistant functional checks
V Nav
4-3-24 |Volume Navigation with inside probe functional

checks
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4-2-3

A DANGER

& DANGER

A DANGER

& CAUTION

& CAUTION

NOTE:

Power ON/Boot Up

Warnings

ALWAYS CONNECT THE LOGIQ FORTIS TO A FIXED POWER SOCKET WHICH
HAS THE PROTECTIVE GROUNDING CONNECTOR.

NEVER USE A THREE-TO-TWO PRONG ADAPTER; THIS DEFEATS THE
SAFETY GROUND.

ENSURE THAT THE POWER CORD AND PLUG ARE INTACT AND THAT THE
POWER PLUG IS THE PROPER HOSPITAL-GRADE TYPE (WHERE REQUIRED).

LOGIQ FORTIS REQUIRES ALL COVERS.

ONLY OPERATE THE LOGIQ FORTIS WHEN ALL OF THE BOARD COVERS AND FRAME
PANELS ARE SECURELY IN PLACE. THE COVERS ARE REQUIRED FOR SAFE OPERATION,
GOOD PERFORMANCE, AND COOLING PURPOSES.

Use only power supply cords, cables, and plugs provided by or designated by GE.

Do not cycle the circuit breaker ON-OFF-ON in less than five seconds. When turning OFF the
circuit breaker, WAIT until the ON/OFF button is no longer lit. The LOGIQ Fortis should de-
energize completely before turning the circuit breaker ON.
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4-2-3

NOTE:

Power ON/Boot Up (cont’d)

Connect AC (mains) power to the LOGIQ Fortis

Connecting AC power to the LOGIQ Fortis involves preliminary checks of the power cord, voltage level,
and compliance with electrical safety requirements.

The LOGIQ Fortis will function on voltages from 100-240 volts and 50 or 60 Hz. However, if
using 220 volt power, then a center tapped power source is required (North America Only).

1.) Ensure that the wall outlet is of appropriate type, and that the circuit breaker is turned off.
2.) Uncaoil the power cable, allowing sufficient slack so that the LOGIQ Fortis can be moved slightly.
3.) Verify that the:

- power cable is without any visible scratches, any sign of damage or tangled.

- on-site mains voltage is within the limits indicated on the rating label near the circuit breaker
on the rear of the LOGIQ Fortis.

4.) Connect the female plug of the power cable to the power inlet at the rear of the LOGIQ Fortis.

5.) Verify that the mains power circuit breaker is in OFF position, If not, switch it to OFF.
Figure 4-2 Circuit Breaker

6.) Connect the other end (male plug) of the power cable to a hospital grade mains power outlet with
the proper rated voltage, and the LOGIQ Fortis is ready for power ON/boot up.
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4-2-3 Power ON/Boot Up (cont’d)
Switch ON the AC power to LOGIQ Fortis

1.) Switch ON the circuit breaker at the rear of the LOGIQ Fortis. The ON/OFF button turns white.
Figure 4-3 ON/OFF Button

You should hear a click from the relays in the AC power and the LOGIQ Fortis is ready to boot. This
indicates that there is power to the PS, but the LOGIQ Fortis is OFF.

2.) Press once on the ON/OFF button on the Operator Panel to boot the LOGIQ Fortis. The ON/OFF
button turns blue when it is pressed.
During a normal boot, you may observe that:

a.) The ventilation fans start on full speed, but slow down after a few seconds (listen to the fan).
b.) Power is distributed to the peripherals, operator panel, monitor, front end and back end.
c.) Back end and rest of the LOGIQ Fortis starts with the sequence listed in the next steps:

1.) Back end is turned ON and starts to load the software.

2.) The Start screen is displayed on the monitor.

3.) A start-up bar indicating the time used for software loading, is displayed on the monitor.
4.) The software initiates and sets up the front end electronics and the rest of the instrument.

5.) The backlight in the keyboard is lit.

6.) As soon as the software has been loaded, either a B-Mode screen is displayed on the
screen, indicating that a probe has been connected, or a No Mode screen is displayed,
indicating that no probe has been connected.

NOTE: Total time used for start-up is typically less than 170 seconds.

After the B-Mode screen is displayed and any function is touched, the LOGIQ Fortis will prompt a
password protected Login.
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4-2-4 Power shut down

When you switch OFF the LOGIQ Fortis, the Ultrasound system performs an automatic shutdown
sequence.

1.) Press once on the ON/OFF button on the operator panel to display the SYSTEM - EXIT menu.
2.) Select Shutdown to shutdown the system..

Table 4-3 SYSTEM - EXIT Menu

Corresponding Graphic

The SYSTEM - EXIT menu, used when switching OFF the LOGIQ Fortis, gives you these
choices:

Logoff:

Use this button to log off the current user.

The Ultrasound system remains ON and ready for a new user to log on.

If the Logoff button is dimmed, it indicates that no user is logged on to the LOGIQ Fortis at the
moment.

Shutdown:

Use this button to shut down the Ultrasound system. The entire system will shut down. It is
recommended to perform a full shutdown at least once a week.

If the Shutdown button is dimmed, press the ON/OFF button or Alt+F10 to shut down the
LOGIQ Fortis.

Cancel:

Use this button to exit from the SYSTEM - EXIT menu and return to the previous operation.

Exit (Only available when logged in as GE Service with an SSA key): —

Select this button when you want to exit to the Windows desktop.
S ks

Change Password

4-2-5 Complete power down

1.) Press once on the ON/OFF button on the operator panel to display the SYSTEM - EXIT menu
2.) Select Shutdown to do a complete power down of the LOGIQ Fortis.
The back end will first turn off the LOGIQ Fortis activity and print the message “Please wait -
Shutdown in progress” in the display on the operator panel.

Next, it starts to shut down. The time to turn down the LOGIQ Fortis, including the back end, may
vary from 10 seconds up to approximately 1 minute.

The last thing that shuts down, is the light on the operator panel, indicating that you can continue
with the next step.

& NOTICE Risk of losing data. Be sure to wait with the next step until the LOGIQ Fortis has finished its shut-down.
Failing to do so may destroy data on the hard disk drive, making the LOGIQ Fortis fail later.

3.) Switch off the Mains Power Circuit Breaker, located on the rear of the LOGIQ Fortis. This will cut
power distribution within the LOGIQ Fortis.
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4-3-1 Top console adjustment control functional checks

& CAUTION To avoid injury or damage, make sure nothing is within the range of motion before moving the

top console. This includes both objects and people.

Table 4-4 Top Console Adjustment Controls

Step

Corresponding Graphic

& CAUTION

console. This includes both objects and people.

To avoid injury or damage, make sure nothing is within the range of motion before moving the top

To SWIVEL the top console:
Press and hold down the SWIVEL button to move the console left or
right.

Release the button.

To RAISE/LOWER the top console:
Press and hold the Up/Down button accordingly to raise or lower the
top console.

Release the button when the top console is at the desired height.
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4-3-2 Main monitor positions and lock functional checks

To perform the function checks for the main monitor:

*  When the monitor arm lock is unlocked, verify the monitor can move up/down (vertically) and left/
right (horizontally).

NOTE: The monitor can move approximately 150 mm (5.91 inches) vertically and
350 mm (13.78 inches) horizontally from center.

Figure 4-4 Main Monitor Positions - Ergotron Arm

Tilt
a. No Collision
1. | Vertical Travel = 150mm 4. |p. Approximately 20°
(based on Pan Arm Off-set)
c. 85°-90°

5 Monitor Translation = 350mm

2. i = 9n° o
Rotation at Mount = 90° (180° total) (both sides from center)

3. |Lift Arm Rotation = 135° (270° total) 6. |Pan Arm Rotation = 45° (90° total)
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4-3-2  Main monitor positions and lock functional checks (cont’d)

To check main monitor platform maneuverability:

Check that the main monitor functions as described below.

Table 4-5 Main Monitor Platform Maneuverability Checks

Step Task Note(s)

Use both hands, one at the top of the main monitor and one at the bottom, to rotate

1. Tilt the main monitor forward/back the screen forward and back.

Use both hands, one at the lower left handle hold of the main monitor and one at the

2 Move the main monitor leftright lower right handle hold, to adjust the screen left and right.

To unlock the main monitor:

*  Turn the knob clockwise to unlock the main monitor. The main monitor can be moved freely in all
directions.

To lock the main monitor:

»  Turn the knob counter clockwise to lock the main monitor in the parked position.
To set the main monitor position for transport:

* Lock the arm and tilt the main monitor down.
Figure 4-5 Main Monitor Transport Position
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4-3-3 Brakes and direction lock functional checks

Examine the wheels frequently for any obvious defects that could cause them to break or bind.

Each wheel has an independent brake pedal. A left rear wheel also has a swivel lock.

Figure 4-6 Wheel lock and Swivel lock

1.) Brake pedal
2.) Swivel lock

4-3-3-1 Brake pedal

Figure 4-7 Front and right-rear caster

1.) Step on Lower side pedal to activate Brake
2.) Step on Upper side pedal to release Brake
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Figure 4-8 Left-rear caster

1.) Step on to activate Brake
2.) Raise up to release Brake

4-3-3-2 Swivel lock

Figure 4-9 Rear-left with Swivel lock

1.) Step on Lower side pedal to activate Swivel Lock with clicking sound
2.) Step on Lower side pedal to De-activate Swivel Lock

NOTE: Wheel needs to be straight when you activate Swivel Lock.

Figure 4-10 Caster position for Swivel lock
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4-3-4

4-3-5

Alphanumeric keyboard functional checks

To perform the function checks for the alphanumeric keyboard:

1.) Press Comment on the operator control panel to activate Comment.
2.) Type any comments using alphanumeric keys to confirm keyboard functionality.

Footswitch functional checks

1.) Plug in the footswitch.

2.) Select Utility > Application. Under Footswitch, you should see the footswitch programming
options for Left, Middle, and Right.

3.) Program the left, middle, and right footswitch pedals for Freeze.
4.) Scan and use each footswitch pedal to freeze and unfreeze to confirm each one works.

Figure 4-11 Footswitch Functional Checks

Template Pharmacological 4x4

ECG
ShowECGTab B
ECGlead 2 »

ELASTO
Show Quality Bar @
Show Quality Graph (restart needed) Off
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4-3-6

O hrWN =

Probe Holder and Cable Management 7.

Touch Panel and Joystick controls 8. Steer/Width/Depth/Reverse
On Screen Keyboard (not display in this graphic) 9

User Defined Keys. 1

Mode/Gain/XYZ (3D) Controls

Trackball, Trackball Keys, Pointer, Measure, Comment, Body Pattern, Clear, Zoom,

Basic control functional checks

Different functions can be assigned to the basic controls depending on the current active mode. The
trackball area consist of the following:

Controls are grouped together by function for ease of use.

L/R, Start/Stop, P1, Simultaneous

. Auto, CF/PW Auto Positioning
0. Freeze, P2

Programmable Keys
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4-3-7 Probe/connector functional checks
NOTE: Probes can be connected at any time, whether the LOGIQ Fortis is ON or OFF.
For information about connecting a probe, see 3-5-6 "Connecting probes" on page 3-16.
To perform the function checks for a probe/connector:
Table 4-6 Probe and Connector Functional Checks
Step Task Expected Result(s)
1. i i - i
Select the appropriate connected probe from the probe indicators on The plrobe actlvates_, in the currently-selected operating mode. The
probe's default settings for the mode and selected exam are used
the Touch Panel. -
automatically.
2. Launch the application.
To change application without changing the current probe, press THE | The selected application starts.
DESIRED MODE on the Operator Panel.
3. Verify no missing channels. All channels is functioning.
4. Verify there is no EMI/RFI or artifacts specific to the probe. No EMI/RFI or artifacts.
5. Test the probe in each active connector slot. It will displav pictorial data each time
See Section 3-5-6 "Connecting probes" on page 3-16. play p '
6. Repeat this procedure for all available probes.

Probes requiring a leakage test

If the probe requires a leakage test, see Section 10-6 "Electrical Safety Tests" on page 10-20.
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4-3-8

B-Mode functional checks
B-Mode is the Ultrasound system’s default mode.

For information on the Ultrasound system’s different modes as well as expected results, see Chapter 5
of the LOGIQ Fortis Basic User Manual (latest revision), or the appropriate LOGIQ Fortis Release
Notes. See 1-4-1 "Label Location" on page 1-14.

Figure 4-13 B-Mode Screen Example

Depending on probe availability, choose the preset application shown below. The LOGIQ Fortis probes
are ONLY approved for use in the applications listed in Chapter 11 of the LOGIQ Fortis Basic User
Manual (latest revision), or the appropriate LOGIQ Fortis Release Notes.

IQC preset for Service is available

Image Quality Check (IQC) is intended to facilitate image quality checks during quality assurance
evaluations. Quality assurance tests are used to determine whether a scanner is providing the same
level of performance year after year.

By using the same settings year after year, this ensures that the data collection is consistent
independently of who performs the test.

This preset only includes fundamental settings for B-Mode.
Processing modes like SRI, Harmonics, etc., are turned off.
To do an Image Quality Check (IQC):

1.) Navigate to Utility > Imaging Preset Manager.

2.) Select the probe.

3.) Under Imaging Preset Selections, select Category.

4.) Expand the plus sign in front of IQC for Service.

5.) Select IQC and then the right arrow to assign it to a touch panel key.
6.) Map the IQC to the location you want it to appear on the touch panel.
7.) Select Probe > 1QC.

Section 4-3 - Functional Checks



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

4-3-8 B-Mode functional checks (cont’d)

Probe indications for use

See the online Help or Chapter 11 of the appropriate version of the LOGIQ Fortis Basic User Manual.
See 1-4-1 "Label Location" on page 1-14.

Preparations
You may use a phantom (optional) when doing these tests.

1.) Connect one of the probes, to the scanner’s active probe connector.
- See Section 3-5-6 "Connecting probes" on page 3-16 for info about connecting the probes.
- For available probes, see Section 9-14 "Probes" on page 9-20.

2.) Turn ON the scanner. The B-Mode window is displayed (default mode).

3.) If needed, adjust the Brightness and Contrast setting on the monitor (see Section 6-2 "Monitor
Adjustments" on page 6-2).

/\\ WARNING ALWAYS USE THE MINIMUM POWER REQUIRED TO OBTAIN ACCEPTABLE IMAGES
IN ACCORDANCE WITH APPLICABLE GUIDELINES AND POLICIES.

4.) Press B-MODE on the Operator Panel to access B-Mode.

5.) These Image Controls are used to optimize the B-Mode picture:
- Use Gain and TGC controls to optimize the overall image together with the Power control.
- Use Depth to adjust the range to be imaged.

- Use Frequency (move to higher frequencies) or Frame rate (move to lower frame rate) to
increase resolution in image.

- Use Frequency (move to lower frequency) to increase penetration.

- Use the control to optimize imaging in the blood flow regions and make a cleaner, less noisy
image.

- Use Reject controls to reduce noise in the image.
Checks

» Check Width, Frame rate, Frequency. The results of these adjustments must be verified on the
B-Mode sector on the screen.

»  Check Up/Down, Left/Right, B Color Maps and Cineloop. The results of these adjustments must be
verified on the B-Mode sector on the screen.

*  Check Gain, TGC and Depth.

»  Check B-Mode Soft Menu Controls.

*  Check Compress, Contour, Reject and Tilt.
» Check Power and Dynamic Range.
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4-3-9 M-Mode functional checks

For information on the Ultrasound system’s different modes as well as expected results, see the
LOGIQ Fortis Basic User Manual. It will familiarize you with image optimization for B-Mode, M-Mode,
Color Flow, and Doppler.

Table 4-7 B/M-Mode Functions

Control Description

Optimizes image quality and allows user to reduce beam intensity. 10% increments between

Power Output (Acoustic Power) 0-100%. Values greater than 0.1 are displayed.

Controls how echo intensities are converted to shades of gray, thereby increasing the

Dynamic Range adjustable range of contrast.

Selects a level below which echoes will not be amplified (an echo must have a certain

Rejection minimum amplitude before it will be processed).

Temporal filter that averages frames together. This has the effect of presenting a smoother,
Frame Average

softer image.
Colorize Enables gray scale image colorization. To deactivate, reselect a Gray Map.
Gray Map Determines how the echo intensity levels received are presented as shades of gray.
Rotation (Up/Down) Rotates the image by selecting the value from the pop up menu.
Frequency L\rll:(l:lijzr:i?fency mode lets you downshift to probe's next lower frequency or shift up to a higher
Frame Rate/Resolution Optimizes B-Mode frame rate or spatial resolution for the best possible image.
Sweep Speed Changes the speed at which the timeline is swept.

Preparations
You may use a phantom (optional) when doing these tests.

1.) Connect one of the probes, to the scanner’s active probe connector.
- See Section 3-5-6 "Connecting probes" on page 3-16 for info about connecting the probes.

- For available probes, see the online Help or the appropriate version of the LOGIQ Fortis Basic
User Manual. See 71-4-1 "Label Location" on page 1-14.

2.) Turn ON the scanner.
Checks

»  Check Horizontal Sweep, Frequency, and Focus.
» Check Compress, Reject, Power and Dynamic Range.
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4-3-10

4-3-11

4-3-12

4-3-13

System CFM and PWD functional checks

For information on the Ultrasound system’s different modes as well as expected results, the Basic User
Manual will familiarize you with image optimization for B-Mode, M-Mode, Color Flow, and Doppler.

For complete information, see the appropriate version of the LOGIQ Fortis Basic User Manual,
Chapter 5, or the appropriate LOGIQ Fortis Release Notes. See 1-2-5 "Product description” on page 1-
10.

Preparations
You may use a phantom (optional) when doing these tests.
1.) Connect one of the probes, to the scanner’s active probe connector.

2.) Turn ON the scanner.

Color Mode functional checks

Color Flow screens are B- or M-Mode screens with colors representing blood or tissue movement. Color
Flow may be selected both from B-Mode, or from M-Mode, or a combination of these screens.

For more information, see the appropriate version of the LOGIQ Fortis Basic User Manual, Chapter 5,
or the appropriate LOGIQ Fortis Release Notes.

Color B-Mode functional checks

For information, see the appropriate version of the LOGIQ Fortis Basic User Manual, Chapter 5, or the
appropriate LOGIQ Fortis Release Notes.

Color M-Mode functional checks

For information, see the appropriate version of the LOGIQ Fortis Basic User Manual, Chapter 5, or the
appropriate LOGIQ Fortis Release Notes.

* Check Horizontal Sweep, PRF, Baseline, and Invert.

»  Check Variance, Color Maps, and Cineloop.

»  Check Frequency and Acoustic Power.

* Adjust ROL.
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4-3-14

PW/CW Doppler mode functional checks

For information on the Ultrasound system’s different modes, the Basic User Manual will familiarize you
with image optimization for B-Mode, M-Mode, Color Flow, and Doppler.

Doppler is used to measure velocity (most often in blood). Doppler mode can be done with a special
pencil probe or with an ordinary probe. By using an ordinary probe, you can first bring up a B-Mode
picture for navigation purpose and then add Doppler.

Preparations

1.) Connect one of the probes to the scanner.

2.) Turn ON the scanner.

3.) The 2D Mode window is displayed (default mode).

4.) If needed, adjust the display’s Brightness and Contrast setting.

5.) Press PW or CW to start Pulsed Wave Doppler (PW) or Continuous Wave Doppler (CW).

6.) Use the Trackball to select the Area of Interest (Sample Volume) in PW or direction of interest in
Cw.

To adjust the PW/CW Doppler Mode controls:
Adjust the Active mode gain to set the gain in the spectral Doppler area.

» Adjust Low velocity reject to reduce unwanted low velocity blood flow and tissue movement.

* In PW mode, adjust Sample volume to low setting for better resolution, or higher setting to more
easily locate the disturbed flows.

* Adjust the Compress setting to balance the effect of stronger and weaker echoes and obtain the
desired intensity display.

» Adjust Frequency to optimize flow display. Higher setting will improve resolution and the lower
setting will increase the depth penetration.

* Adjust Frame rate to a higher setting to improve motion detection, or to a lower setting to improve

resolution.
NOTE: Frequency and Frame rate settings may affect the Low Velocity Reject.
+ Adjust Power to obtain an acceptable image using the lowest setting possible. This is particularly
important in CW-mode, as the energy duty cycle is 100% (constant).
NOTE: The Doppler Power setting affects only Doppler operating modes.
» Adjust the following settings to further optimize the display of the image.
* Use the Horizontal sweep to optimize the sweep speed.
+ To view signal detail, adjust Scale to enlarge the vertical spectral Doppler trace.
* Use Invert to reverse the vertical component of the spectral Doppler area of the display.
* Use Angle correction to steer the ultrasound beam to the blood flow to be measured.
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4-3-15

CW Doppler mode functional checks

For information on the Ultrasound system’s different modes, the Basic User Manual will familiarize you
with image optimization for B-Mode, M-Mode, Color Flow, and Doppler.

1.) Connect one of the probes to the scanner.

2.) Turn ON the scanner.

3.) The 2D Mode window is displayed (default mode).

4.) If needed, adjust the display’s Brightness and Contrast setting.
5.) Press CW to start Continuous Wave Doppler (CW).

6.) Use the Trackball to select the direction of interest in CW.
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4-3-16

Cineloop functional checks

For complete information, see the appropriate version of the LOGIQ Fortis Basic User Manual,
Chapter 5, or the appropriate LOGIQ Fortis Release Notes. See 1-4-1 "Label Location" on page 1-14.

To activate CINE:

1.) Press Freeze, then roll the trackball to activate CINE.
2.) To start CINE Loop playback, press Run/Stop.

3.) To stop CINE Loop playback, press Run/Stop.

To omit images:

* Roll the trackball to the frame you want to delete and press Omit Image.
To restore images:

» To undo deleting an image from the CINE Loop, press Restore Image.
To move quickly to start/end frame:

1.) Press First to move to the first CINE frame.
2.) Press Last to move to the last CINE frame.
To start frame/end frame:

1.) Turn the Start Frame dial to the left to move to the beginning of the CINE Loop.
2.) Turn the dial to the right to move forward through the CINE Loop.

3.) Turn the End Frame dial to the right to move to the end of the CINE Loop.

4.) Turn the dial to the left to move backward through the CINE Loop.

To adjust the CINE loop playback speed:

» Turn the Loop Speed dial right/left to increase/decrease the CINE Loop playback speed.
To move through a CINE loop frame by frame:

*  Turn Frame by Frame to move through CINE memory one frame at a time.
Checks

»  Check Left Marker, Right Marker, Cycle Select and Number of Cycles.
» Check First, Last Cycle, Select all.
» Adjust Scroll and Cine Speed.
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4-3-17

4-3-18

4-3-19

Removable media functional checks
Refer to Chapter 9 of the appropriate LOGIQ Fortis Basic User Manual.

* Using Removable Media

* Labeling Removable Media

+ Formatting Removable Media

»  Verifying Removable Media

Types of removable media - CD/DVD, USB - flash drive and HDD
Archiving and loading presets

To load presets from removable media:

Refer to Chapter 9 of the appropriate LOGIQ Fortis Basic User Manual.

Installation and setup procedures for peripherals
Refer to 3-6-3 "Optional peripherals/peripheral connection" on page 3-36.

Table 4-8 Printer Functional Check

See Section Functional Test Debrief Script

7-15-1 Test of printers Equipment passed all required tests and is ready for use.
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4-3-20

NOTE:

NOTE:

NOTE:

Basic measurement functional checks
The following instructions assume that you first scan the patient and then press Freeze.

To check Distance and Tissue Depth Measurement:

1.) Press Measure once to display an active caliper.

2.) Move the trackball to position the active caliper at the start point (distance) or the most anterior point
(tissue depth).

3.) Press Set to fix the start point. The LOGIQ Fortis fixes the first caliper and displays a second active
caliper.

4.) Move the trackball to position the second active caliper at the end point (distance) or the most
posterior point (tissue depth).

5.) Press Set to complete the measurement. The Ultrasound system displays the distance or tissue
depth value in the measurement results window.

Before you complete a measurement:

» To toggle between active calipers, press MEASURE.

» Toerase the second caliper and the current data measured and start the measurement again, press
CLEAR once.

* To rotate through and activate previously fixed calipers, turn Cursor Select.

After you complete the measurement, to erase all data that has been measured to this point, but not
data entered onto worksheets, press Clear.

To check Circumference/Area (Ellipse) Measurement:

1.) Press Measure once to display an active caliper.
2.) Move the trackball to position the active caliper.

3.) Press Set to fix the start point. The LOGIQ Fortis fixes the first caliper and displays a second active
caliper.

4.) Move the trackball to position the second caliper.
5.) Turn the Ellipse control; an ellipse with an initial circle shape appears.

Be careful not to press the Ellipse control as this activates the Body Pattern.

6.) Move the trackball to position the ellipse and to size the measured axes (the calipers).
7.) To increase the size, turn the Ellipse control in a clockwise direction.

8.) To decrease the size, turn the Ellipse control in a counterclockwise direction.

9.) To toggle between active calipers, press Measure.

10.)Press Set to complete the measurement. The Ultrasound system displays the circumference and
area in the measurement results window.

Before you complete a measurement:

» To erase the ellipse and the current data measured, press Clear once. The original caliper is
displayed to restart the measurement.

* To exit the measurement function without completing the measurement, press Clear again.
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4-3-20

4-3-21

4-3-22

Basic measurement functional checks (cont’d)

Worksheets

Measurement/Calculation worksheets are available to display and edit measurements and calculations.
There are generic worksheets as well as Application specific worksheets. The worksheets are selected
from the Measurement Touch Panel.

Report Pages

Measurements/Calculations that are included on the worksheet can also be displayed on Report Pages.
Report Pages can be customized to meet the appropriate needs of the user.

Multi image functional checks

1.) Press L to activate a dual screen. The single image is placed on the left side.

2.) Press R. The left side image is freezed and the image displays in the right side.

3.) Press B key to return to the single screen.

4.) Press and hold down L to activate a quad screen. The single image is placed on the upper left.
5.) Press B key to return to the single screen.

ECG functional checks

The ECG capability on this LOGIQ Fortis is intended as a trigger for measurements, but can also be
viewed on the screen.

Parts needed: ECG cable and M5Sc-D
ECG Checks

Table 4-9 ECG Functional Checks

Step Task Expected Result(s)

1. Select Preset, select Cardiac, select Scan.

2. If you do not see the ECG line, select the ECG tab, you
should see selection on touch screen for DISPLAY You should then see the line.
ECG. Select and press.

3. Plug in the ECG cables with nothing attached so you

pick up noise The line should display noise.

4. Connect the ECG harness to the connector on the front | The LOGIQ Fortis displays a straight curve along the bottom
of the Ultrasound system. edge of the image sector on the screen.

5. Connect the three leads to an ECG simulator, or fasten |When connecting, the signal on the screen will be noisy.
the three ECG Pads to your body and connect the three | When the connection is completed, a typical clean ECG signal
leads to respective ECG Pad. is displayed.
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4-3-23

4-3-24

4-3-25

4-3-26

4D option functional checks
Required equipment: 4D Probe (RAB6-D or RIC5-9-D)
To perform the functional checks for 4D:

1.) Connect a 4D probe. Press the [3D/4D] button on the console.

2.) Press the [4D] button on the [Mode] tab. Press the [Visualization] button, then select Render.
3.) Press the [L] key the console to start 4D data acquisition.

4.) To complete the acquisition, press [Freeze] or [R].

Volume Navigation with inside probe functional checks
Required tools: a supported VN probe, Transmitter

1.) Connect a transmitter. Connect a VN probe to any probe ports and select it.
2.) Using a VN probe scan and enable VNAV.

3.) Check the system detects sensor and scans by confirming the appearance of a single quality bar
on the screen.

4.) Move a VN probe towards transmitter. Expected result is that the quality bar gauge shows 4.

Power Assistant functional checks
1.) With the LOGIQ Fortis powered up, verify the “batteries charging” icon displays in the status bar and
the LOGIQ Fortis operates as intended.

2.) Unplug the mains cable from the wall. The LOGIQ Fortis enters Power Assistant upon AC power
loss. There is an initial temporary message saying the LOGIQ Fortis is entering battering mode,
then a message appears, saying the LOGIQ Fortis is “running on battery”.

3.) Plug the mains cable back into the wall power and continue with functional checks.

Scan on Battery functional checks
1.) With the LOGIQ Fortis powered up, verify the “batteries charging” icon displays in the status bar and
the LOGIQ Fortis operates as intended.

2.) Go to Utility -> System->General then make sure "Auto Switch to Power Saving Mode” is 30minutes
and “Freeze When AC is Unplugged” is unchecked like following picture.
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4-3-27

3.) Then the system should be able to be unplugged and remain on for at least several seconds and
plugged back on without shutting down. A message may appear to user with a notification of being
in this mode.

4.) Verify that Scan is continued while the system is unplugged without shutdown.
5.) Reconnect AC power. Verify that the batteries begin charging via the battery status icon.

Shear Wave Elastography (Shear Elasto) functional checks
1.) Select a probe (L2-9-D or C1-6-D).
2.) Select the ELASTO button.

3.) From the touch panel, select the Shear Wave button (if not already selected).
4.) Verify that the Shear Wave button is available.
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Section 4-4
Site Log
Table 4-10 Site Log
DATE SERVICE PERSON PROBLEM COMMENTS
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Chapter 5
Components and Functions (Theory)

Section 5-1
Overview

5-1-1 Purpose of this chapter

This chapter explains LOGIQ Fortis’s Ultrasound system concepts, component arrangement, and
subsystem functions. It also describes the power distribution system. Refer to the LOGIQ Fortis Basic
User Manual (latest revision) for more information.

NOTE: The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

5-1-2 Contents in this chapter
5-1 OVEIVIBW. .« . 5-1
5-2 LOGIQ Fortis Models . . ... ... 5-2
5-3 LOGIQ Fortis DesCription . . . . ...t 5-3
5-4 Software Description. . . .. .. . 5-6
5-5 Service Desktop Description . . ... .. 5-19
5-6 Front End Description. . . ... . . e 5-21
5-7 Back End Description . . . . ... e 5-30
5-8 Backplane Description . .. ... ... e 5-34
5-9 Top Console Description. . . ... ... 5-36
5-10 Power Distribution Description . . . ... ... .. . 5-44
5-11 Cable Connection BEPS - OP .. .. ... . . e 5-48
5-12 Air Flow Distribution . . . . .. ... 5-52
5-13 Casters and Brakes Description. . ... ... .. 5-53
5-14 Options and Peripherals Description .. ........ ... .. ... . . . 5-54
5-15 Product Manuals. . . . ... . e 5-62
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Section 5-2
LOGIQ Fortis Models

Table 5-1 LOGIQ Fortis Software Configuration and Hardware

MODEL NUMBER DESCRIPTION SOFTWARE VERSION
6601000 LOGIQ Fortis LCD monitor CONSOLE, 100-240 VAC R3.x.x
6602000 LOGIQ Fortis HDU Display CONSOLE, 100-240 VAC R3.x.x
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Section 5-3
LOGIQ Fortis Description

5-3-1

5-3-2

Purpose of this section

The purpose of this section is to give you an overview of the LOGIQ Fortis and how it functions.

Contents in this section

5-3-1 Purpose of thissection . . . ... .. 5-3
5-3-2 IntroduCtioNn. . . . .. 5-3
5-3-3 LOGIQ Fortis general description. . . . ... . 5-4
5-3-4 LOGIQ Fortis block diagram. . . . . ... . e 5-5

Introduction

The LOGIQ Fortis Ultrasound system is a high performance digital Ultrasound imaging system with total
data management.

The LOGIQ Fortis provides image generation in B-Mode, Color Doppler, Power Doppler, M-Mode, PW,
4D, Harmonic Imaging, and Contrast imaging applications. The fully digital architecture of the

LOGIQ Fortis Ultrasound system allows optimal usage of all scanning modes and probe types
throughout the full spectrum of operating frequencies.
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5-3-3

LOGIQ Fortis general description

The LOGIQ Fortis is a digital beamforming Ultrasound system. The Ultrasound signal flows from the
probe through the Ultrasound system where it is processed and finally displayed as a diagnostic image
on the monitor. Images and patient data can be sent to peripheral devices to be stored, printed, or
displayed.

System configuration is stored on the hard drive and all necessary software is loaded from the hard drive
on power up.

The LOGIQ Fortis is comprised of the following major components:

+ BEPS (Back end and Power supply)
+ DA192 (Front end, Data Acquisition)
* DPI-L (Probe Interface relay)

*  Operator panel

* Peripherals

+ Options
*  Mechanical Parts
» Software

Section 5-3 - LOGIQ Fortis Description
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5-3-4 LOGIQ Fortis block diagram

The transmitted pulse bursts are routed from the DA192 board to the DPI-L relay board where the
ultrasound probes send the energy into the body. Weak ultrasound echoes from body structures and
blood cells are received by the probes and routed through the DPI-L relay board to the DA192 board.
The DA192 board amplifies the ultrasound signal and connects it with an A/D converter to the digital
domain. The digital signals are then further processed on the back end. The user operates the
Ultrasound system operation through the operator panel which consists of an alphanumeric keyboard,
customized controls, trackball, and a touch panel display. Images and patient data are displayed on the
main monitor.

Figure 5-1 LOGIQ Fortis Block Diagram
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Section 5-4
Software Description

5-4-1 Purpose of this section

This section gives you a brief overview of the software used on LOGIQ Fortis. You can also see the
LOGIQ Fortis Basic User Manual (latest revision) for more information.
Contents in this section
5-4-1 Purpose of this section . ... ... ... . 5-6
5-4-2 LOGIQ Fortis base load image and application software . ... .................... 5-7
5-4-3 Electronic media . . ... ... . 5-8
5-4-4 LOGIQ Fortis’s operating modes . . ... 5-9
5-4-5 Option activation Keys. . . ... .. 5-13
5-4-6 System password . . ... ... 5-14
5-4-7 Logfile content . . ... .. 5-17
5-4-8 Smart Device applications. . ......... .. 5-18
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5-4-2 LOGIQ Fortis base load image and application software

LOGIQ Fortis software consists of:

+ Base load image

- Windows 10 Embedded

- Contains all necessary drivers to support devices and peripherals approved for this product
» Application software

- Contains customized software to perform all functions and features for the LOGIQ Fortis
Software location:

« Software resides in the SSD.
Drive partitions

Table 5-2 Drive Partitions

Partition GB
Drive Type Letter Usage (approximately)
C: Windows 10/application 79
Z: Software Repository 31
SSD D: User settings/configuration 42
E: Database/data 783
V: Future Use 10

Software installation:

» Software can be loaded/reloaded with USB media.
+  System partition (Base+Application) can be reloaded from the Z partition.

»  System partition (Base+Application) can be updated through a remote connection to the Service
Back Office.

Network capabilities:

* LAN is IPv6 ready.
» Can only be set up for IPv4 or IPv6. They cannot be mixed.
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5-4-3

NOTE:

Electronic media

To access and view user documentation through a Windows PC:

1.) Insert the media into the media drive.

2.) Open the media drive on your desktop.

3.) Double click on the ‘gedocumentation.html’ document.

4.) Select the item you want to view (click on the blue, underlined link in the File Name column).
5.) To close the window, click on the ‘X’ in the upper, right-hand corner of the browser window.

If your PC does not have Adobe Reader, a free download is available on the Adobe website at
http.//www.adobe.com.
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5-4-4

LOGIQ Fortis’s operating modes
B-Mode

B-Mode is a two-dimensional image of the amplitude of the echo signal. It is used for location and
measurement of anatomical structures and for spatial orientation during operation of other modes. In B-
Mode, a two-dimensional cross-section of a three-dimensional soft tissue structure such as the heart is
displayed in real time. Ultrasound echoes of different intensities are mapped to different gray scale or
color values in the display. The outline of the 2D (B-Mode) cross-section is a sector, depending on the
particular transducer used. B-Mode can be used in combination with any other mode.

Harmonic imaging

Tissue Harmonic Imaging, acoustic aberrations due to tissue, are minimized by receiving and
processing the second harmonic signal that is generated within the insonified tissue. LOGIQ
Fortis's high performance Harmonic Imaging provides superb detail resolution and penetration,
outstanding contrast resolution, excellent acoustic clutter rejection and an easy to operate user
interface for switching into Harmonic Imaging mode. Coded Harmonics enhances near field
resolution for improved small parts imaging as well as far field penetration. It diminishes low
frequency amplitude noise and improves imaging technically difficult patients. It may be especially
beneficial when imaging isoechoic lesions in shallow-depth anatomy in the breast, liver and hard-
to-visualize fetal anatomy. Coded Harmonics may improve the B-Mode (2D) image quality without
introducing a contrast agent.

M-Mode

In M-Mode, soft tissue structure is presented as scrolling display, with depth on the Y-axis and time on
the X-axis. It is used primarily for cardiac measurements such as value timing on septal wall thickness
when accurate timing information is required. M-Mode is also known as T-M mode or time-motion mode.
Ultrasound echoes of different intensities are mapped to different gray scale values in the display. M-
Mode displays time motion information of the ultrasound data derived from a stationary beam. Depth is
arranged along the vertical axis with time along the horizontal axis. M-Mode is normally used in
conjunction with a 2D (B-Mode) image for spatial reference. The 2D (B-Mode) image has a graphical
line (M-line) superimposed on the 2D (B-Mode) image indicating where the M-Mode beam is located.
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5-4-4 LOGIQ Fortis’s operating modes (cont’d)

Color flow Doppler mode

Color Doppler is used to detect motion presented as a two-dimensional display. There are three
applications of this technique:

» Color Flow Mode - used to visualize blood flow velocity and direction
*  Power Doppler (Angio) - used to visualize the spatial distribution of blood

A real-time two-dimensional cross-section image of blood flow is displayed. The 2D (B-Mode) cross-
section is presented as a full color display, with various colors being used to represent blood flow
(velocity, variance, power and/or direction). To provide spatial orientation, the full color blood flow cross-
section is overlaid on top of the gray scale cross-section of soft tissue structure (2D (B-Mode) echo).
For each pixel in the overlay, the decision of whether to display color (Doppler), gray scale (echo)
information or a blended combination is based on the relative strength of return echoes from the soft
tissue structures and from the red blood cells. Blood velocity is the primary parameter used to determine
the display colors, but power and variance may also be used. A high pass filter (wall filter) is used to
remove the signals from stationary or slowly moving structures. Tissue motion is discriminated from
blood flow by assuming that blood is moving faster than the surrounding tissue, although additional
parameters may also be used to enhance the discrimination. Color flow can be used in combination with
2D (B-Mode) and Spectral Doppler modes.

Power Doppler

A real-time two dimensional cross-section of blood flow is displayed. The 2D (B-Mode) cross-
section is presented as a full color display, with various colors being used to represent the power in
blood flow echoes. Often, to provide spatial orientation, the full color blood flow cross-section is
overlaid on top of the gray scale cross-section of soft tissue structure (2D (B-Mode) echo). For each
pixel in the overlay, the decision of whether to display color (Doppler power), gray scale (echo)
information or a blended combination is based on the relative strength of return echoes from the
soft-tissue structures and from the red blood cells. A high pass filter (wall filter) is used to remove
the signals from stationary or slowly moving structures. Tissue motion is discriminated from blood
flow by assuming that blood is moving faster than the surrounding tissue, although additional
parameters may also be used to enhance the discrimination. The power in the remaining signal
after wall filtering is then averaged over time (persistence) to present a steady state image of blood
flow distribution. Power Doppler can be used in combination with 2D (B-Mode) and Spectral
Doppler modes as well as with 4D mode.

Pulsed (PW) Doppler

PW Doppler processing is one of two spectral Doppler modalities, the other being CW Doppler. In
spectral Doppler, blood flow is presented as a scrolling display, with flow velocity on the Y-axis and time
on the X-axis. The presence of spectral broadening indicates turbulent flow, while the absence of
spectral broadening indicates laminar flow. PW Doppler provides real time spectral analysis of pulsed
Doppler signals. This information describes the Doppler shifted signal from the moving reflectors in the
sample volume. PW Doppler can be used alone but is normally used in conjunction with a 2D (B-Mode)
image with an M-line and sample volume marker superimposed on the 2-D image indicating the position
of the Doppler sample volume. The sample volume size and location are specified by the operator.
Sample volume can be overlaid by a flow direction cursor which is aligned, by the operator, with the
direction of flow in the vessel, thus determining the Doppler angle. This allows the spectral display to be
calibrated in flow velocity (m/sec.) as well as frequency (Hz). PW Doppler also provides the capability
of performing spectral analysis at a selectable depth and sample volume size. PW Doppler can be used
in combination with 2D (B-Mode) and Color Flow modes.
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5-4-4 LOGIQ Fortis’s operating modes (cont’d)
Continuous Wave (CW) Doppler
Continuous Wave Doppler systems use two crystals, one to send and one to receive the echoes.
The transmitter inputs a continuous sinusoidal wave. The receiver detects the shift.

An audible sound is created and recorded by either an analog recorder or spectral analyzer. Spectral
analysis separates the signal into individual components and assigns a relative importance.

The benefits of CW Doppler include high sensitivity to low velocities and detection of high velocities
without aliasing. Although CW Doppler cannot distinguish between the sending and receiving signals or
extraneous echoes, nor does CW Doppler produce a precise image like Pulsed Wave Doppler.

Other modes

4D

The LOGIQ Fortis Ultrasound system may be used to acquire multiple, sequential 2D (B-Mode)
images which can be combined to reconstruct a three dimensional image. These 4D images are
useful in visualizing three-dimensional structures, and in understanding the spatial or temporal
relationships between the images in the 2D (B-Mode) sequence. The 4D image is presented using
standard visualization techniques, such as surface or volume rendering.

For more information on Volume Navigation and Contrast Imaging, see the LOGIQ Fortis Basic
User Manual (latest revision).

4D Data Collection and Reconstruction

2D (B-Mode) gray scale images may be reconstructed. The acquisition of volume data sets is
performed by sweeping 2D (B-Mode) scans with special transducers (called 4D-transducers)
designed for the 2D (B-Mode)-scans and the 4D-sweep.

Images are spatially registered, using internal probe position sensing and a position control to
ensure geometric accuracy of the 4D data.

2D (B-Mode) ultrasound imaging modes are used to view a two dimensional cross-sections of parts
of the body. For example in 2D (B-Mode) gray scale imaging, a 2 dimensional cross-section of a 3-
dimensional soft-tissue structure such as the heart is displayed in real time. Typical, the user of an
ultrasound machine manipulates the position and orientation of this 2D (B-Mode) cross-section in

real time during an ultrasound exam.

By changing the position of the cross-section, a variety of views of the underlying structure are
obtained, and these views can be used to understand a 3-dimensional structure in the body.

To complete survey a 3-dimensional structure in the body, it is necessary to collect 2D (B-Mode)
images which span a volume containing the structure. One way is to sweep the imaging cross-
section by translating it in a direction perpendicular to the cross-section. Another example method
is to rotate the cross section about a line contained in the cross section. The LOGIQ Fortis
Ultrasound system uses the automated so called C-Scan for the motion perpendicular to automated
B-scan. Once a representative set of 2D (B-Mode) cross-sections are obtained, standard
reconstruction techniques can be used to construct other 2D (B-Mode) cross-sections, or to view
the collection of the cross-sections as a 4D images.
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5-4-4 LOGIQ Fortis’s operating modes (cont’d)

4D Image Presentation

The basic technique for 4D image presentation is to combine the 2D (B-Mode) cross—sections into
an image which represents how the volume of the data would appear from a particular viewing
direction. The mathematics behind this feature is called 4D-rendering. Such combined images are
called projections, because the data from the volume is projected onto a flat 2-dimensional surface,
e.g. the Ultrasound system display. This technique can be applied to any 2D (B-Mode) ultrasound
mode.

Several techniques can be used to aid the human observer in understanding the resulting 2D (B-
Mode) image as a representation of a three-dimensional object. One is to rotate the volume of data,
and present the resulting sequence of 2D (B-Mode) projections to the observer. The changing
direction of observation helps the observer to separate the features in the volume according to their
distance from the observer.

Volume Navigation

Using a position sensor attached to the probe, Volume Navigation Fusion (V Nav) lets you import a
pre-acquired Ultrasound, CT or MR DICOM volume dataset and register it to the live Ultrasound
image. As a result, you can view live Ultrasound scanning simultaneously with the corresponding
multi-planar reformatted (MPR) slice from the pre-acquired dataset.

In addition, you can use V Nav as a type of “GPS” positioning marker to track an anatomy of interest.

V Nav is available in B-Mode, Color Flow, PDI, and Contrast Modes; it is not available while in
3D/4D or when timeline modes are active. Biopsy capability is available while in V Nav.

Contrast Imaging

The LOGIQ Fortis is designed for compatibility with commercially available Ultrasound contrast
agents. Because the availability of these agents is subject to government regulation and approval,
product features intended for use with these agents may not be commercially marketed nor made
available before the contrast agent is cleared for use. Contrast related product features are enabled
only on Ultrasound systems for delivery to an authorized country or region of use. It is not currently
approved for use in the United States.

Elastography

Elastography shows the spatial distribution of tissue elasticity properties in a region of interest by
estimating the strain before and after tissue distortion caused by external or internal forces. The
strain estimation is filtered and scaled to provide a smooth presentation when displayed.

With Elastography active, the image will show a color map/bar indicating the level of elasticity
detected by the Ultrasound system. The Elastography image is achieved by pulsating the probe
manually while you are scanning the anatomy of interest.

Shear Wave Elastography

With the Shear Wave option, the scanner creates the distortion by generating shear waves in tissue
using a diagnostic ultrasound transducer. Shear waves “push” the tissue at a low frequency in either
a single burst of high amplitude, long duration pulses or a series of such pulses.

UGAP

Ultrasound-Guided Attenuation Parameter (UGAP) measures the attenuation value (i.e.
attenuation coefficient [dB/cm/MHz] or attenuation rate [dB/m]) in the liver to evaluate diffuse liver
disease. There are three visualizations: B Ref, Color Ref and Color Dual. All visualizations measure
a representative attenuation value. Color Ref and Color Dual measure a representative attenuation
value in 2D color map and dual display of B-Mode and 2D color map, respectively.
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5-4-5

Option activation keys

Option keys are a string of characters that activate purchased options and are stored in two different

locations.
BEPS

* Non Volatile RAM
* Primary source
Internal drive

» Stored as a text file under userdefs
+ Can be backed up to CD/DVD/USB
* Can be Imported from Media or from Service folder
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5-4-6 System password
The system password is the Windows password used by the LOGIQ Fortis to automatically log into the
Windows operating system. This is the password you would use from a locked Windows desktop.
Users of the LOGIQ Fortis will never need to use this password. The only reason to change the
password would be if the user, for security reasons, prefers to define their own password instead of the
factory created default password. As with all passwords, this should be treated with care and archived
appropriately so that it can be provided to service personnel if necessary.
The requirement for this password is a minimum of 15 characters including an uppercase letter and a
special character.
The Windows password is not backed up with system presets.
The procedure to change the system password depends on the software version. These are the
available procedures:
A system administrator can change the password of the underlying Windows user from Utility (first
page) > Admin > System Password.
Figure 5-2 System Password
System Admin Users ogol Groy Disk Encryption Audit Report
To change the system password:
1.) Navigate to Utility (first page) > Admin, and then select System Password.
2.) In System Password, type the current password.
3.) In New Password, type a new password according to the password requirements (minimum 15
characters including one upper cap and one symbol).
4.) In Confirm Password, type the new password.
5.) Select Save.
NOTE: The new password procedure will need to be performed each time the LOGIQ Fortis is
reghosted.
5-14 Section 5-4 - Software Description
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5-4-6 System password (cont’d)
To confirm the new password:

1.) Insert an activated SSA key.
2.) Exit to the Windows desktop.

3.) Press Start with the left Trackpad key and select Command Prompt (Admin).
4.) In the Command Prompt window, type “netplwiz” and then press Enter.

The User Accounts window appears.

User Accounts X
Users  Advanced
‘;} Use the list below to grant or deny users access to your computer,
“E0)  andto change passwords and other settings.
v
Users for this computer:
User Name Group
&} DLSService DBLogAccess; Administrators; Us...
&) GEAdmin Administrators
&2 GEService Administrators; Users
Ll ichiro Administrators
& SV CService DBLeogAccess; Administrators; Us...
Password for Ichiro
“2 To change your password, press Ctrl-Alt-Del and select Change
Password.
oy
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5.) In the User Accounts window, do the following:

a.) Check the Users must enter a user name and password to use this computer box.
b.) Under Users for this computer, select “Ichiro”.

c.) Uncheck the Users must enter a user name and password to use this computer box.
d.) Press OK. The Automatically sign in popup appears.

Automatically sign in X

@ You can set up your computer so that users do not have to type a user
EH’ name and password to sign in. To do this, specify a user that will be
automatically signed in below:

User name: [ Ichiro ‘
Password: | sesscssssssseee ‘
Confirm Password: | sescnssssene ‘

e.) In Password and Confirm Password, enter the new password and then press OK.

f.) If you incorrectly type the password, in the following popup, press OK and re-enter the
Password and Confirm Password information on the “Automatically sign in” popup again.

User Accounts X

The passwords you typed do not match. Type the password for this
account in both text boxes,

NOTE: The new password procedure will need to be performed each time the LOGIQ Fortis is
reghosted.
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5-4-7

Log file content

Uncompressing the log files provides a subdirectory with the results.

SysConfig.csv — Contains serial number, hardware info, software version, etc.
log/ExceptionTrace — subdirectory contains text file with call stack of system crashes.

log/DL — (Deep Learning) subdirectory contains anonymized low resolution jpg images. Can be
used for troubleshooting. Every time you press the print key. Very low resolution images, may be
useful to get examples of image issues visible in low resolution. Used for data analytics. Users can
disable them through the UI.

log/Diag — subdirectory contains diagnostics results.

log/Crashes — subdirectory may contain Windows/application crash info.
log/CrashDump — subdirectory may contain Windows/application crash info.
Log/ScLogsDatabase — subdirectory containing tab-separated text files (Data Logging).
Log/ScLogsDatabase_PI — subdirectory with Patient Proprietary Info (keyboard shadow).
WinEvt — subdirectory with Windows Event logs.

Logs are text files and can be open in Microsoft Excel. Fields are separated by tabs in order to make it
easier to be opened in Excel.

Logs will not be present until they are collected through Alt+D or Gather Logs.
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5-4-8

Smart Device applications

The following Smart Device applications (apps) are available for Android devices through a Bluetooth
connection:

LOGIQ Remote
LOGIQ Photo

For more information, see “Smart Device Apps” in Chapter 13 of the LOGIQ Fortis Basic User

Manual (latest revision).

LOGIQ Remote

With the LOGIQ Remote app, you will be able to adjust the following controls:

Depth

PW Gain

CF Gain
B-Mode Gain
Left/Right
Measure
Comment
Clear
Trackball
Freeze

Store

Color Flow Scale
Cursor

LOGIQ Photo

With the LOGIQ Photo app, you can capture images that will go to the patient’'s exam.
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Section 5-5
Service Desktop Description

5-5-1

The Service Desktop is an interface that provides access to system information, status, and diagnostics.
The Service Desktop has different content or views depending on the access level. The access level is
determined by the user profile as well as the service options enabled on the LOGIQ Fortis.

» Basic view is the standard view, restricted only by the user through the user profile settings.
Administrator default user has access to the Service Desktop. Any user with “local Service access”
in their user profile can have access to this view.

+ Class C view is the view enabled by the service options purchased.
- Service Advanced
- Service Expert (requires Service Advanced)
- Service Pro (requires Service Advanced)

Contents in this section

5-5-1 User level of the Service Deskiop .. ... ... e 5-19

User level of the Service Desktop

Table 5-3 shows Service Desktop widgets available for local service user without an SSA Key and
without service options.

Table 5-3 User Level of the Service Desktop

Basic View Class C View Levels
Main Main - : .
Menus Sub-menus Simple Service Service Service
Advanced Expert Pro
Home X X X X
Diags X X X
Run Diags X X X
e-PAT
diagnostic X
Diag History
DICOM
DICOM
Service Status X X X
DICOM X X X
Spooler
Utilities X X X X
Change
Password X X X X
Checkpoints X X X
Clean
Userdefs X X
Data Transfer X X X X
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Table 5-3 User Level of the Service Desktop (Continued)
Basic View Class C View Levels
Main Main - - -
Menus Sub-menus Simple Service Service Service
Advanced Expert Pro
Delete Files X X X X
Disk
Defragment X X X
Disruptive
Mode Utility X X X
Gather Logs X X X X
Network X X X X
Capture
Reset Patient
Database X X
Secure Delete X
Software
Reload X X
SSA License X X X X
Third Party
Licences X X X X
Options X X X X
Agent
Configuration X X X X

Section 5-5 - Service Desktop Description




Direction 5874372, Rev. 3

GE CONFIDENTIAL
LOGIQ Fortis Proprietary Service Manual

Section 5-6
Front End Description

5-6-1

Purpose of this section

The intention with this section is to give you a brief overview of the front end configuration used on the
LOGIQ Fortis.

Contents in this section

5-6-1
5-6-2
5-6-3
5-6-4

Purpose of thissection . . . ... . e 5-21
Card rack circuit boards overview and location .. ............................. 5-22
Relay board (DPI-L) . . ... 5-25
Data Acquisition Board (DA192). . . .. ... 5-28
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5-6-2 Card rack circuit boards overview and location
The card rack houses all the transmit, receive, and processing circuit boards.

Figure 5-3 Card Rack Boards (indicate orange box)

218 =

Vnav
DPI :
Probe Interface Patient 10
DVD
r—— —-— _— =
Printer
DA192 GBP
Back
Plane
Ultrasound TX / RX :
for 192 elements OPIO.
|
Battery HV DCDC JI
X2
—s
Or
x4 =
—E
BEPS crU oooooooooo
P SSD DEDUDDDDUEDDQDUDE
Power Supply Module
ACto DC
{\ Master Controller GPU
Computing Unit
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5-6-2

Card rack circuit boards overview and location (cont’d)

Table 5-4 Card Rack Boards
TOTAL NUMBER OF CARDS PER
ABBREVATION BOARD NAME LOGIQ Fortis
BEPS Back End and Power Supply 1
DA192 Data Acquisition 192 ch 1
DPI-L DLP Probe Interface 1
GBP Back Plane !

Figure 5-4 Details of Card Lack

DPl & DA192
Connected by
Stacking-connector

BEPS < DA19Z
Connected by GBP
(BackPlane)
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5-6-2 Card rack circuit boards overview and location (cont’d)

Card rack location in the LOGIQ Fortis

The card rack can be accessible by Rear side of the system.

Figure 5-5 Card Rack Location
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5-6-3

Relay board (DPI-L)

The main task of the relay board is to route the transducer channels between the active probe and the
Transmitter or Receiver modules that are active. Relays are used in order to switch the connections
between the active probe connectors.

The module contain four probe connectors:

» All connectors have a metal door enclosure that opens only when inserting the probe. The
enclosure protects the pins that connect to the probe flat contact pads. This connector type is
identified as DLP. Probes compatible with this style of connector are identified as “-D”

»  All connectors support probes with 192 channels (one connector is designed to support probes up
to 256 channels.

Location in the LOGIQ Fortis

For DPI-L board location, see 5-6-2 "Card rack circuit boards overview and location" on page 5-22.
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5-6-3 Relay board (DPI-L) (cont’d)

Figure 5-6 Relay Board
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There are four probe connectors mounted on the solder side of the board.

The LOGIQ Fortis Ultrasound systems have one type of probe port that connects directly to the relay
board: four DLP probe ports.

Figure 5-7 Probe Connectors, Four DLP Probe Ports

[ —

J:*:J:*:L

LOGIQ Fortis has Probe port illumination to indicate the Probe port location in the Dark Room.
Brightness of illumination can be controlled on the Touch Panel and in Utility page.
Fiber cable is used as lighting, and LED power is provided by DPI-L though connector.
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5-6-3 Relay board (DPI-L) (cont’d)

Pencil probes (P2D and P6D probes) can be connected to DPI-L board by applying Pencil CW

installation kit Hardware onto DPI-L board.

LOGIQ Fortis is using different connection, but Necessary TX/RX signals are automatically switched/
connected to applicable signal lines.

Figure 5-8 Pencil Probe Connector

- i
1
o ——
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5-6-4 Data Acquisition Board (DA192)

DA192 Board has two main tasks. One is to provide the transmitter channel hardware and function for
the beamformer system. Another is to receive the Weak ultrasound echoes and process 192 channels
concurrently. DA192 board has HV Power bank that generates HV+/- Power for Transmit, and MUX-HV

+/- for MUX-inside Probes.
Figure 5-9 Data Acquisition Board (DA192) Block Diagram
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Figure 5-10 Data Acquisition Board (DA192)
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Figure 5-11 Parts Location on Data Acquisition Board (DA192)

HV Power Circuit

Analog Front End IC

Transmit IC

Data acquisition (DACQ) FPGA
SSCI FPGA

CW Doppler Option Board (GCW)

m ml ool o >

Location in the LOGIQ Fortis

For DA192 board location, see 5-6-2 "Card rack circuit boards overview and location" on page 5-22.
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Section 5-7
Back End Description

5-7-1 Purpose of this section

The intention with this section is to give you a brief overview of the back end configuration used on the
LOGIQ Fortis.

Contents in this section

5-7-1 Purpose of thissection . . ... ... . . . . 5-30
5-7-2 BEPS. . 5-31
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5-7-2

BEPS
The BEPS (Back End and Power Supply) module has two main tasks.

One is single board computer built from a COM express module fitted into customized rack. Its main
function is to be the central processing unit of the Ultrasound system, controlling all the functionality,
user interface and connectivity of the scanner. Another is the Main Power Supply unit with semi-
customized ACDC converter unit.

BackPlane connectors give the Power to DA192/DPI-L boards, and PCl-e signals for image-processing.

The BEPS also host a single slot GPU card, a M.2 Solid State Drive (SSD).

Figure 5-12 Location of each module

A CPU module

B ACDC Converter module (Shield cover bracket is applied, module size/design may be different)
C ACFE (Filter) board

D M.2 SSD Hard Drive

E VCS (S-Video) board - option

F DC4D (4D motor control) board - Option

G Removable EEPROM to store Console S/N and Option keys

H Lithium Coin Battery
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5-7-2 BEPS (cont’d)

Figure 5-13 Location of each module (Back side)

J GPU module

K Connector for Battery Option
L Not used

M Not used
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5-7-2 BEPS (cont’d)
Figure 5-14 Connector description

Hole for Battery cable
Connect to BatteryOption

| ___Monitor Power
~USB3

For monitor
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Touchpanel HDMI
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____—— Foron-board peripherals
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Internal Breaker must ON always (ON means, always “I” should be activated, as graphic
above).

AC-Inlet

NOTE:

Chapter 5 Components and Functions (Theory)



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

Section 5-8
Backplane Description

5-8-1 Purpose of this section
The intention with this section is to give you a brief overview of the backplane used on the LOGIQ Fortis.
Contents in this section

5-8-1 Purpose of thissection . . ... ... .. . . 5-34
5-8-2 Backplane (GBP) . ... . 5-35
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5-8-2

Backplane (GBP)

The LOGIQ Fortis backplane (GBP) is part of an Ultrasound system, main purpose is to connect BEPS
board and DA192 board, capable of processing 192 ultrasound channels concurrently. It also has
connector for Main FAN power, Front-LED, and Wireless LAN module.

GBP does not have ROM for VPD.
Figure 5-15 Backplane

BEPS side DA192 side DA192 side BEPS side
-

i~

Wireless LAN Option

Connector for Main-FAN

Connector for Front LED

Backplane connector for normal signals

m| O| O ®m| >»

Backplane connector for High speed (PClie Gen3 signals)
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Section 5-9
Top Console Description
5-9-1 Purpose of this section
The purpose of this section is to give you an overview of the top console and to tell you how it functions.

Contents in this section

5-9-1 Purpose of thissection . . ... ... . . . 5-36
5-9-2 Transporting the LOGIQ Fortis . . ... ... e 5-36
5-9-3 Operator panel movement - principle of operation . . . .......................... 5-37
5-94 Top console description. . .. ... 5-38
5-9-5 Top console block diagram . . . ... ... 5-39
5-9-6 Main MmoONItOr . . . . .. 5-40
5-9-7 Operator panel . . ... 5-42
5-9-8 Oppanel Interface. . . ... . . . 5-43
5-9-2 Transporting the LOGIQ Fortis

Refer to the appropriate version of the LOGIQ Fortis Basic User Manual, or the appropriate LOGIQ
Fortis Release Notes.
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5-9-3

& CAUTION

VAN

NOTICE

Operator panel movement - principle of operation

To avoid injury or damage, make sure nothing is within the range of motion before moving the
operator panel. This includes both objects and people.

Do NOT attempt to apply excessive rotating force to the operator panel. The elevation brake is
designed to hold the operator panel in desired position during normal use, and not meant to completely
fix the operator panel position.

Push right side button to raise/lower the operator panel.

1.) Hold the front handle in two hands.

2.) Push and hold down the Up/Down button next to the right front handle.
3.) Raise or lower the control panel.

4.) Release the Up/Down button at the desired height.

Push left side button to swivel the operator pane

1.) Hold the front handle in two hands.

2.) Push and hold down the swivel button next to the left front handle.
3.) Move the control panel to the left or the right.

4.) Release the swivel button at the desired position.
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5-9-4 Top console description
The top console includes the following:

e Main monitor
*  Operator panel with:
- An On/Off switch.

- A touch panel screen and a control panel with controls for manipulating the picture quality and
for use in Measure & Analyze (M&A).

- Gel warmer
- A trackball.

- Top console adjustment controls; controls and a lock to move the top console left/right, and
up/down.

*  Sound output (used during Doppler scanning/replay) not visible externally.
The top console is located on the top of the LOGIQ Fortis.
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5-9-5 Top console block diagram

Figure 5-16 Top Console Block Diagram

| [ usBPower oo — _ USB/Power
LCD Monitor HDMI Monitor USBLJEBz HDU Display| [ 5 monitor
M

Figure 5-17 Lower OPIO Block Diagram
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Figure 5-18 Upper OPIO Block Diagram
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5-9-6 Main monitor
LOGIQ Fortis supports Two monitors, LCD Monitor and HDU Display.

5-9-6-1 LCD Monitor
23.8" Wide screen high-resolution LCD Display

Figure 5-19 LCD Monitor Connections

[1]usB2.0from CN8 | 2] Power from CN7 [ 3] HDMI from CN6
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5-9-6-2 High Definition Ultrasound (HDU)

A 23.8-inch wide screen, high definition Ultrasound Dual Layer LED-LCD (Liquid Crystal Display) with
localized dimming and non-interlace scan is used as the main monitor.

Figure 5-20 HDU Display Connections

Upper OPIO 1

[1]usB2.0 from CN8 | 2] Power from CN7 [ 3] HDMI from CN6
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5-9-7 Operator panel

The operator panel includes an On/Off switch, different controls for manipulating the picture quality, and
controls for use in Measure & Analyze (M&A), top console adjustment controls.

An alphanumeric keyboard is Hardware Option, and can be assembled to bottom side of the operator

panel.

Upper Operator panel is 12.1" High-resolution, color, touch, display screen.

Figure 5-21 Operator Panel

1. Probe Holder and Cord Management

2, Touch Panel and Joystick controls

3 On Screen Keyboard (not display in this
" graphic)

4. User Defined Keys
5. Mode/Gain/XYZ (3D) Controls

o

N

Trackball, Trackball Keys, Pointer, Measure,
Comment, Body Pattern, Clear, Zoom,
Programmable Keys

L/R, Start/Stop, Freeze, Simultaneous
Steer/Width/Depth/Reverse

Auto, CF/PW Auto Positioning
P1, P2
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5-9-8

Op panel Interface

Figure 5-22 Upper Op Panel/Touch Panel Assembly Connections

|

L

' cna oz ONS On

._.'d‘

To
CN1 BEPS USB3
CN2 From BEPS to Upper OPIO (for touch panel)
CN3 Upper Tray USB3 ports (EUSB2)
CN4 From BEPS to Upper OPIO HDMI (for main monitor)
CN5 From BEPS to Upper OPIO Power
CN6 From Upper OPIO To Monitor HDMI
CN7 Monitor Power
CN8 Monitor USB2
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Section 5-10
Power Distribution Description

5-10-1 Purpose of this section
The power distribution within the LOGIQ Fortis is described in this section.
Contents in this section
5-10-1  Purpose of thissection . .. ... .. .. . . . . 5-44
5-10-2 Power Supply Distribution. . . . ... ... . 5-45
5-10-3  POWEr ON SEQUENCE . . . .ottt ittt et e e et e e e 5-47
5-44 Section 5-10 - Power Distribution Description



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

5-10-2

Power Supply Distribution

The main power module is located in the BEPS assy, and main task is to isolate the scanner from the
on-site mains power system and to supply the various internal subsystems with DC power.

Power from the wall outlet (100 to 240 VAC, 50/60 Hz) is connected to the main power supply. The main
power supply (ACDC module) provides main P12V Live (Stand-by) 5V.

LOGIQ Fortis does not have Motors for Operator panel motion. Thus, LOGIQ Fortis does not have
48Vdc lane.

Each DCDC converter (located on DPI-L,DA192,BEPS) generates the needed voltages to the rest of
the LOGIQ Fortis:

*  Printer (12 Vdc)

*  Main Monitor(12Vdc)

* Lower/Upper OPIO, Gelwarmer(12Vdc)

» HV (variable DC High voltage, +/-10V ~ +/-100V), THV(+/- 97V), on DA192

+ P5V, M5V on BEPS

!!!! »

Vnav

DPI

Patient IO
Probe Interface DCDCs —
DVvD

- p—— DC
DCDCs Printer
+- 10~100

I DA].dSZ! +-2+10 I
Ultrasound TX / RX !
for 192 elements OPIO:
Battery +/-97 :
x2 i
Or —= i
LIVESV = i
x4 o= !
- —= 1

. ! - !
BEPS CPU 0 oocooooooo
ooooooooo
oopoooooo
+12V

‘j:)-l ACDC - p— ] Ml | @I

DeDc ¢y, | j

Figure 5-23 Power Distribution Diagram

The mains cord has plugs in both ends. A female plug connects to the scanner and a male plug to the
wall outlet.

User cannot detach the mains cord by regulation (fixed by Bracket).
Fuses are located inside the ACDC module (cannot be replaced).
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5-10-2 Power Supply Distribution (cont’d)

LOGIQ Fortis has a Circuit Breaker, located on Rear bottom side.

Figure 5-24 Circuit Breaker

The main power module is located in the BEPS assy, and main task is to isolate the scanner from the
on-site mains power system and to supply the various internal subsystems with DC power.

LOGIQ Fortis Power module does not have dedicated FAN. Necessary Air-Flow is provided by Main-
FAN.

A current limiter will switch off the power if any of the outputs overload.

Under-voltage and over-voltage protection is provided for all of the output voltages.

The power supply will be turned off if the temperature goes too high.

Figure 5-25 Cooling Air Flow of Power Supply
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5-10-3

Power on sequence

1.) BEPS, powered by LIVE5V(stand by 5V), PIC-micon (to manage Power Sequence, on BEPS) starts
working.
=>|f Battery Option is installed (and Capacity is not Full), battery-charging starts with operating
Main-Fan.

2.) BEPS sends PSON signal to ACDC-module when Power button is pushed.

3.) ACDC-module powers up +12V, and provides Power Good signal.

4.) DCDC circuit on BEPS module powers up, +5V, -5V
THV circuit on DA192 powers up, +/- 97V

5.) HV circuit on DA192 powers up after booting up Echoloader application, +/-10~100V variable.
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Section 5-11
Cable Connection BEPS - OP

Almost internal Cables are outputted from BEPS, and connected to each board/modules through ICM

board.
# From To Description
1 BEPS J1 OPIO Lower OPIO CN1 USB2.0 x2_PWR_PW-On, Lower OPIO
2 BEPS J2 Upper OPIO CN1 USB3.0, Upper OPIO
3 BEPS J3 Upper OPIO CN2 HDMI Touch panel LCD, Upper OPIO
4 BEPS J4 Upper OPIO CN4 HDMI Main Monitor, Upper OPIO
5 BEPS LCD J8 Upper OPIO CN5 PWR, Upper OPIO and Main LCD
6 BEPS USB2.0 (L) BW Printer NA USB2.0, Option DC BW PRINTER
7 BEPS USB2.0 (C) V-Nav NA USB2.0, Option V-Nav
8 BEPS USB2.0 (R) NA NA NA
9 BEPS J5 Speaker NA Audio, Speaker
10 BEPS J44 DVD NA SATA, DVD
11 BEPS J9 DVD NA PWR, DVD
12 BEPS J10 V-Nav NA PWR, Option V-Nav
13 BEPS J11 BW Printer NA PWR, Option DC BW PRINTER
14 BEPS J51 VSIO (ECG) NA Option VSIO (ECG)
15 BEPS J52 NA NA Not Use
16 BEPS J53 V-Nav NA Signals, Option V-Nav
17 Upper OPIO CN6 Main Monitor NA HDMI, Main Monitor
18 Upper OPIO CN7 Main Monitor NA PWR, Main Monitor
19 Upper OPIO CN8 Main Monitor NA USB2.0, Main Monitor
20 Upper OPIO J51CN3 EUSB2 CN3 USB3.0 x2, EUSB2 User ports
21 Lower OPIO J1 EXT USB BOARD J3 USB2.0, EXT HUB BOARD
22 Lower OPIO J2 EXT USB BOARD J7 PWR, EXT HUB BOARD
23 EXT USB BOARD J1 Gel warmer NA PWR, Gel warmer
24 EXT USB BOARD J5 AN Keyboard NA USB2.0, Option AN Keyboard
25 EXT USB BOARD J8 AN Keyboard NA LED, Option AN Keyboard
26 GBP u1 CSI2 NA LED indicator cable

Section 5-11 - Cable Connection BEPS - OP
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EXT HUB
BOARD

(Top)

EXT HUB
BOARD
(Bottom)
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GBP
(Backplane)
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Section 5-12
Air Flow Distribution

5-121 Air Flow Distribution
Through the filter grid on the front of the system, air flow into the LOGIQ Fortis.

By means of the 1 FAN, air is blown through the nest-box, and the warm air exits the system through
holes in the left side panel and rear of the system.

Main Air Outlet(Side)

Main Air
Inlet (Filter grid)

Main Air Outlet(Rear)

Figure 5-26 Air Inlet/Outlet
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Section 5-13
Casters and Brakes Description

Examine the wheels frequently for any obvious defects that could cause them to break or bind.

Each wheel has an independent brake pedal. A left rear wheel also has a swivel lock.

Figure 5-27 Wheel lock and Swivel lock
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Section 5-14
Options and Peripherals Description

5-14-1

5-14-2

Purpose of this section

The options and peripherals within the LOGIQ Fortis is described in this section.

Contents in this section

5-14-1
5-14-2
5-14-3
5-14-4
5-14-5
5-14-6
5-14-7
5-14-8
5-14-9
5-14-10
5-14-11

Purpose of this section . .. ... . . . . 5-54
Internal hardware options and peripherals . .. ... ... ... .. ... ... ... . ... 5-54
External peripherals . .. ... ... 5-55
Real Time 4D option . . . .. .. 5-56
CW Doppler (Continuous Wave Doppler)option . .......... ... . ... ... ...... 5-56
Pencil CW option. . . ... . 5-56
S-Video (VCS) option . . ..o oo 5-56
Patient /O (ECG) option. . . ... ... 5-57
Power Assistant Option. . . ... . e 5-58
Volume Navigation option . . ... ... .. 5-60
Wireless LAN option . . ... ... 5-61

Internal hardware options and peripherals
(See 3-6-3 "Optional peripherals/peripheral connection" on page 3-36)

This list covers the internal peripherals available for the LOGIQ Fortis. All of these internal peripherals

should be connected already when the LOGIQ Fortis is delivered.

* Realtime 4D Option (DC4D)

+ CW Doppler Option (GCW)

»  Pencil CW Option

+  S-Video (VCS) Option

+ Patient /O (ECG) Option

» Power Assistant Option

»  Scan on Battery Option

*  Volume Navigation (V Nav) Option
*  Wireless Option

* DVD Drive option

» Printer (Digital Graphic) Option
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5-14-3

External peripherals

This list covers the external peripherals available for the LOGIQ Fortis. The external printers are network
DICOM devices. The inkjet printer is USB connected.

OPTION TRAY

Physical AN KEYBOARD

Probe Holders

Ethernet Protection cable

Inkjet Printer

Powervar144k120v MG UPS
SONY UPD25MD COLOR PRINTR
USB Footswitch 3 Button

Barcode Reader / Card Reader
Digital Expert tools

Rolling Volume Navigation Stand
Customer - supplied USB Flash Drive/Hard Drive
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5-14-4

5-14-5

5-14-6

5-14-7

Real Time 4D option

The Real Time 4D option is located on the BEPS assy of the LOGIQ Fortis and necessary Motor control
signals are delivered to DPI-L board and 4D Probes through an BackPlane connector.

See 8-8-6 "BEPS Assy Replacement" on page 8-144 for location of each modules on BEPS.

CW Doppler (Continuous Wave Doppler) option

The CW Doppler option is to enable the CW scanning mode on the LOGIQ Fortis. CW Doppler option
board (GCW) is located on the DA192 assy of the LOGIQ Fortis.

Pencil CW option

The Pencil CW option is intended to support the connection of CW pencil probes. To enable Pencil CW
option, CW Doppler option board (GCW) is also need to be installed.

See 8-10-6 "GCW (CW Doppler) Replacement" on page 8-224 for location.

S-Video (VCS) option

The S-video (VCS) Option is located on the BEPS assy of the LOGIQ Fortis.

S-Video output signal is generated on the VCS board, and provided to Rear S-Video port.
See 5-7-2 "BEPS" on page 5-31 for location of each modules on BEPS.

Section 5-14 - Options and Peripherals Description



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

5-14-8

NOTE:

Patient I1/0 (ECG) option

The ECG functionality of the Patient I/O module is not intended for patient monitoring nor to
support alarm functionality. This input is intended as a tool for easier synchronization of images
and cineloop control during ultrasound examinations.

The ECG (Patient I/O) panel is located on the front of LOGIQ Fortis
Figure 5-28 ECG (Patient I/O) Panel

The ECG (Patient I/O) contains the electronics for:

1.) Analog inputs - AUX (Pressure/Pulse)
2.) ECG
3.) Phono
The three inputs are separately isolated due to safety requirements.

The patient leads for ECG can be possible to change between Lead |, Il and Il by pushing a button).

The scanned image that is displayed, is synchronized with the ECG and phono traces. In M-Mode or
Doppler, the traces are synchronized to that particular mode's sweep. The operator can control the gain,
the position and the sweep rate of the traces using the assignable controls.

AUX is capable of handling a pulse/pressure signal.
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5-14-9

Power Assistant Option

LOGIQ Fortis has two kinds of Battery Options, Power Assistant (PA) Option and (ScoB) Option.
No Activation Code (Option String) is required for both Options.

The LOGIQ Fortis will identify the option if it is installed.

Power Assistant Option allows the user to move the LOGIQ Fortis from room to room (at least 20
minutes with Brand-new Battery Packs) without completely shutting down the console. Where the
typical boot up time is <100 seconds, typical Power Assistant boot up time is <10 seconds.

Power Assistant Option includes two Li-ion Battery packs.

Scan on Battery Option allows the user to keep scanning without Wall-outlet-Power (at least 50 minutes
as B-mode, with Brand-new Battery Packs).

Also on the Scan-on-Battery Option, User can choose the Power Saving mode. This can save Power-
consumption by freezing Scanning.

Scan on Battery Option includes four Li-ion Battery packs.

Both Options are using same Charger-board (BBG2) and Metal-Box.
Only internal Battery Qty is different (2pcs or 4pcs).

Battery Box is located to the Upper Rear side of the System

Power Cable and Signal Cable are connected to BEPS board.

Y ym g

_—
E———
-1 T- T

L ata

Figure 5-29 Battery location
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5-14-9 Power Assistant Option (cont’d)

Battery Charger board (BBG2) is connected to BEPS board, and communicating with CPU-module
(Host) via SM-bus signals.

Microcontroller on the BBG2 (MSP432) controls overall Charger operation and transfer the summarized
Battery information to Host.

BEPS

Max GO0
—{:‘,‘4—— ComE
Ideal _‘
250 ~ 400W max : : ‘
Swstem power BIC-Mican -
Power- | . ;.
e e sequencer :
¥ -~
i [ ]
Digitial : [
charge e | : -
MSP432 sEEEmEEEEEEEEEE
* 5M-Bus
Char || Char || Char || Char
ger || ger || ger [| ger
Battery || Bottery || Battery " Battery BBG

3amax 3Amax  JAmax  3Amox
charge charge charge charge
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5-14-10 Volume Navigation option

The V Nav (Volume Navigation) option allows for the use of probes that have built-in V Nav sensors,
avoiding having external cables and V Nav bracket use.

LOGIQ Fortis supports the Baybird2 module only. (Baybird1 is not supported)

Figure 5-30 V Nav Option HDMI Routing

Vnav Power Cable

Vnav USB Cable

Vnav
USB Cable
Vnav HDMI Cable
To DPI board Vnav
Power Cable
NOTE: If the DriveBay power connector is a 5-pin type, use a V-Nav power conversion cable (V-Nav

Unit accessories).
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5-14-11 Wireless LAN option

The WLAN (Wireless LAN) option allows the LOGIQ Fortis to connect to a Local Area Network wireless
network.

The WLAN is installed on the Backplane board (GBP) with the WLAN card mounting screw (A).
Antennas are attached to the exterior of the GBP.

Refer to the appropriate version of the LOGIQ Fortis Basic User Manual, Chapter 13.
Figure 5-31 Wireless LAN Option

Antenna
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Section 5-15
Product Manuals

The information needed to use and service the LOGIQ Fortis scanner is collected in the documents
described in this section.

NOTE: Dates on screenshots are represented in MM/DD/YYYY format throughout the manual.

Information on how to change the LOGIQ Fortis’s date can be found in Customizing Your
System, Chapter 10 in the LOGIQ Fortis User Manual.

5-15-1 User documentation
 LOGIQ Fortis User Manual
« LOGIQ Fortis Advanced Reference Manual
* LOGIQ Fortis Release Notes
+ LOGIQ Fortis eLabeling Kit (contains LOGIQ Fortis eDOCs Thumb Drive, which contains all User

Manuals and translations, and the Basic Service Manual)

5-15-2 Basic Service documentation
« LOGIQ Fortis Basic Service Manual
» LOGIQ Fortis Unpacking/Packing Procedure

5-15-3 Service/Proprietary documentation
+ LOGIQ Fortis Proprietary Service Manual
+ LOGIQ Fortis Service Notes
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Chapter 6

Service Adjustments

Section 6-1

Overview

6-1-1

NOTE:

6-1-2

Purpose of this chapter
This section describes how to adjust the LOGIQ Fortis.

The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

Contents in this chapter

6-1
6-2
6-3
6-4
6-5

OVBIVIBW. .« . o o 6-1
Monitor Adjustments. . . ... ... 6-2
Monitor Arm and/or Monitor Range of Motion Adjustment . . . .................... 6-10
DICOM Server Service Adjustments . .. ... ... .. .. . . . 6-13
Volume Navigation (V Nav) Calibration . ......... ... ... .. ... . . ... . . . . ... 6-13
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Section 6-2
Monitor Adjustments

6-2-1 Purpose of this section

This section describes how to adjust the monitor for optimal performance.

Contents in this section

6-2-1 Purpose of thissection . . ... ... . . . 6-2
6-2-2 Access to monitor adjustments. . . .. ... 6-3
6-2-3 Monitor adjustments . . . ... ... 6-4
6-2-4 Advanced monitor adjustments. . . ... ... 6-6
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6-2-2 Access to monitor adjustments

All monitor settings have been optimized at the factory, so there should be no need for any further
adjustments. The default settings on Scan Screen are:.

Table 6-1 Room Profile Table

HDU Display LCD Monitor
Room Profile: Dark Room Profile: Dark
Brightness/Contrast: 52/50 Brightness/Contrast: 50/85

For more information, see the appropriate version of the LOGIQ Fortis Basic User Manual Chapter 3,
or the appropriate LOGIQ Fortis Release Notes. See 7-4-1 "Label Location"” on page 1-14.

To access the Scan Screen, navigate to Utility (second page) > Scan Screen

Figure 6-1 Scan Screen

Use the encoder knobs to adjust the Scan Screen settings (shown on the Scan Screen directly above
each encoder knob).

Figure 6-2 Operator Panel Encoder Knobs

A I
09000 e@
roo N
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6-2-3

Monitor adjustments
Room profile

To set the monitor to different room lighting conditions, you may want to manually adjust the room
profile.

To set the room profile:

1.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display
while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

2.) Under Room Profile, select the room type.

Table 6-2 Room Profile Table

Room Profile Brightness/Contrast HDU Brightness/Contrast LCD
Dark 52/50 50/85
Semi-Dark 60/70 70/85
Light 62/93 90/85
User Defined User-adjustable Brightness/Contrast User-adjustable Brightness/Contrast
Backlight

Under special lighting conditions, you may want to adjust the monitor screen’s backlight intensity.
To set the OPIO backlight:

1.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display
while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

2.) Under the operator panel, turn the encoder to adjust the OPIO backlight setting.
Brightness and contrast

Under special lighting conditions, you may want to manually adjust the brightness and contrast.
To manually set the brightness and contrast:

1.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display
while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

2.) Under Room Profile, select User Defined.
3.) Under the operator panel, turn the encoder to adjust the brightness/contrast setting.

Section 6-2 - Monitor Adjustments
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6-2-3 Monitor adjustments (cont’d)
Touch panel light

1.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display

while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

2.) Touch panel encoder labeled as Touch Panel Light, rotate for brightness.

3.) Push the mode button once to display the popup and select Unlock or wait for the timeout.
4.) Adjust the Touch Panel between 10% to 100%.

For complete information, see the appropriate version of the LOGIQ Fortis Basic User Manual,

Chapter 3 or the appropriate LOGIQ Fortis Release Notes. See 1-4-1 "Label Location" on page 1-
14.

Figure 6-3 Touch Panel Adjustment Button

Unlock
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6-2-4 Advanced monitor adjustments
Review Gamma Setting

Gamma settings can be adjusted in two ways, with or without DICOM Gray Scale Standard Display
Function (GSDF) enabled. GSDF-compliant with all contrast settings, but not all brightness settings.

Because of differences in display technology, the HDU Display or LCD Monitor is GSDF-compliant with
all contrast settings, but not compliant with all brightness settings.

To enable the GSDF mode:

1.) Navigate to Utilities > System > System Display.
2.) Select Enable DICOM grayscale display mode (GSDF).
3.) Set Use Wide Screen for... > Single Image to Off.

4.) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display
while the Utility Touch Panel is active so you can see the affect your adjustments are making to the
monitor.

5.) With GSDF enabled, the Gamma button on the touch panel affects the image, emulating the
appearance of that gamma, but does not affect the monitor.
Figure 6-4 Check to Enable GSDF Mode

If a site’s PACS workstations are calibrated to the GSDF, this setting may help to make the image
appearance more uniform between the Ultrasound system and PACS.

+  With GSDF disabled, the monitor still uses a gamma curve that may be selected on the Touch Panel
(for backwards compatibility with sites that are happy with their PACS or may have a mix of older
systems).

+  With GSDF enabled, the gamma button on the touch panel affects the image, emulating the
appearance of that gamma, but does not affect the monitor.
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6-2-4 Advanced monitor adjustments (cont’d)
Test patterns
Test patterns are available to aid in evaluating the display visually and quantitatively.

For complete information, see the appropriate version of the LOGIQ Fortis Basic User Manual,
Chapter 3. See 1-4-1 "Label Location" on page 1-14.

Table 6-3 Test Patterns

Test
Pattern Description Corresponding Graphic

Confirm that you can clearly see all of the different

Gray Bars ) .
gradations of the grayscale in each gray cell.
Confirm that you can clearly see all of the different

Color Bars .
colors in each colored cell.

. Confirm that this image is clear and crisp, without

Resolution . )

jagged edges or lines.
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Table 6-3

Test Patterns (Continued)

Test
Pattern

Description

Corresponding Graphic

Brightness
Contrast

Before making any adjustments, record the settings for
contrast and brightness. In a dimly lit room, adjust the
monitor to Brightness 50 and Contrast 40. Increase the
contrast until the left most block in the second row from
the bottom is just visible.All the remaining blocks in the
last 2 rows of the image should now be visible.Reset
the contrast and brightness to the recorded levels.

LN1to LN18

Luminance for different grayscale levels. Usually, the
facility’s Biomed Engineer tests each gray level map on
the monitor from LN-1 to LN-18 with a light meter and
then graphs these on a scale to ensure that the curve
falls within the GSDF’s standard.

This can be performed with all three LOGIQ Fortis
monitors with GSDF enabled. Generally, this is
performed yearly.

LN-1

LN-18

QC

Quality Control. Confirm that this image is clear and
crisp, without jagged edges or lines.

N3N 3R 3R
A NI EA H3D
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Table 6-3 Test Patterns (Continued)
Test
Pattern Description Corresponding Graphic
CT
Used for Contrast. Confirm that you can detect the circles within
Luminance the square grayscale boxes.
response
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Section 6-3
Monitor Arm and/or Monitor Range of Motion Adjustment

6-3-1 Purpose of this section
This section describes how to adjust the monitor arm and/or monitor range of motion for optimal
performance.
Contents in this section
6-3-1 Purpose of this section . ... ... ... . 6-10
6-3-2 Monitor and Ergotron arm . . . ... ... 6-10
6-3-3 Cautions and Warnings . . . . . ..ot 6-10
6-3-4 Main monitor adjustments. . . ... ... . . 6-11

6-3-2 Monitor and Ergotron arm
These procedures are available for monitor range of motion and monitor vertical adjustment:
*  "Monitor arm vertical adjustment" on page 6-11
*  "Monitor arm tilt adjustment" on page 6-12

6-3-3 Cautions and warnings
Be aware of pinch points at hinges when adjusting the monitor arm and monitor.
Table 6-4 Pinch Point Caution and Warning Icons
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6-3-4

Main monitor adjustments
Monitor arm vertical adjustment

If the monitor rises or falls when it is released, perform a vertical adjustment.

Table 6-5 Monitor Arm Vertical Adjustment

Step Corresponding Graphic

1. Monitor Arm Vertical Adjustment Screw

| —~
SN 1O,

Tilt the monitor down to access the vertical
adjustment screw.

If the monitor was rising, turn the adjustment |
screw clockwise to increase the friction,
using a 4 mm hex wrench.

If the monitor was falling, turn the adjustment
screw counterclockwise to decrease the
friction.

The monitor should stay in the position it is
released at.

NOTE: The heavier the monitor, the more
friction will be required.
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Table 6-6

6-3-4 Main monitor adjustments (cont’d)

Monitor arm tilt adjustment

If the monitor is too loose or too tight when it is tilted, perform a tilt adjustment.

Monitor Arm Tilt Adjustment

Step

Corresponding Graphic

Tilt the monitor down and remove the
monitor rear cover.

If you have a thick wrench, it is easier to
reach the nuts by using the boxed end of the
wrench.

If the monitor is too loose, turn the
adjustment nut (A) towards the back and
nut (B) towards the front to increase the
friction, using a 13 mm wrench.

Turn the nuts the opposite direction to
decrease the friction. The monitor should
stay in the position it is released at.

NOTE: Be sure to tighten or loosen both
sides equally. Start with 1/4 turn and test full
90 degree movement before tightening or
loosening more.

Reinstall the monitor rear cover.

Section 6-3 - Monitor Arm and/or Monitor Range of Motion Adjustment
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Section 6-4
DICOM Server Service Adjustments

6-4-1

6-4-2

Slow response rate between the LOGIQ Fortis and a DICOM (PACS) server

Problems with slow responses may result in images being re-sent automatically and low transfer rates.
If you are experiencing problems with slow responses from a DICOM server, increase the timeout
setting.

To adjust properties for a DICOM server (online):

1.) Navigate to Utility > Connectivity > Service.
2.) Select the service for the DICOM server.
3.) Under Properties, set Timeout (sec) to 360.

Shutdown problems when running a portable LOGIQ Fortis

When portable (offline and not communicating with a PACS server), use the following settings to avoid
problems with shutdown speed:

To adjust properties for a DICOM server (offline):

1.) Navigate to Utility > Connectivity > Service.

2.) Select the service for the DICOM server.

3.) Under Properties, set these parameters:
- Maximum Retries - Set to 0.
- Retry Interval (sec) - Set to the lowest possible value.
- Timeout (sec) - Set to the lowest possible value.

Section 6-5
Volume Navigation (V Nav) Calibration

There is no calibration available in the field. If the registration seems to be out of calibration, reloading
the software will restore the factory settings. If the registration still seems out of calibration, replace the
Volume Navigation (V Nav) hardware.

For information on the hardware replacement, see 8-10-10 "V-Nav Option Replacement" on page 8-239.
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Chapter 7
Diagnostics/Troubleshooting

Section 7-1

Overview

7-11

Purpose of this chapter

This chapter describes how to setup and run the tools and software that help maintain image quality and
system operation. Basic host-, system-, and board-level diagnostics are run whenever power is applied.
Some Service Tools may be run at the application level.

NOTE: The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,

LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

7-1-2 Contents in this chapter
7-1 OVEIVIBW. .« . 7-1
7-2 Service Safety Considerations . . . ... ... .. . 7-2
7-3 Gathering TroubleshootingData. . ... ... .. . 7-3
7-4 Service Deskiop . . ... 7-11
7-5 DIagnostiCs . . . . . 7-90
7-6 Back End Troubleshooting . . . ... ... .. . 7-104
7-7 Connectivity Troubleshooting . . . ... ... .. 7-106
7-8 Electromagnetic Interference (EMI) Troubleshooting. . .. .......... ... .. ... .... 7-113
7-9 Image Troubleshooting. . . ... ... .. 7-114
7-10 Smart Device Apps Troubleshooting ... ... ... . ... . . . . . 7-115
7-11 Boot Issue Troubleshooting ... ... ... . 7-116
7-12 Noise Troubleshooting . . . .. ... ... 7-117
7-13 Options Troubleshooting. . ... ... ... 7-123
7-14 Probes Troubleshooting . . . . ... ... . 7-138
7-15 Peripherals Troubleshooting. . .. ... ... .. . e 7-142
7-16 Setting Troubleshooting . . . ... .. . 7-143
7-17 Scan Assistant Troubleshooting . . . ........ ... . . . 7-144
7-18 Log File Troubleshooting . .. ... ... e 7-145
7-19 System Error with TVD and Sample Volume Length from Utility . ................. 7-151
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Section 7-2
Service Safety Considerations

/\ DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING, AND
ADJUSTING THE LOGIQ Fortis.

/\ DANGER IF A LOGIQ Fortis IS ENERGIZED AND THE NEST EMI BACK BRACKET IS REMOVED,
THE VOLTAGE TEST POINTS POSE A POTENTIAL SHOCK HAZARD.

/\ WARNING IF THE COVERS ARE REMOVED FROM AN OPERATING LOGIQ Fortis, SOME METAL
SURFACES MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD IF
TOUCHED, EVEN WHILE IN SHUTDOWN MODE.

/\ WARNING USE ALL PERSONAL PROTECTION EQUIPMENT (PPE) SUCH AS GLOVES, SAFETY
SHOES, SAFETY GLASSES, AND KNEELING PAD TO REDUCE THE RISK OF INJURY.
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Section 7-3
Gathering Troubleshooting Data

Contents in this section

7-3-1 Purpose of this section. . . ... ... e 7-3

7-3-2 Collecting vital system information. .. ......... ... .. . . 7-4

7-3-3 ShortCUt KeYS . . . .. 7-4

7-3-4 Collecting a screen capture with logs. .. ... ... . 7-5

7-3-5 Capturing network logs to use for troubleshooting. . .. ......................... 7-9
7-3-1 Purpose of this section

Problem images and system data (logs) can be acquired at the LOGIQ Fortis or through service remote
connectivity. Use this data to perform service at the LOGIQ Fortis or to send it back to the manufacturer.
for analysis.

For more information, see:

+ "Diagnostics" on page 7-90

» "Back End Troubleshooting" on page 7-104

»  "Connectivity Troubleshooting" on page 7-106

» "Electromagnetic Interference (EMI) Troubleshooting" on page 7-113
* "Image Troubleshooting" on page 7-114

» "Smart Device Apps Troubleshooting" on page 7-115
*  "Boot Issue Troubleshooting" on page 7-116

*  "Noise Troubleshooting" on page 7-117

»  "Options Troubleshooting" on page 7-123

* "Probes Troubleshooting" on page 7-138

» "Peripherals Troubleshooting" on page 7-142

» "Setting Troubleshooting" on page 7-143

» "Scan Assistant Troubleshooting" on page 7-144

* "Log File Troubleshooting" on page 7-145
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7-3-2 Collecting vital system information

The following information is necessary to properly analyze data or images being reported as a
malfunction or a LOGIQ Fortis being returned to the manufacturer:

NOTE: This information is normally collected with Alt+D or Gather Logs.

Product Name = LOGIQ Fortis

Navigate to Utility > System > About.

Record the Package Type, Release Information and Part Number for the following:

- Application Software

- Service Platform
- Security Package
- Base Image

- Base Image Update

7-3-3 Shortcut keys

There are several shortcut keys on the LOGIQ Fortis that can be useful during troubleshooting:

Table 7-1 Shortcut Keys

Key

Description

Alt+1 or Alt+2

Marks events in the log file. Used for the flagging issues during operation.

Alt+F10

Displays SW Shut Down. If the LOGIQ Fortis can be shut-down by using these keys, it
means that SW is working and the problem could be the ON/OFF switch or the wire that
carries the shut-down signal.

Alt+F5 and F11

For the echo simulator (keyboard simulation), brings up or removes the front panel
simulator. It may be used with VCO to press buttons on the front panel that are not standard
keys on your PC.

F4 and F12

Displays the DICOM Job Spooler.

Alt+A

Displays a cursor (Alt+A stands for arrow).

Alt+D

Captures scanner logs.

Alt+Ctrl+D

With the SSA key connected, displays the Debug command window to run Sclogs.

Alt+Tab

With the SSA key connected, switches between screens. Access Windows and relaunch
the application to use this functionality.
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7-3-4

Collecting a screen capture with logs

If the LOGIQ Fortis malfunctions, simultaneously press the Alt+D keys. Alt+D is available at all times
and collects a screen capture of the image monitor, user-defined presets, and these logs:

Keyboard Shadow Log (protected information)
Error Logs

Crash Log (protected information)

Vital Product Data

DICOM Logs

Windows Event Logs

Windows Modem Log

Diagnostic Logs

Service Logs

For a detailed list of Service Logs captured,
see 7-3-5 "Capturing network logs to use for troubleshooting” on page 7-9.

Figure 7-1 ALT+D Dialog Box
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7-3-4  Collecting a screen capture with logs (cont’d)

NOTE:

To collect a screen capture with logs:

1.
2.)

3)

4)
5)
6.)

Press Alt+D. The System Problem Reporting dialog box opens.
Enter the following information:

- System ID serial number

- Software version

- System date and time of occurrence

- Sequence of events leading to issue

- Whether the issue is repeatable

- Imaging mode, probe, preset/application

- Media brand, speed, capacity, and type

To authorize the collection of protected information, check Include Protected Information,
requires Admin privileges. If this box is checked, the LOGIQ Fortis creates two log files with the
following format name:

- log_<SN> <DATE>_<TIME>_DB.zip

- log_<SN> <DATE>_ <TIME>_Protectedinfo_DB.zip

Where <SN> is the serial number, <DATE> is the date in format YYMMDD and <TIME> is the time
in format HHMMSS.
To include a duration, check Time Duration and select a duration from the dropdown.

Under Destination, select a storage media or Service directory for remote viewing.
Click the Store button.

To save to a CD/DVD or USB Flash Drive, you MUST select CD/DVD Recordable or USB drive
as the destination device, otherwise the data is written to the default Export/Service directory
on the hard drive. The Export/Service directory is only used for remote service and is not
intended for images or report storage use.

For a CD/DVD, the LOGIQ Fortis automatically formats an unformatted disk, gathers logs and writes it
out to the disk.

The subsequent file is compressed and time stamped. The screen capture is a bitmap which eliminates
the possibility of artifacts from compression.
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7-3-4  Collecting a screen capture with logs (cont’d)

Double check the media that you made to ensure it contains the file. An example is
shown in Figure 7-2 "Example of Zipped Trouble Image and Logs File" on page 7-7.

Figure 7-2 Example of Zipped Trouble Image and Logs File

| Pt DriveTools  DVD RW Drive (G:) 20171130_01
“ Home Share Vigys Manage
1Hi 15) | L
&« B » ThisPC » DVD RW Drive {G:) 2017113001 » (7]
- D

O Name Date mo

# Quick access
BB Deskiop
4 Downloads
5| Expost

O § log_EE0021_171130_142020 DB

= Pictures

& This PC
I Desktop
%| Documents
B Downloads
Ji Music
& Pictures
B videos
i System (C1)
= User (D)
= ARCHIVE (E)
. SECURE KEY (F:)
DVD RW Drrive (G:) 20171130_01
DVD RW Drive (G:) 20171130_01
= Reposit (Z:)

Figure 7-3 Contents of the Zipped Trouble Image and Logs File
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# Chiek aceess
I
B Deskiop b
Scanner
& Downisads
5 Expont
& Pictures
Doug
% loghie_171130_ 142020 descs
BB Thas PC
Il Deskiop
% Documents

- SEC ¥
DVD RW Drive (G:) 20171130_01

Mark log files

If a customer is experiencing issues during operation, mark the issue by pressing Alt+1 or Alt+2 when
the event occurs. When Alt+1 or Alt+2 is pressed, a marker is placed in the log to aid analysis.
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7-3-4  Collecting a screen capture with logs (cont’d)
Trouble image without patient information

To collect a trouble image you need to enable Transfer Images (captured without patient information)
to GE under ADMIN > System Admin.

To collect the image, press the P1 key (copy to hard drive). This places an unidentified .jpeg image in
the D:\Log \DL folder. This folder will be transferred to the back office if a transfer is scheduled.

Figure 7-4 Example of a Trouble Image Collected with P1

To collect logs using Gather Logs, the image or images will be captured in the log collection Zip file and
will be deleted from the D:\Log \DL folder.

Figure 7-5 Example of a Trouble Image Collected with Gather Logs

- o
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7-3-5

Capturing network logs to use for troubleshooting

Use the Network Capture utility to capture network logs. Once the logs are captured and extracted from
the LOGIQ Fortis, use Microsoft Message Analyzer to convert the output, and then Wireshark (or some
other network sniffer) to analyze it.

To troubleshoot network capture logs:

1.) On the LOGIQ Fortis, run the Network Capture utility to generate .etl and .cab files for analysis.
For more information, see "Network Capture" on page 7-68.

2.) Locate the .etl file at D:\Service.

3.) Transfer these files to a laptop.

4.) On the laptop, download Microsoft Message Analyzer (if not already done).
5.) In Microsoft Message Analyzer, open the .etl file.

If the DICOM connection is encrypted, you will not be able to see the contents of the packets.
Microsoft Message Analyzer does not have a plug-in to decode DICOM packets.

o =

...............

Mesige track 1

B rbooesbbbsbbbbbsbbbbbs
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6.) To export the .etl file to .cab, select File > Save As and then select Save As or Export.

Fe Semie  Too  Wep

Save/Export Session; trace

Step 1: Select Data

g For Arsysis G e

Step 2: Save or Bxport

=

Lo da

Saving an matp inchudes ol parsed S5t Mg Tatter adeg whan opesed

S22 a2 dddad ]y

B
¥

b

If the network capture was of a wireless connection, Microsoft Message Analyzer creates a .pcap
file that does not have any of the packets and is probably useless.

7.) Use Wireshark or some other third-party network sniffer to examine the .cab file.
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Section 7-4
Service Desktop

7-4-1

Contents in this section

7-4-1 Purpose of thissection. . ... ... . . . . . .
7-4-2 Disruptive mode . . ... ... . e
7-4-3 Color statuses. . . . ...
7-4-4 Service Classes . . ... oo
7-4-5 Home . . e
7-4-6 Diags . .
7-4-7 DICOM . .
7-4-8 Utilities . . .
7-4-9 OPtIONS .
7-4-10  Agent Configuration . .. .. ... .
7-4-11  Software Maintenance . .. .......... .. .

Purpose of this section

This section describes the features of the Service desktop. These are the different levels of access to

the Service desktop:

» Service Basic access (Class A) — a user locally logged into the machine with Local Service Access

privilege. This level provides limited access to Service desktop widgets and utilities.

» Service Expert, Pro, and Advanced access (Class C) Local — Depending on the purchase level,

includes an option string to control access.

* GE Service access (Class M) and an SSA key. For users with local Service Access privileges, this

level provides unrestricted access to all Service desktop widgets and ultilities.

* Remote access — a user remotely accessing the LOGIQ Fortis. This level provides unrestricted
access to all Service desktop widgets and utilities. Disruptive mode is limited to the user access

privileges to Remote Service Access.
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7-4-2

Disruptive mode

Disruptive mode is a way to control interruptions to operation of the LOGIQ Fortis. Disruptive mode is
required whenever service performs a function that may disrupt a normal scan. Activating Disruptive

mode results in a red message displayed on the task bar. This message indicates that the LOGIQ Fortis
needs to be restarted once the service activity is complete. The message remains until the LOGIQ Fortis
is restarted. This prevents patient scanning while the LOGIQ Fortis is not operating at an optimal status.
For example, running a diagnostic may leave the LOGIQ Fortis in a state that is not good for imaging.

Specifically, Disruptive mode is required to run diagnostics, clean presets, and reset the patient
database, and turn on Virtual Console Observation (VCO).

*  When Disruptive mode is On, all service functionality on the Service desktop is allowed but user
operation of the LOGIQ Fortis may be limited.

*  When Disruptive mode is Off, some service functionality on the Service desktop is not available and
user operation of the LOGIQ Fortis is normal.

Additionally, the ability to enable Disruptive mode depends on the logged in user.

» Local user —a user locally logged into the machine will be able to set the LOGIQ Fortis to Disruptive
mode or allow a Disruptive mode request from a remote user through the Service desktop. The local
user must have Authorize Remote Service Access to allow Disruptive mode. If the local user does
not have this right, the remote user’s request will be automatically denied.

* Remote user — a user remotely accessing the LOGIQ Fortis will not be able to automatically switch
Disruptive mode to On. The logged in user (user actually logged on to the LOGIQ Fortis) needs to
have the ability to grant remote access. The logged in user will be notified through a dialog box and
asked to allow Disruptive mode.

NOTE: Change Password and Disk Defragment are not available for the remote user whether
Disruptive mode is On or Off.
For more information, see "Disruptive Mode" on page 7-65.
7-4-3 Color statuses

Throughout the Service desktop, colors indicate the following:
* Green — Status is normal
+ Orange — Status is a warning
* Red - Status is an error
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7-4-4

NOTE:

Service Classes

With Service Basic Access (Class A), these are the available options:

HOME

Utilities

- Change Password

- Data Transfer

- Delete Files

- Gather Logs

- Network Capture

- Resolve Agent Quarantine
- Secure Delete

- SSA License

- Third Party Licenses
Options

Agent Configuration
Software maintenance

With Service Advanced (Class C), these are the available options:

With a Class C license, options display according to these purchased level of access.

HOME

Diags

DICOM

Utilities

- Backup and Clean LogDb
- Change Password

- Checkpoints

- Data Transfer

- Delete Files

- Disk Defragment

- Disruptive Mode Utility

- Gather Logs

- Network Capture

- Resolve Agent Quarantine
- Secure Delete

- SSA License

- Third Party Licenses

- Virtual Console Observation
Options

Agent Configuration

Software maintenance
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7-4-4  Service Classes (cont’d)

With Service Advanced plus Service Expert (Class C), the Clean Userdefs, Reset Patient Database,
Secure Delete, and Software Reload utilities are added to the Service Advanced options listed.

With Service Advanced and Service Expert plus Service PRO (Class C), the probe assessment tool
(e-PAT) diagnostic is added to the Service Advanced and Service Expert options listed.
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7-4-4  Service Classes (cont’d)

With GE Service access (Class M) and an SSA key, these are the available options:

+ HOME
+ Diags

« DICOM
+  Utilities

- Backup and Clean LogDb
- Change Password (not available through a remote connection)
- Checkpoints
- Clean Userdefs
- Data Transfer
- Delete Files
- Disable Remote Connectivity
- Disk Defragment (not available through a remote connection)
- Disruptive Mode Utility
- Gather Logs
- Network Capture
- Reset Patient Database
- Reset Log Database
- Resolve Agent Quarantine
- Secure Delete (not available through a remote connection)
- Software Reload
- SSA License
- SSH
- System Shutdown
- Third Party Licenses
- Virtual Console Observation
* Options
» Agent Configuration
+  Software Maintenance
For more information, see Section 5-5 "Service Desktop Description" on page 5-19.
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7-4-5 Home

Home configurations vary depending upon the purchased service level.

Figure 7-6 Home with Class C and Class M Access

Figure 7-7 Home with Class A Access

For more information, see:

+ "System Information" on page 7-17

+ "Software Status" on page 7-19

+ "System Status" on page 7-20

» "Disk Drive Space" on page 7-34

»  "Network Configuration" on page 7-39
» "Connected Probes" on page 7-41
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7-4-5 Home (cont’d)

System Information

System Information displays general information about the LOGIQ Fortis. When the LOGIQ Fortis has
been successfully configured with the back office, these elements will have the corresponding values:

» Agent Registered will be Yes

+ Agent Quarantine will be No

» Agent CRM Verified will be Yes

The information on System Information is available to all service class licenses.

To access System Information, navigate to Utility (second page) > Service > Home.

Figure 7-8 System Information

@ Systemn Information

CRM Number 1 INEER_E70012
Agent Registered

Agent Quarantine

Agent CRM Verified

Agent Connected

Model Number DO0OP4

Serial Number engineer_E70012
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7-4-5 Home (cont’d)
This table shows all the elements available on System Information with descriptions.

Table 7-2 System Information

Element Description

Customer Relationship Management (CRM) number. System identifier assigned to

CRM Number the customer unit by the service region.

Registered status of the agent. Valid values are:

* Yes — The agent is registered in the back office.

* No — The agent is not registered in the back office.

* Not Available — The agent is not running or has not been configured.

Agent Registered

Quarantine status of the agent. Valid values are:

* Yes — The agent has more than one device registered with the same CRM Number
in the back office.

* No — The agent has one device registered with the listed CRM Number in the back
office.

» Not Available — The agent is not running or has not been configured.

Agent Quarantine

CRM verified status of the agent. Valid values are:

* Yes — The agent is verified in the back office.

» No — The agent is not verified in the back office.

» Not Available — The agent is not running or has not been configured.

Agent CRM Verified

Connection status of the agent. Valid values are:

* Yes — The agent is connected to the back office.

» No — The agent is not connected to the back office.
Not Available — The agent is not configured or running.

Agent Connected

Model Number GE part number for the LOGIQ Fortis. The same number as listed on the rating plate.
Serial Number Serial number of the LOGIQ Fortis. The same number as listed on the rating plate.
System Type Product name of the LOGIQ Fortis.

Facility Name of the hospital or facility where the LOGIQ Fortis is installed.

For more information, see:

*+  "Home" on page 7-16
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7-4-5 Home (cont’d)

Software Status

Use Software Status to view general information about the software installed on the LOGIQ Fortis.

The information on Software Status is available to all service class licenses.

To access Software Status, navigate to Utility (second page) > Service > Home.

Figure 7-9 Software Status

This table shows all the elements available on Software Status with descriptions.

Table 7-3 Software Status

Element

Description

System Date

Current date in the format <day>, <month> <date> <year>.

System Time

Local time based on the last time the desktop was refreshed in the format
<hh:mm:ss>.

Application Installation Date

Date the application software was installed. The application software includes the
LOGIQ Fortis product-specific software.

Base Image Installation Date

Date the base image software was installed. The base image software includes the
Windows operating system and other supporting software.

Base Image Version

Version number (part number) of the base image software.

Application Software Version

Version number of the application software.

Application Status

Status of the application. Valid values are:
* Running
+ Stopped

For more information, see:

*+  "Home" on page 7-16

» "Software Reload" on page 7-78
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7-4-5

Home (cont’d)

System Status

Use System Status to view status information on the LOGIQ Fortis. Specifically, do the following:

View the hardware configuration file

View temperatures for FRUs and a graphical representation of the monitored temperatures
View statuses of the batteries

View voltages for FRUs.

View issues with the boot process

View alert logs

View logs that occurred before and after an error

View USB devices connected to the LOGIQ Fortis

View the amount of time the LOGIQ Fortis has been running

View the amount of time since the LOGIQ Fortis has last been rebooted

The information on System Status is available to Class C and Class M licenses.

To access System Status, navigate to Utility (second page) > Service > Home.

Figure 7-10 System Status

Section 7-4 - Service Desktop



Direction 5874372, Rev. 3

GE CONFIDENTIAL

LOGIQ Fortis Proprietary Service Manual

7-4-5 Home (cont’d)

This table shows all the elements available on System Status with descriptions.

Table 7-4 System Status

Element

Description

Hardware Configuration

Displays the contents of the hardware configuration file.

Displays the temperature monitoring of the LOGIQ Fortis as normal, warning, or
error using the standard colors and icons. Includes temperature out-of-spec events

Temperature including an overall count of event warnings and errors for the last 30 days or the
last status checkpoint whichever is sooner. Temperature displays temperature a
graph for the configured monitoring points.

Battery Status Displays the battery monitoring of the LOGIQ Fortis.

Displays the voltage monitoring of the LOGIQ Fortis as normal, warning or error

Voltage using the standard colors and icons. Includes voltage out-of-spec events including

an overall count of the event warnings and errors for the last 30 days or last status
checkpoint whichever is sooner.

Bootup Issues

Based on the latest occurrence, displays all abnormal boots of the LOGIQ Fortis for
either the past 30 days or the latest check point.

Alert Logs

Based on the latest occurrence, displays all alerts generated by the LOGIQ Fortis
for either the past 30 days or the latest check point.

Log Analyzer

Displays a list of errors and associated log files for troubleshooting.

USB Devices

Displays the USB connected devices and their status.

System On Time

Displays the time the LOGIQ Fortis was turned on.

Time Since Last Reboot

Displays the time the LOGIQ Fortis was last rebooted.

For more information, see:

* "Hardware Configuration"

on page 7-22

+ "Temperature" on page 7-23
+ "Battery Status" on page 7-26

+ "Voltage" on page 7-28
*  "Bootup Issues" on page

7-30

+ "Alert Logs" on page 7-32
» "USB Devices" on page 7-33

*+  "Home" on page 7-16
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7-4-5

Home (cont’d)

Hardware Configuration

Hardware Configuration displays the contents of the hardware configuration file which includes all the
vital product data (VPD).

To access Hardware Configuration, navigate to Utility (second page) > Service > Home, and then

under System Status, select Hardware Configuration.

Figure 7-11 Hardware Configuration

This table shows all the elements available on Hardware Configuration with descriptions.

Table 7-5 Hardware Configuration
Element Description
Component Hardware component.
Item Parameter with the vital product data (VPD).
Value Actual value of the Item.

For more information, see:

+ "System Status" on page 7-20
+ "Home" on page 7-16
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7-4-5 Home (cont’d)
Temperature

Use Temperature to troubleshoot problems with monitored FRUs. Specifically, use these pages:

+ FRU Status

* Graphs

To access Temperature, navigate to Utility (second page) > Service > Home, and then under
System Status, select Temperature.

For more information, see:

* "FRU Status" on page 7-24

* "Graphs" on page 7-25

+ "System Status" on page 7-20
*+ "Home" on page 7-16
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7-4-5 Home (cont’d)
FRU Status
FRU Status displays a summary of the FRUs being monitored and the details for each FRU.

To access this page, under System Status, select Temperature and then select FRU Status.

Figure 7-12 FRU Status
} Temperature Monitoring

being monitored

This table shows all the elements available on FRU Status with descriptions.

Table 7-6 FRU Status

Element Description

FRU Status Summary Number of the FRUs being monitored.

FRU Status Details

Name Name of the FRU.

Status of the FRU. Valid values are:
« Normal — Indicates that the FRU is operating within the allowable range.

Status « Warning — Indicates that the FRU is operating close to the limit of the allowable range.
« Error — Indicates that the FRU is operating outside the allowable range.

Lower Limit Warning Number of low temperature warnings.

Upper Limit Warning Number of high temperature warnings.

Lower Limit Errors Number of low temperature errors.

Upper Limit Errors Number of high temperature errors.

For more information, see:

+ "Temperature" on page 7-23
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Graphs

Graphs displays trend graphs for selected elements which have been selected as key indicators of
overall temperature status inside the card rack.

To access this page, under System Status, select Temperature and then select Graphs.

Figure 7-13 Graphs

l Temperature Monitoring

Trend A C TURE Temperature Trend

For more information, see:

+ "Temperature" on page 7-23
+ "Home" on page 7-16
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7-4-5 Home (cont’d)

Battery Status

Battery Status displays details for each battery.

To access Battery Status, navigate to Utility (second page) > Service > Home, and then under

System Status, select Battery Status.

Figure 7-14 Battery Status
This table shows all the elements available on Battery Status with descriptions.
Table 7-7 Battery Status
Element Description

Type of the batteries. Valid values are:
* No battery — Indicates that no batteries are present.

Battery Type . .
« EPS only — Indicates that the extended power shutdown batteries are used.
» Power Assistant — Indicates that the power assistant batteries are used.
Status of the batteries. Valid values are:

Battery Status * Normal — Indicates that batteries are charging or fully charged.
» Error — Indicates a problem with the batteries.
Status of the batteries concerning charging. Valid values are:

Charging Status » Charging — Indicates that the batteries are charging.
+ Discharging — Indicates that the batteries are discharging.
Deterioration state of the batteries. Valid values are:

Deteriorated * Yes — Indicates that there is a problem with one or both of the batteries.
* No - Indicates that the batteries are operating normally.

Right PA Battery .

Charge Percentage Percentage of the right battery charge.
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Table 7-7 Battery Status

Element

Description

Left PA Battery
Charge Percentage

Percentage of the left battery charge.
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7-4-5

Home (cont’d)

Voltage

Use Voltage to troubleshoot problems with monitored FRUs of the LOGIQ Fortis. Specifically, use these
pages:
+ FRU Status

To access Voltage, navigate to Utility (second page) > Service > Home, and then under System
Status, select Voltage.

For more information, see:

* "FRU Status" on page 7-28
+ "System Status" on page 7-20
*+  "Home" on page 7-16

NOTE: AC voltage monitoring is not available on LOGIQ Fortis.
FRU Status
FRU Status displays a summary of the voltages for the FRUs being monitored and the details for each
FRU.
To access this page, under System Status, select Voltage and then select FRU Status.

Figure 7-15 FRU Status
% \Joltage Monitoring Einas
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7-4-5 Home (cont’d)

This table shows all the elements available on FRU Status with descriptions.

Table 7-8 FRU Status

Element Description
Name Name of the FRU.
Status of the voltage for the FRU. Valid values are:
* Normal — Indicates that the voltage is within the allowable range.
Status

+ Error — Indicates that the voltage is outside the allowable range.

» Warning — Indicates that the voltage is close to the limit of the allowable range.

Lower Limit Warnings

Number of low limit voltage warnings.

Upper Limit Warnings

Number of high limit voltage warnings.

Lower Limit Errors

Number of low limit voltage errors.

Upper Limit Errors

Number of high limit voltage errors.

For more information, see:

*  "Voltage" on page 7-28
+ "Home" on page 7-16
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7-4-5 Home (cont’d)
Bootup Issues

Bootup Issues displays a summary of bootup issues detected by the LOGIQ Fortis that prevented
normal scanning, shutdowns, or abnormal statuses.

To access this page, under System Status, select Bootup Issues.

Figure 7-16 Bootup Issues

@ Bootup lssues

4T3 18 0RSETR14B0000 D800

Figure 7-17 Bootup Issues with Missing Devices

W Bootup Issues
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7-4-5

Home (cont’d)

This table shows all the elements available on Bootup Issues with descriptions.

Table 7-9 Bootup Issues

Element Description
D Identifier for the LOGIQ Fortis software boot. For example, 10 for the tenth boot and
SO on.
Timestamp Date and time that the associated issue for the boot occurred.
Number of times EcholLoader was restarted during the associated boot.
Cycle Count * 0 — Normal. EchoLoader started without attempting a restart.

* 1 or more — Indicates the number if times EcholLoader attempted to restart.

Missing Devices

Displays the devices that were missing during the boot.

Incompatible Board

Displays whether an incompatible board exists.

Battery State ID

Type of battery detected. For example, EPS or PA. Invalid displays if no battery was
detected.

Previous Boot Crash Dump

Displays whether a crash dump has occurred. Valid values are:
* 1 —Indicates a crash dump has occurred in the previous boot.
* 0 — Normal. No crash dump has occurred.

Displays whether a warm boot has occurred. Valid values are:

Warm Boot * 1 - The LOGIQ Fortis was rebooted.
* 0—The LOGIQ Fortis was started after a shutdown.
AC Fail AC Fail is not available on LOGIQ Fortis.

Abnormal Context

Displays whether the software has booted to a stable state (Interface manager
successfully initiated). Valid values are:

» 1-The LOGIQ Fortis has not booted to a stable state. Only abnormal logs display.
» 0 — Normal. The LOGIQ Fortis initialized to a stable state.

Exit Requested

Displays the type of exit that has been requested. For example, 4 displays the
operating system was restarted.

Echoloader Exit Code

Displays the exit code generated by EchoLoader. 0 indicates that Echoloader exited
without any issues.

Echoloader Exit String

Displays the type of exit requested by EcholLoader. For example, restart the
operating system or exit the application software.

For more information, see:

+ "System Status" on page
*+  "Home" on page 7-16

7-20
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Alert Logs

Alert Logs displays the details for each alert. Alerts are status logs typically reported as a result of an
error. Alerts are sent to the back office to be managed and reported to service.

To access this page, under System Status, select Alert Logs.

Figure 7-18 Alert Logs

This table shows all the elements available on Alert Logs with descriptions.

Table 7-10  Alert Logs

Element Description
Alert ID Identifier for the alert log that has been sent to the back office.
Sub System Hardware component.
Rule Code for the alert. Alerts are filtered in the back office using rule codes.
Description Description of the alert log.
Value Current value read for the associated hardware component.
Lower Limit Value for the lower limit for the associated hardware component.
Upper Limit Value for the upper limit for the associated hardware component.

Severity of the alert. These are the valid values:

. * 1 — Error. Out of specification
Severity

* 2 —Warning
* 3 —Normal
First Alert Time Time the alert first occurred.
Last Alert Time Time the alert last occurred.
Last Alert Local Time Time (local) the alert last occurred.
Last Alert Sent Time Time the alert was last sent to the back office.
Count Number of times that the alert has occurred.

For more information, see:

+ "System Status" on page 7-20
+ "Home" on page 7-16
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7-4-5 Home (cont’d)
USB Devices
USB Devices displays the details for each USB device.

To access this page, under System Status, select USB Devices.

Figure 7-19 USB Devices

This table shows all the elements available on USB Devices with descriptions.

Table 7-11  USB Devices

Element Description
Name Name of the USB device.
Serial Number Serial number of the USB device.
Speed Speed of the USB device. For example, USB 3.0.
HW Version Hardware version of the USB device.
SW Version Software version of the USB device.
Status Status of the USB device.

For more information, see:

+ "System Status" on page 7-20
+ "Home" on page 7-16
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7-4-5

Home (cont’d)

Disk Drive Space

Use Disk Drive Space to view the hard drive partitions including total size and available free space in
GB. Includes the overall health of the drive in one of these colors:

* Red - Available free space is less than 10% of the total size.
+ Orange — Available free space is more than 10% and less than 20% of the total size.

» Green — Available free space is more than 20% of the total size.
Each partition displays these encryption statuses:

+ Conversion status

* Percentage encrypted

*  Encryption method

* Protection status

* Lock status

The information on Disk Drive Space is available to Class C and Class M licenses.

To access Disk Drive Space, navigate to Utility (second page) > Service > Home.

Figure 7-20 Disk Drive Space
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7-4-5 Home (cont’d)

Figure 7-21 E: Drive Details

Encryption Status

Conversion status Fully Decrypted

Percentage encrypted 0.0%
Encryption method None
Protection status Protection Off

Lock status Unlocked
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7-4-5 Home (cont’d)
This table shows all the elements available on Disk Drive Space with descriptions.

Table 7-12  Disk Drive Space

Element Description

C: partition shows the graphical representation of the following:
C: Drive » Used space in GB
* Available free space in GB

D: partition shows the graphical representation of the following:
* Service

* Logs

* Temp

» Export

+ Service configuration

* Misc

* Available free space in GB

D: Drive

E: partition shows the graphical representation of the following:
* Print spooler

* Clipboard

» DICOM spooler

* Misc

» Available free space in GB

E: Drive

V: partition shows the graphical representation of the following:
V: Drive » Misc
« Available free space in GB

Z: partition shows the graphical representation of the following:
« Package repository

» Misc

« Available free space in GB

Z: Drive

For more information, see:

+ "Home" on page 7-16
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7-4-5 Home (cont’d)
Smart Disk Details
Smart Disk Details displays general information for the following drives:

» Solid State Drive (SSD) — Displays SMART disk.
The information on Smart Disk Details is available to Class C and Class M.

To access Smart Disk Details, navigate to Utility (second page) > Service > Home > Disk Drive
Space and then select Smart Disk Details.

Figure 7-22 Solid State Drive (SSD) Details
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This table shows all the elements available on Smart Disk Details with descriptions.
Table 7-13  Smart Disk Details
Element Description
Serial No Serial number for the disk drive (SSD or HD).
Firmware Version Version number for the firmware installed on the disk drive (SSD or HD).
Drive Letter Drive letters associated with the disk drive.
Time Collected Time the details for the disk were collected in YYYY-MM-DDThh:mm:ssZ format.
Index Number associated with the disk drive attribute.
Name Name of the disk drive attribute.
Value Value for the disk drive attribute.
Threshold Threshold for the value of the disk drive attribute.
Worst Lowest value recorded for the disk drive attribute.
Raw Value determined by the drive manufacturer.
Type associated with the disk drive attribute. These are the valid values:
Type + OldAge
* Prefail
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7-4-5 Home (cont’d)
Network Configuration

Use Network Configuration to view network (wired and wireless) information (the full ipconfig details)
for the network configured with the LOGIQ Fortis.

The information on Network Configuration is available to Class C and Class M licenses.

To access Network Configuration, navigate to Utility (second page) > Service > Home.

Figure 7-23 Network Configuration
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This table shows all the elements available on Network Configuration with descriptions.

Table 7-14 Network Configuration

Element Description
Host Name Name of the local host for the LOGIQ Fortis.
More Details Displays the ipconfig details.

Wired Connection

IpV4 Address

Local IP address for the wired network connection.

IpV6 Address

Local IP address for the wired network connection.

Subnet Mask

Local subnet mask for the wired network.

Default Gateway

Default gateway for the wired network.

MAC Address

Address for the MAC for the wired network.

Speed (Mbps)

Speed of the wireless connection.

Wireless Connection

IP Address

IP address for the wireless network connection.

Subnet Mask

Subnet mask for the wireless connection.

Default Gateway

Default gateway for the wireless connection.

MAC Address

Address for the MAC for the wireless connection.

Speed (Mbps)

Speed of the wireless connection.

Status

Current status of the wireless connection.

For more information, see:

*+  "Home" on page 7-16
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7-4-5 Home (cont’d)

Connected Probes

Connected Probes shows probes connected to the LOGIQ Fortis. The order on the user interface is
top down matching the left-to-right order on the LOGIQ Fortis.

The information on Connected Probes is available to all service class licenses.

To access Connected Probes, navigate to Utility (second page) > Service > Home.

Figure 7-25 Connected Probes

This table shows all the elements available on Connected Probes with descriptions.

Table 7-15 Connected Probes

Element Description

) When available, temperature of the active probe.
Active Probe Temperature

(Celsius) Not all probes report temperature. The most common probe to report temperature is
the TEE probe.

Probe Name Name of the probe connected to the LOGIQ Fortis.

Probe ID Identifier of the probe connected to the LOGIQ Fortis.

Serial number of the probe connected to the LOGIQ Fortis. If the serial number of

Serial Number the probe is not available, then N/A displays.

Statuses of the probe connected to the LOGIQ Fortis. Valid values are:
Status « Active

« Non Active

For more information, see:

*+ "Home" on page 7-16

Chapter 7 Diagnostics/Troubleshooting 7-41



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

7-4-6

Diags

Use Diags to troubleshoot functionality with hardware components. With an active Service PRO
license, probe diagnostics will be available. Specifically, use these pages:

* Run Diags — Run diagnostics on hardware components.
+ Diag History — View a history of the diagnostics you have run and the results.

NOTE: Reboot the LOGIQ Fortis after performing any diagnostics before returning the LOGIQ Fortis to
customer use.
For more information, see:
* "Run Diags" on page 7-42
+ "Diag History" on page 7-45
» "Diagnostics" on page 7-90
Run Diags
With Disruptive mode set to On, use Run Diags to run diagnostics on hardware components with the
LOGIQ Fortis. For information on disruptive mode, see "Disruptive Mode" on page 7-65.
The information on Run Diags is available to Class C and Class M licenses.
To access Run Diags, navigate to Utility (second page) > Service > Diags > Run Diags.
Figure 7-26 Run Diags
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7-4-6

Diags (cont’d)

This table shows all the elements available on Run Diags with descriptions.

Table 7-16 Run Diags

Element

Description

Service Menu

Available service diagnostics in a diagnostics tree.

Engineering Menu

Available engineering diagnostics in a diagnostics tree.

Clear All

Resets the selections within the diagnostics tree.

Selected Diagnostics

Diagnostics that have been selected.

Diagnostic Detail

Test Name

Name of the diagnostic.

Last Execution Result

Result of the diagnostic run.

Expected Execution Time

Time expected to run the diagnostic.

Maximum Execution Time

Maximum amount of time allowed to run the diagnostic.

Instruction

Special instructions needed in order to perform the diagnostic.

Diagnostic Controls

Execution Mode

Way the diagnostic behaves when a failure occurs. Valid values are:
+ Continue on Failure

« Finish Loop and Stop on Failure

« Stop on Failure

Loop Count Number of times to run the selected diagnostic.
Start Starts the selected diagnostic.

Stop Stops the selected diagnostic.

Reset Clears the current diagnostic information.

Total Progress

Current Progress

Progress the current diagnostic.

Total Progress

Progress for all of the selected diagnostics.

Diagnostic Results Summary

Diag Name Name of the diagnostic.
Date/Time Date and time of the diagnostic run.
Diag Run Time Amount of time taken to run the diagnostic.

Overall Status

Current status of the diagnostic.

Pass/Fail

Whether the selected diagnostic passed or failed.
« Green — Diagnostic passed
* Red - Diagnostic failed
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7-4-6 Diags (cont’d)
To run a diagnostic:

1.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set
Disruptive mode to On.

2.) Navigate to Utility (second page) > Service > Diags > Run Diags.

3.) From the Service Menu tab, select the diagnostic (For example, DPI_L). The Selected
Diagnostics and Diagnostic Detail areas populate with information specific to the selected
diagnostic.

4.) In Execution Mode, select the desired mode.
5.) In Loop Count, select the number of times to run the diagnostic.
6.) Click Start.

7.) View progress in the Total Progress area.
8.) View the results (Passed or Failed) in the Diagnostic Results Summary area.

9.) To view details about the diagnostics run, see "Diag History" on page 7-45.
For more information, see:

+ "Diags" on page 7-42

» "Diag History" on page 7-45

7-44 Section 7-4 - Service Desktop



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual
7-4-6 Diags (cont’d)
Diag History

Use Diag History to view a history of the diagnostics run on the LOGIQ Fortis and the results.
The information on Diag History is available to Class C and Class M licenses.

To access Diag History, navigate to Utility (second page) > Service > Diags > Diag History.

Figure 7-27 Diag History

This table shows all the elements available on Diag History with descriptions.

Table 7-17 Diag History

Element Description

Checkpoints

Select All Selects all of the available checkpoints in the list.
Controls

All Filters results to show all of the diagnostics.
Failed Filters results to show failed diagnostics.

Get History Select to display a history of the run diagnostics.
Runs

List of diagnostics run on the LOGIQ Fortis.

Diagnostic Results History

Details about the diagnostics run.
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7-4-6 Diags (cont’d)

To view a history of diagnostics:

1.) Navigate to Utility (second page) > Service > Diags > Diag History.
2.) Select the options that you want to view.

3.) Click Get History.

4.) View the results of your query.

5.) To view specific details, click Details

Last Start Time:

Diog Run Time

For more information, see:

+ "Diags" on page 7-42
* "Run Diags" on page 7-42

7-46 Section 7-4 - Service Desktop



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

7-4-6 Diags (cont’d)
Operator Test Panel
In LOGIQ Fortis uses Operator Test Panel to test the following controls:

- LEDs

* A/N Keyboard

»  Buttons/Joysticks

* Encorders

The information on Operator Test Panel is available to Class C and Class M.

To access Operator Test Panel, navigate to Utility (second page) > Service > Diags >
Operator Test Panel.

Figure 7-28 Operator Test Panel

Operator Panel Tests Lawes Opasator Panal Tasts
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DICOM

Use DICOM to troubleshoot DICOM components and connectivity. Specifically, use these pages:

 DICOM Service Status
» DICOM Spooler
For more information, see:

+ "DICOM Service Status" on page 7-48

+ "DICOM Spooler" on page 7-50

DICOM Service Status

DICOM Service Status displays information on the DICOM components and connectivity. Use DICOM

to test the connectivity of all the available DICOM devices or individual DICOM devices. In addition, you
can:

* View DICOM details

* View DICOM connectivity status

+ Stop a service

* Ping a single service

* Ping all services

DICOM connectivity status displays as green or red.

* Green means that the DICOM ping passed
* Red means that the DICOM ping failed
The information on DICOM Service Status is available to Class C and Class M licenses.

To access DICOM Service Status, navigate to Utility (second page) > Service > DICOM > DICOM
Service Status.

Figure 7-29 DICOM Service Status
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7-4-7 DICOM (cont’d)
This table shows all the elements available on DICOM Service Status with descriptions.

Table 7-18 DICOM Service Status

Element Description
DICOM Details
AE Title of Console Application entity title of the LOGIQ Fortis.
Port No of Console Port number of the LOGIQ Fortis.

DICOM Connectivity Status

Service Name Name of the DICOM services configured for the LOGIQ Fortis.

Status of the DICOM service. Valid values are:

*« OK
* Not Ok
Status )
* Not Ping
* Ping in progress
* Queued
Error Details Details for any errors associated DICOM services.
Type Type of error.
Device Name Name of the device.
AE Title Application entity title for the device.
IP Address IP address for the device.
Port Port for the device.
Ping Device Select to confirm that a device is connected or not.

For more information, see:

+ "DICOM" on page 7-48
+ "DICOM Spooler" on page 7-50
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DICOM Spooler
DICOM Spooler provides a summary of the current and recent outgoing jobs.
The information on DICOM Spooler is available to Class C and Class M licenses.

To access DICOM Spooler, navigate to Utility (second page) > Service > DICOM > DICOM Spooler.

Figure 7-30 DICOM Spooler
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DICOM (cont’d)

This table shows all the elements available on DICOM Spooler with descriptions.

Table 7-19

DICOM Spooler

Element

Description

Job Status

Displays the number of jobs for each type by status. For example, Pending.

Spooler Health

DICOM Spooler

Space allotted to DICOM jobs on the E: drive.

Free Space

Available space on the E: drive.

Total Size of the E: Drive

Total space on the E: drive.

Spooler Summary

Job ID

Number for the job.

Job Status

Current status of the job. These are the valid values:
* Pending

« Active

* Hold

* Done

» Success

« Failed

Job Type

Type of job. These are the valid values:

« Storage — Images

« Structured Reports

« Key Image Notes

« STC — Storage Commitment

* MPPS - Modality Performed Procedure Step

Destination

Name of service receiving the objects.

Age

Amount if time the job has been in the spooler.

Spooler Entry time

Time the job entered the spooler.

Transfer time

Time the job was transferred from the spooler.

Job Size

Size of the job.

Error details

If applicable, details for the error.

For more information, see:

+ "DICOM" on page 7-48
+ "DICOM Service Status" on page 7-48
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7-4-8

Utilities

Utilities configurations vary depending upon the service class.

For more information, see:

"Backup and Clean LogDb" on page 7-53
"Change Password" on page 7-54
"Checkpoints" on page 7-56

"Clean Userdefs" on page 7-58

"Data Transfer" on page 7-60

"Delete Files" on page 7-63

"Disk Defragment" on page 7-64
"Disruptive Mode" on page 7-65

"Gather Logs" on page 7-67

"Network Capture" on page 7-68

"Reset Patient Database" on page 7-71
"Resolve Agent Quarantine" on page 7-73
"Secure Delete" on page 7-74

"SSA License" on page 7-76

"Software Reload" on page 7-78

"Third Party Software Licenses" on page 7-80
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7-4-8  Utilities (cont’d)
Backup and Clean LogDb

Backup and Clean LogDb allows you to

Figure 7-31 Backup and Clean LogDb

®
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7-4-8  Utilities (cont’d)
Change Password

Change Password allows you to change the password for a specified user type.

A CAUTION RISK OF LOSING DATA.

IF THE PASSWORD IS LOST, GE WILL NOT BE ABLE TO RECOVER OR RESET IT.
LOSS OF A PASSWORD MAY RESULT IN THE LOSS OF PATIENT DATA.

The information on Change Password is available to all service class licenses. Change Password is
not available through a remote connection.

To access Change Password, select Utility (second page) > Service > Utilities > Change
Password.

Figure 7-32 Change Password

Q@ Change P

This table shows all the elements available on Change Password with descriptions.

Table 7-20 Change Password

Element Description

Type of user for the password reset.
User Type * GEService — Windows user for GE Service.
« SVCService — Windows user loaded with the base image load software.

New password according to the password requirements (14-25 characters including

New Password
one upper cap, one lower cap, one number, and one symbol).

Confirm Password Password you entered in New Password.
Update Password Select to update the password.
Reset Select to reset the information.
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7-4-8  Utilities (cont’d)

NOTE:

A CAUTION

To change the password:

Before changing the GEService password (the default is SvcForward123$), make sure the
LOGIQ Fortis is connected to the network and the agent is configured. The GEService
password is used to perform portions of remote service. If the password is changed and the
LOGIQ Fortis information is not updated, it may slow down remote service. Both file transfer
and SSH depend on the GEService password.

To change the service desktop user password:

1.) Navigate to Utility (second page) > Service > Utilities, and then select Change Password.
2.) From User Type, select one of the following:

- GEService — This is the Windows user for GE Service. Both file transfer and SSH depend on
this user and password combination. When using SSH in FFA, the user and password will
always be requested. Entering the incorrect password multiple times will lock you out. When
changing this password, the LOGIQ Fortis should be online (check the online icon at the
bottom of the screen) so the back office updates. If the password is changed when offline, the
back office will not be updated and you will have to change the password again with the
LOGIQ Fortis online. There is no notification when this password has been changed.
Changes to this password do not affect logs sent to the GE Service data lake.

- SVCService — This is the Windows user loaded with the base image load software. You will
never be prompted for this password. When it is set to default (no password selected), a
randomly generated password will be supplied by the LOGIQ Fortis. If this password is
changed with Change Password, the base image software will automatically store the new
password in the LOGIQ Fortis and it will be fixed to the value entered. The SVCService
password will not be requested of any user. It is only used by the LOGIQ Fortis software.

RISK OF LOSING DATA.

GE WILL NOT BE ABLE TO RECOVER OR RESET CHANGED PASSWORDS.
SECURELY RECORD THE NEW PASSWORD.

3.) In New Password type a new password according to the password requirements (14-25 characters
including one upper cap, one lower cap, one number, and one symbol).

4.) In Confirm Password, type the new password.
5.) Click Update Password. The following message displays if the LOGIQ Fortis is offline.

Password changed successfully, but failed to update new password at back
office. This password is used by GE Remote service to perform portions of remote

service. This may slow down remote service because GE will need to get the
password from you.

6.) When a SVCService user password has been changed, reboot the LOGIQ Fortis to reflect the
password change.

For more information, see:

« "Utilities" on page 7-52
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Checkpoints

Checkpoints allows for the creation of checkpoints and displays the history of those checkpoints.
Checkpoints are used to indicate when the LOGIQ Fortis has been serviced, status has been reset, and
information related to the service performed has been added.

The information on Checkpoints is available to Class C (Service Advanced and Service Expert) and
Class M licenses.

To access Checkpoints, select Utility (second page) > Service > Utilities > Checkpoints.

Figure 7-33 Checkpoints
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This table shows all the elements available on Checkpoints with descriptions.

Table 7-21  Checkpoints

Element Description

Checkpoints History

Checkpoint Displays the name of the checkpoint.

Service Personnel Displays the ID for the logged in user.

Action Displays the service action.

Comment Displays comment text entered when the checkpoint was created.
Service Checkpoint Displays whether the checkpoint is a service checkpoint or not.

Create Checkpoint

Selects the service action. Value values are
+ Scheduled Maintenance

Action * Unscheduled Maintenance

* Upgrade

* FMI

ID for the logged in user. Value values are:
» SSO ID — When a Class M key is plugged in, the SSO ID for the logged in user.
* Remote user ID - If there is a remote connection, the remote user ID.

« User ID — If the SSO ID and remote user ID are not available, the user ID for the logged
in user.

Service Personnel

* Unknown — The logged in user ID is not available.

Comment Enter comments for creating a checkpoint.
Service Checkpoint Select whether to mark a service checkpoint or not.
Save Saves the information.

To create a check point:

1.) Navigate to Utility (second page) > Service > Utilities > Checkpoints.
2.) Under Create Checkpoints, from Action, select the action.

3.) In Comment, enter notes for the checkpoint.

4.) If this is a checkpoint for service, select Service Checkpoint.

5.) Click Save.

For more information:

+ "Utilities" on page 7-52
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Clean Userdefs

Clean Userdefs provides a way to delete user-defined data when user presets may be inhibiting proper
operation. User-defined data returns to the user-defined settings to the factory default values. Clean
Userdefs provides information to backup the current settings if you want to use them later. Disruptive
mode must be On to clean user-defined data. If Disruptive mode is Off, a warning message displays
asking to turn on Disruptive mode.

Before cleaning user-defined data, the LOGIQ Fortis application software automatically shuts down.
Once the operation is complete, the LOGIQ Fortis reboots.

Clean Userdefs provides a way to selectively delete the following user-defined data:

* Connectivity — Deletes this file: % TEST_ROOT%\resources\userdefs\connectivity.res

» Imaging — Deletes this folder: % TEST_ROOT%\resources\userdefs\ImagingPresets\

* Measurement — Delete this folder: % TEST ROOT%\resources\userdefs\EchoMeasure\

*  Annotation/Bodymark — Deletes the folder: % TEST_ROOT%\resources\userdefs\EchoAnnotation\
* Scan Assistant — Deletes the folder: % TEST _ROOT%\resources\userdefs\EchoExamProtocol
The information on Clean Userdefs is available to Class C (Service Expert) and Class M licenses.

To access Clean Userdefs, select Utility (second page) > Service > Utilities > Clean Userdefs.

Figure 7-34 Clean Userdefs
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This table shows all the elements available on Clean Userdefs with descriptions.

Table 7-22 Clean Userdefs

Element

Description

All

When Disruptive mode is ON, deletes all of the user-defined data and returns the
LOGIQ Fortis to factory default settings.

Selective Delete

When Disruptive mode is ON, deletes the selected user-defined data.

When Selective Delete is selected, deletes this file:

Connectivity D:\scanner\target\resources\userdefs\connectivity.res
Imaain When Selective Delete is selected, deletes this folder:
9ing D:\scanner\target\resources\userdefs\ImagingPresets\
When Selective Delete is selected, delete this folder:
Measurement

D:\scanner\target\resources\userdefs\EchoMeasure\

Annotation/Body Patterns

When Selective Delete is selected, deletes this folder:
D:\scanner\target\resources\userdefs\EchoAnnotation\

Scan Assistant

When Selective Delete is selected, deletes this folder:
D:\scanner\target\resources\userdefs\EchoExamProtocol

Clean Userdefs

Restarts the application software with a fresh database.

To clean user-defined data:

1.) If you want to use the current settings later, back them up now.
2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set

Disruptive mode to On.

3.) Navigate to Utility (second page) > Service > Utilities > Clean Userdefs.
4.) Select the data you want to set to the default settings.

5.) Click Clean Userdefs.
For more information, see:

« "Utilities" on page 7-52
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Data Transfer
Data Transfer provides a way to do the following:

+ View information about past transfers of (APM) information.

» Set up automatic/scheduled transfer of allowed data files from the LOGIQ Fortis to the server.
» Manually transfer data files allowed data files from the LOGIQ Fortis to the server.

The information on Data Transfer is available to all service class licenses.

To access Data Transfer, select Utility (second page) > Service > Utilities > Data Transfer.

Figure 7-35 Data Transfer

Type of Upload Upload Permission Last Upload Status Last Upload Attempt Last Successful Attempt
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Figure 7-36 Date Transfer

Type of Uplosd Uplosd Bermasaa Last Upload $tatus Last Uplesd Attempt Last Sudcesatl Altempt

This table shows all the elements available on Data Transfer with descriptions.

Table 7-23 Data Transfer

Element Description

Type of log file. For example, Incremental Logs or Full Logs. Monitoring Logs,
System Logs, and Windows Logs are incrementally transferred when automatic
transfer is enabled. To enable automatic transfer, navigate to System Admin and,
under Service, check Enable Automatic Request for Service.

Type of Upload

Upload Permission Whether the permission to upload the log file is allowed or not.
Last Upload Status Whether the last log file upload was successful or not.

Last Upload Attempt Date and time the last log file upload was attempted.

Last Successful Upload Date and time the last log file was successfully uploaded.

When selected, type of log file to transfer. Making these selections will limit the data

Type of Upload flow to the data lake.
When selected, enables the related day selections. For example, All Days,
Scheduler
Monday, and Tuesday.
Save Settings Saves the information.
Send All Manually send the selected log files to the server.
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To configure automatic data transfers:

1.) Navigate to ADMIN > System Admin.

2.) On System Admin, configure these settings:
- Transfer Machine Logs to GE — Default is checked
- Transfer Operator Information to GE
- Transfer Images (captured without patient information) to GE — Default is checked.
3.) Click Save.
4.) Navigate to Utility (second page) > Service > Utilities > Data Transfer.
5.) On Data Transfer, select Scheduler, and then select the days to perform the data transfer.
6.) Click Save Settings.
7.) To manually perform a data transfer, click Send All.
For more information:

« "Utilities" on page 7-52
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Delete Files

Delete Files displays all the files and folders present in the D:\Service folder and allows for their
deletion. Deleting unneeded files improves performance and reduces the need to defragment the disk
drive.

The information on Delete Files is available to all service class licenses.

To access Delete Files, select Utility (second page) > Service > Utilities > Delete Files.

Figure 7-37 Delete Files

8 Delete Files

W D:/Service

~ & W image

This table shows all the elements available on Delete Files with descriptions.

Table 7-24 Delete Files

Element Description

Delete Files Displays the files that are available for deletion.

Delete Deletes the selected files.

To delete files:

1.) Navigate to select Utility (second page) > Service > Utilities > Delete Files.
2.) Under Delete Files, select the available folders and files that you want to delete.
3.) Click Delete.

4.) In the resulting dialog box, click Delete and then click OK.

For more information, see:

« "Utilities" on page 7-52
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Disk Defragment

Disk Defragment provides a way to launch the Windows Disk Defragmenter tool to use to defragment
the disks. Disk fragmentation can reduce the amount of disk space available, and slow computing
speed. Use the disk defragmenter to restore optimum disk space and speed performance. If LOGIQ
Fortis performance would be significantly reduced when the disk is being defragmented, a warning
message displays. It is not possible to analyze the SSH drives.

The information on Disk Defragment is available to Class C (Service Advanced and Service Expert)
and Class M licenses. Disk Defragment is not available through a remote connection.

To access Disk Defragment, select Utility (second page) > Service > Utilities > Disk Defragment.

Figure 7-38 Disk Defragment

Please use the disk defragment window to start disk drive optimization (Defragl.

; ‘maa.m.eMrmhummmmammméuummmhﬂkm 1
dafragmented.

To analyze, optimize, or schedule optimization for a disk:

1.) Navigate to Utility (second page) > Service > Utilities > Disk Defragment.
2.) Click Launch Disk Defragmenter.

3.) In the Optimize Drives dialog box, select the drive.

My Optimize Drives = g

You can optirmize your drives to help your computer run more efficiently, or analyze them te find out if they need to be
eptimized, Only drives on or connected te your computer are shown,

Status

Drive Media type Las Currant status ~
Salid state drive
s User (D:) Hard disk drive - rnented)
= ARCHIVE (E:) Hard disk drive

= System (1)

fragmented)

s SARATH (F:) Remaovable drive n not svailable
= DVR (V) Hard disk drive fragmented]
== Reposit (Z:) Sofid state drive ys since last run)
Dasnsinns . i i 2 v
Optimize
Scheduled optimization
On Change gettings

Drives are being optimized automatically.
Frequency: Weeldy

Close

4.) To analyze the selected drive, click Analyze.
5.) To optimize the selected drive, click Optimize.

6.) To set up a schedule, click Change settings and select the schedule.
For more information, see:

» "Utilities" on page 7-52
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Disruptive Mode

Disruptive Mode provides a way to enable and disable Disruptive mode. When enabled, Disruptive
mode allows a remote user to access the LOGIQ Fortis which can disrupt normal operation of the
LOGIQ Fortis. Disruptive mode can be remotely turned on when the logged-in user has Authorize
Remote Service Access privilege. If the logged-in user does not have remote service privilege, displays
this error message: “You do not have the required permission to perform this operation.”

When initiating Disruptive mode from a remote location, a message displays on the LOGIQ Fortis asking
whether the user will allow Disruptive mode and notifying them that normal operation might be disturbed.

» If Yes is selected, then Disruptive mode is turned on.
+ If Nois selected, then Disruptive mode is not turned on and an error message displays saying that
permission to change the mode was denied.

When Disruptive mode is On, the GE icon in the status bar changes to red and displays this message:
“Due to Service testing restart needed.”

When Disruptive mode is changed to Off, the GE icon turns white and displays this message: “Due to
Service testing restart needed.” In addition, VCO and SSH stop if running.

The information on Disruptive Mode is available to Class C (Service Advanced and Service Expert)
and Class M licenses.
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To access Disruptive Mode, select Utility (second page) > Service > Utilities > Disruptive Mode
Utility.

Figure 7-39 Disruptive Mode

Date of Last Modification Tue, Jun 12 :

This table shows all the elements available on Disruptive Mode Utility with descriptions.

Table 7-25 Disruptive Mode Utility

Element Description

Indicates whether the LOGIQ Fortis is in Disruptive mode or not. Valid values are:
Disruptive Mode Status o Enabled — Disruptive mode is on.
o Disabled — Disruptive mode is off.

Date of Last Modification Date the LOGIQ Fortis was last enabled or disabled.

Select this check box and then select Enable to place the LOGIQ Fortis into
Start SSH Disruptive mode and start the Secure Shell (SSH) server. The SSH server can also
be started from the SSH utility.

Select this check box and then select Enable to place the LOGIQ Fortis into
Stop SSH Disruptive mode and stop the Secure Shell (SSH) server. The SSH server can also
be stopped from the SSH utility.

Select this check box and then select Enable to place the LOGIQ Fortis into
Start VNC Disruptive mode and start the Virtual Network Computing (VNC) server. The VNC
server can also be started from the Virtual Console Observation utility.

Select this check box and then select Enable to place the LOGIQ Fortis into
Stop VNC Disruptive mode and stop the Virtual Network Computing (VNC) server. The VNC
server can also be stopped from the Virtual Console Observation utility.

Enable Select to enable Disruptive mode.

Disable Select to disable Disruptive mode.

For more information:

« "Utilities" on page 7-52
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Gather Logs

Gather Logs provides a way to collect system logs and place the log files in the D:\Service directory for
retrieval by the online center. These log files do not include protected data such as crash dumps and
keyboard shadow logs. The customer can collect logs (including protected data) using Alt+D when
Protected Data is checked. Log files are compressed into a .zip file and the file path and name display.
If the application software is not running, use the Gather Logs shortcut on the Windows desktop.

The information on Gather Logs is available to all service class licenses.

To access Gather Logs, select Utility (second page) > Service > Utilities > Gather Logs.

Figure 7-40 Gather Logs

This will gather up logs and presats. 1t will thin ploce them i the service directory for retrieval by the On Line Centor.

This vl mat inchuda pratected data such ax crash dumps and kirpboard shadous logs. f you need this information ask the customer to collect the Ings using
Alt-0 with the ‘inchide pratected data’ bas checked,

This table shows all the elements available on Gather Logs with descriptions.

Table 7-26  Gather Logs

Element Description
1 Day Logs When selected, gathers log files for one day.
1 Week Logs When selected, gathers log files for one week.
All Logs When selected, gathers all available log files.
Gather Logs Select to gather the log files for the selected time period.

To gather log files:

1.) Navigate to Utility (second page) > Service > Utilities > Gather Logs.
2.) Select one of the following:
- 1 Day Logs
- 1 Week Logs
- AllLogs
3.) Click Gather Logs. In the resulting dialog box, record the location of the log files and click OK.

4.) When the gather log operation is complete, click the notification icon in the banner to view the
location of the log files.

For more information, see:

+ "Utilities" on page 7-52
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Network Capture

Network Capture displays network traffic between the LOGIQ Fortis and configured devices. A network
capture outputs two log files: one for main logging with no protected information and another including
protected information. These log files are useful when debugging connectivity issues. Because these

log files can be large, they are only kept for one week.

The information on Network Capture is available to all service class licenses.

To access Network Capture, select Utility (second page) > Service > Utilities > Network Capture.

Figure 7-41 Network Capture
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This table shows all the elements available on Network Capture with descriptions.

Table 7-27 Network Capture

Element

Description

Network Capture Parameters

Maximum Size

Allowed size of the generated log file. Valid value are:
+ 256MB

+ 512MB

+ 1024MB

Devices

DICOM-configured devices for which you want to capture information. If no
additional devices are configured, only All will be available.

Start Network Capture

Select to start the process. This causes the network capture to start, enables the
Stop button, and updates the Network Capture Status pane and changes the
Status to Running.

Stop Network Capture

Select to stop the process.

Network Capture Status

Displays information about the status of the network capture. The language setting
for this information is set in Windows and not through the Service desktop or
LOGIQ Fortis application software.

Displays the current status of the network capture. Valid values are:
* Not Running
* Running
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To perform a network capture:

1.) Navigate to Utility (second page) > Service > Utilities > Network Capture.

Metwork Capture

2.) From Network Capture, do the following:
- Under Maximum Size, select the allowed size of the generated log file.

- Under Devices, select the DICOM-configured device for which you want to capture
information. If no additional devices are configured, only All will be available.

3.) Select Start Network Capture to start the process. This causes the network capture to start,

enables the Stop button, and updates the Network Capture Status pane and changes the Status
to Running.

4.) Click the Stop button to end data collection. Stopping is a two-step process:
- Stops the data collection and immediately closes the .etl file.

- Collects additional diagnostic data that may help diagnose network issues. When the file is
closed, you see “There is no trace session currently in progress”. When the remaining data is
collected and the .cab file is closed, you are notified in the banner.

Metwork Copture

For more information, see:

« "Utilities" on page 7-52
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Reset Patient Database

Reset Patient Database resets the LOGIQ Fortis patient database. This operation automatically shuts
down the application before cleaning the patient database. Once the operation is complete, the LOGIQ
Fortis reboots with an empty database. Disruptive mode must be On to reset the patient database. If
Disruptive mode is Off, a warning message displays asking to turn on Disruptive mode.

Reset Patient Database deletes the contents of the following folders:

+ E:\ScannernGEMS_IMG

+ E:\ScannernGEMS_REP

The information on Reset Patient Database is available to Class C (Service Expert) and Class M
licenses.

To access Reset Patient Database, select Utility (second page) > Service > Utilities > Reset Patient
Database.

Figure 7-42 Reset Patient Database

& Reset Patient Database

Bl Instruction

This tool will reset the system patient database to an
empty one. Before resetting the database, the scanner
software will shutdown automatically. Once the process
is complete, the system will reboot.

NOTE: Backup the patient database and any images
if needed. Use the scanner application’s backup and
restore feature under Utility->System tab.
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This table shows all the elements available on Reset Patient Database with descriptions.
Table 7-28 Reset Patient Database
Element Description
Instruction Information about the database reset.
Reset Patient Database When Disruptive mode is ON, resets the LOGIQ Fortis patient database.
To reset the patient database:
1.) Back up the patient database.
2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set
Disruptive mode to On.
3.) Navigate to Utility (second page) > Service > Utilities > Reset Patient Database.
4.) Click Reset Patient Database.
5.) Confirm the patient database has been emptied.
For more information, see:
« "Utilities" on page 7-52
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Resolve Agent Quarantine

LOGIQ Fortis Resolve Agent Quarantine is available on the Service Desktop. Resolve Agent
Quarantine allows you to move the LOGIQ Fortis out of quarantine after an agent update.

Figure 7-43 Resolve Agent Quarantine - Submit

@ Resolve Agent Quarantine

Old Serial b

Old Model Number CS_ULS_LOGIQ_E10_ROLS ﬂ

+ Command successfully send to back office. It may take around 5 minutes to resolve the

quarantine state. If agent quarantine state is not resolved after that time, please contact GE
Service.

This functionality resolves the agent from quarantine state only during agent upgrades. If agent
goes to quarantine due to any other reason, this utility will not fix the quarantine issue.

Figure 7-44 Resolve Agent Quarantine - No Quarantine

@ Agent is not in quarantined state.

This functionality resolves the agent from quarantine state only during agent upgrades. If agent
goes to quarantine due to any other reason, this utility will not fix the quarantine issue.

To resolve a quarantine in Agent Configuration:

1.) From Utility (second page) > Service > Utilities, select Resolve Agent Quarantine.
2.) View the information in Old Serial Number and Old Model Number.
3.) If the information is correct, select Submit.
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Utilities (cont’d)

Secure Delete

Secure Delete will be available on the Service desktop. As part of Privacy and Security, this utility
allows you to delete files on the D:/ and E:/ drives returning the LOGIQ Fortis to a factory clean state,
including the deletion of log files, unless presets are restored.

Secure Delete does not provide a report or log file that can be used as report.

The Secure Delete deletion process encrypts the data on the E:/ drive and then deletes the recovery
keys. This renders all data on the E:/ drive unrecoverable. The D:/ and E:/ drives are then reformatted.
An empty database is then loaded onto the E:/ drive, and if any are selected, userdefs (presets) are
reloaded onto the D:/ drive.

Use the Delete Files utility to improve performance. This utility deletes image files from the
Service folder but does not render the data unrecoverable.

The information on Secure Delete is available to all service classes. Secure Delete is not available
through a remote connection.

To perform a secure deletion of files on the D:/ and E:/ drives:

1.) Insert an activated SSA key.

2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set
Disruptive mode to On.

3.) From Utilities, select Secure Delete. The Secure Delete utility displays.

NOTE: This operation will format the contents of D and E drives and patient data will be lost. Backup the patient database and any images if needed. Use the
scanner application’s backup and restore feature under Utility->System tab.

4.) Select Secure Delete, and then select OK.
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5.) Inthe Secure Delete selection dialog box, select one of the following:

- Factory Default: This selection deletes all information on the D:/ and E:/ drives and reformats
these drives to the factory default settings.

- Perform Partial Secure Delete: This selection enables the Partial Delete Options and
allows you to select from the check boxes. Partial Delete Options allows you to keep
information per customer request.

SECURE DELETE

SECURE DELETE

WARNING: YOU WILL NOT BE ABLE TO RECOVER DATA
ON THIS SYSTEM AFTER SECURE DELETE.

THIS WILL TAKE ABOUT 2 MINUTES.
SYSTEM WILL BE RESTARTED. DO NOT SHUTDOWN SYSTEM.
" FACTORY DEFAULT [Delete all data permanently)
" PERFORM PARTIAL SECURE DELETE [Please check optioris)

5 N [N

[ 1 agree to delete data on this system.

RESTART SYSTEM

6.) If you selected Perform Partial Secure Delete, under Partial Delete Options, select from the
following:

- Keep system settings — Select to retain general system configuration, measurement,
analysis, video, and backup and restore settings made under Utility > System.

- Keep imaging presets — Select to retain exam and imaging parameter settings made under
Utility > Imaging.

- Keep application presets — Select to retain application- and user-specific settings made
under Utility > Application.

- Keep service presets — Select to retain remote connectivity settings made under Utility >
Connectivity.

7.) Select the | agree to delete data on this system check box.

8.) Select Start Secure Delete. After performing secure delete, the LOGIQ Fortis automatically
restarts.

NOTE: To terminate the Secure Delete dialog box and immediately restart the LOGIQ Fortis, use the
Restart System button.
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SSA License
SSA License provides a way to do the following:
*  When inserted, view the details of an SSA key.
* View the status of the service class options.
* Restore an SSA license when the SSA key is not validating or when a remote log in shows as a
Class A user.
The information on SSA License is available to all service class licenses.
To access SSA License, select Utility (second page) > Service > Utilities > SSA License.
Figure 7-45 SSA License
This table shows all the elements available on SSA License with descriptions.
Table 7-29 SSA License
Element Description
Class M Key Details
Status of the SSA key. Valid values are:
Class M Key Status » Not Plugged In
* Plugged In
Drive Letter Drive where the SSA key is plugged into the LOGIQ Fortis.
Expire Date Date the SSA key is set to expire.
SSO ID Identifier for the user assigned to the SSA key.
Key Counter Value Number of times the SSA key has been used.
Max Key Counter Value Number of remaining times the SSA key can be used.
Service Option Keys
Name Name of the service class option.
Status of the access to the associated service class option. Valid values are:
Status * True
 False
Restore SSA Restores the SSA license to the SSA key.
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To view the Class M license information:

1.) Insert the SSA key.
2.) Navigate to Utility (second page) > Service > Utilities > SSA License.

3.) Under Class M key Details, view the values. For example, the SSO ID for the user assigned to the
SSA key.

If Not Available displays for all of these values, the SSA key is not validating.
To restore an SSA key that is not validating:

1.) Remove the SSA key from the LOGIQ Fortis.

2.) If open, close the Service desktop.

3.) Restart the LOGIQ Fortis.

4.) Once the LOGIQ Fortis has restarted, plug in the SSA key.

5.) Navigate to Utility (second page) > Service > Utilities > SSA License.
6.) Click Restore SSA.

7.) Check to see if the SSA key validates.

For more information, see:

+ "Utilities" on page 7-52
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7-4-8

Utilities (cont’d)

Software Reload

Software Reload displays versions of the base image, application software, base patch, service
platform, and documentation packages currently installed on the LOGIQ Fortis. Software Reload
reimages the C:\ drive and installs the base image.

Software Reload indicates whether the disks have been encrypted. If the disk is encrypted AND locked,
when you open Software Reload, this message displays instead of the Software Reload button.

4@ The disks are locked. Go to Utility->Admin->Disk Encryption page and  ~

unlock the disks before proceeding Software Reload

The message above will not prompt if Encryption is Off, On with disks unlocked automatically, or On
with the key stored on USB/password is entered manually (Disks not locked.)

With Disruptive mode set to On, reload these software versions from repository partition on the hard
drive. The software reload is automatic without any loss of presets, patient data, or connectivity settings.

The information on Software Reload is available to Class C (Service Expert) and Class M licenses.

To access Software Reload, select Utility (second page) > Service > Utilities > Software Reload.

Figure 7-46 Software Reload
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7-4-8  Utilities (cont’d)

& CAUTION

This table shows all the elements available on Software Reload with descriptions.

Table 7-30 Software Reload

Element Description
Base Image Version Displays the version number of the base image software.
Base Patch Version Displays the version number of the base patch.
Application Software Version Displays the version number of the application software.
Service Platform Version Displays the version number of the service platform.
Documentation Version Displays the version number for the documentation.
Software Reload Reloads the versions listed.

To reload software:

1.) If the drives are encrypted, obtain the recovery key.

2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set
Disruptive mode to On.

3.) Navigate to Utility (second page) > Service > Utilities > Software Reload.

4.) If the disk is encrypted AND locked, follow the instructions on this message and then return to
Software Reload.

/@ The disks are locked. Go to Utility->Admin->Disk Encryption page and *

unlock the disks before proceeding Software Reload

5.) View the current version numbers.
6.) Click Software Reload.

RELOADING SOFTWARE WITHOUT A RECOVERY KEY WILL RESULT IN THE LOSS OF
PATIENT DATA.

7.) If you have a recovery key, select | have a recovery key and then click Continue.

Sftwire Reload

8.) If you have a recovery key, select | Agree and then click Continue Reload.

Softwore Relood

U o ot have the recovery key, you will lose 3 the Patient Data. If you want to continue, then seiect 1 Agre’

© o | X s

9.) Ifthe SVCService and/or GEService passwords have been changed, these passwords will need to
be updated on Change Password after software is reloaded.

For more information, see:

+ "Utilities" on page 7-52
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7-4-8  Utilities (cont’d)

Third Party Software Licenses

Third Party Software Licenses displays the third-party software licenses used as part of the service
platform.

The information on Third Party Software Licenses is available to all service class licenses.

To access Third Party Software Licenses, select Utility (second page) > Service > Utilities > Third
Party Software Licenses.

Figure 7-47 Third Party Software Licenses

N Third Party Software Licenses

accepts(1.3.3)

License Information

For more information, see:

+ "Utilities" on page 7-52
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7-4-9 Options

Use Options to:

* View software options.
* View software option details.

» Add (or delete) a valid option key, add a duplicate option key, not add an invalid option key, and ask
for confirmation before deleting an option key.

* View software option key details. Key details are a list of options that are enabled by a particular
key. Under Available Keys, highlight the option string, select Details and then view the options on
the left side of the screen. Press Show All to view all of the activated options.

The information on Options is available to all service class licenses.

To access Options, navigate to Utility (second page) > Service > Options.

Figure 7-48 Options

This table shows all the elements available on Options with descriptions.

Table 7-31  Options

Element Description

Software Options

Option Software options on the LOGIQ Fortis.

Status Status of the options on the LOGIQ Fortis.

Software Option Details

Product Name of the product.

Number for the hardware. The hardware number is the hash of the serial number

Hardware Number that is used to generate the option key.

Serial Number Serial number of the LOGIQ Fortis.

Software Option Keys

Available Keys List of the option keys installed on the LOGIQ Fortis.
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7-4-10 Agent Configuration
Use Agent Configuration to:
» Edit and configure the following:
- Enterprise host name in the agent
- Enterprise port number in the agent
- URL for software downloads
- Proxy server in the agent
- Proxy port in the agent
- CRM number in the agent
- Display name in the agent
»  Set the serial number in the agent
» Enter the username and password for the proxy
* Reset the edited unsaved value
* Update contact details
The information on Agent Configuration is available to all service class licenses.
To access Agent Configuration, navigate to Utility (second page) > Service > Agent Configuration.
Figure 7-49 Agent Configuration
This table shows all the elements available on Agent Configuration with descriptions.
Table 7-32  Agent Configuration
Element Description
Agent Configuration
Phone number for the person at the customer site a GE remote service engineer would
Contact Details contact. The phone number is entered during installation and reviewed at every service
call to make sure the information is correct.
Status for the agent. Valid values are:
Agent Status * Running
* Not Running
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Table 7-32  Agent Configuration (Continued)

Element

Description

Agent Registered

Registration status of the agent. Valid values are:

* Yes — The agent is registered in the back office.

» No — The agent is not registered in the back office.

» Not Available — The agent is not configured or running.

Agent Quarantine

Quarantine status of the agent. Valid values are:

* Yes — The agent has more than one device registered with the same CRM Number in
the back office. This scanner cannot send data back to GE or be remotely accessed.

* No —The agent has one device registered with the listed CRM Number in the back office.
» Not Available — The agent is not configured or running.

Agent CRM Verified

Verification status of the Customer Relationship Management (CRM) number for the
agent. Valid values are:

* Yes — The CRM number for the agent is verified in the back office.
» No — The CRM number for the agent is not verified in the back office.
» Not Available — The agent is not configured or running.

Agent Model Number

GE part number for the LOGIQ Fortis. The same number as listed on the rating plate.

Serial Number

Serial number of the agent (read-only). If the agent is not registered with a serial number,
this field is populated with the serial number of the LOGIQ Fortis. The serial number of the
agent is tied to the serial number of the LOGIQ Fortis.

Customer Relationship Management (CRM) number. System identifier assigned to the

CRM No customer unit by the service region. CRM is pre-populated by adding LFortis to the CRM
number. The CRM number of the LOGIQ Fortis is editable.
Display Name Displayed name of the agent.

Agent Connected

Connection status of the agent. Valid values are:

* Yes — The agent is connected to the back office.

» No — The agent is not connected to the back office.

» Not Available — The agent is not configured or running.

Last Connected Time

When Agent Connected is Yes, the last time the LOGIQ Fortis successfully connected to
the agent. When Agent Connected is No, this field does not display.

Advanced Configuration

Server

Name of the enterprise server. Should be set to Production. Do not use the IP address of
the enterprise server using the “other” selection as Windows 10 has removed the ability to
bypass a certificate error that occurs when using the IP address. This error can block
connectivity.

Enterprise Host

Number of the enterprise host. Should be set to insite.gehealthcare.com.

Enterprise Port

Number of the enterprise port. Should be set to 443.

Software Download URL

Address where software will be downloaded from to the LOGIQ Fortis.

Proxy Configuration

Enable Proxy

Enables the proxy server.

Proxy Server

When Enable Proxy is selected, name of the proxy server IP provided by the customer.

Proxy Port

When Enable Proxy is selected, number of the proxy server port provided by the customer.

Credentials

Enable Proxy Credentials

Enables the proxy credentials.

Username

When Enable Proxy Credentials is selected, name of the user provided by the customer.

Chapter 7 Diagnostics/Troubleshooting 7-83



Direction 5874372, Rev. 3

GE CONFIDENTIAL
LOGIQ Fortis Proprietary Service Manual

Table 7-32  Agent Configuration (Continued)
Element Description
When Enable Proxy Credentials is selected, password for the user provided by the

Password
customer.

Saves the changes made on the Agent Configuration page.

Submit Changes Once Submit Changes has been selected, exit the Agent Configuration page. Wait
between 4 and 5 minutes and then reopen the Agent Configuration page. Agent Status
should display Running.

Reset Form Clears the values on the Agent Configuration page.
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7-4-11

NOTE:

Software Maintenance

In LOGIQ Fortis uses Software Maintenance to manage software updates including check for pending
updates and initiate the download for installation. Additionally, use these pages to reset declined
software packages and view information about installed software.

Use Software Maintenance after a full load/C only load from media as the LOGIQ Fortis will
lose any downloaded updates after these software loads.

Specifically, use these pages:

» Software Updates — Query and view available software updates.

* Reset Declined Packages — Reset software updates declined through the Software Download
and Install dialog box.

+ Software Information — View information that is currently installed on the LOGIQ Fortis.
For more information, see:

+ "Software Updates" on page 7-86
+ "Reset Declined Packages" on page 7-87
+ "Software Information" on page 7-88
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7-4-11

Software Maintenance (cont’d)

Software Updates
Software Updates provides a way to do the following:

*  Query for available software updates

» View available software updates

+ Select and download from the available software updates

The information on Software Updates is available to all service classes.

To access Software Updates, navigate to Utility (second page) > Service > Software Maintenance
> Software Updates.

Figure 7-50 Software Updates

This table shows all the elements available on Software Updates with descriptions.

Table 7-33  Software Updates

Element Description
Product Name Model number for the LOGIQ Fortis.
Product Version Version for the LOGIQ Fortis.
Update ID Identifier for the software update.
Update Name Name for the software update.
Package ID Identifier for the package.
Package Name Name for the package.

Type for the software update. Valid values include:
Update Type » OS Security
* General Update

Requirement for installation of the related software update. Valid values include:

Option required for install . .
» Service installation

Part Number Part number for the software update.

Version Version for the software update.

Released Date Date the software update was released.

Update Description Description for the software update.

Query for Updates Select to populate the page with the available software updates.
Select Update Select to initiate the download of the associated software update.
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7-4-11  Software Maintenance (cont’d)

Reset Declined Packages

Reset Declined Packages provides a way to reset software updates that have been previously
declined through software download.

The information on Reset Declined Packages is available to all service classes. Reset Declined
Packages is not available through a remote connection.

To access Reset Declined Packages, navigate to Utility (second page) > Service > Software
Maintenance > Reset Declined Packages.

Figure 7-51 Reset Declined Packages

This table shows all the elements available on Reset Declined Packages with descriptions.

Table 7-34 Reset Declined Packages

Element Description
Select Check box for the associated software update that has been declined.
Update ID Identifier for the software update.
Update Name Name for the software update.
Package ID Identifier for the package.

Package Name Name for the package.

Type for the software update. Valid values include:
Update Type « OS Security
« General Update

Part Number Part number for the software update.

Version Version for the software update.

Released Date

Date the software update was released.

Update Description

Description for the software update.

Declined Timestamp

Timestamp for when the software update was declined.

Declined User

Name for the user who declined the software update.

Reset

Clears the declined software update so that it is again available through a query on
Software Updates.
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7-4-11  Software Maintenance (cont’d)

Software Information

Software Information displays general information about the software currently installed on the
LOGIQ Fortis.

The information on Software Information is available to all service classes. Software Information is
not available through a remote connection.

To access Software Updates, navigate to Utility (second page) > Service > Software Maintenance
> Software Information.

Figure 7-52 Software Information
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7-4-11

Software Maintenance (cont’d)

This table shows all the elements available on Software Information with descriptions.

Table 7-35

Software Information

Element

Description

Installed Packages

Package Type Type for the software update.
Part Number Part number for the software update.
Version Version for the software update.

Installed Date

Date the software update was installed.

Installed Hotfixes

Hot Fix ID Identifier for the hot fix.
Installed On Date the hot fix was installed.
Description Description for the hot fix.

Windows Defender Status

Status information for Windows Defender.
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Section 7-5
Diagnostics

Contents in this section

7-5-1 Purpose of thissection . . ... . . . . 7-90
7-5-2 Available diagnostics. . . ... ... 7-91
7-5-3 Service Diagnostics List . ... ... 7-92
7-5-1 Purpose of this section
This section describes the available diagnostics.
NOTE: Reboot the LOGIQ Fortis after performing any diagnostics and before returning it to customer
use.
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7-5-2

Available diagnostics
To enter service diagnostic mode, use Utility (second page) > Service > Diags > Run Diags.

See "Service Diagnostics List" on page 7-92 for more information.

Figure 7-53 Run Diags Display

- S S s B

NOTE:

L LDSIQIGAL82/5 DA0GmAcy

To enter into engineering diagnostic mode, press ALT+F2.

Do not use engineering diagnostic mode unless requested by engineering. Some of the tests
require special tools that are not available in the field.

Figure 7-54 Alt+F2 Display

Dpen Log @
Cpen Pep.:

View Log / Report
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7-5-3 Service Diagnostics List
Diag. Description Test
A_DACQ_Access_Test
DACQ DACQ FPGA test A_DACQ_Memory_Test
A_DMAConfigurationTest
A_DSP_DDR3_Test
DSP DSP IC test A_DSP_EMIF_Test
A _DSP_SRIO_Test
) . ) A_ADM_I2C_Test
High voltage (for TX) test including Power
HV Sequencer check, and Emergency HV A_HV_Stop_Test
stop check
A_TX_Power_Control_Test
A_MLP_MEMORY_Test
MLP TX Pulser IC test
DA192 A_MLP_SPI_Test
A_PCle_ClearRegisters_Test
A_PCle_ReadRegisters_Test
PCle PCle signal communication test :S}PCIe_RecelveImagePath_Noanma_T
A_PCle_ReceivelmagePath_Rdma_Test
A_PCle_Communication_Test
A_AnalogReceivePathHi_Test
A_AnalogReceivePathLow_Test
RX AFE RX test
A_AnalogReceivePathMed_Test
A_NoiseFloorTest
SPI SPI test DSP AFE SPI Test
12C Probes Test 12C communicaiton test between Probe 12C Probes Test
DPI-L and System
LVDS SAP Test NA NA
EPAT Probe Channel check test E-PAT Test
Probes 12 12C communication test between Probe 12C Probes Test
and System
TEE NA NA
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Diag.

Description

Test

BEPS

PC Doctor

PC Doctor test

AVI Playback

CDR

DVD Read Only

DVD-R

Essential Test No Network

Essential Test

HD Test Long

HD Test Short

Keyboard

LAN Network interface

LAN Network interface reliability test

Memory

Monitor

Mouse

Sound

RTC clock

USB Ports Test

Video cards

WLAN

Wireless LAN Option test

Wireless Network interface

Wireless Network interface reliability test

Temp.Test

DA192

DA192 Temperature monitoring test

DA192 Temperature Test

GPU

GPU Temperature monitoring test

GPU Temperature Test

COMe

CPU module Temperature monitoring test

SOM Temperature Test

VPD

DA192/DP(L)/BEPS

Vital Product Data communication test

VPD I12C Test

Option

4D basic test without
Probe

4D Motor controller (DC4D) Option, basic
test without Probe

Presence Test

Version Test

4D with Probe

4D Motor controller (DC4D) Option test
with 4D Probe

Static 3D Test

4D Test

Battery

Battery Option (Power Assistant or Scan-
on-Battery) test

A_Battery_Status_Test

Cw

CW doppler Option (GCW) test

A_CWTest_g1_Polaris

A_CWTest_g8 Polaris

A_CWTest_g16_Polaris

A_CWTest_g24_Polaris

A_CWTest_g96_Polaris

A_CWDopplerBeamformerTest_Polaris

A_CWChannelSelectionSwitchControlTest

A_CWSummingGainControlTest_Polaris
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Diag.

Description

Test

Option

Vnav

Volume navigation(Baybird2) test,
including Sensor test and Transmi

Sensor 1

Sensor 2

Sensor 3

tter test Sensor 4

Transmitter

System
7-5-3-1 DA192 diagnostics
Name: DACQ
Table 7-36 DACQ Diagnostics
Description Test Instruction If the test fails... NOTE
A_DACQ_Access_Test 1. Disconnect probes to all four -
ports.
A_DACQ Memory_Test |, rom Service > Diags > Run | CONfirm if DA192 and BEPS i
DACQ FPGA test Diags, select DA192 > DACQ. are inserted to BackPlane
3. Select the Execution Mode and properly. If still Fail, replace
A_DMAConfigurationTest : DA192. -
Loop Count.
4. Select Start.
Name: DSP
Table 7-37 DSP Diagnostics
Description Test Instruction If the test fails... NOTE
A_DSP_DDRS3_Test 1. Disconnect probes to all four -
ports.
A_DSP_EMIF_Test 2. From Service > Diags > Run Confirm if DA192 and BEPS B
DSP IC test Diags, select DA192 > DSP. are inserted tp Baf:kPlane
3. Select the Execution Mode and properly. If stil Fail, replace
A_DSP_SRIO_Test ) DA192. -
Loop Count.
4. Select Start.
Name: HV
Table 7-38 HV Diagnostics
Description Test Instruction If the test fails... NOTE

High voltage (for TX) test
including Power Sequencer
check, and Emergency HV
stop check

A_ADM_[2C_Test

A_HV_Stop_Test

A_TX_ Power_Control_Test

1. Disconnect probes to all four
ports.

2. From Service > Diags > Run
Diags, select DA192 > HV.

3. Select the Execution Mode and
Loop Count.

4. Select Start.

Confirm if DA192 and BEPS

are inserted to BackPlane
properly. If still Fail, replace
DA192.
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Name: MLP
Table 7-39 MLP Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four -
ports.
2. From Service > Diags > Run Confirm if DA192 and BEPS
MLP TX Pulser IC test Diags, select DA192 > MLP. are inserted fo BackPlane
K properly. If still Fail, replace -
3. Select the Execution Mode and
DA192.
Loop Count.
4. Select Start.
Name: PCle
Table 7-40 PCle Diagnostics
Description Test Instruction If the test fails... NOTE

PCle signal communication
test

A_PCle_ClearRegisters_Te
st

A_PCle_ReadRegisters_Te
st

A_PCle_ReceivelmagePath
_NonRdma_Test

A_PCle_ReceivelmagePath
_Rdma_Test

A_PCle_Communication_Te
st

1. Disconnect probes to all four
ports.

2. From Service > Diags > Run
Diags, select DA192 > PCle.

3. Select the Execution Mode and
Loop Count.

4. Select Start.

Confirm if DA192 and BEPS
are inserted to BackPlane
properly.

If still Fail, replace DA192. If
still Fail, replace BEPS.

Name: RX
NOTE: Perform RX test only at first. RX test may be Fail when all DA192 tests are performed at one
time. If you do all DA192 test at one time, perform RX test after re-booting system
(Workaround).
Table 7-41 RX Diagnostics
Description Test Instruction If the test fails... NOTE
A_AnalogReceivePathHi_Te Perform RX test
st . only at first. RX test
A AnalogRecevePathLow 1. glsconnect probes to all four may be Fail when
— — |ports. o all DA192 tests are
Test 2. From Service > Diags > Run Conflrm if 3A1SI332 aEgIBEPS performed at one
AFE RX test Diags, select DA192 > RX. are inserted to BackPlane 1 Yie 1 o all

A_AnalogReceivePathMed_
Test

A_NoiseFloorTest

3. Select the Execution Mode and
Loop Count.

4. Select Start.

properly. If still Fail, replace
DA192.

DA192 test at one
time, perform RX
test after re-
booting system
(Workaround).
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Name: SPI

Table 7-42  SPI Diagnostics

Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four
ports.
2. From Service > Diags > Run Confirm if DA192 and BEPS
SPI test DSP AFE SPI Test Diags, select DA192 > SPI. are inserted to BackPlane .

R properly. If still Fail, replace
3. Select the Execution Mode and DA192.

Loop Count.
4. Select Start.

7-5-3-2 DPI-L diagnostics
Name: I12C Probe Test

Table 7-43  12C Probe Test Diagnostics

Description Test Instruction If the test fails... NOTE

Confirm if Probe is connected

1. Disconnect probes to all four to DPI-L board properly.

ports. Confirm if Probe-Connector-

2. From Service > Diags > Run  |Pin is clean.

12C Probes Test I2C communicaiton test Diags, select DPI > 12C Probe If still Fail, try to use another )
between Probe and System | Test. Probe.

3. Select the Execution Mode and |If still Fail, replace DPI-L

Loop Count. board.

4. Select Start. If still Fail, replace BEPS
board.

Name: LVDS SAP Test
NOTE: DO NOT perform this test. Always Fail without Engineering loopback-JIG.

Table 7-44 LVDS SAP Test Diagnostics

Description Test Instruction If the test fails... NOTE

DO NOT perform
this test. Always
NA NA NA NA Fail without
Engineering-
loopback-JIG.
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7-5-3-3 Probes diagnostics
Name: E-PAT Test

NOTE: E-PAT does not support Pencil probes and 6Tc probe. E-PAT may not work properly with 6S-

D, L3-12-D, M5Sc-D, ML6-15D.

Table 7-45 E-PAT Diagnostics

Description Test Instruction If the test fails...

NOTE

This test is pass or fail.
Passing means that the test is

1. Disconnect probes to all four
complete. Not that the probe has

EPAT does not
support Pencil

ports.
2. From Service > Diags > Run passed.. o S:gg:s and 6Tc

Probe Channel check test |E-PAT Test Diags, select Probes >e-PAT. | Iftest fa";’ g/!s pmbabl'y due to f”d EPAT work
3. Select the Execution Mode and unsupporte |mpropery connecte may. not wor
Loop Count probe or a malfunctioning probe. properly with 6S-D,

' To keep track of probe performance, |[L3-12-D, M5Sc-D,
4. Select Start. graph the results for comparison over |ML6-15D
time.
Name: 12C Probe Test
Table 7-46  12C Probe Test Diagnostics
Description Test Instruction If the test fails... NOTE

1. Disconnect probes to all four Confirm if Probe is connected to DPI-L
ports. . . board properly.

2 — E":rzmszfazlgfozgiglszz IFi:'J:be Confirm if Probe-Connector-Pin is

i
C communication test 12C Probes Test gs, clean. B
between Probe and System Test L
. If still Fail, try to use another Probe.

3. Select the Execution Mode and If still Fail | DPI-L board
Loop Count. still Fail, replace -L board.

If still Fail, replace BEPS board.

4. Select Start.

Name: TEE Probe Test
NOTE: DO NOT perform this test. Always Fail without Engineering loopback-JIG.

Table 7-47 TEE Probe Test Diagnostics

Description Test Instruction If the test fails...

NOTE

NA NA NA NA

DO NOT perform this
test. Always Fail
without Engineering-
loopback-JIG.
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7-5-3-4 BEPS diagnostics
Name: PC Doctor Test
Description Test If the test fails... NOTE
AVI Playback Not used - -

PC Doctor test

CDR

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > CDRKk.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the DVD-R drive.

DVD Read Only

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > DVD Read
Only.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the DVD-R drive.

DVD-R

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > DVD-R.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the DVD-R drive.

Essential Test No
Network

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Essential Test
No Network.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the BEPS.

Essential Test

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Essential Test
3. Select the Execution Mode and Loop
Count.

4. Select Start.

Due to the network, check the network
connection and setup.

This test expects the network to be
connected and active.

And the network connection is up and
active, replace the

BEPS.

HD Test Long

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > HD Test Long.
3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the SSD.
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Description

Test

If the test fails...

NOTE

PC Doctor Test

HD Test Short

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > HD Test Short
3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the SSD.

Keyboard

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Keyboard.
3. Select the Execution Mode and Loop
Count.

4. Select Start.

If there are any errors, keys may be
damaged and you may have to replace
or repair the keyboard.

LAN Network
interface

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > LAN Network
Interface.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Check the ICM and internal LAN cable.
Check the BEPS.

Overall test result may
indicate FAIL, please
confirm Diag detail
result on
ServiceDesktop, then
wired-LAN or wireless-
LAN test result can be
confirmed.

LAN Network
interface reliability
test

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > LAN Network
interface reliability test.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Check the ICM and internal LAN cable.
Check the BEPS.

Overall test result may
indicate FAIL, please
confirm Diag detail
result on
ServiceDesktop, then
wired-LAN or wireless-
LAN test result can be
confirmed.

Memory

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Memory.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the SOM

DO NOT perform this
test. Test result may
not be displayed
depends on the SW-
version.

Monitor

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Monitor.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the monitor

Mouse

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor > Mouse.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Replace the trackball.

Sound

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select BEPS > PC Doctor >Sound.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

If no sound is produced in these tests,
choose the More Info button in the Audio
Test dialog box for information about
possible causes and solutions.
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Description Test If the test fails... NOTE

1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags, Replace the battery on the BEPS board.
RTC clock select BEPS > PC Doctor >Sound. If the test still fails, replace the BEPS )
3. Select the Execution Mode and Loop |board.

Count. If still fail, replace the SOM.

4. Select Start.

1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags,
select BEPS > PC Doctor >USB Ports
PC Doctor Test |USB Ports Test Test. Check the USB device. -
3. Select the Execution Mode and Loop
Count.

4. Select Start.

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags, Replace VCS

) select BEPS > PC Doctor >Video cards. o
Video cards i If still fail, replace BEPS. -
3. Select the Execution Mode and Loop o

If still fail, replace SOM.

Count.
4. Select Start.

Name: WLAN

Table 7-48 WLAN Diagnostics

Description Test Instruction If the test fails... NOTE

Wireless Network interface | 1. Disconnect probes to all four -

Confirm Wireless network
ports.

. . setting.
. , 2D'.Fr°m sf"";‘;; g'a!xl_;ﬁ““ If still fail, replace Wifi module.
Wireless LAN Option test | \yjrless Network interface | 2129S: select > :

3. Select the Execution Mode and if stillfail, replace SOM. B
reliability test . xecuti e
Loop Count. If still fail, replace BEPS.

4. Select Start. If still fail, replace BackPlane.
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7-5-3-5 Temp. Test diagnostics
Name: DA192
Table 7-49 DA192 Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags,
lect T .Test>DA192 T t
DA192 Temperature |DA192 Temperature .T.isef emp. 1es emperature Replace DA192. )
itoring test Test ill fai
meniioring fes es 3. Select the Execution Mode and Loop If still fail, replace BEPS.
Count.
4. Select Start.
Name: GPU
Table 7-50 GPU Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags,
select Temp. Test > GPU Temperature
GPU Temperature P P Replace GPU.
monitoring test GPU Temperature Test | Test If still fail, replace BEPS )
3. Select the Execution Mode and Loop stll fall, replace
Count.
4. Select Start.
Name: COMe
Table 7-51 COMe Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags,
lect T .Test>SOM T t
CPU module select Temp. Tes emperature Replace SOM.
Temperature SOM Temperature Test |Test e -
N . If still fail, replace BEPS
monitoring test 3. Select the Execution Mode and Loop
Count.
4. Select Start.
7-5-3-6 VPD diagnostics
Name: DA192/DPI-L/BEPS
Table 7-52 DA192/DPI-L/BEPS Diagnostics
Description Test Instruction If the test fails... NOTE
1. Disconnect probes to all four ports.
2. From Service > Diags > Run Diags, . .
) Specify Failed board by LOG
Vital Product Data /o 156 gt select VPD> VPD [2C Test file or VPD editor. -
communication test 3. Select the Execution Mode and Loop
Replace defect board.
Count.
4. Select Start.
7-101
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7-5-3-7 Option diagnostics
Name: 4D basic test without Probe
Table 7-53 4D basic test without Probe Diagnostics
Description Test Instruction If the test fails... NOTE
Presence Test 1. Disconnect probes to all four ports. -
2. From Service > Diags > Run Diags, Check to see if the option is
4D Motor controller select Option > 4D basic test without installed.
(DC4D) Option, basic ' Probe. If the option is installed,
test without Probe Version Test 3. Select the Execution Mode and Loop  |replace DC4D. )
Count. If still Fail, replace BEPS.
4. Select Start.
Name: 4D basic test with Probe
Table 7-54 4D basic test with Probe Diagnostics
Description Test Instruction If the test fails... NOTE
Static 3D Test 1. Disconnect probes to all four ports. Check to see if the option is -
4D M i 2. From Service > Diags > Run Diags, installed.
(DC4I(D)t)oécct)'2tr:0teii select Option > 4D basic test with Probe. |If the option is installed, try to
i
with 4D Prrc))be 4D Test 3. Select the Execution Mode and Loop  |use another 4D probe. -
Count. If still Fail, replace DC4D.
4. Select Start. If still Fail, replace DPI-L.
Name: Battery
Table 7-55 Battery Diagnostics
Description Test Instruction If the test fails... NOTE

Battery Option (Power
Assistant or Scan-on-
Battery) test

A_Battery_Status_Test

1. Disconnect probes to all four ports.

2. From Service > Diags > Run Diags,
select Option > Battery.

3. Select the Execution Mode and Loop
Count.

4. Select Start.

Confirm if Battery Cable (of
each Battery Pack, both of
Power-cable and Signal-
cable) is connected to BBG2
board.

Confirm if BBG2 Power cable
and signal cable are
connected to BEPS properly.
If installed Option is Power-
Assistant(2 packs), confirm the
assembled-Battery location is
same as Installation-manual.

if still fail, replace BBG2.

if still fail, replace all Battery
Packs.

If still fail, replace Harness
between BBG2 and BEPS.
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Name: CW

Table 7-56 CW Diagnostics

Description Test Instruction If the test fails... NOTE
A_CWTest_g1_Polaris -
A_CWTest_g8_Polaris -
A_CWTest_g16_Polaris -
A_CWTest_g24_Polaris 1. Disconnect probes to all four ports. _

2. From Service > Diags > Run Diags,
CW doppler Option ~ |A_CWTest_g96_Polaris |select Option > CW. Replace GCW. -
(GCW) test A_CWDopplerBeamform|3- Select the Execution Mode and Loop  |If still fail, replace DA192.
erTest_Polaris Count. i
—14. Select Start.
A_CWChannelSelection .
SwitchControlTest
A_CWSummingGainCo _
ntrolTest_Polaris
Name: Volume Navigation
Table 7-57 Volume Navigation Diagnostics
Description Test Instruction If the test fails... NOTE
Move sensor 1 (transducer) to
a different port. If the
S 1 transducer fails, replace the )
ensor transducer.
If the problem still persists,
replace the bayBIRD.
Move sensor 2 (transducer) to
a different port. If the
S 9 transducer fails, replace the )
ensor transducer.
If the problem still persists,
) replace the bayBIRD.
1. Disconnect probes to all four ports.
Volume navigation 2. From Service > Diags > Run Diags, Move sensor 3 (transducer) to
(Baybird2) test, select Option > Volume Navigation. a different port. If the
including Sensor test | gengor 3 3. Select the Execution Mode and Loop | ransducer fails, replace the -
and Transmitter test Count. transducer.
4. Select Start If the problem still persists,
’ ’ replace the bayBIRD.
Move sensor 4 (transducer) to
a different port. If the
S 4 transducer fails, replace the )
ensor transducer.
If the problem still persists,
replace the bayBIRD.
. If the problem still persists, _
Transmitter replace the bayBIRD.
If the problem still persists, _
System replace the bayBIRD.
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Section 7-6
Back End Troubleshooting

Contents in this section

7-6-1 Back end isolation from the front end (Simulatormode). .. ...................... 7-104
7-6-2 GPU proCessing ITOrS . . . . oo e 7-104

7-6-1 Back end isolation from the front end (Simulator mode)
To isolate the front end from the back end and boot up in Simulator mode, you must:
+ Power down the LOGIQ Fortis, and open the card rack.
» Disconnect the BEPS board from the back plane.
» If present, Disconnect the BBG2 Power/Signal cable for Battery Option.
In Simulator mode, the scan screen may display a white image screen or no scan at all, but will allow
other application functions to run normally.
7-6-2 GPU processing errors
If transmitting errors between DA192 and GPU occur, a message appears as a system error, indicating
that the system cannot keep up with the streaming data. If minor errors occur, the system can recover
on its own and the system error will request the user to re-select the probe to continue scanning.
The signal path between the DA192 and GPU is digital and can be tested using the DA192 Digital
diagnostics. The PCle transfer test in the DA192 (Digital) tests communication and errors between the
DA192 Digital interface and the GPU.
It may be hard to isolate problems with the GPU versus the DA192. These PCLe Communication
diagnostics can help determine the origin of a problem:
+ PCle ImagePath NonRdma tests the communication between the DA192 Digital interface and the
BEPS CPU
+ PCle ImagePath Rdma tests the communication between DA192 Digital interface and the GPU
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7-6-3 GPU overheating

If the GPU is collecting lint or dirt inside, it will cause overheating messages and the system will typically
shut down. Follow the instructions below to clean the GPU.

A CAUTION Risk of damage to the GPU. Please be careful when opening and cleaning the GPU.

To clean the GPU:

1.) Remove GPU from BEPS Assy. Refer to 8-8-6 "BEPS Assy Replacement" on page 8-144 and 8-8-9 "GPU
replacement" on page 8-156.

2.) Remove the seven T5 Torx screws from the top cover on the GPU.
NOTE: The screws are very small. Take care to not lose any of the screws.

A CAUTION Risk of damage to the fan blades on the GPU. Take extra caution as the fan blades can be easily
broken.

3.) Carefully remove visible lint from the fan blades and heat sink assembly. If necessary, use a
static-free vacuum cleaner.

4.) Replace the cover on the GPU and reinstall the seven TS Torx screws.
5.) Reinstall all parts to the system in reverse procedure.
6.) Start the Ultrasound system and check the temperature of the GPU.
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Section 7-7
Connectivity Troubleshooting

7-7-1 Image problems . ... .. 7-106
7-7-2 Network problems . . . . ... 7-107
7-7-3 Ping problems . . . ... 7-107
7-7-4 Storage problems . . ... ... 7-109
7-7-5 Setting problems . . . ... 7-109
7-7-6 Transfertimes and failures . . . ... .. . . 7-110
7-7-7 Spooler problems . . ... 7-111
7-7-8 Slow transferrates .. ... . 7-111
7-7-9 INSite CONNECHION. . . . . ... e 7-112
T-T-10  WIreleSS . . oot 7-112
7-71 Image problems
Table 7-58 Image Problems
Symptom Cause Solution
Incorrect settinas Check Utility > Connectivity > Miscellaneous and, under Print
gs: and Store options, select Send Images via Wireless.
. . When connected to the network through a wireless LAN
No images sent on wireless. Wireless is not connection and Send Images via Wireless is selected, images
available on all will be sent to the DICOM device over the wireless LAN. If not
systems. selected, spooled images will be sent when the Ultrasound
system is connected to the wired network.
Images from one patient ended up on |Edit a.nd Copy tool Have customer contact GE Service.
prior patient exam. used incorrectly.
Frozen duall 'mage W'.th.ECG graph . Frozen dual image with ECG graph stored as clip when
stored as clip when printing and sending | Unknown. rinting and sending to PACS
to PACS. printing 9 '
Most likely Direct Store
is selected on the Disable the DICOM Store Device on the print key.
Getting double images of everything on | Dataflow and/or the or
DICOM Store Device. DICOM Store Deviceis | )
selected on the print Disable the DICOM Store in the dataflow.
key.
Color images are transferring with No Incorrect color settings. | Change Color Support to Mixed.
color or color is showing as white. Disable Use Button Settings.
Dual screen images are very small on Incorrect settin Under Utility > System > System Display > Use Wide Screen
DICOM Store Device monitor. 9 For..., unselect Dual screen.
Most likely the
Images are populating out of order on hanging protocpl qn Under Utility > Connectivity > Miscellaneous; change Image
. the DICOM Device is L
DICOM Store Device. . : Order Scheme to Acquisition.
not sorting by image
instance ID.
Image number on DICOM Store device Incorrect settin Under Utility > Connectivity > Miscellaneous; change Image
are not 1,2,3. 9 Order Scheme to Off.
: Under Utility > Connectivity > Misc. select Add Titlebar
No Title bar and/or Image Parameters . . . .
on cine clio imaaes Incorrect setting. information to multiframe loops and/or Add Scan Parameter
P ges. Information to multiframe loops.
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7-7-2

7-7-3

Network problems

Table 7-59 Network Problems

Symptom

Cause

Solution

Cannot connect to PACS through the
network.

Network properties are
not correct.

Network card failure.

Open a command prompt.

“Ping 127.0.0.1" and verify no lost packets. If there is an error,
try to reimage.

“Ping“ IP address for the LOGIQ Fortis (given by hospital or
the listed default in manual) and verify no lost packets. If there
is an error, replace the BEPS.

“Ping” gateway if given one and verify no lost packets. If there
is an error, verify that network cable plugged in, and the
network lights on the front are blinking. Double check subunit
and gateway are correctly entered. This point and beyond are
hospital issues.

“Ping” another machine on the network and verify no lost
packets. If there is an error, try pinging from another computer
on the same network.

Ping problems

Table 7-60 Ping Problems

Symptom

Cause

Solution

No ping through the network.

Media type not set to
Auto Select.

Check the speed of your connection. Media type should be set
for Auto Select. Remember that every time the LOGIQ Fortis
is re-ghosted that setting goes back to the default value.

Hardware not
connected properly.

Check cables. You need a crossover cable if you are
connected directly to the device. Use a straight cable
whenever you go through a hub. The use of a hub is highly
recommended.

Try connecting the network cable directly to the Ethernet port
in the BEPS. If the connection works, troubleshoot the cabling
to the external device.

Incorrect address.

Check proper addressing. The LOGIQ Fortis should be under
the same subnet or have a gateway address to be able to
connect to another subnet.

Network is down.

Verify that the network is active and running.

With your laptop check to see if you can ping the LOGIQ Fortis
and the device (Printer or PACs).
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Table 7-60

Ping Problems (Continued)

Symptom

Cause

Solution

No verify for the DICOM server.

Server does not
support the DICOM
service.

Check if the device supports Verify.

Port or AE title settings
are not correct.

Check port and AE title info.

Server is not running.

Check if the device is up and running. It may be up but in an
error status. Reboot the device if possible. You also may need
to reboot the LOGIQ Fortis.

Use Network Capture.
See "Network Capture" on page 7-68.

Clean User Defs before reloading software in case there is a
corrupt Connectivity.res file. Perform an Alt+D to capture logs

Ping fails for a device.

Unknown before performing a Clean User Defs so that, if the presets are
corrupt, the logs can be sent to Engineering for review.
See "Clean Userdefs" on page 7-58 for more information.
Reload software.
See "Software Reload" on page 7-78 for more information.
Bad network Verify network connection, check “computer” icon on the
connection. Windows Desktop.

Bad network wall port.

Try plugging the network cable into a different network wall
port.

Bad cable.

Try a new network cable.

Incorrect IP address.

Confirm IP Address is correct on the Device page.

Remote DICOM device
does not accept pings.

Contact the PACS Administrator.

Pings successful for a device but fails
for a service.

Incorrect settings.

Confirm AE Title and Port Number are correct on the Device
page.

Systemis not set up on
the host table at the
remote DICOM device.

Contact the PACS Administrator and make sure the Service
Class User (SCU) and Service Class Provider (SCP) between
the LOGIQ Fortis and the remote DICOM device is correct.

Remote DICOM device
does not support the
ping.

Contact the PACS Administrator.

Pings successful and verified for a
DICOM worklist service, but a query
returns no results.

Incorrect/incompatible
date or time settings on
the system.

Check date and time (AM & PM) setting on the LOGIQ Fortis.

May need to set the LOGIQ Fortis so that it is one or two
minutes later than the DICOM device.

Modality setting is not
correct.

Make sure Modality is correct under Search Criteria on the
Service page.

Scheduled Procedure
Step Start Date is not
correct.

Make sure Scheduled Procedure Step Start Date is correct
under Search Criteria on the Service page.

System is not set up on
the host table at the
remote DICOM device.

Contact the PACS Administrator and make sure the Service
Class User (SCU) and Service Class Provider (SCP) between
the LOGIQ Fortis and the remote DICOM device is correct.

No patients match the
search criteria.

Contact the PACS administrator and make sure the
Ultrasound system is registered. This scenario usually results
in an error displayed on the Ultrasound system.
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7-7-4

7-7-5

Storage problems

Table 7-61

Storage Problems

Symptom

Cause

Solution

System will not store images.

Dataflow is set to No
Archive under
Properties.

Change from No Archive to Local Archive.

Reboot the scanner. If the problem persists, contact GE
Service.

As a workaround to save images, set up a print key to send to
DICOM Store Device only or use Save As to save images to
external media.

Query and retrieve does not work when
alternating between a wired and
wireless network connection.

Going back and forth
between a wired and
wireless connection
can result in improper
network settings.

Check the network settings.

LOGIQ Fortis is not receiving exams.

LOGIQ Fortis does not
have the correct device
set up.

Set up the remote DICOM device on the Device page.

Setting problems

Table 7-62  Setting Problems

Symptom

Cause

Solution

Unchecking of DHCP does not stick on
reboot.

Default Gateway was
not entered.

When selecting Static IP connectivity, always enter Default
Gateway. If you do not enter a value, the static IP settings will
be erased on reboot.

It takes time to show patient list for
DICOM Read and Import.

Unknown

When there are multiple patient files on a USB device, the
LOGIQ Fortis may take a longer than expected amount of time
to display the patient list when reading and importing DICOM
files.

Print key is not set to
Single.

Under Utility> Applications set the print key to Single.

Incorrect button
setting.

Under Connectivity > Button make sure Format under Still
Images is set to Ultrasound Image.

Measuring pixels on DICOM Store
Device.

Incorrect compression
setting.

Under Connectivity, check compression for DICOM Store
Device. Typically, compression is not preferred because it
reduces the quality.

Incorrect setting.

Dual images are stored as secondary capture on all but the
LOGIQ Fortis and do not send Regional calibration data.
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7-7-6 Transfer times and failures
Table 7-63  Transfer Times and Failures
Symptom Cause Solution
Slow response from
the DICOM server. Check device configuration. Increase the time out properties.
Large data sets.
s Check device configuration. Increase the number of parallel
Server limitations. . .
ports if possible.
Clean the spooler (F4). If the jobs in the spooler cannot be
deleted, you need to do it in Windows. These jobs may be
corrupted or may be using a lot of space in the disk and
causing problems with the sending of DICOM images. Insert
Probl ith th the SSA key, turn the LOGIQ Fortis on and log in into
roblem with the maintenance and exit to Windows (the application should not
spooler. be running). Then go to Windows Explorer and look for the file
E:\Spooler\jobqueue.xml. Delete the file. See "DICOM
Spooler" on page 7-50.
Delete the files from E:/Spooler and then the Recycle Bin.
Reboot the LOGIQ Fortis.
Check the Connectivity configuration on the
System pings and verifies but there is a LOGIQ Fortis.
transfer failure from the LOGIQ Fortis to « Ifitis a printer, check that the printer supports the film type
the DICOM server. and format. Some printers do not support different image
sizes (or different formats, such as the Patient entry screen).
Probl ith th If this is the case, the spooler may show the job in a “Done”
Cro emg _W't the status but the images never get printed. Try sending
on.nect|v'|ty secondary capture.
configuration. . . . .
« If it is a storage device, check whether the image type is
supported (color, gray, Multiframe).
« If it is a Worklist broker, use a Dataflow in which your
Worklist is the primary input. Otherwise, it will not let you
retrieve patients. Also, check your Worklist search criteria
configuration.
Use Network Capture. See "Network Capture" on page 7-68.
Clean user-defined data before reloading software in case
there is a corrupt Connectivity.res file. Do an Alt+D to capture
Unknown logs before cleaning user-defined data so that if the presets
prove corrupt the logs can be sent for review. See "Clean
Userdefs" on page 7-58.
Reload the software. See "Software Reload" on page 7-78.
Problem with file size . .
and compression. Check Compression under Still Images on the Button page.
Large files need to be compressed to improve transfer time.
Size of the exam.
Long transfer times. )
Check Network Speed on the TCP/IP page. Auto Detect is
Network speed and . g h
. generally a preferred selection. NOTE: Using a wireless
settings on the ; ) -
connection to transfer images can take 4-5 times longer than
Ultrasound system. . .
a wired connection.
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7-7-7

7-7-8

Spooler problems

Table 7-64 Spooler Problems

Symptom Cause

Solution

Destination unable to
view the particular
photometric
interpretation.

Jobs exist on the spooler but do not
display at destination (sometimes only
on Cine or Secondary Capture).

Check what compression and photometric interpretation the
destination device supports and adjust (if possible) on the
destination service to the settings, which results in successful
viewing.

Note that compression JPEG will give photometric
interpretation YBR_FULL_422, RLE will give YBR_FULL and
uncompressed will give RGB. The exception to this is if you
enable B/W only, then you will get photometric interpretation
MONOCHROMES2 for all compressions.

Images say Done in Spooler but are not

populated on DICOM Store Device. Incorrect settings.

Confirm My Computer > AE Title on the Device page is
correct. The DICOM Store Device may use the AE Title of the
ultrasound machine to determine where the images are placed
in the DICOM store device.

Slow transfer rates

Table 7-65 Slow Transfer Rates

Symptom Cause

Solution

Images being re-sent
automatically and low
transfer rates.

Slow transfer between the LOGIQ
Fortis and DICOM server.

Adjust the retry settings to make jobs retry on bad networks.
There is no need to set retries for mobile (off-line) use.

See 6-4-1 "Slow response rate between the LOGIQ Fortis and
a DICOM (PACS) server" on page 6-13.

Increase compression

« Uncheck Use Button Settings
» Set the Max Framerate to 25%
« Set Clip Quality to 85%

« Set Color Support to Mixed
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7-7-9

7-7-10

InSite connection

Table 7-66 InSite Connection

Symptom

Cause

Solution

Cannot connect to InSite because of
missing DNS address.

Some customer sites
cannot connect to the
GE back office using
the URLs provided by
default in the Agent
Configuration page. A
DNS address is
needed but the LAN
connectivity set up
pages do not offer the
entry field. Only the
WLAN set up pages
allow that entry. The
agent configuration on
the service desktop
does not work using IP
addresses when
selecting Enterprise

server as “other”.

See 7-4-10 "Agent Configuration" on page 7-82.

This needs to be repeated if the software has been reloaded
to regain InSite connectivity.

Wireless

Table 7-67 Wireless

Symptom

Cause

Solution

Cannot set up wireless connection.

CISCO PEAP
authentication
methods for wireless
connectivity are not
available.

If the hospital wireless network supports PEAP authentication,
use the Microsoft PEAP authentication methods for wireless
connectivity.
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Section 7-8
Electromagnetic Interference (EMI) Troubleshooting

7-8-1

7-8-2

NOTE:

7-8-3

7-8-4

7-8-5

Contents in this section

7-8-1 Prevention/abatement . ........ . . ... 7-113
7-8-2 Different poweroutlet . . .. ... ... 7-113
7-8-3 Different system . . ... . 7-113
7-8-4 Different location. . . .. ... e 7-113
7-8-5 Disconnect external cables. . . ... ... . . ... 7-113

Prevention/abatement

For electromagnetic interference (EMI) rules and details, see 2-2-3 "EMI limitations" on page 2-6.

Different power outlet

Connect the LOGIQ Fortis to another power outlet and check to see if the noise changes or disappears.

Image artifacts can occur if, at any time within the facility, the ground from the main facility's incoming
power source to the LOGIQ Fortis is only a conduit.

See 2-3-4 "Minimal floor plan suggestions"” on page 2-11.

Different system

Try another LOGIQ Fortis at the same location and look for the same noise. If the noise is present on
the new system too, the noise is most likely from an external source/equipment.

Different location

Move the LOGIQ Fortis to another location and check to see if the noise changes or disappears. This
may help to locate an external noise source.

Try to move the LOGIQ Fortis to:

* another location inside the room
« another room
» another floor

Disconnect external cables

Disconnect all external cables (network, all unused probes, ECG leads, etc.) and check to see if the
noise disappears.
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Section 7-9
Image Troubleshooting

7-9-1

7-9-2

7-9-3

Contents in this section
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7-9-2 Image management . ... ... 7-114
7-9-3 Image quality. . . ... ... 7-114

Image artifacts

When the image artifact is observed or Analog RX diag is Failed, that may be caused by insufficient
connection of Stacking-connector (between DPI-L and DA192).

It is recommended to confirm the Stacking-connection. If connection is insufficient, Gold-Plating area
may be observed.

In that case, try to push each board by strong force to hidden Gold-Plating area.

Figure 7-55 Image Artifacts

Image management

When a VCI Omniview clip is recalled from the clipboard for the first time after reselecting an
Application, trackball does not show Omniview controls. Reselect the Omniview line selection from the
touch panel.

Cannot delete Images from Active Images Screen after a Save As operation. If a clip is saved from the
active images screen via Save As it cannot be deleted until system is rebooted.

Image quality

B-Mode 1Q change when activating M-Mode on recalled cine Activating M-Mode on recalled images
introduces undesirable image quality and is not recommended.

Acquire M-Mode Acquisition while scanning.
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Section 7-10
Smart Device Apps Troubleshooting

7-10-1

7-10-2

7-10-3

7-10-4

Smart Device apps are used on Android devices (both phone and tablet) through a Bluetooth connection
to the LOGIQ Fortis. For more information, see 5-4-8 "Smart Device applications" on page 5-18.

Smart Device apps pairing confirmation delay

The Smart Device apps may require 10-30 seconds to pair. Turn the Bluetooth setting off and then on
again can minimize this delay time.

Smart Device apps library downloads

After downloading LOGIQ Remote and LOGIQ Photo immediately enter the barcode reader or pairing
screen. This initiates download of critical libraries to the device. Only turn off wireless after this has been
completed or the apps will fail to function.

LOGIQ Photo crashes if camera permission denied

If a user decides to deny permission to the camera on first launch of one of the Smart device apps the
app crashes when attempting to use it.

If a user decides to deny permission to the Camera on first launch of one of the LOGIQ Apps the app
crashes when attempting to use it

Upside down image from LOGIQ Photo

On certain devices (including the Lenovo Taba 4 10"), the images are sent to the LOGIQ Fortis upside
down.

Lock the device screen rotation and take pictures upside down.
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Section 7-11
Boot Issue Troubleshooting

7-11-1 No boot (Minimum configuration to boot)
Try to determine how far the system tries to boot:

»  With the main breaker on, do you get a white back light on the on/off button?

If not, check AC outlet. If AC outlet is connected correctly, then check internal-connection of BEPS
inside, including ACDC module connection. Also, recommend to try to disconnect Battery Cables.

» If you press the power on button, does it change color to blue? Power on button tells the BEPS to
turn ON and drives PSON_N low (active) to power up ACDC-module. ACDC-module turns on 12V.

If the BEPS is not booting, BEPS module and/or CPU-module may need to be replaced.

* Is Windows loading? If it seems to hang while loading, try reloading the software.

* Is Windows loading but the application software does not start, try reloading the application
software.

» Is the application ready to scan? If not, check logs to see if there are any hardware compatibility
issues that would prevent a normal scan.

Try minimum configuration to boot:

*  Minimum configuration 1 - WARNING DO NOT LEAVE SYSTEM ON as fans will not be running.

+  The minimum configuration to boot the LOGIQ Fortis requires the BEPS (with CPU module), Lower/
Upper OPIO for Power On, and the main display.

These boards may be removed/unplugged:

«  DA192

« DPI-L

*  GBP (Backplane)

» All options (DC4D, VCS, GCW, VSIO, V-Nav, etc.)
The following are connected to the BEPS:

+ LCD J8 (on BEPS) to provide P12V Power to Monitor
* J1 (on BEPS) to provide Live5V power to Lower OP IO, and to connect PSON signal

+ J3/J4(on BEPS) for HDMI signals (NOTE: keep all connection, Lower OP IO <-> Upper OPIO,
Upper OPIO<->Monitor)

If the LOGIQ Fortis is not powering up by pressing the On/Off button, try to power up pushing the U66
button on the BEPS board.
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Section 7-12
Noise Troubleshooting

7-121
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Noise

Ultrasound machines are susceptible to Electromagnetic Interference (EMI) from radio frequencies,
magnetic fields, and transients in the air or wiring. They also generate EMI. Possible EMI sources
should be identified before the unit is installed. Electrical and electronic equipment may produce EMI
unintentionally as the result of a defect. Some of these sources include:

* medical lasers

* scanners

* cauterizing guns
* computers

*  monitors

+ fans

+ gelwarmers

* microwave ovens
» light dimmers

* portable phones

The presence of a broadcast station or broadcast van may also cause interference.

When talking to the customer, try to gather as much information as possible about the conditions when

the noise appears.

Table 7-68 Noise Conditions

The noise is present

Determine

If the test fails, see...

All the time

n/a

7-12-2 "Noise picked up from the air" on page 7-118 and
7-12-3 "Noise received through the external cables" on page
7-118.

After some time of use

The amount of time
between initial use and
when the noise begins.

7-12-2 "Noise picked up from the air" on page 7-118.

Certaln times of the day or night

The time of day or night
along with the duration.

7-12-2 "Noise picked up from the air" on page 7-118 and
7-12-3 "Noise received through the external cables" on page
7-118.

At all locations in the hospital

n/a

7-12-2 "Noise picked up from the air" on page 7-118.

Only in one room or area

The room or area

7-12-2 "Noise picked up from the air" on page 7-118 and
7-12-3 "Noise received through the external cables" on page
7-118.
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Table 7-68

Noise Conditions (Continued)

The noise is present

Determine

If the test fails, see...

From time to time with no special
pattern of time is observed

n/a

7-12-2 "Noise picked up from the air" on page 7-118 and
7-12-3 "Noise received through the external cables" on page
7-118.

7-12-2 Noise picked up from the air
Table 7-69 Noise Conditions Picked Up from the Air
Symptom Cause Solution
Noise is coherent -“penlight noise”
?aoé?g?; (tjr?ew:c;ir;;hiz felzg:/"l'eglfntg"the .The electromagnetic | Test whether the noise is picked up by a probe cable.
channels interference (EMI) from
i radio frequencies,
Noise is a problem on a single probe. |magnetic fields, and Test with another probe.
— - transients in the air. - : } !
Noise is a problem on a single probe Move the LOGIQ Fortis to another location to see if the noise
port. persists.
7-12-3 Noise received through the external cables
Electromagnetic Interference (EMI) from radio frequencies, magnetic fields, and transients in the wiring.
The noise can enter the LOGIQ Fortis through the mains power cable, probe cable(s) or any other
external connected cable(s).
Disconnect cables that are not needed for the basic use of the LOGIQ Fortis:
* Network cable
+ Cables to any external peripherals
+ ECG cables and other cables connected to the Patient 1/0O
Verify whether the noise changed or disappeared when the cables were removed.
Often, this type of noise is due to grounding problems in the mains power system or when the LOGIQ
Fortis is sharing a power line with other equipment.
7-12-4 Doppler noise

Doppler noise symptoms can be horizontal stripes or spikes.

Table 7-70

Noise Conditions for Doppler

Symptom

Cause

Solution

Horizontal stripes

Typically an analog
problem caused by the
DA192 or DPI-L

Determine if one of these boards is the cause:
« Transmit & Receive board (DA192)
* Probe interface board (DPI-L)

Spikes

Typically a digital
problem caused by
either the DA192 or
DPI-L

Determine if one of these boards is the cause:
« Transmit & Receive board (DA192)
* Probe interface board (DPI-L)
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7-12-5 Intermittent noise

Intermittent noise can be caused by other equipment.

Table 7-71  Noise Conditions for Intermittent

Symptom Solution
Intermittent noise Check equipment that is turned on and off near the scanner.
Intermittent noise present around the clock Check the clock.
. . L Check equipment that is turned on and off near the scanner at
Intermittent noise present at certain times .
certain times.
7-12-6 Noise on a board
Table 7-72 Noise on a Board
Symptom Solution

Isolate the board to see if you can determine the specific board
where the noise originates.

For example, unplug the receive area of the board and see if
the noise persists.

There is noise on a board
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7-12-7 B-Flow noise issue

At B-Flow with C1-6 probe, B-Flow noise induced by AC power supply (TDK-ACDC) was observed on
LOGIQ Fortis. See the B-Flow issue image.

Figure 7-56 Vertical noise issue image

To prevent this issue, BEPS2 assy has Power supply bracket cover included absorber sheet. This
BEPS2 assy is being used for all forward production for LOGIQ Fortis. But some of the FRU parts
(BEPS2 Assy - 8813300-10) in stock have not included this sheet. If BEPS2 assy needs to be replaced
in the field, make sure to check that power supply bracket cover is included absorber sheet to the new
BEPS2 assy. If it is not included, it needs to transfer the power supply bracket cover of BEPS2 in
console to new FRU part (BEPS2 assy). perform the following procedure to prevent the issue.

The absorber sheet on power supply bracket cover and BEPS2 Assy with absorber sheet images:

E

| T

Power Supply Bracket cover with BEPS2 Assy with absorber sheet (The image
absorber sheet in BEPS2 assy)
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7-12-71 To transfer the Power supply bracket cover to new FRU part
About BEPS assy replacement procedure, See “BEPS Assy Replacement” on page 8-144.

Table 7-73 BEPS removal

Step Corresponding Graphic

1. | Remove the BEPS Assy.
Place it on an ESD safe place.

NOTE: Use Card puller (indicate orange circle) to
pull out BEPS assy.

2. Remove BEP TOP PLATE from current BEPS
Assy2 and new BEPS Assy (14 screws).
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Table 7-73 BEPS removal

Step

Corresponding Graphic

*For current BEPS assy

Unscrew 4 screws (red circle) from Power supply
bracket cover (with Absorber sheet), then take it
from current BEPS assy.

*For New BEPS2 assy (FRU part)

Unscrew 4 screws (red circle) from Power supply
bracket cover. Also, Take Power supply bracket
cover (without Absorber sheet) from New BEPS
Assy.

*For New BEPS2 assy(FRU part)

Install Power supply bracket cover of Step 3 to New
FRU part (Step4), fasten 4 screws (red circle).
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Section 7-13
Options Troubleshooting

7-13-1

7-13-2

Contents in this section
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7-13-5
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Unable to measure in both stiffness and velocity in Breast and Thyroid ............ 7-123
Breast Assistant, Powered by Koios DS. . .. ... .. .. 7-124
Device Management (Device Mgmt) . ....... .. ... 7-125
Continuous Wave (CW) . . ... 7-136

ECG display disappears after backup/restore

With ECG, after system auto-restart, turn system off and then back on. Otherwise ECG and TGC may
not function until next full power cycle.

Unable to measure in both stiffness and velocity in Breast and Thyroid

WIth Shearwave, when entering Measurement in Breast or Thyroid, only the stiffness measurements
show up on the touch panel if display units is set to kPa, even though both stiffness and velocity are
enabled in the Utility pages.
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7-13-3 Breast Assistant, Powered by Koios DS
Use Table 7-74 to troubleshooting Breast Assistant, Powered by Koios DS installations.

Table 7-74 Troubleshooting the Breast Assistant, Powered by Koios DS Option

Symptom

Solution

Analysis takes longer than 5 seconds.

Check the spooler and clear any failures.
Check the connection to the server and attempt to ping the device on Utility >
Connectivity > Device to verify the service.

On Utility > Connectivity > Koios, the
Activate button does not display (may be
encountered during demos).

If Breast Assistant, Powered by Koios DS was previously activated, and only
the Deactivate button displays, on Utility > Connectivity > Koios, select
Deactivate, and then follow the steps in Table 3-8 on page 3-41 under “Set up
and test the Koios connection” to activate again.

Do not know the IP address to enter on
Utility > Connectivity > Koios.

You cannot activate Breast Assistant, Powered by Koios DS without a valid IP
address. Breast Assistant, Powered by Koios DS should have been installed on
the customer network. Obtain a valid address by contacting the customer IT
department to confirm the installation occurred.

Contact Koios DS Support to confirm this installation occurred.

On Utility > Connectivity, cannot find the
Koios tab.

Make sure the option string has been entered on the LOGIQ Fortis and the
option is enabled.

Check that the LOGIQ Fortis has the correct software version that includes
Breast Assistant, Powered by Koios DS installed.

On Utility > Connectivity > Device,
clicking the Verify button fails.

Verify that the IP Address field matches the address/hostname of the Koios DS
server on file and update the field if necessary.

If the information is correct, the Koios DS server information may have changed
or an error may have occurred. Contact Koios DS Support and provide the
scanner AE Title, Port, and IP Address.

On Utility > Connectivity > Service,
clicking the Verify button fails.

Verify that the AE Title and Port Number fields match the values of the Koios
Server on file and update the fields if necessary.

If the fields are correct, from the Device tab, try to ping the server. If the ping is
successful, the Koios Server info may have changed or an error may have
occurred. Contact Koios DS Support and provide the scanner AE Title, Port,
and IP Address.

For Koios DS Support contact:

» Koios DS Support / Servicing Email: logig@koiosmedical.com
» Koios DS Vendor Support Phone Number: +1(732)529-5755 Ext. 2
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7-13-4 Device Management (Device Mgmt)

Use Table 7-75 to troubleshoot Device Management (Device Mgmt).

Table 7-75 Troubleshooting the Device Management Option

Symptom Solution
Do not have or lost the “DEVICE Under Utilities > Connectivity > DEVICE MANAGEMENT, under Server URL,
MANAGEMENT” server URL address. enter the default URL: https://iot.gehelathcare.com.
Confirm with the site IT department the following conditions:
. Internet access is required
. Ethernet connection required 10/100 Mbps or an 10/100/1000 Mbps
. LOGIQ Fortis uses port 443 on a secure HTTPS connection

If the site uses Proxy servers:
Under Utilities > Connectivity > DEVICE MANAGEMENT, confirm proxy

LOGIQ Fortis cannot connect to the settings (Server/ port/ Username and password).

“DEVICE MANAGEMENT” cloud.

Contact the site IT administrator to ensure these settings are correct.

Also check for possible issues with the site firewall preventing the device from
reaching the cloud server.

Additionally, to connect with Cloud through proxy, the proxy port that was setup
in the Utility page opens.

Reset the registration key by:

1. Delete any information in Registration Key.

2. Enter the default registration key in Registration Key.

The registration key is prepopulated by the software on the device, reloading
software will restore the original value but you will need to re-register.

Missing the registration key for the
“DEVICE MANAGEMENT” cloud.

In Account Email, select Update and enter the correct email address.

Incorrect email address entered. . . L .
This is the user e-mail account that was used when signing up online.

Restore email account information (Account Email):
1. Navigate to Utility > Connectivity > Device Mgmt to access Device
Management. Do not select Remove Registration. If you do, you will need to

Missing email address (Account Email) contact the support team to re-establish registration to the server.

. . . 2. Select Deactivate.
associated with the Device Management . .
account after a full load of software 3. In Account Email, enter the email address for the account.
' 4. If applicable, enter Proxy Server, Proxy Port, Proxy User Name, and
Proxy Password.
5. Select Activate.
6. Select Save.

If Device Management was active prior to the software load, confirm that the
cloud still verifies your activation.

Navigate to Utility > Connectivity > Device Mgmt and confirm that status
shows “Active”. It is normal if the e-mail address is not visible. If so, proceed to
select “Verify” and confirm that you get a smiley face. Keep in mind that you
need to be connected to the network for the Device manager to verify
successfully.

If the system is not successfully connecting to the cloud, contact the Device
management team for support at email: dc.support@ge.com indicating the
serial number of the unit, description of the problem and e-mail of the admin
user registered in the account.

After a full software load, cannot connect to
the “DEVICE MANAGEMENT” cloud.

As a user, do not have account to the

“DEVICE MANAGEMENT” cloud. Go to https://AVURI.gehealthcare.com/signup for sign up instructions.
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Table 7-75 Troubleshooting the Device Management Option

Symptom Solution

After a manual backup (Utility > System >
Backup/Restore > Manual Backup), a new
user is not able to see any backups or the If the system shows it is connected to Device Management, perform these

history on the web app. steps to associate a time zone with your profile. Once the steps are complete,
you will be able to view the backups and the history on the web app.

After preset information is uploaded from 1. Navigate to http://AVURI.gehealthcare.com.

the master system (Utility > System > 2. Sign in to access your profile.

Backup/Restore > Upload for Fleet), anew | 3. Confirm the time zone.

user is not able to see any backups or the
history on the web app.

Other issues needing help with “DEVICE Contact the support team:
MANAGEMENT” feature. Support email: dc.support@ge.com
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7-13-4 Device Management (Device Mgmt) (cont’d)

NOTE:

Use Table 7-76 to troubleshoot Device Management (Device Mgmt) through the error codes. These
error codes will appear in the loTAgentService.log log file. This log file can be found under D:\log.

Error codes may change over time.

Table 7-76  Errors for the Device Management Option
Error Details Solution
Activate

Agent service config file is corrupted.

Please contact your GE service personnel.

Agent side config
file(loTAgentConfig.json) is
corrupted.

Contact service for enabling re-
registration.

Activation failed. Missing input Parameter.
(Error code: 000104)

Invalid Account Email has been
entered.

Enter valid Account Email.

Activation failed. Please contact your GE
service personnel. (Error code: 401)

Invalid Registration Key has been
entered.

Enter valid Registration Key.

Activation failed.

Invalid Server URL has been entered.

Enter valid Server URL.

Activation failed.

Invalid Proxy server or Proxy port has
been entered.

Enter valid Proxy server and Proxy
port.

Activation failed. Please contact your GE
service personnel. (Error code: 403)

After successful registration again
perform register.

Contact service for enabling re-
registration.

Invalid fleet account email format.
Activation failed.

Invalid or empty Account Email format
field.

Enter valid Account Email.

Invalid proxy port. Activation failed.

Enter string value in Proxy port field.

Enter valid Proxy port.

Agent service config file is corrupted.

Please contact your GE service personnel.

Empty Registration Key field.

Enter valid Registration Key.

Agent service config file is corrupted.

Please contact your GE service personnel.

Empty Server URL field.

Enter valid Server URL.

Invalid server certificate.

Please contact your GE service personnel.

Invalid server certificate

Install valid certificate using Device
Connect Service Certificate.

Activation failed. Timeout occurred.

Console side did not receive any
response from Agent\ThingWorx side
in predefined activation time delay.

Ensure network connection and retry.

Activation failed. Please contact your GE
service personnel. (Error code: 400)

Bad request

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code: 500)

Internal server error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code: 503)

Service unavailable

Retry

Activation failed. Please contact your GE
service personnel. (Error code: 404)

Digital twin not found

Contact AVURI Device Connect
Support at dc.support@ge.com to
initiate device re-Register.

Activation failed. Please contact your GE
service personnel. (Error code: 000011)

Unknown error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Chapter 7 Diagnostics/Troubleshooting

7-127



GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

Table 7-76  Errors for the Device Management Option (Continued)

Error

Details

Solution

Activation failed. Please contact your GE
service personnel. (Error code: 000010)

Internal error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code:000115)

Default application not found for
Digital Twin

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code: 000100)

Missing appID or appName

Device error. Contact AVURI Device
Connect Support at
dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code: 000105)

Application does not exist

Contact AVURI Device Connect
Support at dc.support@ge.com,
escalate to L3 or L4 for support.

Activation failed. Please contact your GE
service personnel. (Error code: 000116)

The application has not been
associated with your digital twin. No
application device exists.

Retry desired action. Contact AVURI
Device Connect Support at
dc.support@ge.com if problem
persists.

Activation failed. Missing input Parameter.
(Error code: 000100)

Missing Input user or application not
provided.

Ensure valid user email is used in
Device Mgmt and then retry.

Activation failed. Invalid input parameter.
(Error code: 000102)

Invalid data format

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Invalid input parameter.
(Error code: 000103)

Invalid data type

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Invalid input field size.
(Error code: 000101)

Field size error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Activation failed. Please contact your GE
service personnel. (Error code: Xxxxxx)

Unknown

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload for Fleet

Upload of backup to cloud failed. Timeout
occurred.

Console side did not receive a
response from Agent\ThingWorx side
in predefined upload time delay.

Ensure network connection and retry.

Agent service config file is corrupted.

Please contact your GE service personnel.

Agent side config
file(loTAgentConfig.json) is corrupt.

1. Contact service for enabling re-
registration.

2. Select Deactivate.

3. Follow steps for activation.

App key expired.

Please contact your GE service personnel.

ThingWorx server App key expired.

Contact service personnel for app key
expiry date correction.

Invalid server certificate.

Please contact your GE service personnel.

Invalid server certificate

Install valid certificate using Device
Connect Service Certificate.

Upload of backup to cloud failed.

1.Retry count elapsed.

(Any exception happened in service
APN\Agent code and there is no
specific error code)

2. Any unknown connection issue.

Ensure network connection and retry.

Network is disconnected.

Establish network connection.

Upload of backup to cloud failed. Please
contact your GE service personnel. (Error
code: 000109)

File Id or file path/file name not found
(Resource not found).

Contact AVURI Device Connect
Support at dc.support@ge.com.

Section 7-13 - Options Troubleshooting




GE CONFIDENTIAL

Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

Table 7-76  Errors for the Device Management Option (Continued)

Error

Details

Solution

Upload of backup to cloud failed. Please
contact your GE service personnel. (Error
code: 000101)

Field size error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel. (Error
code: 000102)

Invalid data format

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: 000103)

Invalid data type

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: 000119)

Invalid data value
File type is invalid

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: 000120)

Invalid data value
Data classification is invalid

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: 000118)

Insufficient storage

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: 000100)

Missing Input

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: 000111)

File transfer subsystem encountered
an error (I/O error)

Retry desired action. Contact AVURI
Device Connect Support at
dc.support@ge.com if problem
persists.

Internal error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: 000105)

App Id does not exist (Resource not
found)

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: 000113)

Invalid data value

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: 000010)

External error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Upload of backup to cloud failed. Please
contact your GE service personnel.
(Error code: xxxxxx)

Unknown

Contact AVURI Device Connect
Support at dc.support@ge.com.

Update Connection Configuration

Invalid proxy port. Update proxy
configuration failed.

Invalid string value in Proxy port field.

Enter valid Proxy port.

Proxy configuration update failed.

1.Retry count elapsed. (Any
exception happened in service
APIN\Agent code and th.ere is no
specific error code)

2. Any unknown connection issue.

Ensure network connection and retry.
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Table 7-76

Errors for the Device Management Option (Continued)

Error

Details

Solution

Proxy configuration update failed. Timeout
occurred.

Console side did not receive any
response from Agent\ThingWorx side
in predefined update proxy time
delay.

Check the new configuration and
retry.

Agent service config file is corrupted.

Please contact your GE service personnel.

Agent service configuration file is
corrupt.

1. Contact service for enabling re-
registration.

2. Select Deactivate.

3. Follow steps for activation.

App key expired.

Please contact your GE service personnel.

The application key has expired.

Contact service personnel for app key
expiry date correction.

Invalid server certificate.

The server certificate is invalid.

Install valid certificate using Device
Connect Service Certificate.

Please contact your GE service personnel.

Network is disconnected.

Establish a network connection.

Deactivate

Deactivation failed. Timeout occurred.

Console side did not receive any
response from Agent\ThingWorx side
in predefined deactivate time delay.

Ensure network connection and retry.

Agent service config file is corrupted.

Please contact your GE service personnel.

1. Contact service for enabling re-
registration.

2. Select Deactivate.

3. Follow steps for activation.

App key expired.

Please contact your GE service personnel.

Contact service personnel for app key
expiry date correction.

Invalid server certificate.

Please contact your GE service personnel.

Install valid certificate using Device
Connect Service Certificate.

Deactivation failed.

1. Network not connected state
2. Any unknown connection issue

Ensure the network connection and
retry.

Deactivation failed. Please contact your
GE service personnel. (Error code: 500)

After activation remove digital twin
from ThingWorx server.

Contact GE support.

Deactivation failed. Please contact your
GE service personnel. (Error code: 400)

Bad request

Retry desired action. Contact AVURI
Device Connect Support at
dc.support@ge.com.

Deactivation failed. Please contact your
GE service personnel. (Error code: 401)

Unauthorized

Retry desired action. Contact AVURI
Device Connect Support at
dc.support@ge.com.

Deactivation failed. Please contact your
GE service personnel. (Error code: 404)

Digital twin not found

Contact AVURI Device Connect
Support at dc.support@ge.com to
initiate Device re-registration.

Deactivation failed. Please contact your
GE service personnel. (Error code: 503)

Service unavailable

Retry desired action. Contact AVURI
Device Connect Support at
dc.support@ge.com.
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Table 7-76  Errors for the Device Management Option (Continued)
Error Details Solution
Backup

Backup to cloud failed.

1.Retry count elapsed. (Any
exception in service AP\Agent code
and no specific error code).

2. Any unknown connection issue.

Ensure network connection and retry.

Backup to cloud failed. Timeout occurred.

Console side did not receive any
response from Agent\ThingWorx side
in predefined backup time delay.

Ensure network connection and retry.

No change identified. Backup not
performed.

No action needed.

Agent service config file is corrupted.

Please contact your GE service personnel.

Agent side config file
(loTAgentConfig.json) is corrupt.

1. Contact service for enabling re-
registration.

2. Select Deactivate.

3. Follow steps for activation.

App key expired.

Please contact your GE service personnel.

ThingWorx server App key expired.

Contact service personnel for app key
expiry date correction.

Invalid server certificate.

Please contact your GE service personnel.

Invalid server certificate.

Install valid certificate using Device
Connect Service Certificate.

Network is disconnected.

Establish network connection.

Local restore completed successfully.
Failed to backup newly restored backups
to cloud.

Auto backup will be triggered after
completing restore operation.

If Auto backup fails, execute Manual
Backup.

Backup to cloud failed. Please contact your
GE service personnel. (Error code:
000109)

or

Local restore completed successfully.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000109)

File Id or file path/file name not found
(Resource not found).

Contact AVURI Device Connect
Support at dc.support@ge.com.

Backup to cloud failed. Please contact your
GE service personnel. (Error code:
000101)

or

Local restore completed successfully.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000101)

Field size error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Backup to cloud failed. Please contact your
GE service personnel. (Error code:
000102)

or

Local restore completed successfully.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000102)

Invalid data format

Contact AVURI Device Connect
Support at dc.support@ge.com.
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Table 7-76  Errors for the Device Management Option (Continued)

Error Details Solution

Backup to cloud failed. Please contact your
GE service personnel. (Error code:
000103)

or Invalid data type Contact AVURI Device Connect
Local restore completed successfully. Support at dc.support@ge.com.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000103)

Backup to cloud failed. Please contact your
GE service personnel. (Error code:

000119)
or Invalid data value Contact AVURI Device Connect
Local restore completed successfully. File type is invalid Support at dc.support@ge.com.

Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000119)

Backup to cloud failed. Please contact your
GE service personnel. (Error code:

000120)
or Invalid data value Contact AVURI Device Connect
Local restore completed successfully. Data classification is invalid Support at dc.support@ge.com.

Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000120)

Backup to cloud failed. Please contact your
GE service personnel. (Error code:
000118)

or Insufficient storage Contact AVURI Device Connect
Local restore completed successfully. Support at dc.support@ge.com.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000118)

Backup to cloud failed. Please contact your
GE service personnel.

(Error code: 000100)

or Missing Input Contact AVURI Device Connect
Local restore completed successfully. Support at dc.support@ge.com.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000100)

Backup to cloud failed. Please contact your
GE service personnel.

(Error code: 000111) Retry desired action. Contact AVURI
or File transfer subsystem encountered Device Connect Support at

Local restore completed successfully. an error (I/O error). dc.support@ge.com if problem
Failed to backup newly restored backups persists.

to cloud.Please contact your GE service
personnel.(Error code: 000111)

Backup to cloud failed. Please contact your
GE service personnel.

(Error code: 000011)

or Internal error Contact AVURI Device Connect
Local restore completed successfully. Support at dc.support@ge.com.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000011)
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Table 7-76  Errors for the Device Management Option (Continued)

Error Details Solution

Backup to cloud failed. Please contact your
GE service personnel.

(Error code: 000105)

or App Id does not exist (Resource not Contact AVURI Device Connect
Local restore completed successfully. found). Support at dc.support@ge.com.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000105)

Backup to cloud failed. Please contact your
GE service personnel.

(Error code: 000113)

or Invalid data value Contact AVURI Device Connect
Local restore completed successfully. Support at dc.support@ge.com.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000113)

Backup to cloud failed. Please contact your
GE service personnel.

(Error code: 000010)

or External Error Contact AVURI Device Connect
Local restore completed successfully. Support at dc.support@ge.com.
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: 000010)

Backup to cloud failed. Please contact your
GE service personnel. (Error code: xxxxxx)
or

Local restore completed successfully. Unknown
Failed to backup newly restored backups
to cloud. Please contact your GE service
personnel. (Error code: xxxxxx)

Contact AVURI Device Connect
Support at dc.support@ge.com.

Install

1.Retry count elapsed (Agent or
service API| exception).

3. Any unknown connection issue.
Console side did not receive any
response from Agent\ThingWorx side
in predefined download time delay.

Configuration installation failed. Ensure network connection and retry.

Configuration downloaded is identical to
the current configuration. Press OK to Stop installation. No action needed.
discontinue installation.

1. Contact service for enabling re-
Agent service config file is corrupted. Agent side config registration.

Please contact your GE service personnel. | file(loTAgentConfig.json) is corrupt. 2. Select Deactivate.

3. Follow steps for activation.

App key expired.
Please contact your GE service personnel.

Contact service personnel for app key

ThingWorx server App key expired. expiry date correction.

Invalid server certificate Install valid certificate using Device
Invalid server certificate. Connect Service Certificate.

Please contact your GE service personnel.
Network is disconnected. Establish network connection.
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Table 7-76

Errors for the Device Management Option (Continued)

Error

Details

Solution

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000109)

File Id or file path/file name not found
(Resource not found).

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000101)

Field size error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000102)

Invalid data format

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000103)

Invalid data type

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000119)

Invalid data value
File type is invalid

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000120)

Invalid data value
Data classification is invalid

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000118)

Insufficient storage

Insufficient storage on device.
Reclaim device storage. Contact
AVURI Device Connect Support at
dc.support@ge.com if problem
persists.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000100)

Missing input

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000111)

File transfer subsystem encountered
an error (I/O error).

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000011)

Internal error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000010)

External error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: 000110)

Not authorized to access file

Contact AVURI Device Connect
Support at dc.support@ge.com.

Configuration installation failed. Please
contact your GE service personnel.
(Error code: xxxxxx)

Unknown

Contact AVURI Device Connect
Support at dc.support@ge.com.

Get Notification

Failed to retrieve notification from Cloud.

1.Retry count elapsed. (Any
exception happened in service
API\Agent side code and no specific
error code).

2. Any unknown connection issue.

Ensure network connection and
execute Verify.
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Table 7-76

Errors for the Device Management Option (Continued)

Error

Details

Solution

Timeout occurred. Device Connect
notification request has been sent, but
there is not confirmation yet. Please try
again later.

Console side did not receive any
response from Agent\ThingWorx side
in predefined notification time delay.

Ensure network connection and
execute Verify.

Agent service config file is corrupted.

Please contact your GE service personnel.

Agent side config file
(loTAgentConfig.json) is corrupt.

1. Contact service for enabling re-
registration.

2. Select Deactivate.

3. Follow steps for activation.

App key expired.

Please contact your GE service personnel.

ThingWorx server App key expired.

Contact service personnel for app key
expiry date correction.

Invalid server certificate.

Please contact your GE service personnel.

Invalid server certificate

Install valid certificate using Device
Connect Service Certificate.

The message retrieved from the cloud at
%s is too large.

Contact fleet owner for correction of
the message.

Network is disconnected.

Establish network connection.

Failed to retrieve notification from Cloud.

Please contact your GE service personnel.

(Error code: 000112)

Invalid data range

Contact AVURI Device Connect
Support at dc.support@ge.com.

Failed to retrieve notification from Cloud.

Please contact your GE service personnel.

(Error code: 000113)

Invalid data value

Contact AVURI Device Connect
Support at dc.support@ge.com.

Failed to retrieve notification from Cloud.

Please contact your GE service personnel.

(Error code: 000101)

Field size error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Failed to retrieve notification from Cloud.

Please contact your GE service personnel.

(Error code: 000105)

App Id does not exist

Contact AVURI Device Connect
Support at dc.support@ge.com.

Failed to retrieve notification from Cloud.

Please contact your GE service personnel.

(Error code: 000011)

Internal Error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Failed to retrieve notification from Cloud.

Please contact your GE service personnel.

(Error code: 000010)

External Error

Contact AVURI Device Connect
Support at dc.support@ge.com.

Failed to retrieve notification from Cloud.

Please contact your GE service personnel.

(Error code: xxxxxx)

Unknown

Contact AVURI Device Connect
Support at dc.support@ge.com.

Verify

Smiley icon display

Check whether the Agent is
connected to the ThingWorx Core
using BaseClient::isConnected()
method.

Ensure the network connection and
retry.
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7-13-5 Continuous Wave (CW)

7-13-5-1 Vertical noise with P2D/P6D probes and Continuous Wave (CW)
A vertical noise issue (Figure 7-57) may exist when using P2D/P6D probes and Continuous Wave (CW).

Figure 7-57 Example of Vertical Noise

Workaround for vertical noise

There is no workaround for this issue. Hardware does not need to be replaced when this issue is
identified.
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7-13-5-2

Tone noise with M5Sc-D / 6S-D probes and Continuous Wave (CW)

A Tone noise issue may exist when using M5Sc-D / 6S-D probes and Continuous Wave (CW) with
limited position.

There is no workaround for this issue. Hardware does not need to be replaced when this issue is
identified.

But if noise is quite stronger than this image, replacing BEPS assy may improve noise level.

Figure 7-58 Example of Tone Noise
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Section 7-14
Probes Troubleshooting

Contents in this section

7-14-1  Probe recognition . . ... ... .. e 7-138

7-14-2  IC/RIC5-9 CHIM-Mode toodark. . ... ... ... e 7-138

7-14-3  ML6-15 breast B and color flow “zipper artifact”. . . .......... .. ... ... .. ... . ... 7-138

7-14-4  Body pattern probe mark shift. . . ... ... .. 7-138

7-14-5  Automatic probe diagnostics (VITAOnDemand) . . ........... ... . i ... 7-139

7-14-6  Advanced Probe Option . ... ... . . e 7-141
7-141 Probe recognition

Check all of the probes on all the ports. Remove all of the probes, and then check each probe singly in
every port.

» If only one probe fails to be recognized, clean User Defs to check if the problem is caused by
corrupted presets. If the problem is not resolved, replace the probe.

7-14-2 IC/RIC5-9 CHI M-Mode too dark

With 1IC5-9 and RIC5-9 probes CHI M-Mode appears too dark compared to B-Mode image and is limited
on the amount it can be brightened. Fundamental M-Mode gain is acceptable.

Use Anatomical M-Mode.

7-14-3 ML6-15 breast B and color flow “zipper artifact”
With ML-6-15 probes, a zipper artifact may appear. Try the following to resolve:

+ Decrease the frame rate to minimize artifact.
» Change FR to 0 (this causes a slower FR).

* Do not use during a biopsy.

» Decrease depth to above 4 cm’s.

7-14-4 Body pattern probe mark shift

If system is set to active body pattern on freeze, the body pattern will shift to the right on freeze. If it is
then moved back it will save as desired.

Do not activate body pattern on freeze.
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7-14-5

NOTE:

Automatic probe diagnostics (VITAOnDemand)

If there is VITAOnDemand option string and Enable Automatic Probe Diagnostics is selected on
Utility > Admin, the Probe Test button appears when using the applicable probes with any B mode
application.

Supported probes are C1-6-D, M5SC-D, IC5-9-D, RIC5-9-D, and ML6-15-D.
To enable automatic probe diagnostics (VITA), see "Service settings" on page 3-48.

The initial VITA version collects diagnostic data at boot up from the first supported probe found
connected from the left to the right.

+ Automatic Test Routine - Periodically between patient exams, an automatic routine pulses a
single element and lens echoes are recorded by other elements in the array. This is repeated until
all elements are pulsed.

+ Advanced Data Analysis - The system compiles the lens echo data into a sensitivity matrix
comprising the relative transmit and receive frequencies between each combination of elements.
This matrix is then analyzed for patterns.

+ On-Board Customer Features - The result of this analysis will assess the health of the customers
probe, alert to specific failure types, and can even adjust image quality to compensate for probe
wear and degradation.

The diagnostic result will be logged in a file, stored under the Diag/VITA folder, with a.JSON extension.

This file can be transferred to the GE backoffice through a data transfer or can be collected with the
Alt+D logs.

Figure 7-59 VITA Folder and File Location
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7-14-5 Automatic probe diagnostics (VITAOnDemand) (cont’d)
To run a VITAOnDemand probe test:

1.) From Scan, navigate to the second page of the B-mode tab.

2.) Select Probe Test. A popup window displays requesting to clean the probe before starting the test.

3.) Clean the probe.

4.) Select Yes to start the test.

5.) If the test passes, a popup window will show that the probe test passed.

6.) If the test fails, a popup window displays to suggest next steps to retest the probe.
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7-14-5 Automatic probe diagnostics (VITAOnDemand) (cont’d)

After running the test again with a test fail, perform the following steps to identify if the failure is a system
problem or a probe problem:

To determine a system failure or a probe failure:

1.
2.)

3)
4)

5.)
6.)

Using a good probe on the same connector, run a VITAOnDemand probe test.

If the test passes, then this might be a probe problem. Refer to the detailed VITA analysis results in
the coming days from the Datalake.

If the test fails, then this is a system problem.

Run system diagnostics to detect where the problem is and replace whichever board is causing the
problem.

If the system diagnostics passes, this is relay board problem.
Replace the relay board.

7-14-6 Advanced Probe Option

If the following probes does not activate even if you select, check the Advanced Probe Option
(H46612LS) is installed in Utility -> Admin-> System Admin.

C2-9-D probe
C2-9VN-D probe
C1-6-D probe
C1-6VN-D probe
C3-10-D probe
M5Sc-D Probe
L2-9-D probe
L2-9VN-D probe.

Figure 7-60 System Admin Window
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Section 7-15
Peripherals Troubleshooting

Contents in this section

7-15-1  Testof printers. . . ... 7-142
7-15-2  EZbackup will not delete images to opendiskspace . .............. ... .. ... ... 7-142
7-15-1 Test of printers
Print Test Page tests that the printer is installed correctly and hooked up at the Windows level.
1.) Open the Printers folder, either from Start > Settings > Printers or Utilities > System > Printers.
2.) Right click on a printer and select Preferences.
3.) Select Print Test Page (this sends a print to the printer bypassing all of the scanner software).
4.) Observe the page. If the page prints out, the problem is probably a Windows configuration issue or
a configuration issue with Connectivity. If the page does not print out, there probably is a cabling
issue or a printer configuration issue in Windows.
NOTE: For the Sony small format printers you will see the test page clipped. This is normal.
7-15-2 EZbackup will not delete images to open disk space
Customers have to manually delete the patients after successful EZBackup operation to free up disk
space.
7-142 Section 7-15 - Peripherals Troubleshooting



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

Section 7-16
Setting Troubleshooting

Table 7-77  Setting Troubleshooting

Symptom Solution

The cm from nipple annotations are assigned to the same

Incorrect group assignment of CMFN group in Breast Comment |group as the o'clock annotations. This group needs to be
Library page 2 adjusted in the utility pages for these annotations.

Assign as Group 5

Region presets have not been set up, If the European region is

used the finger and hip models are not functional. Set the region to None.

The issue is Utility > Imaging Preset Manager > Imaging
Preset Selections list items are not highlighted when selected.

All functions work, the selection is just not highlighted.

Imaging preset selection is not highlighted on Imaging Preset
Manager

If both Copy to Dataflow and USB QuickSave are programmed
Print button with both Copy to Dataflow and USB QuickSave |to the same print button, images may fail to save.

does not save image to clipboard. Do not program Copy to Dataflow and USB QuickSave to the
same print button.

GSDF is defaulted to on which may cause undesirable image

quality on PACS systems that do not support GSDF. Change the default GSDF setting to off.

Avoid putting multiple periods, commas, etc. in annotations as

System crashes if multiple commas are placed in annotations. L
this will cause a system crash.
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Section 7-17
Scan Assistant Troubleshooting

7171

7-17-2

Scan Assistant Creator

With Scan Assistant Creator, when the LOGIQ Fortis is locked or in auto-logoff, you can lose your Scan
Assistant protocol. Do not allow the LOGIQ Fortis to enter lock screen or auto-logoff the Scan Assistant.

Saving and closing Scan Assistant Creator before leaving the LOGIQ Fortis is recommended.

Problems with annotations/comments and Scan Assistant

When running Scan Assistant and pausing or editing annotations/comments, the annotation/comments
might remain on screen or may fail to display. To fix this problem, press the Comment key twice to close
or display annotation/comments.
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Section 7-18
Log File Troubleshooting

Contents in this section

7-18-1  Use ScLogWindow . . .. ... . 7-146
7-18-2  Log analysis . . . . ...t 7-149
7-18-3  Log analysis with button presses and touch panelevents . . ..................... 7-150
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7-18-1 Use ScLogWindow

The ScLogWindow application helps identify errors while the LOGIQ Fortis is running. Access this
application from the Windows desktop or through Task Manager. From ScLogWindow, you can:

* View the logs

+ Save the log

* Filter the log

To open ScLogWindow from the Windows desktop:

Figure 7-61 ScLogWindow from the Windows desktop

LU T

Insert and activate the SSA key. E@

+  Exit to Windows.

*  From the Windows desktop,
click the ScLogWindow ¢
icon.

Wgtataisli

2

(et SR [y
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7-18-1 Use ScLogWindow (cont’d)

To open ScLogWindow from Task Manager:

1.) Insert and activate the SSA key.
2.) Press Ctri+Alt+Del and select Task Manager.
3.) In Task Manager, select File > Run New Task.

1! Task Manager - m] b
File Options View
Run new task rses Performance App history Startup Users Details  Senvices
Exit
m— 0% 13% 0% 0%
Name CPU | Memary Disk | Metwork
n] System interrupts 0.1% OMB 0 ME/s 0 Mbps 2
(& Antimalware Service Executable 0% 588 MB 0 MEB/s 0 Mbps
7= Task Manager 0% 9.5MB O ME/s 0 Mbps
[#] System 0% 0LIMB 0.1 MB/s 0 Mbps
(%] Desktop Window Manager 0% 23.8MB O MESs 0 Mbps
(a7 SQL Server Windows NT - 64 Bit 0% 172.6MB 0 MB/s 0 Mbps
[ Client Server Runtime Process 0% 14 MB 0 MB/s 0 Mbps
[ Client Server Runtime Process 0% oeme OME/s 0 Mbps
[a] Services and Controller app 0% 33MB 0 ME/s 0 Mbps
1 Windows Explorer 0% 19.7 MB 0 MB/s 0 Mbps
wsappx 0% 1.0MB 0 ME/s 0 Mbps
sl Paint 0% 483 MB 0 MB/s 0 Mbps
[#:] Micresoft Malware Protection C... 0% 1.3 MB 0 MB/s 0 Mbps
B search 0%  28IMB OMB/s 0Mbps
8] Windows Shell Experience Host 0% 13.2 MB 0 ME/s 0 Mbos bl
Fewer details End task

4.) In Open, enter SclogWindow, check Create this task with administrative privileges, and then

press OK.
File Options View
=i Create new task X

0% 0%

Type the name of a program, folder, document, or Internet :
Disk Network

= resource, and Windows will open it for you.

MB/s 0 Mbps 2

Open: sclogwindow v|

7 z T g MB/s 0 Mbps
Create this task with administrative privileges.

MB/s 0 Mbps
ME/s 0 Mbps

. Cancel Browse...
MB/s 0 Mbps

[%7] Desktop Window Manager 0% 30.8 MB 0 MB/s 0 Mbps
sl Paint 0% 87.7MB 0 MB/s 0 Mbps
[ System 0% 0.1 MB 0MB/s 0 Mbps
r1 Windows Explorer 0% 16.5 MB 0MB/s 0 Mbps
Service Host: DCOM Server Pro... 0% 45MB 0 MB/s 0 Mbps
[#7] Client Server Runtime Process 0% 0.8 MB 0MB/s 0 Mbps
[®7] Services and Controller app 0% 33MB 0MB/s 0 Mbps
| 3 wsappx 0% 1.0 MB 0 MB/s 0 Mbps
[#=] Microsoft Malware Protection C... 0% 1.3 MB 0MB/s 0 Mbps

B8l Search 0% 281 ME OMB/s 0 Mbos ¥

‘ Fewer details End task
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7-18-1 Use ScLogWindow (cont’d)

To view logs in the ScLogWindow:

1.) With the ScLogWindow open, double-click the EchoLoader icon.
2.) Use Alt+Tab to put the ScLogWindow in front.
3.) While the application is booting up, observe logging in ScLogWindow.

]

Inchde: | | Add ™ Case Senslive Hidden: (1 Clear

seeaping

zeKeeping
acqReussResping

0xd001
n: 0x=0001

Aurcra incerface...

acqHousaRasping 2.0.0.0 12/07/2017

acqgSfL 1 Register{@0ucOZ00028] = Dx0000

#DO0S

acqHAL
aegHAL
moghhL
acqHAL

Ta versien = MerCrzlSW: 1.0 (05.05.200% 13:1,

To save logs in ScLogWindow:

+ Select File > Save as

B SclogWindow - - -
Fle Edit View
— ]:_w‘ [ =] add| T CoeSeraiim Hidden0 "
mport.. = S L |
Optians... ] Thoesa | spac == :

acqizansierping
saqcassdeeping
anqFcuseReRping
acqBfi

azge nor small eprom device = '

or amall eprem davies =

05:11:44. 367 : THRS

06:11:44. 567 aFcaseReepang nox
06:11:44.967 0 scqFsaseZeeping Bars 144M0000602
0€:11:44. 567 acqEsuselesping Vpd for THRS Bar Code Serial Wusber [BCEN): 1644MI0ODSDZ w

To filter logs in ScLogWindow:

1.) Select View and check the entries to filter.

2.) Select Stop to stop the logging.

3.) View the filtered logs.

4.) To clear the window and start a fresh log capture, select Clear.
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7-18-2

Log analysis

Error logs and monitoring logs are kept in a database format. If needed for troubleshooting, collect them
with Alt+D or gather logs. Either process extract information from the database in a collection of files
that are readable for the field.

Crashes
Crash information is contained in /[Log/CrashDump.

Use this log to troubleshoot issues with software crashes. Send these files to engineering for evaluation
and determination of the root cause.

Auto transfer errors
When auto transfer is enabled, error information is contained in CSD_LogFile.log.
Auto transfer periodically logs data to the back office. For example:

13:27:49] ERROR data-transfer.js:764 DataTransfer Manual Data Transfer: Error in uploading full
logs file D:\Scanner\upload\log_LogOther E70034_171221_132748_DB.zip “error”

This example may indicate that network connectivity has been compromised on the LOGIQ Fortis or
there is an issue with the facility reaching out to the back office. Check with the network administrator.

Service alerts
Service alert information is contained in /[Log/SvcAlert*.txt.

Use this log to troubleshoot issues with alerts generated by the LOGIQ Fortis. Alerts can also be viewed
on the Service desktop. Review log file content to determine the errors the LOGIQ Fortis has generated
in the past.

USB issues
USB information is contained in /Log/ScLogsDatabase/UsbLog.txt.

Use this log to troubleshoot issues with a USB device that may be working intermittently. This log
indicates connection and disconnection of USB devices during operation.

Probe use

Probe use information is contained in /Log/ScLogsDatabase/MainLog.txt.

Use this log to troubleshoot issues with probes. This log indicates probe selection and mode.
Monitoring logs

Monitoring log information is contained in /Log/ScLogsDatabase/MonitoringLog.txt.

Use this log to troubleshoot issues with voltage and temperature. This log contains the monitoring
parameters for voltage and temperature, same used to the status indicators on the Service desktop. Use
this log to evaluate details of red indicators in the Service desktop.
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7-18-2 Log analysis (cont’d)
System configuration logs
Hardware configuration information is contained in /Log/SysCfg.csv.

Use this file to troubleshoot issues with hardware configuration (also known as VPD). This log helps to
determine the part numbers of boards installed along with versions and serial numbers.

Boot up issues

To troubleshoot issues at boot up, see Bootup Issues on page 2-30.

7-18-3 Log analysis with button presses and touch panel events

You can see button presses (Touch button) and touch panel events (Touchpanel action) in the
SCLogViewer window. The button press is logged as both protected with the value and as an ASCII
button in the main log for the characters on the normal keyboard.

Figure 7-62 ScLogWindow with action|buttonpress Selected

i SeLegWindew
File Edit View

| Add [ Case Sensitve Hidder: 434

7-150 Section 7-18 - Log File Troubleshooting



GE CONFIDENTIAL
Direction 5874372, Rev. 3 LOGIQ Fortis Proprietary Service Manual

Section 7-19
System Error with TVD and Sample Volume Length from Utility

A system error sometimes occurs when entering TVD after changing the Sample Volume (SV) Length
from Ultility for Cardiac presets.

Figure 7-63 Example of System Error

Be aware that SV can display the wrong value even if the system error does not display.

Figure 7-64 Example of SV with Incorrect Value

When changing the Sample Volume (SV) Length in the Cardiac presets, avoid changing it from Utility
and change it from the touch panel. Perform these steps.

1.) When system error occurs, click OK.

2.) On the touch panel, change SV Length to 6 mm.

3.) Select M5Sc, Save and then Overwrite.

4.) Shut down the system.
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Chapter 8
Replacement Procedures

Section 8-1

Overview

8-1-1

NOTE:

8-1-2

Purpose of this chapter

This chapter describes how to remove and install, or replace, modules and subsystems in the
LOGIQ Fortis. It also includes instructions for installing and re-installing the software.

The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

Contents in this chapter

8-1 OVEIVIBW. . .
8-2 Warnings and important information. . .. ... ... ..
8-3 Definitions of Left, Rear / Back, Rightand Front .. ........... .. ... .. ... .. ....
8-4 Loading / Reloading / Upgrading the Software. . . . . ...... ... ... .. ............
8-5 Replacing Cable . . . ... ...
8-6 Replacing Covers . . ... ... e
8-7 Replacing Top Console Parts . . .. ... ...
8-8 Replacing Front End Acquisition/ Card Cage parts. . . ........ ... .. .........
8-9 Replacing Main Console Parts . . . . ... . .

8-10 Replacing Options . . ... ... e
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Section 8-2
Warnings and important information

8-2-1 Purpose of this section
This section includes important information. Read it before doing any of the procedures in this chapter.

Contents in this section

8-2-1 Purpose of thissection . . ... ... . . . . 8-2
8-2-2 VarNiNgS . . . 8-3
8-2-3 ESDreceptacles . . ... ..o 8-4
8-2-4 Returning/Shipping Probes and RepairParts. . . ........ ... ... . ............ 8-4
8-2-5 Manpower - When two personsareneeded . . . ............. ... .. . . ... 8-4
8-2-6 Tools needed for servicing the LOGIQ Fortis .. ........ ... ... ... .. . . ... 8-5
8-2-7 PPE Required During Service. . . . ... ... 8-6
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8-2-2 Warnings

Table 8-1 Preparations and Preparation Links

Preparations - you must perform the following steps

A DANGER

Risk of dangerous voltage within the LOGIQ Fortis.
Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.
To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
Plan and prepare for shutdown.
Completely power down the LOGIQ Fortis.
Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
Apply lockout/tagout devices to maintain exclusive control of the power cable.
Relieve all potentially hazardous stored or residual energy (batteries).
Verify isolation.
For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:
4-2-4 "Power shut down" on page 4-10
4-2-5 "Complete power down" on page 4-10

A DANGER

Risk of electrical shock, system must be turned off.
Avoid all contact with electrical contacts, conductors and components. Always use non-conductive handles

designed for the removal and replacement of ESD sensitive parts. All parts that have the potential for storing
energy must be discharged or isolated before making contact.
A DANGER AT LEAST TWO PERSONS ARE NEEDED WHEN REPLACING CASTERS

& DANGER

La

CAUTION
VAN

& CAUTION

H

(WHEELS) OR ADJUSTING BRAKES.

DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE
NECESSARY ESD PRECAUTIONS.

1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED TO
ONE OF THE TWO RECEPTACLES INTEGRATED ON THE FRAME, SPECIFICALLY FOR
THAT PURPOSE.

2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE
EQUIPMENT.

BECAUSE OF THE LIMITED ACCESS TO CABINETS AND EQUIPMENT IN THE FIELD, AND
PLACING PEOPLE IN AWKWARD POSITIONS, WE HAVE LIMITED THE LIFTING WEIGHT FOR
ONE PERSON IN THE FIELD TO 16 KG (35 LBS). ANYTHING OVER 16 KG (35 LBS)
REQUIRES TWO PEOPLE.

THE WASTE OF ELECTRICAL AND ELECTRONIC EQUIPMENT MUST NOT BE
DISPOSED AS UNSORTED MUNICIPAL WASTE AND MUST BE COLLECTED
SEPARATELY.

CONTACT THE MANUFACTURER OR OTHER AUTHORIZED DISPOSAL COMPANY TO
DECOMMISSION YOUR EQUIPMENT.
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8-2-3 ESD receptacles

Figure 8-1 ESD Receptacles

8-2-4 Returning/Shipping Probes and Repair Parts
Equipment being returned must be clean and free of blood and other infectious substances. For more
information, see "Returning/Shipping Probes and Repair Parts" on page 1-29.

8-2-5 Manpower - When two persons are needed
These replacement procedures require two persons:

» Casters Replacement

+ Elevation Arm Replacement

+  HDU Monitor Arm Replacement

The rest of the replacement procedures can be carried out by one person.
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8-2-6

Tools needed for servicing the LOGIQ Fortis

The following tools are needed to service the LOGIQ Fortis. If the torque is not indicated with the
procedure, hand tighten the screws/nuts.

Table 8-2 Tools Used for Servicing LOGIQ Fortis
Tool Type Tool Size GE Part Number
BIT # TX-5 Use available equivalent
BIT # TX-8
BIT # TX-10
Torx Driver BIT#TX15 29-899073-00 or available equivalent
BIT # TX-20
BIT # TX-25
BIT # TX-30*
BIT # TX-45* Use available equivalent
Slcz:lraet\;vr:ieri/ir 1/4 inch or 6 mm 5384716 or use available equivalent

Phillips Screwdriver

#1

46-258100P92 or use equivalent
available

#2 and #2 “Stubby"

46-258100P93 or use equivalent
available

#3

46-320688P4 or available equivalent

Nut Driver

7 mm, 10 inches long

1/4”

Use available equivalent

Hex Wrench

0.9 mm

1 mm

1.5 mm

2mm

3 mm

4 mm

5mm

6 mm

8 mm

10 mm

Use available equivalent

Open End Wrench

2mm

3 mm

4 mm

5mm

10 mm

13 mm

3/16 inch

Use available equivalent

Torque Wrench Kit?

Two wrenches and one driver includes extra batteries.
Covers 5 Ib-in to 250 Ib-ft (0.55 Nm to 339 Nm)**

5135228 or available equivalent

Adjustable Wrench 152 mm (6 inches) long Use available equivalent
Pry Bar Approximately 18 inches (457 mm) overall Use available equivalent
Drill Bosch GSR 12-2-L| Cordless Drill 5815870 or available equivalent

Digital Multimeter®

Digital Multimeter, Model 2020

2102278-050 or available equivalent

Digital Multimeter Test Leads

Test Leads Pomona kit

5110653 or available equivalent

Safety Analyzer® Fluke ESA 612 120V Safety Analyzer Service Tool 5453348-2 or available equivalent
ESD Vacuum Cleaner Vacuum cleaner 46-194427P392 or available equivalent
Grease Krytox 227 by DuPont 2301-0478-00
Chapman Kit Number 7331 Use available equivalent
Thumb Drive Class M SSA 5431898-3 or available equivalent
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DIRECTION 5874372, REV. 3
Table 8-2 Tools Used for Servicing LOGIQ Fortis (Continued)

Tool Type Tool Size GE Part Number
Adjustable Torque Driver 2.5-11.5in-lbs 46-282782P1 or available equivalent
11-29 in-lbs. 2102278-043 or available equivalent

1 1/8 inch thin profile 2356552 or available equivalent

Spanner Open End Wrench
Allen Hex Head Long Shaft . . .
Ball End Driver Set American 46-194427P353 or available equivalent
Needle Nose Pliers and Part of small maintenance tool set 5112579-2 or available equivalent

Cutters Set
Channel Lock Pliers
Combination Open And Box .
End Ratchet Wrench 1/2inch
* 90 degree “L" is suggested. A full set of 90 degree “L“ TORX wrenches are recommended.
** Heavy mechanical parts may need a specific torque. Each procedure will indicate the torque needed.
A Torque wrenches, digital multimeters and safety analyzers are tools that required periodic calibration. Check with your local
Service Organization to ensure the tools periodic calibration is performed.

10 inch 5109897 or available equivalent

2246823 or available equivalent

8-2-7 PPE Required During Service
The following PPE are required during service tasks, per EHS Policy:

PPE Required During Service

» Safety Glasses

» Safety Shoes

+ Cut Resistant Gloves

* Kneel pad (if kneeling is required)
» ESD - mat and wrist strap
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Section 8-3
Definitions of Left, Rear / Back, Right and Front

Figure 8-2 illustrates what is the Left Side (A), Rear / Back (B), Right Side (C), and Front (D).
Figure 8-2 Definitions of Left, Rear / Back, Right and Front
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Section 8-4
Loading / Reloading / Upgrading the Software

8-4-1 Purpose of this section

This section describes how to install and/or re-install software on LOGIQ Fortis.
Contents in this section
8-4-1 Purpose of thissection . ... ... . . 8-8
8-4-2 LOGIQ Fortis Model Software Configuration and Hardware. . ... ................. 8-9
8-4-3 Software provided with the LOGIQ Fortis . . ... ... . 8-9
8-4-4 Space management - moving allimages . ............ . ... i 8-9
8-4-5 Backing up the Patient Archive and System Configurations. ... .................. 8-9
8-4-6 Overview of the Base Image and Application Software .. ....................... 8-10
8-4-7 Suspending encryptionto load software . . .......... ... ... . 8-11
8-4-8 Loading the base image and application software - fullload ..................... 8-13
8-4-9 Loading the base image and application software - Systemonly.................. 8-25
8-4-10 Loading only the application software. ... ......... .. ... ... . ... .. ... . . .. . . ... 8-31
8-4-11  Loading software from the internal partition . .......... ... ... ... .. ... .. ... . ... 8-36
8-4-12  Full disk encryption and replacement procedures. . .. ........ ... ... ... . ...... 8-39
8-4-13 Software download andinstall ............. . .. . . ... . .. .. 8-41
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8-4-2 LOGIQ Fortis Model Software Configuration and Hardware

8-4-3

8-4-4

& NOTICE

Table 8-3 LOGIQ Fortis Software Configuration and Hardware

MODEL NUMBER DESCRIPTION SOFTWARE VERSION
6601000 LOGIQ Fortis LCD monitor CONSOLE, 100-240 VAC R3.x.x
6602000 LOGIQ Fortis HDU Display CONSOLE, 100-240 VAC R3.x.x

Software provided with the LOGIQ Fortis

Software is provided on a flash drive with base load image and application software. If patch software
has been included, an additional flash drive may be included with patch software. Verify that the
software is current. Updated software may be available. Check for any available FMIs.

Space management - moving all images

In order to complete a successful restore of the Patient Database, if needed, the images must be
moved away from LOGIQ Fortis before doing backup of the Patient Database. Depending on the
location set-up, either move the images to a remote server or to removable media like DVD or CD discs.
As the images are moved, the database will point to the new location.

If the backup procedure is not completed correctly, the images and database information could be lost.

Refer to “Recording Images” in Chapter 9 of the Basic User Manual (appropriate version).

A\ Warning Before loading software, CONFIRM WITH THE CUSTOMER OR SITE ADMINISTRATOR

8-4-5

A CAUTION

whether the patient archive has been encrypted and if the customer has the password

or the key to unlock the data. Failure to obtain those items will cause permanent DATA
LOSS!

Speak with the personnel at the site to determine which patient images need to be backed up prior to
starting.

Backing up the Patient Archive and System Configurations

An error, or a power loss, may occur during the software loading. Always back up the patient
images, patient archive, and the system configurations before starting a software load.

In order to complete a successful restore of the patient database, if needed, the images must
be moved away from the LOGIQ Fortis before backing up the patient database. Depending on
the location set-up, either move the images to a remote server or to removable media like DVD

or CD discs. If the backup procedure is not completed correctly, the images and database
information could be lost.

See “Backup and Restore” in Chapter 9 of the Basic User Manual (appropriate version).
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8-4-6 Overview of the Base Image and Application Software
The SSD on the LOGIQ Fortis are divided into five partitions.

NOTE: The LOGIQ Fortis has three visible partitions (two partitions are hidden).

Table 8-4 Drive Partitions

Partition GB
Drive Type Letter Usage (approximately)
C: Windows 10/application 79
z Software repository 31
SSD D: User settings/configuration 42
E Database/data 750
Y Future use 10

When installing (and re-installing) software, you get the choice to either replace all the contents or only
install the software on the System partition. If you chose to replace all the contents, all stored data
(including all set-up data) will be lost. It is considered a best practice to always move images away from
the drive, do backup of databases, etc. and record important configuration data on paper before starting
a software load or reload.

The software is delivered on a thumb drive with the base load image and LOGIQ Fortis application
software. In some cases, a second thumb drive with a software patch, may also be included. A software
patch is used when a few new files should be installed or changed, but the changes do not require a
complete software load.

When installing the software, start with the system software, then the application software and if
included, install the patch software at the end. This is described in detail over the next pages.

NOTE: System software may also be referred to as the base image or ghost.

WHILE THE SOFTWARE INSTALL PROCEDURE IS DESIGNED TO PRESERVE DATA,
YOU SHOULD SAVE ANY PATIENT DATA, IMAGES, SYSTEM SETUPS AND
CUSTOMER PRESETS TO CD, DVD OR HARDCOPY BEFORE DOING A SOFTWARE
UPGRADE. FAILURE TO FOLLOW INSTRUCTIONS COULD RESULT IN LOSS OF
PATIENT DATA.

& WARNING

Before the system software load, you must perform the following steps:

» Contact the customer to allow enough lead time to back up the system.

* Review troubleshooting section to collect information for future analysis if you are troubleshooting
loss of image or patient data.

NOTE: After a full or partial system software load, confirm the Windows automatic Daylight Saving
Time feature is turned off (Utility > System > General > Date/Time > Time Zone tab >
Automatically Adjust Clock check box). Be sure the system and DVR date, time and time
zone are set correctly.

NOTE: System and application software disables the Run window normally accessed from Start >
Run, and the mouse right-click (left set key) feature.

8-10 Section 8-4 - Loading / Reloading / Upgrading the Software



GE CONFIDENTIAL
DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-4-7 Suspending encryption to load software

With an activated SSA key on the LOGIQ Fortis, Encryption Suspended is available. Encryption
Suspended temporarily disables encryption without un-encrypting the drives to enable the C:\ only
software load through external media. You can suspend the encryption process to reload software or
replace the BEPS/hard disk drive.

NOTE: If you reload software through the Service Desktop, then encryption is automatically
suspended.

To suspend encryption to load software:

1.) Insert an activated SSA key.
2.) Navigate to Utility > Admin > Disk Encryption.
3.) Under Choose Encryption Policy, select Encryption Suspended.

Encryption Suspended.

4.) View Encryption Suspended information.

5.) Perform the software load.
6.) After the software load is complete, under Choose Encryption Policy, select the encryption policy.
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8-4-7

Suspending encryption to load software (cont’d)

7.) Select Initialize System Encryption or set encryption to ON.

NOTE: If you have done a full system restore, this is what Patient Data Encryption will look like. You
need to select “Initialize System Encryption”.
Initialize System Encryption
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8-4-8 Loading the base image and application software - full load

Follow this procedure to load the base image software and application software from the thumb drive.
NOTE: Lockout/tagout (LOTQ) is not required as you will not manipulate any electronics.
NOTE: A Service key is not required to run this procedure.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5 and 8-2-7 "PPE Required During Service" on page
8-6.

Table 8-5 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Approximately 1 hour and 30 minutes
to 2 hours and 30 minutes depending

on the amount of back-up/restore 3 mm hex wrench )
One person L . . . No PPE required
activities (presets and patient archive) Software thumb drive
needed prior to and after the
installation.

Loading base image and application software

Before loading software, CONFIRM WITH THE CUSTOMER OR SITE ADMINISTRATOR
that the patient archive has been backed up. Failure to do so will cause permanent
DATA LOSS!

& WARNING

A NOTICE Before loading the base image load software, remove all media from USB ports and internal drives (for
example, DVD), and disconnect any portable hard drives. Failing to do so may interrupt the software
load process.
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8-4-8

Loading the base image and application software - full load (cont’d)

Read and understand the contents of this procedure before performing the software update.
Before loading the base image and application software, you must perform the following steps:

» Back up patient data by using EZBackup or Export.

NOTE: Do not use Patient Archive Backup/Restore in Utility > System > Backup Restore to back up

patient data. For more information on backing up and restoring patient data or system presets,

see “Backup and Restore” in the LOGIQ Fortis Basic User Manual, Direction 5817681-1EN.

»  Back up user-defined configurations only. Leave service unchecked.

NOTE: Use a USB thumb drive to back up user-defined configurations. These configurations will be

restored once the software load is complete.

» For software options (for example, Breast Assistant, Powered by Koios DS (Utility > Connectivity
> Koios), Tricefy (Utility > Connectivity > Tricefy), and Device Management (Utility >
Connectivity > Device Mgmt) capture the information on those screens before loading the full
ghost.

NOTE: Once the software installation is complete, use this information to set up the options again.

+ Confirm that no images are in the clipboard or opened exams.

» Disconnect the Ultrasound system from the network and remove all transducers from the system.

» If used, disconnect the secondary monitor.

* Connect and turn ON the printer to retain printer preferences. Before you load the base image,
record any printer preferences. After the base image is loaded, check the printer preferences and
update as needed.

If a printer is plugged in at this time, it is automatically installed.

* You must record all service presets on paper to restore remote connectivity after software
installation is complete. You will have to manually restore service presets (for example, Agent
Configuration).

*  From Windows, Utility > Connectivity > TCP/IP or from the customer, manually record the DNS
server settings.
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8-4-8 Loading the base image and application software - full load (cont’d)

Table 8-6 Load Base Image and Application Software- full load

Step Corresponding Graphic

1. |Remove any USB flash drives and any CD/DVDs from
the DVD drive prior to updating the software.

Disconnect the system from the network and remove all

transducers from the system.
If used, disconnect the secondary monitor, any HDMI
GE Healthcare

Ultrasound

cables and/or external monitors.

Power down the LOGIQ Fortis. Looding .. 5758301 UEFI

2017 Generol Electric Compony - All Rights Reserved

Insert the software thumb drive into the USB port on the
back of the LOGIQ Fortis.

Power on the LOGIQ Fortis.

& CAUTION

Selecting 1- (FULL) is a DATA WIPE & System Application reload. ALL EXISTING PATIENT DATA WILL BE
REMOVED. All existing data will be removed. System and application installation will be completed without
preserving customer data.

With the trackball, point to 1 - (FULL) and then press the
left set key to select

1 - (FULL).

With the trackball, point to OK and press the left set key
to select OK.

In the Warning dialog box, select Yes.

This will take approximately 10-15 minutes.
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Table 8-6 Load Base Image and Application Software- full load(Continued)

Step

Corresponding Graphic

View these screens as the application software loads.

This will take approximately 15-20 minutes.

When System Imaging is Complete displays, do the
following:
+ Select OK to reboot the system.

* Remove the USB media BEFORE the system starts
rebooting.
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Table 8-6 Load Base Image and Application Software- full load(Continued)

Step

Corresponding Graphic

After the system reboots, view these screens as the
application software loads.

This will take approximately 15-20 minutes.

NOTE: These screen shots are examples of the progress screens that will
display as the software loads. These progress screens vary according to
the software revision and version.

GE Healthcare

Ultrasound

Loading .. 5758301 UEFI

© 2017 Generol Blectric Compony - All Rghts Reserved
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Table 8-6 Load Base Image and Application Software- full load(Continued)

Step Corresponding Graphic
5.
GE Healthcare
Ultrasound
Loading .. 5758301 UEFI

After the system reboots again, view these screens as

the application software loads.

This will take approximately 15-20 minutes.
6.

When the Install Success dialog box displays, if '

necessary, select OK to reboot the system. SURRER AT Il iy Y wE Atent et

o I
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Table 8-6 Load Base Image and Application Software- full load(Continued)

Step Corresponding Graphic

GE Healthcare

Ultrasound

Loading .. 5758301 UEFI

© 2017 Generol Blectric Compony - All Rghts Reserved

After the system reboots, view these screens as the
audio is configured.

This will take approximately 15-20 minutes. R " curee T comies Wy res i —

-
e e @0

X4 REALTEK

GE Healthcare
Ultrasound

Loading .. 5758301 UEFI
2017 Generol Bectc Compony - Al Rghts Reserved
Once the application software installation is complete,
the LOGIQ Fortis restarts.

You're about to be signed out

Tha 5 s being rebooted to complete the sohtware instaltaban
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Table 8-6 Load Base Image and Application Software- full load(Continued)

Step

Corresponding Graphic

After boot up, in Operator, enter ADM.
In Password, leave this field empty.

NOTE: No password is required. Do not create any
password at this time.

Select OK.

GE Healthcare

Ultrasound

Loading .. 5758301 UEFI

© 2017 Generol Blectric Compony - All Rghts Reserved

10.

When prompted with Default Security Level, select Skip
for Now for the security level, and then select Apply
Change.

NOTE: If you select the Lowest security level and then
continue with installation and testing. After the update is
complete, you can transfer the LOGIQ Fortis to the Site
Administrator who can reset the security level for the
site. The security level can be reset through Utility >
Admin > Logon.
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Table 8-6 Load Base Image and Application Software- full load(Continued)

Step

Corresponding Graphic

11.

Put USB flash memory about BASE SYSTEM
SOFTWARE and APPLICATION SOFTWARE in a
pocket on the rear cover again.
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8-4-8

NOTE:

Loading the base image and application software - full load (cont’d)

Verifying the software versions:

1.) From the touch panel, select Utility > System > About.

2.) If upgrading the software, verify software version matches the version in the software used during
installation, version received with the kit.

Verifying the software option key settings:

Software option keys are software version dependent. If a new software version has been
installed, please follow installation instructions for that software. Usually, with new software
option strings are needed. When re-installing the same software, the software option strings
should be reused.

1.) From the touch panel, select Utility > Admin > System Admin.

2.) Verify that the options previously installed in the system are still activated after the software
installation.

3.) If any option is missing, request new option strings from the Online Support. Enter any new or
missing option key string(s) in the S/W Option Key field and select Add, or by importing from a
USB or DVD drive.

Verifying the TCP/IP settings:

1.) From the touch panel, select Utility > Connectivity > TCP/IP.
2.) Verify TCP/IP settings.

3.) If needed, manually set the DNS server settings you recorded.
4.) If you modified or updated any settings, select Save settings.
5.) Select OK to continue.

6.) Reboot the system.

Restoring the patient archive

Restore the patient archive (if previously exported or backed up with EZBACKUP) using the import
function. If the patient archive media is encrypted and locked, you will need the encryption key or
password to unlock it.

From the touch panel, select Patient > Data Transfer > Import.
Verifying the AE title and port settings:

1.) From the touch panel, select Utility > Connectivity > Device.
2.) Verify device settings.
3.) If you modified or updated any settings, select Save settings.
4.) Select OK to continue.

Section 8-4 - Loading / Reloading / Upgrading the Software



GE CONFIDENTIAL

DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-4-8 Loading the base image and application software - full load (cont’d)

A CAUTION

Restoring system configurations:

1.) From the touch panel, select Utility > System > Backup/Restore.

2.) On the Restore screen, select System configuration to restore System settings/User Defined
Configuration.

3.) Select the appropriate source device.

The restore procedure will OVERWRITE the existing data on the local hard drive. Make sure to
select the correct source device.

4.) If restore is done from a backup on a removable media, insert the media in the drive.
5.) Select Restore Now.
Depending on the selection, one or two restore confirmation windows are displayed.

6.) Ensure that the correct source is selected, and select OK.

The selected items are copied to the LOGIQ Fortis. If items from the System Configuration are
restored, the LOGIQ Fortis needs to be rebooted. The Reboot system window is displayed.

7.) Select OK to reboot the system, and verify the Customer Presets are working properly.
8.) Import scan assistant programs previously exported.

9.) Check the printer selection and reselect the standard printer color and/or B&W if needed. Reloading
software may reset the printer selection even after restoring user configurations.

10.)Load the online help files from the elFU flash drive. For more information, see “Updating
Documentation on the Ultrasound Scanner Via the USB” in the Basic User Manual (appropriate
revision) or the elFU leaflet.

11.)Check for any field that appears highlighted in yellow as this is an indication that the field needs to
be reset.

12.)Confirm that at least the system drive encryption has been initialized. Contact the site administrator
for them to set up the user partitions encryption.

13.)Set up InSite. See the Basic User Manual for instructions if using GE Connect Guide under the
InSite icon menu, or the Service Manual if using the Agent Configuration from the Service Desktop.

- Navigate to Utility (second page) > Service > Utilities, select Resolve Agent Quarantine
and, if the system appears to be in quarantine, resolve the quarantine. If the quarantine does
not resolve, contact the On Line support team to escalate the issue.

14.)If Device Management was active prior to the upgrade, you need to re-enter the e-mail address
since it does not get repopulated automatically.

- If Device Management was active prior to the software load, confirm that the cloud still verifies
your activation.

- Navigate to Utility > Connectivity > Device Mgmt and confirm that status shows “Active”. It
is normal if the e-mail address is not visible. If so, proceed to select “Verify” and confirm that
you get a smiley face. Keep in mind that you need to be connected to the network for the
Device manager to verify successfully.

- If the system is not successfully connecting to the cloud, contact the Device management
team for support at email: dc.support@ge.com indicating the serial number of the unit,
description of the problem and e-mail of the admin user registered in the account.
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8-4-8 Loading the base image and application software - full load (cont’d)

15.)Configure any new features (for example, Device Management) if applicable. Refer to the LOGIQ
Fortis Basic User Manual for more information. For software options (for example, Breast Assistant,

Powered by Koios DS and Tricefy), restore the information you recorded before loading the full
ghost.

16.)Store the software thumb drive on the inside pocket of the left side cover. Reinstall any covers and
Verify that all screws and covers removed earlier have been installed.

Functional checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-7 Loading Software all Partitions Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-7 Probe/connector functional checks

4-3-8 B-Mode functional checks Equipment passed all required checks and is ready for
4-3-10 System CFM and PWD functional checks use.
4-3-20 Basic measurement functional checks

4-2-4 Power shut down
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8-4-9

Loading the base image and application software - System only

Follow this procedure to load the application software and Windows operating system from the thumb
drive. This procedure will load System partition only and will also load the repository partition. Neither
Patient data nor user data is lost.

If disk encryption is enabled, you will need the correct recovery keys (32-bit string) and password (if set
up). If recovery keys are not available, you will have to do a full load instead. The only way to recover
the patient data is if the customer has previously backed up data and images.

NOTE: It is recommended to suspend encryption rather than turning it off. For non self-encrypted
drives, turning encryption off will take 24 hours.
NOTE: Lockout/tagout (LOTQ) is not required as you will not manipulate any electronics.
NOTE: A Service key is not required to run this procedure.
This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5 and 8-2-7 "PPE Required During Service" on page
8-6.
Table 8-8  Manpower, Time, Tools, and PPE
Manpower Time Tools PPE
Approximately 1 hour and 30 minutes
to 2 hours and 30 minutes depending
One berson on the amount of back-up/restore Phillips screw driver No PPE required
P activities (presets and patient archive) Software thumb drive aut
needed prior to and after the
installation.

Section 8-4 - Loading / Reloading / Upgrading the Software 8-25




GE CONFIDENTIAL

DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-4-9

& WARNING

A

NOTICE

NOTE:

Loading the base image and application software - System only (cont’d)

Loading application software

Before loading software, CONFIRM WITH THE CUSTOMER OR SITE ADMINISTRATOR if the
patient archive has been encrypted and if the customer has the password or the key to unlock
the data. Failure to obtain those items, will cause permanent DATA LOSS!

Before loading the base image load software, remove all media from USB ports and internal drives (for
example, DVD), and disconnect any portable hard drives. Failing to do so may interrupt the software
load process.

Read and understand the contents of this procedure before performing the software update.
Before loading the base image and application software, you must perform the following steps:

» Back up patient data and system presets.

+ Confirm that no images are in the clipboard or opened exams.

» Disconnect the system from the network and remove all transducers from the system.
» If used, disconnect the secondary monitor.

» Connect and turn ON the printer to retain printer preferences. Before you load the base image,
record any printer preferences. After the base image is loaded, check the printer preferences and
update as needed.

If a printer is plugged in at this time, it is automatically installed.

» Save all service presets to restore remote connectivity after software installation is complete.
+ Save all user presets.

For more information on backing up and restoring patient data or system presets, see “Backup
and Restore” in the LOGIQ Fortis Basic User Manual (latest revision).

Table 8-9 Loading the base image and application software - System only

Step Corresponding Graphic

Suspend encryption prior to turn off the system.
Suspended encryption will be maintained until reboot,
make sure this is the last step prior to reload.

Remove any USB flash drives and any
CD/DVDs from the DVD drive prior to updating the
software.

Power down the LOGIQ Fortis.

Insert the software thumb drive into the USB port on the
back of the LOGIQ Fortis.

Power on the LOGIQ Fortis.

GE Healthcare

Ultrasound

Loading .. 5758301 UEFI

© 2017 Generol Blectric Compony - All Rghts Reserved
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Table 8-9 Loading the base image and application software - System only(Continued)

Step Corresponding Graphic

With the trackball, point to 2 - (SYSTEM) and press the left
set key to select

2 - (System).

With the trackball, point to OK and press the left set key to
select OK.

NOTE: Selecting 2-System is a not DATA WIPE. ALL
EXISTING PATIENT DATA WILL BE PRESERVED.

This will take approximately 10-15 minutes.

NOTE: If encryption is enabled, a warning message will
appear requesting to connect a USB keyboard to enter the
encryption recovery key. Select OK to continue and enter
the key using the alphanumeric keyboard.

View the different screens that appear as the following
tasks are performed:

« Identifying Local Disk Properties

» Configuring Disk Partitions

* Populating Repository

* Populating System Drive. This may take some time...
* Populating Data Drives

4. |When System Imaging is Complete displays, do the
following:

* Press OK to reboot the system.

* Remove the USB media BEFORE the system starts
rebooting.

Remove the USB media BEFORE the system starts
rebooting (right after the screens go black).
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Table 8-9 Loading the base image and application software - System only(Continued)

Step Corresponding Graphic

View these screens as the application software loads.
This will take approximately 15-20 minutes.

BasePatches

Service Platform

LOGIQ Software Installation

BasePatches

Shutting down running programs
Updating policy files

Updating drivers

Applying Security Patches

Service Platform

Logig Software Installation

Removing previous installation
Installing application
Configuring application
Updating Files

Service Platform Prerequisites

Once the application software installation is complete, the
LOGIQ Fortis restarts.

7. | After boot up, log in as ADM (no password required) and, when prompted, select Lowest for the security level.
NOTE: Select the Lowest security level and then continue with installation and testing. After the update is complete, you can

transfer the LOGIQ Fortis to the Site Administrator who can reset the security level for the site. The security level can be reset
through Utility > Admin > Logon.

8. |Go to "Full disk encryption and replacement procedures” on page 8-39.
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Table 8-9 Loading the base image and application software - System only(Continued)

Step Corresponding Graphic

Put USB flash memory about BASE SYSTEM
SOFTWARE and APPLICATION SOFTWARE in a pocket
on the rear cover again.

If applicable, remove the old version of the software thumb
drive and dispose of it per local policy.
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8-4-9

Loading the base image and application software - System only (cont’d)

Verifying the software versions:

1.) From the touch panel, select Utility > System > About.

2.) Verify software version matches the version in the software used during installation, version
received with kit.

Verifying the TCP/IP settings:

1.) From the touch panel, select Utility > Connectivity > TCP/IP.
2.) Verify TCP/IP settings.

3.) If you modified or updated any settings, select Save settings.
4.) Select OK to continue.

5.) Reboot the system.

Verifying the AE title and port settings:

1.) From the touch panel, select Utility > Connectivity > Device.
2.) Verify device settings.

3.) If you modified or updated any settings, select Save settings.
4.) Select OK to continue.

Check patient archive

Confirm that the patient archive is available. If the patient archive is encrypted, you will need the
encryption key or password to unlock.

Check system configurations

Check the printer selection and reselect the standard printer color and/or B&W if needed. Reloading
software may reset the printer selection even after restoring user configurations.

Check that the online help language is set.

Check for any field that appears highlighted in yellow as this is an indication that the field needs to be
reset.

Confirm that at least the system drive encryption has been initialized. Contact the site administrator for
them to set up the user partitions encryption.

Functional checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-10 Loading System Partition Only Software Functional Checks

See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks Equipment passed all required checks and is ready for
4-3-10 System CFM and PWD functional checks use.
4-3-20 Basic measurement functional checks
4-2-4 Power shut down
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8-4-10 Loading only the application software

Follow this procedure to only load the application software (and not the Windows operating system).

If disk encryption is enabled, you will need the correct recovery keys (32-bit string) and password (if set
up). If recovery keys are not available, you will have to do a full load instead. The only way to recover
the patient data is if the customer has previously backed up data and images.

NOTE: Lockout/tagout (LOTOQ) is not required as you will not manipulate any electronics.
NOTE: A Service key is not required to run this procedure.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5 and 8-2-7 "PPE Required During Service" on page
8-6.

Table 8-11 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Approximately 1 hour and 30 minutes
to 2 hours and 30 minutes depending

One person on the amount of back-up/restore Phillips screw driver No PPE required
activities (presets and patient archive) Software thumb drive
needed prior to and after the
installation.
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8-4-10 Loading only the application software (cont’d)

Loading only application software

Table 8-12 Loading Only Application Software

Step Corresponding Graphic

GE Healthcare
Ultrasound

Loading ... 5758301 Rev 7 UEFI

Turn on the LOGIQ Fortis and wait until Windows has booted
and is loading. Watch carefully for the screen swirling circles, © 2017 General Electric Company - All Rights Reserved

as shown.

2. |Promptly insert the software thumb drive into the USB port on
the back of the LOGIQ Fortis.

This action will trigger the application only installation. If you
wait too long, the application will start without detecting the
thumb drive and you will have start the process again.

At the Start Application dialog, select Install SW.... nistall 5\ i

Start Appbcation

W Pyitem software

fore actnvaling this

At the StartLoader dialog, select OK.

oK i Cantel |I
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Table 8-12 Loading Only Application Software (Continued)

Step

Corresponding Graphic

Select OK to continue with the application software load
process.

StartLoader

y i; New system SW installation will start now

| E OK ] Cancel J

If prompted, select Install to begin the software installation.

If you get an error stating “This package cannot be installed.
The package is not compatible or has been tampered. Please
contact GE Service”, select OK and try to select the correct file
again.

Once the application software installation is complete this
screen will display, remove the thumb drive before the system
re-starts.

The system will boot up.

You're about to be signed out
The system is being rebooted to complete the software installation

Let the load process continue. It will take several minutes. DO
NOT disturb the process.
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Table 8-12 Loading Only Application Software (Continued)

Step Corresponding Graphic

10.
Once the application software installation is complete this : ;
screen will display, remove the thumb drive before the system You're about to be signed out
re-starts. The syste is being rebooted to complete the saftware instaation
The system will boot up.

11. | After boot up, log in as ADM (no password required) and, when prompted, select Lowest for the security level.
NOTE: Select the Lowest security level and then continue with installation and testing. After the update is complete, you can
transfer the LOGIQ Fortis to the Site Administrator who can reset the security level for the site. The security level can be reset
through Utility > Admin > Logon.

12.

New Software Verification
Whether encryption is On or Off and after a load of the
application software (only), the New Software Verification
dialog box may display outlining the functional checks required
for the software installation.
Select each of the functional checks.
Enter a signature and select OK.
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8-4-10 Loading only the application software (cont’d)

Verifying the software versions:

1.) From the touch panel, select Utility > System > About.

2.) Verify software version matches the version in the software used during installation, version
received with the kit.

Verifying the TCP/IP settings:

1.) From the touch panel, select Utility > Connectivity > TCP/IP.
2.) Verify TCP/IP settings.

3.) If you modified or updated any settings, select Save settings.
4.) Select OK to continue.

5.) Reboot the system.

Verifying the AE Title and Port settings:

1.) From the touch panel, select Utility > Connectivity > Device.
2.) Verify device settings.

3.) If you modified or updated any settings, select Save settings.
4.) Select OK to continue.

Check patient archive

Confirm that the patient archive is available. If the patient archive is encrypted, you will need the
encryption key or password to unlock.

Check system configurations

1.) Check the printer selection and reselect the standard printer color and/or B&W if needed. Reloading
software may reset the printer selection even after restoring user configurations.

2.) Check that the online help language is set.

3.) Check for any field that appears highlighted in yellow as this is an indication that the field needs to
be reset.

4.) Confirm that at least the system drive encryption has been initialized. Contact the site administrator
for them to set up the user partitions encryption.

Functional checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-13 Loading Application Software Functional Checks

ee:
S:ction Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks Equipment passed all required checks and is ready for
4-3-10 System CFM and PWD functional checks use.
4-3-20 Basic measurement functional checks
4-2-4 Power shut down
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8-4-11 Loading software from the internal partition
Use this procedure to reload base load and application software from the repository partition in the hard
drive.
NOTE: Lockout/tagout (LOTQ) is not required as you will not manipulate any electronics.
NOTE: A Service key is not required to run this procedure if run remotely.
This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5 and 8-2-7 "PPE Required During Service" on page
8-6.
Table 8-14 Manpower, Time, Tools, and PPE
Manpower Time Tools PPE
Approximately 1 hour and 30 minutes
to 2 hours and 30 minutes depending
One person on the amount of back-up/restore If reloading locally, SSA key No PPE required
activities (presets and patient archive) Software thumb drive
needed prior to and after the
installation.
WARNING Before loading software, CONFIRM WITH THE CUSTOMER OR SITE ADMINISTRATOR if the
& patient archive has been encrypted and if the customer has the password or the key to unlock

the data. Failure to obtain those items will cause permanent DATA LOSS!

Table 8-15

Loading Software from the Internal Partition

Step

Corresponding Graphic

Log into Service Desktop (if FE is reloading locally, SSA key is required. IF Reload is triggered remotely by the OLC, no SSA

key is required).

Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set Disruptive mode to On.

Navigate to Utilities > Software Reload.
View the current version numbers.
Select Software Reload.

Before proceeding you need to check for encryption. System asks

to confirm if encryption key is available.

If yes, select the | Agree check box and then select Continue

Reload.

Goplanie Fapkood

1o
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System message will appear on the screen stating that reload is
configured and system will automatically restart in 10 seconds.
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Table 8-15 Loading Software from the Internal Partition (Continued)

Step Corresponding Graphic

Wait until the system goes through the whole loading process.
System will boot up to applications automatically after about 30
minutes.

You will see several screens as the application software is being
loaded. Let it run.
At this point, the load time will be approximately 20 minutes.

Once the software installation is complete the

LOGIQ Fortis will restart twice.

When the LOGIQ Fortis restarts, it will be active and ready for
testing.

You're about to be signed out
The system is being rebooted to complete the software installation
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8-4-11

Loading software from the internal partition (cont’d)

Verifying the software versions:

1.) From the touch panel, select Utility > System > About.

2.) Verify software version matches the version in the software used during installation, version
received with kit.

Check patient archive

Confirm that the patient archive is available. If the patient archive is encrypted, you will need the
encryption key or password to unlock.

Functional checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-16 Loading Software from the Internal Partition Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-7 Probe/connector functional checks

4-3-8 B-Mode functional checks Equipment passed all required checks and is ready for

4-3-10 System CFM and PWD functional checks use.

4-3-20 Basic measurement functional checks

4-2-4 Power shut down
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8-4-12 Full disk encryption and replacement procedures

Full disk encryption (all partitions on the SSD are encrypted) is available. Previously, only patient data

on the E: drive could be encrypted.

Due to full disk encryption, some replacement procedures require an extra step to make sure the data

is recoverable after the replacement.

+ Ifthe LOGIQ Fortis is down, you must have the correct recovery keys and password (if set up),
otherwise the data will be irretrievable. recovery keys are required.

+ Ifthe LOGIQ Fortis is up and running, suspend encryption before performing a replacement
procedure (hardware or software). Otherwise you must have the correct recovery keys and
password (if set up). The length of encryption varies. Generally, encryption with SSD takes about
20 minutes. recovery keys are required.

Patient data should be backed up before these replacement procedures. If possible, the customer

should be backing up data on a regular basis. In the event the system cannot access the patient data

after the repair, the backup would be the only way to return the data to the LOGIQ Fortis.

Use Table 8-17 to determine the steps needed when performing a replacement procedure. Refer to the

complete replacement steps in Chapter 8.

Table 8-17 Replacement Procedures and Encryption Updates

Full disk encryption
Procedure is... After replacement, load... After load, perform...
On n/a n/a
Loading application software
Off n/a n/a
on n/a "To complete a replacement procedure
Loading base and application with full disk encryption On:" on page 8-40
only (C only) software “1
Off n/a n/a
If encryption is On and Locked, you
will be prompted to turn it off. Go back and select initialize encryption
on Encryption will then be suspended. again as loading from the repository
Software Reload (from Service (Encryption is automatically leaves the drives encrypted but Off (in
Desktop) suspended if you load software case there is an issue).
from the Service Desktop).
Off n/a n/a
"To complete a replacement procedure
SOM replacement using the On Application only (C only) software with full disk encryption On:" on page 8-40
existing SSD “1, 2 PP Y y
Off n/a
SSD (solid state drive) On Full load image and application E Go t.o Encry.ptlon > Select Initialize
ncryption again. Doing a full load leaves
replacement software S .
Off the application drive unencrypted.

*1) If system has been full disk encryption, the system may request to type the correct recovery keys
and password, in advance, note the correct recovery keys and password.

*2) If it needs to replace the SSD with new one at same time as SOM replacement, refer to SSD (solid
drive) replacement in same table.
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8-4-12Full disk encryption and replacement procedures (cont’d)

To complete a replacement procedure with full disk encryption On:

The system may request the recovery keys through the Numeric Key dialog box. This dialog box may
display up to three times (once for each of the encrypted partitions).

1.) Once you select to load C only or System, the system will check for encryption status and if not
suspended or turned off, it will prompt you to enter the recovery keys. On the Numeric Key dialog
box, enter the recovery key and then select Submit and Exit. This step automatically place the
entered number in Memory.

a5l Encryption Keypad - O X
BackSpace Clear Entry
7 8|9 Mem Recall
4 hbl|6 Memoary Clear @
1 2|3 Submit and Exit
0 —MNo Digits Entered-
Enter digits then press Submit and Exit

2.) When the Numeric Key displays Second time, select Mem Recall to recall the recovery key from
memory and then select Submit and Exit.

3.) When the Numeric Key displays the third time, select Mem Recall to recall the recovery key from
memory and then select Submit and Exit. If the keys are accepted, the system will continue to load
the software.

4.) Close with the X.

5.) When the Numeric Key displays again, select Mem Recall to recall the recovery key from memory
or manually enter the recovery key.

6.) Close with the X.
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8-4-13 Software download and install
Use Software Download and Install to view available software updates and to install them.

+ To view more information about the software download, select More Info.

» To postpone the software download, select Remind me later.

* To decline the software download, select Decline.

» To accept the software download, select Start.

For more information about software download, see the Basic User Manual (appropriate version).

Figure 8-3 Software Download and Install
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Section 8-5
Replacing Cable

8-5-1

8-5-2

Purpose of this section

This section describes how to replace the cables used by LOGIQ Fortis.

Contents in this section

8-5-2 Preparation . .. ... ... 8-42
8-5-3 Power cable replacement . . . ... ... .. . 8-43
8-5-4 Cable Duct and OPIO Cable Assy Replacement .. .......... .. ... .. ... .. ...... 8-46
Preparation

Table 8-18 Preparations and Preparation Links

Preparations - you must perform the following steps

A DANGER

&
LOCKOUT

Risk of dangerous voltage within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
¢ Plan and prepare for shutdown.

e Completely power down the LOGIQ Fortis.

¢ Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
¢ Apply lockout/tagout devices to maintain exclusive control of the power cable.
¢ Relieve all potentially hazardous stored or residual energy (batteries).

¢ Verify isolation.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.

e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.

e "Disconnect battery power" on page 1-28.

1. Lock the casters.
2. Power down the system.
3. Disconnect the mains power cable from the wall outlet, all Probes and External I/O Cabling.

Preparation Links (if you need more information):
* 4-2-4 "Power shut down" on page 4-10.
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8-5-3 Power cable replacement

When preparing for the replacement, confirm that no images are in the clipboard or opened exams.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5 and 8-2-7 "PPE Required During Service" on page

8-6.
Table 8-19 Manpower, Time, Tools, and PPE
Manpower Time Tools PPE
One person Approximately 30 minutes Phillips screw driver Kneel pajzl:‘el(tzec:?ns:?ssrequired)

Table 8-20 Power cable removal

Step

Corresponding Graphic

& CAUTION

Risk of losing patient data

images/clips.

To avoid losing patient data, ensure that you have properly ended the patient’s exam and transferred all exam data/

1. |Set the caster brake.

2. |To completely power down the LOGIQ Fortis:

Lightly press the ON/OFF button on the operator panel to
display the System - Exit menu.

Select Shutdown to completely power down the LOGIQ
Fortis.

& CAUTION

blue.

DO NOT turn off the breaker before the Power button is changed to blue.
Data may be lost or system software damaged if the breaker is turned off before the Power button is changed to

Turn off the breaker on the back of the system.

471 ——

 OO® (e o
@@.@_ﬁﬁr e

£
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Table 8-20 Power cable removal

Step

Corresponding Graphic

& WARNING

To avoid risk of fire, the system’s power must be supplied from a separate, properly rated outlet.

Under no circumstances should the AC power plug be altered, changed, or adapted to a configuration rated less than
specified. Never use an extension cord or adapter plug.

To help assure grounding reliability, connect to a “hospital grade” or “hospital only” grounded power outlet.

& CAUTION

Use caution to ensure that the power cable does not disconnect during system use.

If the system is accidentally unplugged, data may be lost.

& WARNING

extension cord or power strip.

To avoid leakage current above safety limits as prescribed by IEC 60601-1 and to ensure continuity of protective
earth, DO NOT connect the Ultrasound system and mains-operated accessories to a single or multiple socket

4.
Unscrew 2 screws to remove the power cable clamp.
5.
Remove the power cable.
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8-5-31

8-5-3-2

8-5-3-3

8-5-3-4

Installation
Install components in reverse order of removal.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Leakage current is NOT required since no electronic part is being replaced. Ground continuity, however,
is recommended..

Table 8-21 Cable replacement Functional Checks

See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks Leakage Current measured at (record the value) and
- — meets allowable limits. Equipment passed all required
10-6-7 Grounding continuity checks and is ready for use.
4-2-4 Power shut down
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8-5-4 Cable Duct and OPIO Cable Assy Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-22 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

. ! Safety shoes
. . Phillips screwdriver )
One person Approximately 30 minutes Cut resistant gloves
Hex wrench
Kneel pad

ESD mat and wrist strap

8-5-4-1 Removal Procedure of Monitor Cable and OPIO Cable.

Table 8-23 Removal procedure

Steps Corresponding Graphic

1. Disconnect all cables from NEST.

2. Unscrew 1 screw to remove BBG2 Signal Cable and BBG2
Power Cable.
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Table 8-23 Removal procedure

Steps Corresponding Graphic

3. Remove Battery installation kit from frame.
Loosen the upper 2 screws (indicate yellow circle). Unscrew
lower 2 screws (indicate red circle).

4. Loosen 2 cable clamp.
5. Loosen 1 screw to remove Front Block Dummy Cover.
6. Remove the tie-wrap
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Table 8-23 Removal procedure

Steps Corresponding Graphic

7. Remove 4 screws and Elevation arm lower cover.

8. Remove 2 screws to loosen the 2 cable clamp.

9. Remove the cable clamp.

10. | Gently push the connectors through center of the operator
panel base and pull the cables downward.
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8-5-4-2

8-5-4-3

8-5-4-4

8-5-4-5

Installation Main Cable (Harness) Cables
Install components in reverse order of removal.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-24 Cable replacement Functional Checks

Sesft?on Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-7 Probe/connector functional checks

4-3-8 B-Mode functional checks

4-3-10 System CFM and PWD functional checks Leakage Current measured at (record the value) and
meets allowable limits. Equipment passed all required

4-3-11 Color Mode functional checks checks and is ready for use.

4-3-14 PW/CW Doppler mode functional checks

4-3-1 Top console adjustment control functional checks

4-2-4 Power shut down
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Section 8-6
Replacing Covers

8-6-1 Purpose of this section.
This section describes how to replace the covers and bumpers on the Ultrasound system.
Contents in this section
8-6-2 Preparation . .. ... ... 8-50
8-6-3 Covers and bumpers OVEIVIEW . . . ... ... 8-50
8-6-4 Front Cover Replacement. . . ... ... 8-51
8-6-5 Cabinet Cover Replacement. . . ... . . . . . . . 8-53
8-6-6 Low Cabinet Cover replacement. . .. ... ... ... . . . e 8-55
8-6-7 Side Cover Replacement . . ... .. . 8-57
8-6-8 Rear Cover Replacement . . ... ... . e 8-61
8-6-9 Base Cover & Foot Coverreplacement ......... ... ... ... ... . . ... . ... 8-63
8-6-10 OPIO Top Cover Replacement . . ... . e 8-66
8-6-11  Label Placement for the LOGIQ Fortis used in a Veterinary Environment . . ... ...... 8-69
8-6-12 Rear handle Replacement ... ... . . . . . 8-70
8-6-13  Main Monitor Arm Assembly Covers Replacement. . .. ....... ... ................ 8-71
8-6-14  Elevation Arm Cover Replacement. . . ... . . . . 8-74
8-6-15 OPIO Bottom Base Back Cover Replacement . . ......... ... ... ................ 8-77
8-6-16  Side Cabinet Replacement. . . ... ... ... . . . 8-78
8-6-2 Preparation
Table 8-25 Preparations and Preparation Links
Preparations - you must perform the following steps
1. Lock the casters.
2. Completely shutdown the system.
3. Disconnect the mains power cable from the wall outlet, all Probes and External I/O Cabling.
Preparation Links (if you need more information):
» 4-2-4 "Power shut down" on page 4-10.
8-6-3 Covers and bumpers overview
The main console has a front cover, two side covers, a front bumper (foot rest) and rear bumper, a rear
cover with a top trim, and a top cover.
WARNING When replacing side covers and/or the rear cover for an Ultrasound system used in veterinary
& environment, the labels for veterinary systems MUST BE re-installed before the LOGIQ Fortis is
returned for use. See8-6-11 "Label Placement for the LOGIQ Fortis used in a Veterinary
Environment" on page 8-69 and Section 9-16 "Product Labels" on page 9-30.
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8-6-4  Front Cover Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-26 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
One person Approximately 5 minutes No tools required Kneel pad
8-6-4-1 Removal Procedure
Step Corresponding graphic

Pull the Front Cover Assy to remove it (no tool
required).
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8-6-4-2 Installation Procedure

Step Corresponding graphic

_—

1. |Remove the window film.

——

Align the edges and simply push to make sure all
three “latches” are engaged.

8-6-4-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-6-4-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Connect cables and Probes removed earlier.

2.) Power up the system to verify that it operates as intended.

8-6-4-5 Functional Check
Visual inspection only.

8-52 Section 8-6 - Replacing Covers



GE CONFIDENTIAL
DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-6-5 Cabinet Cover Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-27 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
) ) . Cut resistant gloves
One person Approximately 5 minutes No tools required
Kneel pad
8-6-5-1 Mid and High Cabinet Cover Removal Procedure
NOTE: Cabinet Cover shapes differ for each configuration, but removal/installation procedure are the

same.

Step Corresponding graphic

1. |Slide out Cabinet Cover toward front of the console.
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8-6-5-2 Mid/High Cabinet Cover Installation Procedure

Step Corresponding graphic

Slide the Cabinet cover as shown in right figure.

Make sure “latches” on both sides are engaged.

NOTE: For Mid and High Cabinet type, there is “Guide Rail” for installation. Simply align “Cover Rail” on cover side to “Rail
Guide” in chassis side.

Cover rail

Rear rail

8-6-5-3 Calibration and adjustments

No calibrations or adjustments are needed after this part replacement.

8-6-5-4 Verification

Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Connect cables and Probes removed earlier.
2.) Power up the system to verify that it operates as intended.

8-6-5-5 Functional Check

Visual inspection only.
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8-6-6 Low Cabinet Cover replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-28 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
) ) . Cut resistant gloves
One person Approximately 5 minutes No tools required
Kneel pad
8-6-6-1 Removal Procedure
Step Corresponding graphic

1. |Lift the top cover upwards.

8-6-6-2 Installation Procedure

Step

1. |Push the top cover downward.
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8-6-6-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-6-6-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Connect cables and Probes removed earlier.

2.) Power up the system to verify that it operates as intended.

8-6-6-5 Functional Check
Visual inspection only.
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8-6-7 Side Cover Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-29 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

One person Approximately 15 minutes Phillips Screw Driver Cut resistant gloves
Kneel pad
8-6-7-1 Removable procedure
Step Corresponding graphic
1. Remove the Cabinet Cover and the front cover.

Unscrew 3 screws to remove the Side Cover L Assy.
Disengage the hook from the frame.
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Step

Corresponding graphic

Unscrew 3 screws to remove the Side Cover R Assy.
Disengage the hook from the frame.

Section 8-6 - Replacing Covers




GE CONFIDENTIAL
DIRECTION 5874372, REV. 3

LOGIQ ForrTIs Proprietary Service Manual

8-6-7-2 Installation Procedure

Step

Corresponding graphic

Engage the hook and fasten 3 screws to attache
the Side Cover L Assy.
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Step Corresponding graphic

Engage the hook and fasten 3 screws to attach the
Side Cover R Assy.

3. Install the front cover and Cabinet cover.

8-6-7-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-6-7-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

8-6-7-5 Functional Check
Visual inspection only.
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8-6-8 Rear Cover Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-30 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
. . . . Safety glasses
One person Approximately1 5 minutes Phillips Screw Driver
Kneel pad
8-6-8-1 Removal Procedure

Step

Corresponding graphic

1. |Unscrew 5 screws to remove the rear cover.

I
oo
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8-6-8-2 Installation Procedure

Step Corresponding graphic

Check that the ODD SATA SHIELD CABLE (red) is clamped to
1. | the left position. If it is clamped to the right position, move to the
left position.

Check that the internal cables have not entered the | /O Rear
2. | Panel area. If there is a cable in the area, pull up the clamp
position of the cable to move it away from the area.

3. Install the cover with 5 screws.

8-6-8-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-6-8-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Internal cables have not entered the | / O rear panel area.

3.) Connect cables and Probes removed earlier.

4.) Power up the system to verify that it operates as intended.

8-6-8-5 Functional Checks
Visual inspection only.
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8-6-9 Base Cover & Foot Cover replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-31 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
. ) . . Cut resistant gloves
One person Approximately 15 minutes Phillips Screw Driver
Kneel pad

Footcove le

Front

Figure 8-4 Base Cover and Foot Cover

8-6-9-1 Removal Procedure

Step Corresponding graphic

See

8-6-5 "Cabinet Cover Replacement" on page 8-53
8-6-4 "Front Cover Replacement" on page 8-51
8-6-16 "Side Cabinet Replacement" on page 8-78

Remove the cabinet cover.
1. Remove the front cover.
Remove the side cabinet (If installed).
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Step

Corresponding graphic

Remove Base Cover Front.
Pulling edge of each side to unhook the base cover
front.

There are 2 attached latches under the base cover
front.

Pulling out the base cover front upward to disconnect
the latch from the base.

Then remove the foot cover front.

Remove Foot Cover Front.
Pulling side edge of the foot cover front to unhook and
then move upward.

Remove Base Cover Left / Right.
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8-6-9-2

8-6-9-3

8-6-9-4

8-6-9-5

Installation Procedure
Parts to be installed in reverse order of removal.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Check
Visual inspection only.
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8-6-10 OPIO Top Cover Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-32 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses
Cut resistant gloves
Kneel pad
ESD mat and wrist strap

One person Approximately 15 minutes Phillips Screw Driver

8-6-10-1 Removal Procedure

Step Corresponding graphic

1. Unscrew 2 screws from the rear of the OPIO Base.

|SB 3.0 cable

Remove the OPIO Top cover Left and Right.

2. Disconnect USB3.0 Cable from CN3 on the EUSB2 PWA and
unscrew 1 screw on the bottom of the OPIO base.
3 Unscrew 4 screws to separate Ext USB CON from OPIO TOP

COVER Right

OPIO Top Cover Right
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8-6-10-2 OPIO TOP Cover installation

Step

Corresponding graphic

Assemble Ext USB CON and OPIO TOP COVER Right
with 4 screws.

Insert the connector on CN3 label side of the user port
USB3.0 cable into the CN3 connector on the EUSB2 PWA.

Push the metal frame part of the connector with fingernail
and insert until feel a click.

gttt

IS

AT

3. |Assemble EUSB2 GND cable with 1 screw.
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Step

Corresponding graphic

4. |Putonthe OPIO TOP COVER R/L on OPIO.

5. |Assemble LOWER OPIO with 2 screws.

8-6-10-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-6-10-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

8-6-10-5 Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-33

Main Monitor assembly replacement Functional Checks

See:
Section

Functional Check

Debrief Script

4-2-3

Power ON/Boot Up

Leakage Current measured at (record the value) and

4-3-17

Removable media functional checks

meets allowable limits.
Equipment passed all required checks and is ready for

4-2-4

Power shut down

use.
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DIRECTION 5874372, REV. 3
Label Placement for the LOGIQ Fortis used in a Veterinary Environment

8-6-11
Table 8-34 LOGIQ Fortis used in a Veterinary Environment Label Placement
Steps Corresponding Graphic
1. If the Side Cover Assemblies are replaced, re-install the

“VET" Label as shown on both side.
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2. If the monitor cover is replaced,
re-install the “Vet label” as shown.

3. If a Probe is replaced, re-install ALL the “For Veterinary
use only“ Label(s) for Probes as shown (Example). This

label is shown on the Probe Cable, near the connector.
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8-6-12 Rear handle Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-35 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
) ) . . Safety shoes
One person Approximately 5 minutes Phillips Screw Driver ]
Cut resistant gloves
Kneel pad

8-6-12-1 Remove the rear handle

Step

Corresponding graphic

1. Unscrew 5 screws to remove the rear cover.

(<]

|

[T

L &25*
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2. Unscrew 3 screws to remove the Rear Handle.

8-6-12-2 Installation

Parts to be installed in reverse order of removal.

8-6-12-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-6-12-4 Verification

Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.

8-6-12-5 Functional Check
Visual inspection only.
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8-6-13 Main Monitor Arm Assembly Covers Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-36 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses
Cut resistant gloves
Kneel pad

Phillips screw driver

One person Approximately 15 minutes Hex Wrench
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8-6-13-1 Remove the covers

Step Corresponding graphic

1. Unscrew 1 screw to remove1st cover Polaris.

2. Remove 2nd axis cover.

Unscrew 2 screws (indicate yellow circle) to remove 2nd Arm
Cover L/R.
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Step Corresponding graphic

4. Unscrew 2 screws to remove 3rd Arm Cover.

8-6-13-2

8-6-13-3

8-6-13-4

8-6-13-5

Installation
Parts to be installed in reverse order of removal.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.

Functional Check
Visual inspection only.
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8-6-14 Elevation Arm Cover Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-37 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses
One person Approximately 5 minutes Phillips Screw Driver Cut resistant gloves
Kneel pad
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8-6-14-1 Remove the covers

Step

Corresponding graphic

Lift the Elevation Arm Assy to the highest position.
Unscrew 4 screws to remove the Elevation Arm Lower Cover LCF.

Highest position
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Step Corresponding graphic

Down the Elevation Arm Assy to the horizontal position.
2. |Unhook to remove the Elevation Arm Upper Cover LCF
from Elevation Arm Upper Frame LCF (4 places).

8-6-14-2 Installation
Parts to be installed in reverse order of removal.

8-6-14-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-6-14-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.

8-6-14-5 Functional Check
Visual inspection only.
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8-6-15 OPIO Bottom Base Back Cover Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-38 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
One person Approximately 5 minutes Phillips Screw Driver Safety glasses
8-6-15-1 Remove the air filter

Step

Corresponding graphic

Unscrew 1 screw to remove the OPIO bottom base back

cover.
8-6-15-2 Installation
Parts to be installed in reverse order of removal.
8-6-15-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.
8-6-15-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.
8-6-15-5 Functional Check

Visual inspection only.
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8-6-16 Side Cabinet Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5 /8-2-7 "PPE Required During Service" on page 8-

6Remove the air filter

Table 8-39 Manpower, Time, Tools, and PPE

Manpower Time

Tools

PPE

One person Approximately 30 minutes

Safety glasses
Safety shoes

Phillips Screw Driver Cut resistant gloves

Kneel pad
ESD mat and wrist strap

Step

Corresponding graphic

1. Unscrew 3 screws to remove the SIDE CABINET REAR COVER.

2.  |Remove POWER CORD FIX BRACKET and Main power cable.

See

8-5-3 "Power cable replacement" on page 8-43.

3. Unscrew 5 screws to remove Rear cover.

See

8-6-8 "Rear Cover Replacement" on page 8-61

Remove OPTIONAL PERIPHERAL DEVICES (ECG / Vnav/BW
Printer) from the side cabinet.

See

244

8-10-13 "BW Printer Replacement" on page 8-251
8-10-11 "VSIO (ECG) Option Replacement" on page 8-

8-10-10 "V-Nav Option Replacement" on page 8-239

5. Unscrew 4 screws to remove the Side Cabinet.
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Step Corresponding graphic

Unscrew 2 screws to remove the SUPPORT ARM OPTION TRAY
from Side Cabinet.

8-6-16-1 Installation
Parts to be installed in reverse order of removal.

8-6-16-2 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-6-16-3 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.

8-6-16-4 Functional Check
Visual inspection only.
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Section 8-7
Replacing Top Console Parts

8-7-1 Purpose of this section

This section describes how to replace the Top Console parts.
Contents in this section
8-7-2 Preparation . ... ... . 8-81
8-7-3 Main monitor - High Definition Ultrasound (HDU) assembly replacement .. ......... 8-82
8-7-4 Main monitor - LCD monitor Assembly Replacement. ... ....................... 8-89
8-7-5 LCD Arm with Cable Assembly replacement ... ... ... ....... ... ... ......... 8-93
8-7-6 Option VERTICAL TV PROBE HOLDER Left or Right Support replacement. ... ... .. 8-96
8-7-7 Option TVTR Probe Holder Assembly Left or Right Support replacement........... 8-98
8-7-8 OPTIONAL DRAWER AN KEYBOARD Replacement . . ........................ 8-100
8-7-9 OP (Operator Panel) Knobs replacement. .. ....... .. ... .. ... .. ... ... 8-103
8-7-10  Upper/Lower Operator Panel replacement. . .. ........ ... ... .. .. ... .. ....... 8-104
8-7-11  OPIO Lower Main PWA ASSY replacement. . .. ........ ... .. . ... 8-111
8-7-12  Trackball Assembly replacement .. ....... ... . . ... . 8-114
8-7-13 LowerBezelreplacement . . ... ... . . e 8-117
8-7-14  Encoder/Joystick replacement . . ... ... . 8-120
8-7-15 Hard key capsreplacement . . ... ... . . e 8-124
8-7-16 EXT Hub Board Assy replacement. .. ... ... .. ... . i 8-126
8-7-17 OPIO FRONT HOOK replacement . . . ... ... 8-129
8-7-18 Gel warmer /Gel warmer cap replacement . . ... ... . . i 8-131
8-7-19 Probe Holder Insertreplacement . . ... ... .. . . . . . . 8-134
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8-7-2  Preparation

Table 8-40 Preparations and Preparation Links

Preparations - you must perform the following steps

DANGER | Risk of dangerous voltage within the LOGIQ Fortis.
A Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.
To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
¢ Plan and prepare for shutdown.
e Completely power down the LOGIQ Fortis.
¢ Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
* Apply lockout/tagout devices to maintain exclusive control of the power cable.
¢ Relieve all potentially hazardous stored or residual energy (batteries).
¢ Verify isolation.
For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:
e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.
e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.
e "Disconnect battery power" on page 1-28.

&
LOCKOUT

1. Lock the casters
2. Completely shutdown the system.
3. Disconnect the mains power cable from the wall outlet, all Probes and External I/O Cabling.

Preparation Link (if you need more information):
* 4-2-4 "Power shut down" on page 4-10.
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8-7-3  Main monitor - High Definition Ultrasound (HDU) assembly replacement
NOTE: Before removing the Monitor, record old monitor settings or user settings if possible.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-41 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Two people ) . Safety glasses
NOTE: The monitor weighs Flathead screwdriver/plastic tool Safety shoes
approximately 15 Ibs. Itis Approximately 40 minutes Phillips screwdriver Cut resi >t/ ol
recommended two people Level (optional) utresistant gloves

ESD mat and wrist strap

perform this procedure.

8-7-3-1 Removal procedure

Step Corresponding Graphic

& DANGER

WHEN REMOVING THE MONITOR FROM THE
ARM, KEEP THE MONITOR ARM ASSEMBLY IN
THE LOCKED POSITION. THE SPRINGS TO
SUPPORT THE MONITOR CAN CAUSE THE ARM
TO SPRING OPEN CAUSING SEVERE
PERSONAL INJURY AND PROPERTY DAMAGE.

1. Make sure the user interface (top console) has been moved to its lower position.

2. |Lock the brakes.

3. Lower the monitor to a flat (horizontal) position.

4. Rotate the monitor arm assembly so that it is facing the left or right side of the console to allow easier access.
3. Lock the monitor arm assembly.

6.

Using a flathead screwdriver, carefully pry up the monitor cable
cover from the bottom.

NOTE: The monitor back cover fits into slots at the top and is
held in place by posts at the bottom. It is removed by prying it up
from the bottom with a flat tool.

Remove the monitor cable cover.

NOTE: DO NOT discard the cable cover of the monitor, transfer
it to the replacement monitor. The cover IS NOT included in the
monitor FRU.
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Step Corresponding Graphic
7. Cable connectors

Disconnect the HDMI, USB and power cables from the monitor.
NOTE: Re-use the cable clamps on new HDU monitor.

Remove the two lower Phillips screws.
Open the plastic clamp that holds the cables in place.

& WARNING

Two people are recommended for this procedure because it is very difficult for one person to loosen the screws
and support the main monitor at the same time; the second person does not need to be a trained FE or do any
lifting.
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Step Corresponding Graphic

Loosen the two upper Phillips screws. The monitor will be
supported by these two upper screws.

Slide the monitor off of the arm assembly.

Remove the upper Phillips screws to re-install into the
replacement monitor.
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8-7-3-2 Installation procedure

Step

Corresponding Graphic

& DANGER

WHEN INSTALLING THE MONITOR TO THE
ARM, KEEP THE MONITOR ARM ASSEMBLY IN
THE LOCKED POSITION. THE SPRINGS TO
SUPPORT THE MONITOR CAN CAUSE THE ARM
TO SPRING OPEN CAUSING SEVERE
PERSONAL INJURY AND PROPERTY DAMAGE.

onto the arm.

1. Re-install the upper two Phillips screws into the replacement monitor leaving enough clearance to slide the monitor back

With the monitor flat, slide the monitor onto the arm assembly using the
two upper Phillips screws to support the monitor.

Monitor
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Step

Corresponding Graphic

Support the lower portion of the monitor and install the two lower
Phillips screws.

NOTE: Do not completely tighten the lower Phillips screws. You
will level the monitor later in this procedure.

Re-connect the HDMI, USB and power cables to the monitor.

NOTE: you may need to disconnect the USB cable coming from
the side USB port to have more room to route the USB cable
coming from the arm.

Close the plastic clamp that holds the cables in place.

Cable connectors
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Step

Corresponding Graphic

Put on gloves

Place a level on the monitor (as shown).
Check that the Ultrasound system is level.

NOTE: To ensure the monitor is installed level with the system
and before re-installing the cable cover, MAKE SURE THE:

- Ultrasound system is on a level surface.

- wheels are in-line.

- monitor arm lock is LOCKED.

NOTE: If a level is not available, make sure the monitor is
visually as square as possible with the Ultrasound system.

If any adjustment is required, loosen the four mounting screws and make the adjustment.

Tighten the four screws after the adjustment.
Torque to 160 Ncm (14.2 Ibf-in)

NOTE: These torque specs are required to prevent the monitor from falling.

Re-install the cable cover by sliding into the slots at the top and then
pressing down onto the button of the cable cover.
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8-7-3-3

Calibration and adjustments

See: Section 6-2 "Monitor Adjustments" on page 6-2 for Main Monitor calibration instructions and/or
Monitor Arm and Monitor Friction Adjustment.

8-7-3-4 Verification

Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.

2.) Connect cables and Probes removed earlier.

3.) Power up the system to verify that it operates as intended.

NOTE: The Wide Screen Monitor may need a second reboot for the system to fully identify the
monitor’s USB device. To confirm, verify that the Monitor Controls for the Wide Screen Monitors
are available on the Touch Panel Utility pages.
8-7-3-5 Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system

to the customer.

Table 8-42 Main Monitor assembly replacement Functional Checks
See:

Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks
a . Leakage Current measured at (record the value) and
4-3-10 System CFM and PWD functional checks meets allowable limits.
10-6-7 Grounding continuity Equipment passed all required checks and is ready for
use.
10-6-8 Chassis leakage current test
4-2-4 Power shut down
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8-7-4  Main monitor - LCD monitor Assembly Replacement
NOTE: Before removing the Monitor, record old monitor settings or user settings if possible.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-43 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Two people ) . Safety glasses
NOTE: The monitor weighs Flathead screwdriver/plastic tool Safety shoes
approximately 15 Ibs. Itis Approximately 40 minutes Phillips screwdriver Cut resi >t/ tal
recommended two people Level (optional) utresistant gloves

perform this procedure. ESD mat and wrist strap
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8-7-41 Removal procedure

Steps

Corresponding Graphic

& WARNING

WHEN REMOVING THE MONITOR FROM THE ARM, KEEP
THE MONITOR ARM ASSEMBLY IN THE LOCKED
POSITION. THE SPRINGS TO SUPPORT THE MONITOR
CAN CAUSE THE ARM TO SPRING OPEN CAUSING
SEVERE PERSONAL INJURY AND PROPERTY DAMAGE.

Make sure the user interface (top console) has been moved to its lower position.

Lock the brakes.

Lower the monitor to a flat (horizontal) position.

Rotate the monitor arm assembly so that it is facing the left or right side of the console to allow easier access.

Lock the monitor arm assembly.

N o 9o M @D

Remove the LCD Rear Cover from the current LCD Monitor.

Unscrew 2 screws to remove 2 cable clamps.

Remove HDMI cable, Power cable and USB cable.
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Steps Corresponding Graphic

10. | Unscrew 2 screws on the bottom side.

11. | Loosen 2 screws on the upper side.
Remove the LCD monitor from the monitor arm bracket.

8-7-4-2 Installation procedure

Steps Corresponding Graphic

1. Remove the monitor rear cover of the new monitor.

2. Parts to be installed in reverse order of removal.

Section 8-7 - Replacing Top Console Parts 8-91



GE CONFIDENTIAL

DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-7-4-3

Calibration and adjustments

See: Section 6-2 "Monitor Adjustments" on page 6-2 for Main Monitor calibration instructions and/or
Monitor Arm and Monitor Friction Adjustment.

8-7-4-4 Verification

Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.

2.) Connect cables and Probes removed earlier.

3.) Power up the system to verify that it operates as intended.

NOTE: The Wide Screen Monitor may need a second reboot for the system to fully identify the
monitor’s USB device. To confirm, verify that the Monitor Controls for the Wide Screen Monitors
are available on the Touch Panel Utility pages.
8-7-4-5 Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system

to the customer.

Table 8-44 Main Monitor assembly replacement Functional Checks
See:

Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks
a . Leakage Current measured at (record the value) and
4-3-10 System CFM and PWD functional checks meets allowable limits.
10-6-7 Grounding continuity Equipment passed all required checks and is ready for
use.
10-6-8 Chassis leakage current test
4-2-4 Power shut down
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8-7-5 LCD Arm with Cable Assembly replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-45 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Flathead screwdriver/plastic tool
Safety shoes

Phillips screwdriver

One person Approximately15 minutes Cut resistant gloves
Hex wrench
. Kneel pad
Level (optional) ]
ESD mat and wrist strap
8-7-51 Removal procedure
Steps Corresponding Graphic
A WARNING /f,

WHEN REMOVING OR INSTALLING THE MONITOR ARM,

KEEP THE ARM LOCKED, AS SHOWN TO ENSURE THE ——

MONITOR ARM ASSEMBLY IS IN THE LOCKED POSITION 4 ’

UNTILL THE ARM AND MONITOR ARE INSTALLED. THE
SPRINGS TO SUPPORT THE MONITOR CAN CAUSE THE
ARM TO SPRING OPEN CAUSING SEVERE PERSONAL

INJURY AND PROPERTY DAMAGE. —

%

1 Remove the Upper/Lower Operator Panel. Refer from 8-7-10-
1 "Preparation if the system has Drawer AN keyboard" on
page 8-104 to step 5 of 8-7-10-2 "Upper/Lower OP Assembly
removal" on page 8-106..

2 Unscrew 1 screw to remove OPIO bottom base back cover.

3 Remove HDMI, Power and USB2.0 monitor cable.
* Lift the OPIO Upper Assy slightly.

- CN6: MONITOR HDMI CABLE

- CN7: MONITOR POWER CABLE

- CN8: MONITOR USB2.0 CABLE
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Steps Corresponding Graphic

4 | Pull out Monitor Cables (HDMI, Power and USB).
5 | Remove the Set Screw using a 5 mm hex wrench. Carefully lift

the Arm Assembly up and retrieve the cables and connectors

out, one at a time from the LOGIQ Fortis.
6 Pull out the LCD arm from the LCD ARM SHAFT BASE and

pull out the 3 cables one by one from the shaft..
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8-7-5-2

8-7-5-3

8-7-5-4

8-7-5-5

Installation Procedure
Parts to be installed in reverse order of removal (Monitor Arm, Upper/Lower Operator Pane, Monitor).

Calibration and adjustments

See: Section 6-2 "Monitor Adjustments"” on page 6-2 for Main Monitor calibration instructions and/or
Monitor Arm and Monitor Friction Adjustment.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-46 Main Monitor assembly adapter replacement Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-8 B-Mode functional checks

Leakage Current measured at (record the value) and

4-3-10 System CFM and PWD functional checks meets allowable limits

Equipment passed all required checks and is ready for

10-6-7 Grounding continuity use

10-6-8 Chassis leakage current test

4-2-4 Power shut down
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8-7-6  Option VERTICAL TV PROBE HOLDER Left or Right Support replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-47 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
One person Approximately 5 minutes Phillips screwdriver Safety shoes
Kneel pad

8-7-6-1 Option Vertical TV Probe Holder removal

Steps

Corresponding Graphic

1. | Disconnect and remove all probes on the side with
the Vertical TV Probe holder. Store Probes in safe
place.

2. | Unscrew 2 screws to remove the Option Vertical TV
Probe Holder.

Be careful do not drop the holder.

NOTE: The photo shows an example on the left.
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8-7-6-2 Option Vertical TV Probe Holder installation
Assemble Option VERTICAL TV PROBE HOLDER in reverse procedure.

8-7-6-3 Calibration and adjustments
No calibration and adjustments are needed.

8-7-6-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.

8-7-6-5 Functional Check
Visual inspection only.
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8-7-7

Option TVTR Probe Holder Assembly Left or Right Support replacement

The Probe Holder Inserts are soft rubber inserts, used to protect the Probes from scratches, when
stored on the LOGIQ Fortis. You can place the Probe Holder Inserts in any of the desired places on the
edge of the Operator Panel. The following types of inserts are available:

* Probe Holder Insert STD

* Probe Holder Insert 3D

*  Probe Holder Soft insert Doppler

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-48 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
One person Approximately 5 minutes No tools required No PPE required.
8-7-71 Option TVTR Probe Holder Assembly removal

Corresponding Graphic

Disconnect and remove all probes on the side with the TVTR

Probe holder. Store Probes in safe place.

Carefully pull out the TVTR probe holder assembly from the

left or right probe holder as shown in right graphic.

Be careful do not drop the holder.

NOTE: The photo shows an example on the left.
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8-7-7-2 Installation
Insert the TVTR probe holder assembly into the left or right rear probe holder.

8-7-7-3 Calibration and adjustments
No calibration and adjustments are needed.

8-7-7-4 Verification
No verification is needed.

8-7-7-5 Functional Check
Visual inspection only.
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8-7-8 OPTIONAL DRAWER AN KEYBOARD Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-518-2-7 "PPE Required During Service" on page 8-6.

Table 8-49 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses
Cut resistant gloves
Kneel pad
ESD mat and wrist strap

One person Approximately 15 minutes Phillips screwdriver

8-100 Section 8-7 - Replacing Top Console Parts



GE CONFIDENTIAL
DIRECTION 5874372, REV. 3

LOGIQ ForrTIs Proprietary Service Manual

8-7-8-1 Replacement and Installation Procedure
Steps Corresponding Graphic
1. Disconnect and remove all probes. Store Probes in
safe place.

2. Keep the console extended upward to gain access to
the Lower OP screws. The screws are accessible
from the bottom of the OP Lower

Frame.

3. Remove the METAL CAP EXT HUB BOARD from
OPIO Base.

o

METAL CAP EXT
HUB BOARD T1

4. Remove AN Keyboard USB cable and AN Keyboard
LED cable.

AN KEYBOARD

Loosen 2 screws (indicate yellow circle).

NOTE: AN KEYBOARD ASSY can be dropped when
2 screws are loosen

E LED cable
AN KEYBOARD
USB cable
5. | Remove 4 screws (indicate red circle). LEFT side Right side

AN KEYBOARD ASSY T1

6. Remove AN KEYBOARD ASSY from OPIO Base.

LEFT side

RIGHT side

AN KEYBOARD ASSY T1
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8-7-8-2

Installation
Install new AN KEYBOARD ASSY by reverse steps.

8-7-8-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.
8-7-8-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier
3.) Power up the system to verify that it operates as intended.
4.) Select comments and type different A/N keys to confirm keyboard functionality.
8-7-8-5 Functional Check
Perform the following functional checks to confirm the system is operational before returning the system
to the customer.
Table 8-50 Lower Bezel replacement Functional Checks
See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-4 Alphanumeric keyboard functional checks Equipment passed all req:;r:d checks and is ready for
4-2-4 Power shut down
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8-7-9  OP (Operator Panel) Knobs replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-51 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
One person Approximately 15 minutes n/a Safety glasses
8-7-91 Replacement procedure
Steps Corresponding Graphic
To remove

Carefully pull the knobs, one by one, to remove them.

To install

Insert the knobs one by one in their respective positions.

NOTE: The OP knobs are concentric knobs, the center shaft has a D

shape. Replace the outer knobs first then the inner ones.

8-7-9-2 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-7-9-3 Verification

Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Power up the system to verify that it operates as intended.

2.) Operate all knobs and verify that they don't slip when operated.

8-7-9-4 Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system

to the customer.

Table 8-52 Main Cable replacement Functional Checks

See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-10 System CFM and PWD functional checks
Equipment passed all required checks and is ready for use.
4-3-20 Basic measurement functional checks
4-2-4 Power shut down
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8-7-10 Upper/Lower Operator Panel replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-53 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately 15 minutes Phillips screwdriver Cut resistant gloves
Kneel pad

ESD mat and wrist strap

8-7-10-1 Preparation if the system has Drawer AN keyboard

Steps Corresponding Graphic

1. Remove the METAL CAP EXT HUB BOARD from
OPIO Base.

AL CAP EXT
HUB BOARD T1

2. Remove AN Keyboard USB cable and AN Keyboard

LED cable.
AN KEYBOARD
_ LED cable
AN KEYBOARD
USB cable
3. | Remove 4 screws (indicate red circle). LEFT side Right side

Loosen 2 screws (indicate yellow circle).

NOTE: AN KEYBOARD ASSY can be dropped
when 2 screws are loosen
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Steps Corresponding Graphic

4, Remove AN KEYBOARD ASSY from OPIO Base. ) .
LEFT side _ RIGHT side

AN KEYBOARD ASSY T1
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8-7-10-2

Upper/Lower OP Assembly removal

Steps

Corresponding Graphic

Keep the console extended upward to gain access to the Lower OP screws. The screws are accessible from the bottom of

the OP Lower Frame.

Remove the five screws from the bottom of the

OPIO Base.

Access the screws from the bottom.

Lower OP shown removed

Unscrew 2 screws from the rear of the OPIO Base.

Remove the OPIO Top cover Left and Right.

Disconnect USB3.0 Cable from CN3 on the EUSB2
PWA and unscrew 1 screw on the bottom of the

OPIO base.
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Steps

Corresponding Graphic

5 Unscrew 2 screws from top of the OPIO ASSY and
lift up top of OPIO ASSY.

6 Release the cable clamp.

7 Disconnect 7 cables. Refer to the figure and lift up
bottom of OPIO ASSY.
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Steps Corresponding Graphic

8 Disconnect 3 cables.
9 Separate OPIO ASSY from the console.
10 | Unscrew 6 screws to separate Upper and Lower

OPIO.

Slowly disassemble Upper OPIO Assy from Lower

OPIO Assy.
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8-7-10-3 Lower/Upper OP installation
Assemble Lower/Upper OP and AN keyboard in reverse procedure.

Be careful when insert the USB3.0 cable into the CN3 connector as below.

Step Corresponding graphic

Insert the connector on CN3 label side of the USB3.0 cable
into the CN3 connector on the EUSB2 PWA.

Push the metal frame part of the connector with fingernail
and insert until feel a click.

8-7-10-4 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-7-10-5 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.

2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.
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8-7-10-6 Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-54 Functional Checks

Sesft?on Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks Equipment passed all required checks and is ready for
4-3-20 Basic measurement functional checks use.
4-3-4 Alphanumeric keyboard functional checks
4-2-4 Power shut down
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8-7-11 OPIO Lower Main PWA ASSY replacement
This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.
Table 8-55 Manpower, Time, Tools, and PPE
Manpower Time Tools PPE
Safety glasses
Safety shoes
One person Approximately 20 minutes Phillips screwdriver Cut resistant gloves
Kneel pad
ESD mat and wrist strap
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8-7-11-1 OPIO Lower Main PWA ASSY removal

Steps Corresponding Graphic
1. Remove Upper/Lower OPIO Assembly and separate Upper See 8-7-10 "Upper/Lower Operator Panel replacement”
and Lower OPIO. on page 8-104.

2. Remove the OP knobs.

If possible, place them in their relative position on a table, or
other place where you can keep them until you start the re-
installation.

Before you install the Bezel, you should move the OP controls
over to the new Bezel, one by one.

3. Unscrew 24 screws around the PWA and remove the cover
(Marked yellow).
Slowly lift the OPIO Main PWA Assy from OP Panel.

8-7-11-2 OPIO Lower Main PWA ASSY installation
Assemble OPIO Lower Main PWA ASSY, OPIO Assembly and AN keyboard in reverse procedure.

8-7-11-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-7-11-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.

2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.
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8-7-11-5 Functional Checks
Perform the following functional checks to confirm the system is operational before returning the system

to the customer.

Table 8-56 Lower Bezel replacement Functional Checks

Sesft?on Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks Equipment passed all required checks and is ready for
4-3-20 Basic measurement functional checks e
Joysticks
4-2-4 Power shut down
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8-7-12 Trackball Assembly replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-518-2-7 "PPE Required During Service" on page 8-6.

Table 8-57 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately15 minutes Phillips screwdriver Cut resistant gloves
Kneel pad

ESD mat and wrist strap
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8-7-121 Trackball Assembly removal

Steps Corresponding Graphic
1. Remove Upper/Lower OPIO Assembly and separate See 8-7-10 "Upper/Lower Operator Panel replacement” on page
Upper and Lower OPIO. 8-104.

2. Turn the ring counter clock-wise and lift trackball from
the operator panel.

3. Disconnect the signal cable connector from the OPIO
Main PWA ASSY and unscrew 2 screws on the bracket.

Note: Grasp the connector on the large, flat sides and
pull straight away from the board. The Trackball
includes the Trackball Cable. The Customer Removable
Trackball can be cleaned from the top.

4, Unscrew 4 screws from rear of the OPIO Base and
remove Trackball Assembly.
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8-7-12-2

8-7-12-3

8-7-12-4

8-7-12-5

Trackball Assembly Installation
Assemble Trackball Assembly in reverse procedure.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.

3.) Power up the system to verify that it operates as intended.

4.) Verify that the Trackball operates as intended.

Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-58 Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-8 B-Mode functional checks Equipment passed all required checks and is ready for
use.

4-2-4 Power shut down
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8-7-13 Lower Bezel replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-59 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately 15 minutes Phillips screwdriver Cut resistant gloves
Kneel pad

ESD mat and wrist strap
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8-7-13-1 Lower Bezel removal procedure

Steps Corresponding Graphic
1. Remove Upper/Lower OPIO Assembly and separate | See 8-7-10 "Upper/Lower Operator Panel replacement" on page 8-
Upper and Lower OPIO. 104.

2. Remove the OP knobs.

If possible, place them in their relative position on a
table, or other place where you can keep them until
you start the re-installation.

Before you install the Bezel, you should move the OP
controls over to the new Bezel, one by one.

3. Unscrew 24 screws around the PWA and remove the
cover (Marked yellow).
Slowly lift OPIO Main PWA Assy from OP Panel.

4. Remove Rubber Sheath on reverse side of PWA

Assy. OPIO PWA Assy. Rubber sheet removed

5. Remove the boards to assemble with new Lower Bezel.
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8-7-13-2

NOTE:

8-7-13-3

8-7-13-4

8-7-13-5

Lower Bezel Installation procedure

1.) Setthe new Bezel in place.
2.) Reattach the Boards with screws.

Before continuing, test the Encoders and Op Panel controls to ensure they operate properly. If
the Encoder seals are too close to the Encoder, the seals can cause the Encoder operation to
bind. If the seals are to high, the can limit the joystick operation.

3.) Re-install the Lower OP, Upper OP/Touch Panel Assembly (verify Encoder operation) and all
covers removed.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-60 Lower Bezel replacement Functional Checks

See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks Equipment passed all required checks and is ready for
4-3-20 Basic measurement functional checks e
Joysticks
4-2-4 Power shut down
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8-7-14 Encoder/Joystick replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-518-2-7 "PPE Required During Service" on page 8-6.

Table 8-61 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

. ) Safety glasses
Phillips screwdriver
Safety shoes
Open end wrench

One person Approximately 15 minutes Cut resistant gloves
Torque wrench
Kneel pad

Adjustable wrench ]
ESD mat and wrist strap
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8-7-14-1 Encoder/Joystick replacement procedure

Steps Corresponding Graphic

1. Remove Upper/Lower OPIO Assembly and separate | See 8-7-10 "Upper/Lower Operator Panel replacement" on page 8-
Upper and Lower OPIO. 104.

2. Remove the OP knobs.

If possible, place them in their relative position on a
table, or other place where you can keep them until
you start the re-installation.

Before you install the Bezel, you should move the OP
controls over to the new Bezel, one by one.

3. Unscrew 24 screws around the PWA and remove the
cover (Marked yellow).
Slowly lift OPIO Main PWA Assy from OP Panel.

4. Remove Rubber Sheath on reverse side of PWA
Assy.

5. Loosen the Encoder/Joystick nut, using use a 24 mm
socket an adjustable wrench and remove the nut.
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Steps

Corresponding Graphic

6. Remove the remaining 8 nuts. Disconnect the 9
Encoders.

Grasp the Encoder/Joystick and pull straight away
from the board.

-
LR P
Lot g
el -

L=

L =
A

7. Loosen the Encoder nut, using a 7/16 inch, deep
socket wrench or 7/16 inch open-ended wrench and
remove the nut.

8. Remove the remaining 3 nuts. Disconnect the 4
Encoders.

Grasp the Encoder and pull straight away from the
board.

9. Replace Encoder(s)/Joystick(s) and Encoder(s) as necessary. Secure the Encoder(s)/Joystick(s) and Encoder(s).

10. | Re-assemble Lower OP.
Re-install Lower Op, Upper Op and all Covers removed.
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8-7-14-2

8-7-14-3

8-7-14-4

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.

2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-62 Lower Bezel replacement Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-7 Probe/connector functional checks

4-3-8 B-Mode functional checks Equipment passed all required checks and is ready for
4-3-10 System CFM and PWD functional checks use.
4-3-20 Basic measurement functional checks

4-2-4 Power shut down
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8-7-15 Hard key caps replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-63 Manpower, Time, Tools, and PPE

Manpower

Time

Tools PPE

One person

Approximately 15 minutes

Flathead screwdriver Safety glasses

8-7-15-1 Hard key caps replacement procedure

Steps

Corresponding Graphic

1. Turn off the system with the Power On/Off button on the control panel.

hard key cap.

2. With small slotted screwdriver, carefully push against the

3. Lift the cap, until it is completely loosened from its base.

4. Place the new hard key cap down until it snaps into position.

8-7-15-2 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-7-15-3 Verification

Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.

3.) Power up the system to verify that it operates as intended.

4.) Verify that the replaced key operates as intended.
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8-7-15-4 Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system

to the customer.

Table 8-64 Lower Bezel replacement Functional Checks

See:
Section

Functional Check

Debrief Script

4-2-3

Power ON/Boot Up

4-3-8

B-Mode functional checks

Equipment passed all required checks and is ready for

use.

Section 8-7 - Replacing Top Console Parts

8-125



GE CONFIDENTIAL
DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-7-16 EXT Hub Board Assy replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-518-2-7 "PPE Required During Service" on page 8-6.

Table 8-65 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
. . . . Safety glasses
One person Approximately 20 minutes Phillips screwdriver )
Cut resistant gloves
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8-7-16-1 EXT Hub Board ASSY removal procedure

Steps Corresponding Graphic

1. Remove Upper/Lower OPIO Assembly and separate Upper and See 8-7-10 "Upper/Lower Operator Panel
Lower OPIO. replacement" on page 8-104.

2. Unscrew 1 screw to remove the GEL WARMER CABLE COVER.

3. Remove the GEL WARMER CONNECTOR.

4. Unscrew 4 screws to remove EXT HUB BOARD.
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8-7-16-2 ExT Hub Board Assy Installation procedure
Assemble EXT Hub Board ASSY, OPIO Assembly and AN keyboard in reverse procedure.
8-7-16-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.
8-7-16-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.
8-7-16-5 Functional Checks
Perform the following functional checks to confirm the system is operational before returning the system
to the customer.
Table 8-66 Lower Bezel replacement Functional Checks
See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks Equipment passed all reqL:JSi;ed checks and is ready for
4-3-20 Basic measurement functional checks .
4-2-4 Power shut down
8-128 Section 8-7 - Replacing Top Console Parts



DIRECTION 5874372, REV. 3

GE CONFIDENTIAL

LOGIQ ForrTIs Proprietary Service Manual

8-7-17 OPIO FRONT HOOK replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-67 Manpower, Time, Tools, and PPE

Manpower

Time

Tools PPE

One person

Approximately 5 minutes

Phillips screwdriver n/a

8-7-17-1 OPIO FRONT HOOK removal

Steps

Corresponding Graphic

1. | Disconnect and remove all Probes. Store

Probes in safe place.

2. | Unscrew 2 screws to remove the target OPIO

FRONT HOOK.

With Option AN KEYBOARD ASSY
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8-7-17-2

Installation procedure
Assemble OPIO FRONT HOOK in reverse procedure.

NOTE: If the customer wants change the direction of cable hook, see 3-6-12 "Cable hook direction" on
page 3-51.

8-7-17-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-7-17-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.

8-7-17-5 Functional Check
Visual inspection only.
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8-7-18 Gel warmer /Gel warmer cap replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-68 Manpower, Time, Tools, and PPE

Manpower Time

Tools

PPE

One person Approximately 15 minutes

Phillips screwdriver

n/a
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8-7-18-1 Gel warmer removal

Steps

Corresponding Graphic

1. | Turn Gel warmer off (0) and store the Gel in safe place.

2. | Unscrew 1 screw to remove the cable clamp.

3. | Unscrew 1 screw to remove the GEL WARMER CABLE
COVER cable.

4. | Disconnect the Gel warmer cable.

5. | Unscrew 3 screws to remove the Gel warmer.

iz

bl
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8-7-18-2

Gel warmer cap removal

Steps Corresponding Graphic

1. | Rotate the Gel warmer cap counterclockwise.

‘-- ,

8-7-18-3

8-7-18-4

8-7-18-5

8-7-18-6

Installation procedure
Assemble Gel warmer cap and Gel warmer in reverse procedure.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and cables removed earlier have been installed.
2.) Power up the system.

3.) Place a closed bottle of gel, applicator end first, in the gel warmer. Turn the Gel warmer on to verify
it works properly.

Functional Check
Visual inspection only.
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8-7-19 Probe Holder Insert replacement

The Probe Holder Inserts are soft rubber inserts, used to protect the Probes from scratches, when
stored on the LOGIQ Fortis. You can place the Probe Holder Inserts in any of the desired places on the
edge of the Operator Panel. The following types of inserts are available:

*  Probe Holder Insert STD
*  Probe Holder Insert 3D

*  Probe Holder Soft insert Doppler

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-69 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

One person Approximately 15 minutes Phillips screwdriver n/a

8-7-

19-1 Probe Holder Insert removal

Steps Corresponding Graphic

Disconnect and remove all Probes. Store Probes in safe
place.

Carefully pull out the flexible Probe Holder Insert from the
Lower Ul Frame. Left Large (1), Right Large (2) and Small
(3) soft, Probe Holder Inserts.

Remove the SMALL PROBE HOLDER if it is attached.
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8-7-19-2 Probe Holder Insert installation

Steps

Corresponding Graphic

1. Install the flexible Probe Holder Insert into the Lower Ul
Frame. Be sure the hooks and tab fit properly and the Probe
Holder fits snugly.

8-7-19-3 Calibration and adjustments
No calibrations or adjustments are needed.

8-7-19-4 Verification
No verification is needed after this part replacement.

8-7-19-5 Functional Checks
Visual inspection Only
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Section 8-8
Replacing Front End Acquisition / Card Cage parts

8-8-1 Purpose of this section

This section describes how to replace the parts in the Front End / Card Cage.

8-8-2 Contents in this section
8-8-1 Purpose of thissection . . . ... ... . . 8-136
8-8-2 Contentsinthis section. . ... ... . . . 8-136
8-8-3 Preparation . . ... ... 8-137
8-8-4 DA192 Replacement. . . .. ... .. 8-138
8-8-5 DPI-L PWA Replacement . . ... ... .. 8-141
8-8-6 BEPS Assy Replacement . . . ... 8-144
8-8-7 GBP (Backplane) Replacement . ... ... . . . . 8-148
8-8-8 CSI2 (LED Indicator) Replacement. . . ............ ... . . . 8-153
8-8-9 GPU replacement . . ... ... 8-156
8-8-10 SOMreplacement. . .. ... .. 8-158
8-8-11  SSD replacement . . . ... ... 8-160
8-8-12 Coin Battery replacement . . ... ... .. e 8-162
8-8-13 FAN Assy Replacement . . . ... ... . 8-165
8-8-14  Probe Port lllumination Replacement . .. ........ ... .. ... ... . . . . 8-169
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8-8-3

Preparation

Table 8-70 Preparations and Preparation Links

Preparations - you must perform the following steps

A DANGER

Risk of electrical shock, system must be turned off. Avoid all contact with electrical contacts, conductors
and components. Always use non-conductive handles designed for the removal and replacement of ESD
sensitive parts. All parts that have the potential for storing energy must be discharged or isolated before
making contact.

& DANGER

DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE NECESSARY ESD
PRECAUTIONS:

1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED TO ONE OF THE
TWO RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY FOR THAT PURPOSE.

2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE EQUIPMENT.

&
LOCKOUT

Risk of dangerous voltage within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
e Plan and prepare for shutdown.

e Completely power down the LOGIQ Fortis.

¢ Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
* Apply lockout/tagout devices to maintain exclusive control of the power cable.
¢ Relieve all potentially hazardous stored or residual energy (batteries).

e Verify isolation.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.

e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.

e "Disconnect battery power" on page 1-28.

1. Lock the casters.
2.Completely shut down the system.

3. Disconnect the mains power cable from the wall outlet, all Probes and External I/O Cabling.
4. Remove the Rear Cover.

Preparation Links (if you need more information):
* 4-2-4 "Power shut down" on page 4-10.
* 8-6-8 "Rear Cover Replacement” on page 8-61.
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8-8-4 DA192 Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-71 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately 15 minutes Phillips screwdriver Cut resistant gloves
Kneel pad

ESD mat and wrist strap

8-8-4-1 DA192 Removal procedure

NOTE: Ifthe WLAN Option is present, note the orientation of the antennas, they MUST BE returned to
the same position. Reposition the antennas when removing the Cover.

Table 8-72 DA192 removal procedure

Steps Corresponding Graphic

1. Remove the Rear Cover and disconnect all cables
from NEST.

2. Remove the 9 screws securing the NEST EMI back
bracket.
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Table 8-72 DA192 removal procedure

Steps

Corresponding Graphic

Pull out DA192/DPI-L Board Assy.
Use Card Puller to pull out.

Place it on an ESD safe place.

Card puller

Unscrew 6 screws to disassemble DA192 and DPI-L
Board Assy.

* I-j.i L ‘
e e e
i
>
- e
-.Il -I =

NOTE: If DA192 Board has GCW option,

remove one more screw (indicate yellow circle)
and remove it from current Board and mount (re-
use) it on new DA192 Board.

Replace DA192 Board Assy.
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8-8-4-2

DA192 Installation procedure

1.) Assemble DA192/DPI-L Board Assy with 7 screws (See Step 4 in Table 8-72).

NOTE: If DA192 Board has GCW option, assemble GCW option with 1 screw.
NOTE: Confirm the Stacking-connection before install the Assy to the system.
2.) Put DA192/DPI-L Board Assy back to the system. Re-install the NEST EMI BRKT with 9 screws.
3.) Connect all cables to NEST.
4.) Re-install the rear cover removed.
8-8-4-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.
8-8-4-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.
8-8-4-5 Functional Check
Perform the following functional checks to confirm the system is operational before returning the system
to the customer.
Table 8-73 Lower Bezel replacement Functional Checks
See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks Leakage Current measured at (record the value) and
meets allowable limits. Equipment passed all required
4-3-1 Top console adjustment control functional checks checks and is ready for use.
10-6-7 Grounding continuity
10-6-8 Chassis leakage current test
4-2-4 Power shut down
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8-8-5 DPI-L PWA Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-74 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately 15 minutes Phillips screwdriver Cut resistant gloves
Kneel pad

ESD mat and wrist strap

8-8-5-1 DPI-L PWA Removal procedure

Table 8-75 DPI-L PWA removal procedure

Steps Corresponding Graphic

1. Remove the Rear Cover and disconnect all cables from
NEST.

2. Remove the 9 screws securing the NEST EMI back bracket.
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Table 8-75 DPI-L PWA removal procedure

Steps Corresponding Graphic
3. Pull out DA192/DPI-L Board Assy.
Use Card Puller to pull out.
Place it on an ESD safe place.
Card puller
4, Disassemble DA192 and DPI-L Board Assy. (Remove 6
sSCrews).
- l-:- —'lé e ] ‘:I
* ﬁ Ll | *
S5 BE BE SIS 3
;]
L5
- e e
e TTe—— romT———
.' — ——
5. Replace DPI-L PWA.
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8-8-5-2

NOTE:

8-8-5-3

8-8-5-4

8-8-5-5

DPI-L PWA Installation procedure
1.) Assemble DA192/DPI-L Board Assy with 6screws (See Step 4 in Table 8-73).

Confirm the Stacking-connection before install the Assy to the system.

2.) Put DA192/DPI-L Board Assy back to the system. Re-install the NEST EMI BRKT with 9 screws.
3.) Connect all cables to NEST.
4.) Re-install the rear cover removed.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-76 Lower Bezel replacement Functional Checks

ee:
S:ction Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks

Leakage Current measured at (record the value) and
4-3-15 CW Doppler mode functional checks meets allowable limits. Equipment passed all required

4-3-1 Top console adjustment control functional checks checks and s ready for use.
10-6-7 Grounding continuity

10-6-8 Chassis leakage current test

4-2-4 Power shut down

Section 8-8 - Replacing Front End Acquisition / Card Cage parts 8-143



GE CONFIDENTIAL
DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-8-6 BEPS Assy Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-77 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately 15 minutes Phillips screwdriver Cut resistant gloves
Kneel pad

ESD mat and wrist strap

8-8-6-1 BEPS Removal procedure

Steps Corresponding Graphic

1. Remove the Rear Cover and disconnect all cables
from NEST.

2. Remove the 9 screws securing the NEST EMI back
bracket.
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Steps Corresponding Graphic

3. Pull out the BEPS Assy.
Use Card Puller to pull out.

Place it on an ESD safe place.

BEPS ASSY & SSD &
SOM & GPU

4. Remove BEPS TOP PLATE from current BEPS Assy
and new BEPS Assy (14 screws).

5. Take EEP-ROM, SOM, SSD and GPU (also DC4D
and VCS, if installed.) out from current BEP Assy.
Install those parts on new BEP Assy.

For details,

8-8-9 "GPU replacement" on page 8-156

8-8-10 "SOM replacement" on page 8-158

8-8-11 "SSD replacement” on page 8-160

8-10-8 "DC4D Replacement" on page 8-231

8-10-9 "VCS (S-Video) Replacement" on page 8-235
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Steps Corresponding Graphic

e —— P —
6. : B oSS

If the system has Scan on Battery /Power Assistant
option, you have to reuse battery cables with new
BEPS2 Assy.

Disconnect BBG2 Signal Cable and BBG2 Power
Cable.
Unscrew 1 screw to remove one ground line.

WARNING: Hold down a knob (indicate yellow circle)
to unlatch cables before disconnect. Connector may
damage if you don’t hold down a knob

Disconnect the BBG2 signal cable and BBG2 power
cable from the cable clamp (RED CIRCLE).

Loosen one screw and Disconnect the BBG2 signal
cable and BBG2 power cable from the cable clamp
(GREEN CIRCLE).

Loosen one screw and disconnect the ground cable
of the BBG2 power cable (ORANGE CIRCLE).

Disconnect the BBG2 Signal Cable and BBG2 Power
Cable (YELLOW CIRCLE).

WARNING: Hold down a knob (LIGHT BLUE
CIRCLE) to unlatch the connector and then
disconnect a cable. Connector may DAMAGE if you
don’t hold a knob.
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8-8-6-2

8-8-6-3

8-8-6-4

8-8-6-5

Installation procedure

1.) Assemble BEPS TOP PLATE with 14 screws.

2.) Put BEPS Assy back to the system. Re-install the NEST EMI BRKT with 9 screws.
3.) Connect all cables to NEST.
4.) Re-install the rear cover removed.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.

2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-78 Lower Bezel replacement Functional Checks

Sesft?on Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks
4-3-25 Power Assistant functional checks Leakage Current measured at (record the value) and
4-3-26 _ Scan on Battery functional checks meets allowable limits. Equipment passed all required
(if the system has or Power Assistant) checks and is ready for use.
4-3-23 4D option functional checks
10-6-7 Grounding continuity
10-6-8 Chassis leakage current test
4-2-4 Power shut down
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8-8-7 GBP (Backplane) Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-79 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

. ! Safety shoes
. . Phillips screwdriver )
One person Approximately 15 minutes Cut resistant gloves
Hex wrench
Kneel pad

ESD mat and wrist strap

Table 8-80 Preparations and Preparation Links

Preparations - you must perform the following steps

DANGER | Risk of electrical shock, system must be turned off. Avoid all contact with electrical contacts, conductors
A and components. Always use non-conductive handles designed for the removal and replacement of ESD
sensitive parts. All parts that have the potential for storing energy must be discharged or isolated before
making contact.

A DANGER | DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE NECESSARY ESD
PRECAUTIONS:

1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED TO ONE OF THE
TWO RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY FOR THAT PURPOSE.

2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE EQUIPMENT.

Risk of dangerous voltage within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
¢ Plan and prepare for shutdown.

e Completely power down the LOGIQ Fortis.

¢ Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
¢ Apply lockout/tagout devices to maintain exclusive control of the power cable.
¢ Relieve all potentially hazardous stored or residual energy (batteries).

¢ Verify isolation.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.

e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.

e "Disconnect battery power" on page 1-28.

LOCKOUT

1. Lock the casters.

2.Completely shut down the system.

3. Disconnect the mains power cable from the wall outlet, all Probes and External /0O Cabling.
4. Remove the Rear Cover.

Preparation Links (if you need more information):

* 4-2-4 "Power shut down" on page 4-10. « 8-6-4 "Front Cover Replacement" on page 8-51

* 8-6-8 "Rear Cover Replacement” on page 8-61. « 8-8-4 "DA192 Replacement"” on page 8-138.

* 8-8-5 "DPI-L PWA Replacement” on page 8-141. « 8-8-6 "BEPS Assy Replacement" on page 8-144.
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8-8-71 GBP Removal procedure

Steps Corresponding Graphic

1. |Pull the Front Cover Assy to remove it (no tool
required).

2. Unscrew 2 screws.

3. | Remove LED Indicator BRKT. (4 screws) .

LED indicator BRKT T1 Assy

Section 8-8 - Replacing Front End Acquisition / Card Cage parts 8-149



GE CONFIDENTIAL

DIRECTION 5874372, REV. 3

LOGIQ ForrTIs Proprietary Service Manual

Steps

Corresponding Graphic

Unscrew 4 screws to remove CSI2 Assy and cable
and Fan Assy cable (indicate red frame).

If the system has WiFi option, unscrew 1 screw to
remove WiFi module and WiFi antenna (indicate
orange frame).

C3I2 Assy with cable

WWiFi module and antenna

Remove the Rear Cover and disconnect all cables
from NEST.

Please see the below link:

8-8-4 "DA192 Replacement" on page 8-138

8-8-5 "DPI-L PWA Replacement" on page 8-141
8-8-6 "BEPS Assy Replacement" on page 8-144

Unscrew 2 screws to remove NEST Assy.
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Steps

Corresponding Graphic

7. Pull out Nest box from console.

8. Remove BACKPLANE BRKT(6 screws).

9. Unscrew 4 screws to remove GBP.
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8-8-7-2 Installation procedure
1.) Assemble new GBP and BACKPLANE BRKT.
2.) Put Nest Box back to the system.
3.) Assemble the Nest Box with 4 screws. (2 screws for front side and 2 screws for rear side).

4.) Install CSI2 Assy and FAN Assy cable. If the system has WiFi option, install Wifi module and
antenna.

5.) Assemble LED Indicator BRKT.

6.) Assemble BEPS/DPI-L/DA192 to Next box.

7.) Connect all cables to NEST.

8.) Re-install the rear cover and the front cover removed.

8-8-7-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-8-7-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

8-8-7-5 Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-81 Lower Bezel replacement Functional Checks

Sesft?on Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-7 Probe/connector functional checks

4-3-8 B-Mode functional checks

4-3-10 System CFM and PWD functional checks Leakage Current measured at (record the value) and

meets allowable limits. Equipment passed all required

4-3-20 Basic measurement functional checks checks and is ready for use.

10-6-7 Grounding continuity

10-6-8 Chassis leakage current test

4-2-4 Power shut down
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8-8-8 CSI2 (LED Indicator) Replacement
This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-518-2-7 "PPE Required During Service" on page 8-6.
Table 8-82 Manpower, Time, Tools, and PPE
Manpower Time Tools PPE
Safety glasses
Safety shoes
One person Approximately 15 minutes Phillips screwdriver Cut resistant gloves
Kneel pad
ESD mat and wrist strap
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8-8-8-1 CSI2 Removal procedure
Steps Corresponding Graphic
1. |Pull the Front Cover Assy to remove it (no tool
required).

T
e p——

Remove LED Indicator BRKT. (4 screws)

L §Y

Remove CSI2 Assy (1 connector and 4 screws).

Note: Pick both sides of the connector and pull it out.
Don't pull the cable.
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8-8-8-2 Installation procedure

1.) Assemble new CSI2 Assy.
2.) Assemble LED indicator BRKT.
3.) Re-install the front cover removed.

8-8-8-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-8-8-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

8-8-8-5 Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-83 Lower Bezel replacement Functional Checks

See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up

Leakage Current measured at (record the value) and
4-3-7 Probe/connector functional checks meets allowable limits. Equipment passed all required
checks and is ready for use.

4-2-4 Power shut down
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8-8-9 GPU replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-84 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately 30 minutes Phillips screwdriver Cut resistant gloves
Kneel pad

ESD mat and wrist strap

8-8-9-1 GPU Assy replacement

Table 8-85 GPU Assy replacement

Steps Corresponding Graphic
1. Remove BEPS from the console. See 8-8-6 "BEPS Assy Replacement" on page 8-144.
2. Remove GPU Assy from BEPS (5 screws and 1 connector).

3. Replace with new GPU Assy and fasten it with the fixing
screw.
Re-install in reverse procedure.
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8-8-9-2

8-8-9-3

8-8-9-4

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Checks

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-86 GPU replacement Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-8 B-Mode functional checks

4-3-20 Basic measurement functional checks Leakage Current measured at (record the value) and
- — meets allowable limits. Equipment passed all required

10-6-7 Grounding continuity checks and is ready for use.

10-6-8 Chassis leakage current test

4-2-4 Power shut down
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8-8-10 SOM replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-87 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses
Safety shoes
One person Approximately 15 minutes Phillips screwdriver Cut resistant gloves
Kneel pad

ESD mat and wrist strap

Table 8-88 Preparations and Preparation Links

Preparations - you must perform the following steps

* 8-4-7 "Suspending encryption to load software" on page 8-11.
* 8-4-12 "Full disk encryption and replacement procedures" on page 8-39.

8-8-10-1 SOM replacement

Table 8-89 SOM replacement

Steps Corresponding Graphic
1.
Remove BEP Assy and BEPS TOP PLATE from the See 8-8-6 "BEPS Assy Replacement” on page 8-144.
console.
2. Remove SOM from BEP Assy (5 screws and 1 connector).
3. Replace with new SOM and fasten it with the fixing screw.
Re-install in reverse procedure.
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8-8-10-2

8-8-10-3

8-8-10-4

Calibration and adjustments
No calibrations or adjustments are needed after these parts replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-90 SOM replacement Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-8 B-Mode functional checks

4-3-20 Basic measurement functional checks Leakage Current measured at (record the value) and
- — meets allowable limits. Equipment passed all required

10-6-7 Grounding continuity checks and is ready for use.

10-6-8 Chassis leakage current test

4-2-4 Power shut down
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8-8-11 SSD replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

NOTE: If you are replacing the SSD drive as FRU, the new SSD drive does not come loaded with software,
therefore a full software load is needed. See Section 8-4 "Loading / Reloading / Upgrading the
Software" on page 8-8.

Table 8-91 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes
One person Approximately 15 minutes Phillips screwdriver Cut resistant gloves

Kneel pad

ESD mat and wrist strap

8-8-11-1 SSD replacement

Table 8-92 SSD replacement

Steps Corresponding Graphic

1.
S:r?;g;/ee BEP Assy and BEPS TOP PLATE from the See 8-8-6 "BEPS Assy Replacement" on page 8-144.

2. Remove SSD from BEP Assy (1 screws).

3. Replace with the new SSD and fasten it with the fixing screw.
Re-install in reverse procedure.
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8-8-11-2

8-8-11-3

8-8-11-4

Calibration and adjustments
No calibrations or adjustments are needed after these parts replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-93 SSD replacement Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-8 B-Mode functional checks

4-3-20 Basic measurement functional checks Leakage Current measured at (record the value) and
- — meets allowable limits. Equipment passed all required

10-6-7 Grounding continuity checks and is ready for use.

10-6-8 Chassis leakage current test

4-2-4 Power shut down
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8-8-12 Coin Battery replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-94 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately 15 minutes Phillips screwdriver Cut resistant gloves
Kneel pad

ESD mat and wrist strap

8-8-12-1 Coin Battery replacement

Table 8-95 Coin Battery replacement

Steps Corresponding Graphic

1. Remove BEP Assy and BEPS TOP PLATE from the

See 8-8-6 "BEPS Assy Replacement" on page 8-144.
console.

2. Remove Coin Battery from BEP Assy.

3. Replace with the new Coin Battery.
Re-install BEPS in reverse procedure.
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8-8-12-2 Calibration and adjustments
Clock adjustment is needed after the coin battery replacement.

Table 8-96 Clock adjustment

Steps Corresponding Graphic
1. Go to The Utility -> System -> General, and click Date/
Time button.
2. Select time zone of your region, then click Update button Time zone
in Time zone. If Time zone Updated successfully pop up is {UTCH09:00} Osaka, Sappora, Tokyo

shown, select OK button.

Current date and time 06/08/2021 01:40 PM
New date and time 06/08/2021 01:39 PM

Internet Time
time. windows.com

3. Set current date and time in Date and Time, then click e
Update button in Date and Time. p [ DateandTime

Date 06/08/2021
Mdﬂli!‘dlﬂm 06/08/202101:40:20PM &

Time zone
{UTC+09:00) Osaka, Sapporo, Tokyo

Current date and time 06/08/2021 01:40PM
New date and time 06/08/2021 01:35 PM

Internet Time
timewindows.com

4. | Click OK on the Date and Time Settings dialog.

5. Restart the system. After booting, check Date/Time on left-
bottom side of task bar. New date and time are correct.

8-8-12-3 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.

2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.
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8-8-12-4 Functional Checks

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-97 Coin Battery replacement Functional Checks

See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks
4-3-20 Basic measurement functional checks Leakage Current measured at (record the value) and
- — meets allowable limits. Equipment passed all required
10-6-7 Grounding continuity checks and is ready for use.
10-6-8 Chassis leakage current test
4-2-4 Power shut down
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8-8-13 FAN Assy Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-98 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses
Safety shoes

Phillips screwdriver .
Cut resistant gloves

One person Approximately 10 minutes

Hex wrench
Kneel pad
ESD mat and wrist strap
8-8-13-1 FAN Assy replacement
Steps Corresponding Graphic
1. Remove the Rear Cover and disconnect all cables from
NEST.

2. Remove the front cover and LED Indicator BRKT (4
sSCrews).

L TN —— -

LED indicator BRKT T1 Assy
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Steps Corresponding Graphic

3. Remove 2 screws indicate red circle.

If the system has WiFi option, remove WiFi module (1
screw indicate red circle in yellow frame).

4. Unscrew 2 screws to remove NEST Assy.

5. Remove the 9 screws securing the NEST EMI back
bracket.
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Steps

Corresponding Graphic

6. Pull out Nest box from console.

7. Remove FAN cable and FAN Assy (8 screws).
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8-8-13-2

Installation procedure

1.) Assemble FAN Assy and FAN cable.

2.) Put Nest Box back to the system.

3.) Assemble the Nest Box with 4 screws. (2 screws for front side and 2 screws for rear side).
4.) Install CSI2 Assy. If the system has WiFi option, install Wifi module and antenna.

5.) Assemble LED Indicator BRKT.

6.) Connect all cables to NEST.

7.) Re-install the rear cover and the front cover removed.

8-8-13-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.
8-8-13-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.
8-8-13-5 Functional Check
Perform the following functional checks to confirm the system is operational before returning the system
to the customer.
Table 8-99 Lower Bezel replacement Functional Checks
See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks
Leakage Current measured at (record the value) and

10-6-7 Grounding continuity meets allowable limits. Equipment passed all required

10-6-8 Chassis leakage current test checks and is ready for use.

4-2-4 Power shut down
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8-8-14 Probe Port lllumination Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-518-2-7 "PPE Required During Service" on page 8-6.

Table 8-100 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
. . - . Cut resistant gloves
One person Approximately 15 minutes Phillips screwdriver

Kneel pad
ESD mat and wrist strap
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8-8-14-1 Replace Procedure

Steps

Corresponding Graphic

Remove the Rear Cover and disconnect all cables
from NEST.

2. Remove the 9 screws securing the NEST EMI back
bracket.
3. Pull out DA192/DPI-L Board Assy.
Use Card Puller to pull out.
Place it on an ESD safe place.
Card Puller
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Steps

Corresponding Graphic

4. Remove the LED cable from DPI-L Assy.

5. Remove 4 screws from DLP Front Bracket.
(1 screw from left side,1 screw from right side, 2
screws from front side)

6. Replace DPI-L Lighting Assy and re-install by reverse

steps.
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8-8-14-2

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-8-14-3 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.
2.) Check that Probe port LED is Lighted when “Bright” is selected in Probe Light (llluminator) button
of Utility Page.
3.) Check that Probe port LED is NOT Lighted when “Off” is selected in Probe Light (llluminator) button
of Utility Page.
Probe Light
4.) Power up the system to verify that it operates as intended.
8-8-14-4 Functional Check
Perform the following functional checks to confirm the system is operational before returning the system
to the customer.
Table 8-101 Probe Port lllumination replacement Functional Checks
See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks Equipment passed all required checks and is ready for
4-3-8 B-Mode functional checks use.
4-2-4 Power shut down
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Section 8-9
Replacing Main Console Parts

8-9-1

8-9-2

Purpose of this section

This section describes how to replace the replaceable parts in the main console.

Contents in this section

8-9-1
8-9-2
8-9-3
8-9-4
8-9-5
8-9-6
8-9-7
8-9-8

Purpose of this section . . . ... ... . . . . e 8-173
Contentsinthis section. . . ... .. . . 8-173
Preparation. . ....... ... e 8-174
Elevation Arm Replacement. . .. ... . . 8-175
Speaker Replacement . ... ... ... .. 8-181
BACKBONE Rear Cover LCF/Front Top LCF /Front Bottom LCF Replacement . . . . .. 8-184
Metal Air Filter Assy Replacement . . .. ... .. . ... . . . . 8-188
Caster Replacement. . . .. ... 8-191
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8-9-3 Preparation.

Table 8-102 Preparations and Preparation Links

Preparations - you must perform the following steps

DANGER | Risk of electrical shock, system must be turned off. Avoid all contact with electrical contacts, conductors
A and components. Always use non-conductive handles designed for the removal and replacement of ESD
sensitive parts. All parts that have the potential for storing energy must be discharged or isolated before
making contact.

& DANGER | DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE NECESSARY ESD
PRECAUTIONS:

1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED TO ONE OF THE
TWO RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY FOR THAT PURPOSE.

2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE EQUIPMENT.

DANGER | Risk of dangerous voltage within the LOGIQ Fortis.
& Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.
To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
e Plan and prepare for shutdown.
e Completely power down the LOGIQ Fortis.
¢ Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
* Apply lockout/tagout devices to maintain exclusive control of the power cable.
¢ Relieve all potentially hazardous stored or residual energy (batteries).
e Verify isolation.
For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:
e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.
e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.
e "Disconnect battery power" on page 1-28.

&
LOCKOUT

1. Lock the casters.

2. Completely shut down the system.

2. Disconnect the mains power cable from the wall outlet, all Probes and External I/O Cabling.
3. Remove the HDU/LCD Monitor, Main Monitor Arm, OPIO Assembly Battey pack, Option tray

Preparation Links (if you need more information):

* 4-2-4 "Power shut down" on page 4-10.

* 8-7-3 "Main monitor - High Definition Ultrasound (HDU) assembly replacement" on page 8-82.

* 8-7-4 "Main monitor - LCD monitor Assembly Replacement” on page 8-89.

* 8-7-5 "LCD Arm with Cable Assembly replacement" on page 8-93.

* 8-7-10 "Upper/Lower Operator Panel replacement" on page 8-104.

» 8-9-6 "BACKBONE Rear Cover LCF/Front Top LCF /Front Bottom LCF Replacement"” on page 8-184.
» 8-10-3 "Scan on Battery replacement"” on page 8-196.

» 8-10-12 "Option Tray Replacement" on page 8-249.
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8-9-4 Elevation Arm Replacement
This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6
Table 8-103 Manpower, Time, Tools, and PPE
Manpower Time Tools PPE
Safety glasses
- . Safety shoes
. . Phillips screwdriver )
One person Approximately 90 minutes Cut resistant gloves
Hex wrench
Kneel pad
ESD mat and wrist strap
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8-9-4-1 Removal Procedure
Steps Corresponding Graphic

1. Power down the system.
2. Disconnect the mains power cable from the wall

outlet and all Probes and External 1/0 Cabling.
3. Remove HDU/LCD Monitor, Main Monitor Arm, OPIO

Assembly.
4. Unlock cable ties to untie cables.
5. Unscrew 1 screw to remove the cable clamp.
6. Unscrew 4 screws to remove Elevation Arm Lower

Cover.
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Steps Corresponding Graphic

7. Unscrew 1 screw to remove ELEVATION ARM
FRONT DUMMY COVER.

8. Remove the cable tie.

9. Unscrew 2 screws to remove Elevation cable clamps.

NOTE: Removed cable clamps will be used when
new elevation arm installation.

10. | Unscrew 1 screw to remove ground cable.

Section 8-9 - Replacing Main Console Parts 8-177



GE CONFIDENTIAL

DIRECTION 5874372, REV. 3

LOGIQ ForrTIs Proprietary Service Manual

Steps Corresponding Graphic
11. | Pull out the Monitor cables and OP Panel cable
through the hole. (5 cables)
12. | Gently push and pull the cables through the hole
under the ELEVATION ARM LOWER FRAME.
(1) Pull out the following cables along the route
indicated by the yellow arrow.
- OPIO Upper Monitor
- OPIO Upper Touch HDMI
(2) Pull out the following cables along the route
indicated by the yellow arrow.
- Lower OPIO CABLE
- OPIO POWER CABLE
- OPIO USB3.0 CABLE
13. | Pull out the Monitor cables and OP Panel cable.
(1) Pull out the 2 types of cables on the left side in the
opening at the top of the BACKBONE LCF.
- OPIO Upper Monitor
- OPIO Upper Touch HDMI
(2) Pull out the 3 types of cables on the right side in
the opening at the top of the BACKBONE LCF.
- Lower OPIO CABLE
- OPIO POWER CABLE
- OPIO USB3.0 CABLE
14. | Unscrew 1 screw to remove the ground cable.
15. | Unscrew 1 nut.
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Steps

Corresponding Graphic

16.

Remove the gas spring wire from the cable wire fixing
bracket as shown in the picture.

(1) Remove a nut.

(2) Move up side.

(3) Move right side.

17.

Unscrew 1 screw to remove the cable clamp. Pull out
the gas spring wire.

18.

Remove the OPIO Bottom Base Assy from the
Elevation Arm Assy.

19.

Hold Elevation ARM ASSY with one hand and
unscrew 6 screws to disassemble ELEVATION ARM
ASSY from Frame.

20.

For High cabinet, Remove the stopper.
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8-9-4-2 Elevation Arm Assy LCD Installation
Steps Corresponding Graphic
1. Assemble the Elevation Arm Assy LCF in reverse

procedure.

2. For High cabinet,

Replace the stopper that was removed in Step 20, 8-9-4-1
"Removal Procedure" on page 8-176

For Low Cabinet,
Remove the stopper from both side from the new Elevation

arm.

8-9-4-3 Installation Procedure
Parts to be installed in reverse order of removal.

NOTE: ELEVATION ARM LOWER COVER should be reused.

8-9-4-4 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-9-4-5 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.

8-9-4-6 Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-104 Lower Bezel replacement Functional Checks

See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-2 Main monitor positions and lock functional checks Equipment passed all required checks and is ready for
4-3-8 B-Mode functional checks use.
4-2-4 Power shut down
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8-9-5 Speaker Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-105 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately 30 minutes Screw Driver Cut resistant gloves
Kneel pad

ESD mat and wrist strap

8-9-5-1 Removal procedure

Steps Corresponding Graphic
1. Remove the rear cover. See 8-6-8 "Rear Cover Replacement" on page 8-61.
2. If the system has Battery option kit option, remove it. See 8-

10-3 "Scan on Battery replacement" on page 8-196.

3. Unscrew 4 screws to remove Speaker Dummy Cover BRKT
Polaris.

4. Unscrew 5 screws to remove Speaker Dummy Back BRKT
Polaris.
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Steps Corresponding Graphic

5. Remove Speaker cable.

6. Unscrew 6 screws to remove Speaker Unit.

7. Unscrew 5 screws to remove Speaker Cable ASSY and
ground cable.
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8-9-5-2

8-9-5-3

8-9-5-4

8-9-5-5

Installation Procedure
Parts to be installed in reverse order of removal.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.

2.) Connect cables and Probes removed earlier.

3.) Power up the system to verify that it operates as intended.

4.) Turn the volume control on at the Operator Panel.

5.) Select PW mode and press on the selected Probe to ensure the Speaker produces sound.

Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-106 Lower Bezel replacement Functional Checks

See:
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks Equipment passed all required checks and is ready for
4-3-14 PW/CW Doppler mode functional checks use.
4-2-4 Power shut down
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8-9-6 BACKBONE Rear Cover LCF/Front Top LCF /Front Bottom LCF Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-107 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Safety shoes

One person Approximately 30 minutes Screw Driver Cut resistant gloves
Kneel pad

ESD mat and wrist strap

8-9-6-1 Removal procedure

Table 8-108 BACKBONE REAR COVER LCF

Steps Corresponding Graphic

1. Shut down the System.

Turn Circuit breaker off.

Unscrew 2 screws to remove the POWER CORD FIX
BRACKET and disconnect the Main power cable.

See Table 8-20 "Power cable removal" on page 8-43.

2. Unscrew 5 screws to remove the rear cover. See 8-6-8 "Rear Cover Replacement" on page 8-61.

3. Unscrew 3 screws to remove the HANDLE. ——

ome -

4. Unhook and pull out the BACKBONE REAR COVER LCF.
There are 10 points of hook around the BACKBONE REAR
COVER LCF.

Unhook from bottom to top.
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Table 8-109 BACKBONE FRONT TOP LCF

Steps

Corresponding Graphic

1. Shut down the System.

Turn Circuit breaker off.

Unscrew 2 screws to remove the POWER CORD FIX
BRACKET and disconnect the Main power cable.

See Table 8-20 "Power cable removal" on page 8-43.

2. Unscrew 5 screws to remove the rear cover.

See 8-6-8 "Rear Cover Replacement" on page 8-61.

3. Set the ELEVATION ARM ASSY in horizontal position.

Remove the BACKBONE REAR COVER LCF.

See Table 8-108 "BACKBONE REAR COVER LCF" on
page 8-184.

5. Unscrew 4 screws to disassemble the BACKBONE FRONT
TOP LCF from the BACKBONE.

6. Slightly lift the BACKBONE FRONT TOP LCF to disassemble.
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Table 8-110 BACKBONE FRONT BOTTOM LCF

Steps

Corresponding Graphic

Shut down the System.

Turn Circuit breaker off.

Unscrew 2 screws to remove the POWER CORD FIX
BRACKET and disconnect the Main power cable.

See Table 8-20 "Power cable removal" on page 8-43.

Unscrew 5 screws to remove the rear cover.

See 8-6-8 "Rear Cover Replacement" on page 8-61.

Set the ELEVATION ARM ASSY in horizontal position.

Remove the BACKBONE REAR COVER LCF.

See Table 8-108 "BACKBONE REAR COVER LCF" on
page 8-184.

Remove the Cabinet Cover (High / Mid / Low).
Remove the Front Cover.
Remove the Side Cover.

See

8-6-4 "Front Cover Replacement" on page 8-51.
8-6-5 "Cabinet Cover Replacement” on page 8-53
8-6-7 "Side Cover Replacement" on page 8-57

Disconnect 2 cables from DVD.
* If other Option is attached, unplug the cable.

Unscrew 4 screws to remove the HIGH or MID FRAME
POLARIS.

Unscrew 6 screws and then pull out the BACKBONE FRONT

BOTTOM LCF.

Section 8-9 - Replacing Main Console Parts




GE CONFIDENTIAL
DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-9-6-2 Installation Procedure
Parts to be installed in reverse order of removal.

8-9-6-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-9-6-4 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.

8-9-6-5 Functional Check
Visual inspection only.
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8-9-7 Metal Air Filter Assy Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6

Table 8-111 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

One person Approximately 10 minutes Phillips screwdriver Cut resistant gloves
Kneel pad
8-9-71 Removal procedure
Steps Corresponding Graphic
1. Remove the front cover.
2. If the system has WiFi option, remove antenna (4

SCrews).
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Steps Corresponding Graphic

3. Remove Metal Air Filter Assy (4 screws).
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8-9-7-2 Installation Procedure
Parts to be installed in reverse order of removal.

8-9-7-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-9-74 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.

8-9-7-5 Functional Check
Visual inspection only.
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8-9-8 Caster Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-112 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Phillips screwdriver Safety glasses
. ) Hex wrench Safety shoes
One person Approximately 15 minutes ]
Open end wrench / Torque wrench Cut resistant gloves
Adjustable wrench Kneel pad
8-9-8-1 Caster location and caster type

Figure 8-5 Caster location and caster type

1.) Brake pedal
2.) Swivel lock
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8-9-8-2 Removal procedure
Steps Corresponding Graphic
1. Remove the cabinet cover and left/right side cover. |See 8-6-5 "Cabinet Cover Replacement" on page 8-53 and 8-6-7

"Side Cover Replacement" on page 8-57.
If the system has the side cabinet, also remove it. See 8-6-16 "Side Cabinet Replacement" on page 8-78

2. Pulling edge of each side to unhook the foot cover
front.

Pulling out the 3 points of edge of front side to unhook
the foot cover front. Then move Foot cover front
upward. Refer to figure right.

3. Remove base cover rear by slightly pulling edge of
the cover to outside and then move upward.

3. Loosen the nut to remove the caster.
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8-9-8-3

8-9-8-4

8-9-8-5

8-9-8-6

Installation Procedure
Parts to be installed in reverse order of removal.

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that all screws and covers removed earlier have been installed.

Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-113 Lower Bezel replacement Functional Checks

See:
Section Functional Check Debrief Script
4-3-3 Brakes and direction lock functional checks
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Section 8-10
Replacing Options
8-10-1 Purpose of this section
This section describes how to install LOGIQ Fortis options.

Contents in this section

8-10-1  Purpose of thissection .. .....................
8-10-2 Preparation........... ... ... ... ... ...
8-10-3 Scanon Battery replacement .. ................
8-10-4 Power Assistantreplacement . . ................
8-10-5 WLANReplacement . ............ ... ... .....
8-10-6 GCW (CW Doppler) Replacement ..............
8-10-7 Pedof CWReplacement......................
8-10-8 DC4DReplacement . ........................
8-10-9 VCS (S-Video) Replacement . .................
8-10-10 V-Nav Option Replacement. . ..................
8-10-11 VSIO (ECG) Option Replacement. . . ............
8-10-12 Option Tray Replacement. ... .................
8-10-13 BW Printer Replacement. . .. .. ... ............
8-10-14 DVD Drive Replacement. .....................
8-10-15 V-Nav Roll Stand assembly and replacement. . . . ..
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8-10-2 Preparation

Table 8-114 Preparations and Preparation Links

Preparations - you must perform the following steps

A DANGER

Risk of electrical shock, system must be turned off. Avoid all contact with electrical contacts, conductors
and components. Always use non-conductive handles designed for the removal and replacement of ESD
sensitive parts. All parts that have the potential for storing energy must be discharged or isolated before
making contact.

& DANGER

DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE NECESSARY ESD
PRECAUTIONS:

1. ALWAYS CONNECT YOURSELF. THE ESD WRIST STRAP SHOULD BE CONNECTED TO ONE OF THE
TWO RECEPTICALS INTEGRATED ON THE FRAME, SPECIFICALLY FOR THAT PURPOSE.

2. FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE EQUIPMENT.

LOCKOUT

Risk of dangerous voltage within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
e Plan and prepare for shutdown.

e Completely power down the LOGIQ Fortis.

¢ Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
* Apply lockout/tagout devices to maintain exclusive control of the power cable.
¢ Relieve all potentially hazardous stored or residual energy (batteries).

e Verify isolation.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

e 1-7-2-1"Power down the LOGIQ Fortis" on page 1-26.

e 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27.

e "Disconnect battery power" on page 1-28.

1. Lock the casters.
2.Completely shut down the system.

3. Disconnect the mains power cable from the wall outlet, all Probes and External I/O Cabling.
4. Remove the Rear Cover.

Preparation Links (if you need more information):
* 4-2-4 "Power shut down" on page 4-10.

* 8-5-3 "Power cable replacement” on page 8-43

» 8-6-8 "Rear Cover Replacement" on page 8-61.

» 8-8-6 "BEPS Assy Replacement" on page 8-144
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8-10-3 Scan on Battery replacement

THE BATTERY MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD. WAIT

& WARNING
UNTIL BATTERY HAS COOLED DOWN BOFORE REMOVING.

Replace all 4 batteries when you replace the Extended Battery.

A\ WARNING
If you replace partially, there is a possibility of battery failure.

Depleted Battery New Batl:aer'_g-r

‘a%‘ N~ 4
vV S -
S8

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-115 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

One person Approximately 15minutes Phillips screwdriver Cut resistant gloves
Kneel pad (if kneeling is required)

NOTE: If you don't have Torque driver, assemble a battery without causing looseness. However, apply
too much torque have the potential for causing the cover damage or twist off the stud. Take
extra care when you screw up.

NOTE: The replacement includes all the hardware for the Battery, replace all the hardware when the is
replaced.
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8-10-3-1 Battery Installation kit replacement procedure

THE BATTERY MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD. WAIT

& WARNING
UNTIL BATTERY HAS COOLED DOWN BOFORE REMOVING.

Step Corresponding graphic

= N
ey

1. Remove 5 screws and rear cover.

SRR
. = ?-'-'..-. ey

Disconnect BBG2 Signal Cable and BBG2 Power Cable.
Unscrew 1 screw to remove one ground line.

WARNING: Hold down a knob (indicate yellow circle) to
unlatch cables before disconnect. Connector may
damage if you don’t hold down a knob
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Step Corresponding graphic

Remove Battery installation kit from frame.
3. | Loosen the upper 2 screws (indicate yellow circle).
Unscrew lower 2 screws (indicate red circle).

4. | Unscrew 8 screws and remove the battery box cover.

5. | Disconnect upper 2 battery packs.
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Step Corresponding graphic

6. | Unscrew 2 screws to remove Battery pack mid Bracket.

BATTERY PACK
MID BRKT T1

7. | Disconnect lower 2 battery packs.

Install Battery Packs to new Battery Installation kit and re-
install all parts by reverse steps.

8. | Make sure that the BBG2 power and signal cable fit
together correctly and that they will not come off even if
you pull them lightly.
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8-10-3-2 Battery 4 Pack Replacement procedure

Step Corresponding graphic

1. Remove 5 screws and rear cover.

Remove the metal bracket.
2. Loosen the upper 2 screws (indicate yellow circle).
Unscrew lower 2 screws (indicate red circle).

Unscrew 4 screws to remove battery packs.
2 screws on each side.
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Step Corresponding graphic
4 Remove the two 4S2P BATTERY PACKSs from the front
' side.
Unscrew 2 screws to remove the BATTERY PACK MID
5.
BRKT.
Remove the two 4S2P BATTERY PACKs.
6.
Install new 4S2P BATTERY PACK.
7. Re-install all parts and cover removed in reverse
procedure.
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8-10-3-3 Battery Cable replacement

Step Corresponding graphic

1. |Unscrew 5 screws to remove the rear cover.

Disconnect BBG2 Signal Cable and BBG2 Power
Cable.
Unscrew 1 screw to remove one ground line.

WARNING: Hold down a knob (indicate yellow
circle) to unlatch cables before disconnect.
Connector may damage if you don’t hold down a
knob

Remove all cables and unscrew 9 screws to
remove the NEST BACK BRKT.
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Step

Corresponding graphic

Pass the BBG2 Power Cable and the BBG2 Signal
Cable thought the hole of the NEST EMI BRKT.

4.
Pull out the BEPS Assy.
Use Card Puller to pull out.
Place it on an ESD safe place.
5.

ASSY & SSD &
SOM & GPU
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Step Corresponding graphic
BBG Signal Cable BBG Power Cable

Disconnect the BBG2 signal cable and BBG2
power cable from the cable clamp (RED
CIRCLE).

Loosen one screw and Disconnect the BBG2
signal cable and BBG2 power cable from the
cable clamp (GREEN CIRCLE).

Loosen one screw and disconnect the ground
6. | cable of the BBG2 power cable (ORANGE
CIRCLE).

Disconnect the BBG2 Signal Cable and
BBG2 Power Cable (YELLOW CIRCLE).

WARNING: Hold down a knob (LIGHT BLUE
CIRCLE) to unlatch the connector and then
disconnect a cable. Connector may
DAMAGE if you don’t hold a knob.

Replace the BBG2 Signal Cable and BBG2 Power
Cable, and assemble in reverse procedure.

Gently pull the cable to make sure that the cable
does not come off.
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8-10-3-4 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-3-5 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.

8-10-3-6 Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-116 Lower Bezel replacement Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-7 Probe/connector functional checks

4-3-25 Power Assistant functional checks Equipment passed all required checks and is ready for
10-6-7 Grounding continuity use.

10-6-8 Chassis leakage current test

4-2-4 Power shut down
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8-10-4 Power Assistant replacement
THE BATTERY MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD. WAIT

& WARNING

A WARNING

UNTIL BATTERY HAS COOLED DOWN BOFORE REMOVING.

Replace all 2 batteries when you replace the Extended Battery.
If you replace partially, there is a possibility of battery failure.

Depleted Battery

¥

MNew Battery

&

&

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-117 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
. . - . Cut resistant gloves
One person Approximately 20 minutes Phillips screwdriver . L )
Kneel pad (if kneeling is required)
ESD mat and wrist strap
NOTE: The Power Assistant Option replacement includes all the hardware for the Battery, replace all

the hardware when the Power Assistant is replaced.

NOTE: If you don't have Torque driver, assemble a battery without causing looseness. However, apply
too much torque have the potential for causing the cover damage or twist off the stud. Take

extra care when you screw up.

NOTE: The Power Assistant replacement includes all the hardware for the Battery, replace all the

hardware when the Power Assistant is replaced.

8 - 206

Section 8-10 - Replacing Options




GE CONFIDENTIAL
DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-10-4-1 Battery Installation Kit Replacement procedure

THE BATTERY MAY BE WARM ENOUGH TO POSE A POTENTIAL HEAT HAZARD. WAIT

A WARNING
UNTIL BATTERY HAS COOLED DOWN BOFORE REMOVING.

Step Corresponding graphic

1. |Remove 5 screws and rear cover.

Disconnect BBG2 Signal Cable and BBG2 Power Cable.
Unscrew 1 screw to remove one ground line.

WARNING: Hold down a knob (indicate yellow circle) to
unlatch cables before disconnect. Connector may
damage if you don’t hold down a knob
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Step Corresponding graphic
Remove Battery installation kit from frame.
3. Loosen the upper 2 screws (indicate yellow circle).
Unscrew lower 2 screws (indicate red circle).
4. |Unscrew 8 screws and remove the battery box cover.
5. |Unscrew 2 screws to remove Battery pack mid Bracket.
BATTERY PACK
MID BRKT T1
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Step Corresponding graphic

Install Battery Packs to new Battery Installation kit and
re-install all parts by reverse steps.

Assemble BATTERY PACK MID BRKT with 2 screws.

Note: Power Assistant batteries only use those
connectors. Failing to install batteries properly will
cause battery charging errors.

Battery Pack
Mid Bracket T1

7. | Assemble the battery pack with 2 screws on both sides.

Battery Pack

Top BRKT T1
8. | Assemble the BATTEY PACK TOP BRKT by 4 screws.

Loosen 2 screws (YELLOW CIRCLES).

Hang the BBG2 ASSY on 2 screws (ORANGE
CIRCLES).

9. | Assemble the BBG2 ASSY to FRAME with 2 screws
should be tightened with proper torque 120KgfEcm
(ORANGE CIRCLES).

Assemble the BBG2 ASSY to FRAME with 2 SCREWS
(RED CIRCLES).
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Step

Corresponding graphic

Connect BBG2 Signal Cable and BVG2 Power Cable to
the connector of bottom of battery.

Fasten the 1 screw with GROUND cable of BBG Power
10. | and Signal Cable.
WARNING: Hold down a knob (indicate yellow circle) to
unlatch cables before disconnect. Connector may
damage if you donft hold down a knob.

S om am S ST RRRRRIY
SSIIIIIITEEN
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Assemble the AC power cable and Rear Cover with
S5screws.
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8-10-4-2 Battery 2 Pack replacement procedure

Step Corresponding graphic

1. Remove 5 screws and rear cover.

Remove the metal bracket.
2. Loosen the upper 2 screws (indicate yellow circle).
Unscrew lower 2 screws (indicate red circle).

Unscrew 2 screws to remove the BATTERY PACK MID
BRKT.
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Step

Corresponding graphic

Unscrew 2 screws to remove the battery packs.

4.
Remove the two 4S2P BATTERY PACKs.
5.
Install the battery packs to Battery bracket.
6. Be sure to insert the battery pack to J15 and J17
connector.
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Step Corresponding graphic

7. Assemble the battery pack with 2 screws on both sides.

8. Assemble BATTERY PACK MID BRKT with 2 screws.

Install the metal bracket.
Fasten the upper 2 screws and lower 2 screws.
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Step

Corresponding graphic

10.

Assemble the AC power cable and Rear Cover with

S5screws..
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8-10-4-3 Battery Cable replacement

Step

Corresponding graphic

1. |Unscrew 5 screws to remove the rear cover.

Disconnect BBG2 Signal Cable and BBG2 Power
Cable.
Unscrew 1 screw to remove one ground line.

WARNING: Hold down a knob (indicate yellow
circle) to unlatch cables before disconnect.
Connector may damage if you don’t hold down a
knob

Remove all cables and unscrew 9 screws to
remove the NEST BACK BRKT.
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Step Corresponding graphic

Pass the BBG2 Power Cable and the BBG2 Signal
Cable thought the hole of the NEST EMI BRKT.

4.
Pull out the BEPS Assy.
Use Card Puller to pull out.
Place it on an ESD safe place.
5.

ASSY & SSD &
SOM & GPU
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Step Corresponding graphic
BBG Signal Cable BBG Power Cable

Disconnect the BBG2 signal cable and BBG2
power cable from the cable clamp (RED
CIRCLE).

Loosen one screw and Disconnect the BBG2
signal cable and BBG2 power cable from the
cable clamp (GREEN CIRCLE).

Loosen one screw and disconnect the ground
6. | cable of the BBG2 power cable (ORANGE
CIRCLE).

Disconnect the BBG2 Signal Cable and
BBG2 Power Cable (YELLOW CIRCLE).

WARNING: Hold down a knob (LIGHT BLUE
CIRCLE) to unlatch the connector and then
disconnect a cable. Connector may
DAMAGE if you don’t hold a knob.

Replace the BBG2 Signal Cable and BBG2 Power
Cable, and assemble in reverse procedure.

Gently pull the cable to make sure that the cable
does not come off.
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8-10-4-4 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-4-5 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that all screws and covers removed earlier have been installed.

2.) After connecting the power cable and turn on the breaker, then check the battery LED. Blue LED
behaves

- Under charging : blinking
- Full: ON
- Discharge or Not charging (e.g. battery mounted on wrong position) : OFF

3.) Power up the system to verify that it operates as intended.

8-10-4-6 Functional Check

Perform the following functional checks to confirm the system is operational before returning the system
to the customer.

Table 8-118 Lower Bezel replacement Functional Checks

See:
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-7 Probe/connector functional checks
4-3-25 Power Assistant functional checks Equipment passed all required checks and is ready for
10-6-7 Grounding continuity use.

10-6-8 Chassis leakage current test

4-2-4 Power shut down
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8-10-5 WLAN Replacement

NOTE: The WLAN Card replacement Kit includes all the hardware for the WLAN, replace all the
hardware when the WLAN Card is replaced.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-119 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses
. . - . Cut resistant gloves
One person Approximately 30minutes Phillips screwdriver
Kneel pad

ESD mat and wrist strap

A magnifying glass to connect the WLAN antenna cables to the WLAN Card will be very useful for this
procedure.
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8-10-5-1 Replacement procedure

Steps Corresponding Graphic
1. Remove the Front cover.
2. Unscrew 4 screws to remove the LED Indicator - o

BRKT.

3. Unscrew 4 screws to remove antenna cable clamp.
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Steps Corresponding Graphic

4. Unscrew 1 screw to remove WiFi module.

5. Replace antenna and Wifi module.

Re-install all parts and cover removed in reverse
procedure.

8-10-5-2 WLAN Set-up
For configuring the WLAN, refer to the latest revision of the LOGIQ Fortis Basic User Manual, Chapter
13 “Configuring the Wireless Network”.

Services Security Set-up

NOTE: This step is mandatory in order to insure proper functionality of services and communications
security settings.

1.) Connect the Service key and access Windows.
2.) Open an explorer window.
3.) Navigate to C:\Remap.

4.) Run the batch file “EnableWLAN.bat”. A screen will flash “updating network configuration for
WLAN.*
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8-10-5-3 Basic Configuration of WLAN

Steps Corresponding Graphic
1. |Contact the site Network Administrator to obtain the neces-
sary parameters to configure the WLAN. New Wireless Network Properties X
* IP Address or DHCP
« Network ID and Network key Hetmert R ) ,
- Security type Secuy Tye [WPA2: Peiaicl bl |

* Encryption type, etc. Cancel

Perform the WLAN configuration as described in Basic P i oot G510 and sty et ot sk oo e it o lice

User Manual MNOTE: ¥ you encounter problems saving or connecting, please remove the old settings and create
) " . . . new settings with comect 5510 and security type.

See: Configuring the Wireless Network in Chapter 13 of the '

of the Basic User

Manual.

{bluesso Wireless Netuork Properies X
Configure as required by the site IT department. [ wity  Diagnostics

Name: bluesso
S5I0: bhussso
Network type: Agcess pont
Metwork avalabilty: Al users

[ Connect automatically when this network i in range
[] Look for other wireless networks whie connected to this network
[J Connect even if the network is not broadcasting its name (S510)

[ox ]/ coe

Protected EAP Froperties E
Conrecton  Seaty ¥ an soenecang:

[ vty the server's isentiy by vakdateg P cartibcas

e TR [Cltarmect o Swse servers (exampiessry liev - "ol ool
Ennptentpe: A5
Trusted Rinct Cartifcaon Authorses:
[ kTt Excternal 4 Rast, -
Croase 8 network suthentcaton metod: [ onms 3 e Primary Cerafiemton Autherity
Meresoft: Protected EAP PEAF) v Setngs ] mspcert Assured T Rooa C4
e [ opcert BV Code Sigrang €A (3142
U,_,-".,ﬁ,‘ﬂm o oo el ] e righ Asriancn BV Rout Ca
] Estas Secure Certficate Aupory
[ &= Mechcal Systens, Uirascund and Primary Care Diagrosse v
* »
Hothcatons before comectng!
= Dot s user tn auionize new servers of ated CAs ~

Select Authesication Methed:

Secured password (EAF-MECHAP vZ) ¥ ConSgre...
[IEnatie Fast Recomect
[lcsscarmmect  sarvie cots et prasent ryploberien TLV
o careel [ClEnable tdersty Pravacy
[ Cancel
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8-10-5-4 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-5-5 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that the screw that you removed earlier has been installed.
2.) Iffinished, connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

8-10-5-6 Functional Check

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-120 WLAN Option replacement Functional Checks

See
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks Equipment passed a";:ﬂs;‘:d checks and is ready
4-3-20 Basic measurement functional checks .
4-2-4 Power shut down
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8-10-6 GCW (CW Doppler) Replacement

NOTE: The CW Doppler Option Collector Swallow replacement Kit includes all the hardware for the
GCW PWA, replace all the hardware when the GCW PWA is replaced.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-121 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

Cut resistant gloves
One person Approximately 20minutes Phillips screwdriver 9
Kneel pad

ESD mat and wrist strap
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8-10-6-1 Replacement procedure

Step

Corresponding graphic

1. Unscrew 5 screws to remove the rear cover.

Remove the 9 screws securing the NEST EMI

2. back bracket.
Pull out DA192/DPI-L Board Assy.
Use Card Puller to pull out.
Place it on an ESD safe place.
Card puller
3.
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Step Corresponding graphic

4 Unscrew 1 screw (red circle) and remove the
* | GCW PWA to the DA192 BOARD ASSY

Replace CW Doppler Option Collector Swallow.
5. ;
Reinstall all parts and cover by reverse steps.

8-10-6-2 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-6-3 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that the screw that you removed earlier has been installed.
2.) If finished, connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

8-10-6-4 Functional Check

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-122 GCW replacement Functional Checks

See
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks
4315 CW Doppler mode functional checks Equipment passed allfr:f:;r:d checks and is ready
4-3-14 PW/CW Doppler mode functional checks .
10-6-7 Grounding continuity
10-6-8 Chassis leakage current test
4-2-4 Power shut down
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8-10-7 Pedof CW Replacement

NOTE: The Pencil CW HW Kit Swallow replacement Kit includes all the hardware for the Pencil CW,
replace all the hardware when the Pencil CW is replaced.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-123 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
Safety shoes
One person Approximately 20minutes Phillips screwdriver Cut resistant gloves

Kneel pad
ESD mat and wrist strap
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8-10-7-1 Replacement procedure

Step Corresponding graphic

b 'al
e @
II
—

1. Unscrew 5 screws to remove the rear cover.

Remove all cables and unscrew 9 screws securing the
NEST EMI back bracket to remove.

Pull out DA192/DPI-L Board Assy.
Use Card Puller to pull out.

Place it on an ESD safe place.

Card puller
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Step Corresponding graphic

4 Unscrew 6 screws to disassemble DPI shield plate.
’ Detach DPI-I boards from the shield plate.

5 Unscrew 3 screws to remove the CWD assy from the DPI-
' L Board assy.

6 Replace Pencil CW HW kit. Reinstall all parts and cover
’ by reverse steps.

8-10-7-2 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-7-3 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that the screw that you removed earlier has been installed.

2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.
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8-10-7-4 Functional Check

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-124 GCW replacement Functional Checks

See
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks
4-3-15 CW Doppler mode functional checks Equipment passed all required checks and is ready
4-3-14 PW/CW Doppler mode functional checks for use.
10-6-7 Grounding continuity
10-6-8 Chassis leakage current test
4-2-4 Power shut down
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8-10-8 DC4D Replacement

NOTE: The Realtime 4D Option Collector Swallow replacement Kit includes all the hardware for the
Realtime 4D, replace all the hardware when the Realtime 4D is replaced

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-125 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses
Safety shoes
Phillips screwdriver Cut resistant gloves
Kneel pad
ESD mat and wrist strap

One person Approximately 20minutes
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8-10-8-1 Replacement procedure

Step Corresponding graphic

b 'al
e @
II
——

1. | Unscrew 5 screws to remove the rear cover.

Remove all cables and unscrew 9 screws
2. | securing the NEST EMI back bracket to
remove.

Pull out the BEPS Assy.
Use Card Puller to pull out.

Place it on an ESD safe place.

BEPS ASSY & SSD &
SOM & GPU
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Step Corresponding graphic

Unscrew 14 screws to remove BEPS TOP
PLATE.

5. | Unscrew 5 screws to remove the DC4D PWA.

Replace DC4W PWA. Reinstall all parts and
cover by reverse steps.

8-10-8-2 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-8-3 Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that the screw that you removed earlier has been installed.

2.) If finished, connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.
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8-10-8-4 Functional Check

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-126 DC4D replacement Functional Checks

See
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-1 Top console adjustment control functional checks
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks Equipment passed all required checks and is ready
4-3-23 4D option functional checks for use.
10-6-7 Grounding continuity
10-6-8 Chassis leakage current test
4-2-4 Power shut down

8-234 Section 8-10 - Replacing Options



GE CONFIDENTIAL

DIRECTION 5874372, REV. 3 LOGIQ ForrTIs Proprietary Service Manual

8-10-9 VCS (S-Video) Replacement

NOTE: The S-Video Option Collector Swallow replacement Kit includes all the hardware for the VCS
(S-video), replace all the hardware when the VCS (S-video) is replaced

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-127 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
Safety shoes
One person Approximately 20minutes Phillips screwdriver Cut resistant gloves

Kneel pad
ESD mat and wrist strap
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8-10-9-1 Replacement procedure

Step Corresponding graphic

1. Unscrew 5 screws to remove the rear cover.

Remove the 9 screws securing the NEST EMI back
bracket.

Pull out the BEPS Assy.
Use Card Puller to pull out.

Place it on an ESD safe place.

BEPS ASSY & SSD &
SOM & GPU
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Step

Corresponding graphic

4. Unscrew 14 screws to remove BEPS TOP PLATE.

5. Unscrew 4 screws to remove the VCS (S-Video).

reverse steps.

Replace VCS (S-Video). Reinstall all parts and cover by
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8-10-9-2

8-10-9-3

8-10-9-4

Calibration and adjustments

No calibrations or adjustments are needed after this part replacement.

Verification

Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that the screw that you removed earlier has been installed.
2.) Iffinished, connect cables and probes removed earlier.
3.) Power up the system to verify that it operates as intended.

Functional Check

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-128 DC4D replacement Functional Checks

See
Section

Functional Check

Debrief Script

4-2-3

Power ON/Boot Up

4-3-7

Probe/connector functional checks

10-6-8

Chassis leakage current test

Attach the customer’s S-Video device to the rear I/0.

Confirm content displayed on the monitor mirrors
content displayed on the main monitor of the LOGIQ
Fortis.

Confirm that the customer’s S-Video device can

record content displayed on the main monitor of the
LOGIQ Fortis.

4-2-4

Power shut down

Equipment passed all required checks and is ready
for use.
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8-10-10 V-Nav Option Replacement

NOTE: The V Nav Option replacement includes all the hardware for the V Nav Option, replace all the
hardware when the V Nav Option is replaced.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6.

Table 8-129 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
Safety shoes
One person Approximately 20 minutes Phillips screwdriver Cut resistant gloves

Kneel pad
ESD mat and wrist strap

8-10-10-1 V-Nav on the Mid/High cabinet replacement

Step Corresponding graphic
Remove the Front Cover and Mid Cabinet Cover or High See
1. Cabinet Cover 9 8-6-4 "Front Cover Replacement" on page 8-51
' 8-6-5 "Cabinet Cover Replacement" on page 8-53.
2. Unscrew 5 screws to remove the rear cover. See 8-6-8 "Rear Cover Replacement" on page 8-61.

Mid Cabinet

—

High Cabinet

g

3. Unscrew 4 screws to remove Dual 5inch Bay Assy.

Unscrew 4 screws to remove the Dual 5inch Bay Mid
Cover
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Step

Corresponding graphic

Remove V Nav cables.(V-Nav Power Cable, V-Nav Hdmi-

5. D-Sub Cable, V-Nav Usb Cable)
6 Remove the Dual 5inch Bay Assy from Mid or High Frame A N
’ Assy. l‘ oo N
Mid Frame Assy High Frame Assy
Dual 5 inch Bay Dual 5 inch Bay
Mid Bracket High Bracket
i gn —
Left ’ ;
side 4 5
Unscrew 5 screws to remove DriveBay2 Unit With Cables
7. to Dual 5inch Bay Mid Bracket Assy or Dual 5inch Bay
High Bracket Assy.
8 Disconnect the Cable-Tie to Dual 5inch Bay High Bracket
’ Assy.
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Step

Corresponding graphic

Remove V Nav cables.

10.

Replace V Nav Option Assy. Re-install all parts and cover
removed in reverse procedure.

8-10-10-2 V-Nav on the side cabinet replacement

Step

Corresponding graphic

Unscrew 3 screws to remove the Cabinet Rear Cover.

Unscrew 2 screws to remove the upper blind tray.

Cut the Cable-Tie.
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Step Corresponding graphic

Left side

—

Unscrew 5 screws to remove Option Tray 5-Inch Bay
Assy.

5. Remove V Nav cables.

Replace V Nav Option Assy. Re-install all parts and cover
removed in reverse procedure.

8-10-10-3  Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-10-4  Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that the screw that you removed earlier has been installed.
2.) Connect cables and probes removed earlier.

3.) Power up the system to verify that it operates as intended.

4.) Perform scans requiring V Nav module.
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8-10-10-5 Functional Check

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-130 DC4D replacement Functional Checks

See
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-7 Probe/connector functional checks
4-3-8 B-Mode functional checks
4-3-10 System CFM and PWD functional checks Equipment passrzgda;lfﬁql:g':d checks and is
4-3-20 Basic measurement functional checks
4-3-24 Volume Navigation with inside probe functional checks
4-2-4 Power shut down
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8-10-11 VSIO (ECG) Option Replacement

NOTE: The VSIO (ECG) Option replacement includes all the hardware for the VSIO, replace all the
hardware when the VSIO is replaced.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6..

Table 8-131 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
Safety shoes
One person Approximately 20minutes Phillips screwdriver Cut resistant gloves

Kneel pad
ESD mat and wrist strap

8-10-11-1  VSIO on the Mid/Highcabinet replacement

Step Corresponding graphic

See 8-6-4 "Front Cover Replacement” on page 8-51 and 8-6-5

Remove the Front Cover and Mid Cabinet Assy or High
"Cabinet Cover Replacement" on page 8-53.

Cabinet Assy.

2. Unscrew 5 screws to remove the rear cover. See 8-6-8 "Rear Cover Replacement" on page 8-61

Mid Cabinet

——

High Cabinet

3. Unscrew 4 screws to remove Dual 5inch Bay Assy.

Unscrew 4 screws to remove the Dual 5inch Bay Mid
Cover
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Step Corresponding graphic

5. Disconnect ECG cable.

Remove the Dual 5inch Bay Assy from Mid or High Frame
Assy.

"

Mid Frame Assy High Frame Assy

Dual 5 inch Bay Dual 5 inch Bay
Mid Bracket High Bracket
3 e — —

Unscrew 5 screws to remove DriveBay2 Unit With Cables
7. to Dual 5inch Bay Mid Bracket Assy or Dual 5inch Bay
High Bracket Assy.

Disconnect the Cable-Tie to Dual 5inch Bay High Bracket
Assy.
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Step

Corresponding graphic

Remove VSIOcables.

= \/SIO cable T1

10.

Replace VSIO Option. Re-install all parts and cover
removed in reverse procedure.

8-10-11-2 VSIO on the side cabinet replacement

Step

Corresponding graphic

Unscrew 3 screws to remove the Cabinet Rear Cover.

2. Unscrew 2 screws to remove the upper blind tray.
3 Unscrew 5 screws to remove Option Tray 5-Inch Bay
© | Assy.
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Step

Corresponding graphic

4. Remove VSIO cable.

Replace VSIO Option Assy. Re-install all parts and cover
removed in reverse procedure.
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8-10-11-3

8-10-11-4

8-10-11-5

Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that the screw that you removed earlier has been installed.

2.) Connect cables and probes removed earlier.

3.) Power up the system to verify that it operates as intended.

4.) Perform and record a scan, and play back to confirm proper ECG operation.

Functional Check

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-132 DC4D replacement Functional Checks

See
Section Functional Check Debrief Script

4-2-3 Power ON/Boot Up

4-3-8 B-Mode functional checks

4-3-14 PW/CW Doppler mode functional checks

10-6-9 System CFM and PWD functional checks

10-6-10 Basic measurement functional checks

10-6-11 Volume Navigation with inside probe functional checks . i .
Equipment passed all required checks and is

ECG functional checks ready for use.
Utility->Applications->Settings->ECG->Show ECG tools.
Connect cables.

4-3-22 Press Display ECG tab on Touch Panel.
Verify ECG signal displayed on the monitor.

Plug in the ECG cables with nothing attached so they pick
up noise.

4-2-4 Power shut down
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8-10-12 Option Tray Replacement

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6..

Table 8-133 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
; . . . Safety shoes
One person Approximately 30 minutes Phillips screwdriver

Cut resistant gloves
Kneel pad

8-10-12-1 Removal procedure

Steps

Corresponding Graphic

1. |Loosen a screw (1) to remove OPTION TRAY.

2. Unscrew 5 screws to remove the rear cover.

3. Unscrew 1 screw to remove the TRAY HOLDING
BRKT.

=

TRAY HOLDING
BRKT R T1

=

TRAY HOLDING
BRKTLT1
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8-10-12-2 Installation
Parts to be installed in reverse order of removal.

8-10-12-3  Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-12-4  Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:
1.) Verify that the screw that you removed earlier has been installed.

8-10-12-5 Functional Check
Visual inspection only.
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8-10-13 BW Printer Replacement

NOTE: The Black and White Printer replacement includes all the hardware for the Black and White
Printer, replace all the hardware when the Black and White Printer is replaced.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6..

Table 8-134 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE
Safety glasses
Safety shoes
One person Approximately 20 minutes Phillips screwdriver Cut resistant gloves

Kneel pad
ESD mat and wrist strap
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8-10-13-1 BW Printer on Mid/Hight Cabinet Replacement procedure

Step Corresponding graphic

See
8-6-4 "Front Cover Replacement" on page 8-51
8-6-5 "Cabinet Cover Replacement” on page 8-53.

Remove the Front Cover and Mid Cabinet Cover or High
Cabinet Cover.

2. Unscrew 5 screws to remove the rear cover. See 8-6-8 "Rear Cover Replacement" on page 8-61.

Mid Cabinet

High Cabinet

BgEs

3. Unscrew 4 screws to remove BW Printer assy.

Disconnect BW Printer cables.( Dc Bw Pr Power Cable,

4. Bw Printer USB Cable)
5 Remove the BW Printer Assy from Mid or High Frame
’ Assy.
Printer
Prinnter Power _
6. | Remove BW Printer cables. Cable

Prineter USB
Cable
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Step

Corresponding graphic

procedure.

Replace BW Printer Assy.
7. Re-install all parts and cover removed in reverse
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8-10-13-2

BW Printer on Side Cabinet Replacement procedure

Step

Corresponding graphic

CABINET REAR.

1. Unscrew 3 screws (RED CIRCLE) and remove the SIDE

2. Disconnect the Cable-tie..

Cable-Tie

Pull out the LOWER BLIND TRAYS.

3.
BW Printer
4 Unscrew 4 screws to remove BW Printer assy.
’ NOTE: The graphic right shows from bottom side.
e S0 T oF g .
Bottom of the Side Cabinet
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Step Corresponding graphic

Prinnter Power
5. | Remove BW Printer cables. Cable

Prineter USB
Cable

Replace BW Printer Assy.
6. Re-install all parts and cover removed in reverse
procedure.

8-10-13-3 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-13-4  Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that the screw that you removed earlier has been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.

8-10-13-5 Functional Check

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-135 Functional Checks

See
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks Equipment passed all required checks and is ready
Print by BW Printer for use.
4-2-4 Power shut down
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8-10-14 DVD Drive Replacement

NOTE: The DVD R/W drive replacement Kit includes all the hardware for the DVD R/W drive, replace
all the hardware when the DVD R/W drive is replaced.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6..

Table 8-136 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses
Safety shoes
Approximately 20 minutes Phillips screwdriver Cut resistant gloves
Kneel pad
ESD mat and wrist strap

One person

8-10-14-1 DVD Drive on Mid/Hight Cabinet Replacement procedure

Step Corresponding graphic
Remove the Front Cover and Mid Cabinet Cover or High See
1. Cabinet Cover 9" |8.6-4 "Front Cover Replacement" on page 8-51
' 8-6-5 "Cabinet Cover Replacement” on page 8-53.

2. Remove cables from DVD drive.

Right side Left side
Unscrew 4 screws to remove DVD Drive assy to remove s
DVD Drive.

Replace DVD Drive.
4. Re-install all parts and cover removed in reverse
procedure.
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8-10-14-2 DVD Drive on Low Cabinet Replacement procedure

Step Corresponding graphic

See
1. Remove the Front Cover and Low Cabinet Cover. 8-6-4 "Front Cover Replacement" on page 8-51
8-6-5 "Cabinet Cover Replacement” on page 8-53.

2. Remove cables from DVD drive.

3. Unsrew 4 screws to remove DVD Drive assy.

Right side

Unscrew 4 screws to remove DVD Drive assy to remove
DVD Drive.

Replace DVD Drive.
5. Re-install all parts and cover removed in reverse
procedure.

8-10-14-3  Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-14-4  Verification
Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that the screw that you removed earlier has been installed.
2.) Connect cables and Probes removed earlier.
3.) Power up the system to verify that it operates as intended.
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8-10-14-5 Functional Check

Perform the following functional tests to confirm the system is operational before returning the system
to the customer.

Table 8-137 Functional Checks

See
Section Functional Check Debrief Script
4-2-3 Power ON/Boot Up
4-3-8 B-Mode functional checks Equipment passed all required checks and is ready
Burn the data to media for use.
4-2-4 Power shut down
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8-10-15 V-Nav Roll Stand assembly and replacement

The purpose of this section is to describe assembly or replacement of the V Nav roll stand assembly.

NOTE: Be sure the wheels on the roll stand are not locked and move the roll stand slowly, with caution
to avoid tip over. DO NOT move with the arm extended.

NOTE: The roll stand basket is designed to hold the transmitter, which weighs about five
pounds (2.27 kg). DO NOT overload the basket.

This table includes information specific to these instructions. For more information, see 8-2-6 "Tools
needed for servicing the LOGIQ Fortis" on page 8-5/8-2-7 "PPE Required During Service" on page 8-6..

Table 8-138 Manpower, Time, Tools, and PPE

Manpower Time Tools PPE

Safety glasses

1/2 inch socket wrench Safety shoes
One person Approximately 30 minutes 3/32 inch hex wrench Cut resistant gloves
1/8 inch hex wrench Kneel pad

ESD mat and wrist strap
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8-10-15-1 Parts Reference - Roll Stand
Parts reference for the roll stand assembly

Figure 8-6 Volume Navigation Roll Stand Installation Kit
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8-10-15-1 Parts Reference - Roll Stand (cont’d)

The following parts and hardware are included with this installation kit (hardware not shown):

Table 8-139 Volume Navigation Roll Stand Installation Kit - Parts Reference

Item # Description Quantity
1 Roll Stand Post, 60 inches 1
2 Roll Stand Base with 21-lb. Counterweight 1
3 5/16-18 x 1 inch Hex Head Cap Screw (HHCS) 1
4 5/16 Flat Washer 1
5 5/16 Split Lock Washer 1
6 GE Volume Navigation Arm 1
7 Cord Loop Hook 1
8 Utility Basket 1
9 Handle 1
10 Track Cover, 12 inches 3
11 Cover Plate 1
not shown 1/4-20 x 3/8 inch Socket Head Cap Screw (SHCS) 4
not shown 1/2 inch Socket Wrench 1
not shown 3/16 inch hex wrench 1
not shown 3/32 inch hex wrench 1
not shown 1/8 inch hex wrench 1
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8-10-15-2 Assembling or replacing the Roll Stand
Roll stand assembly or replacement

Use these instructions to assembled or replace the Roll Stand.

1.) Insert the post in the base. The locator pin ensures correct alignment.

Figure 8-7 Post into Base - (1) 5/16 fLAT Washer, (2) 5/16 Lock Washer,
(3) 5/16-18 x 1 inch Screw - Roll Stand only

2.) Using the 1/2 inch socket wrench provided, fasten the post to the base with the hardware shown.
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8-10-15-2

Assembling or replacing the Roll Stand (cont’d)
3.) Slide the cord loop hook, basket and handle into the rear channel in the order shown.

Figure 8-8 Post Assembly

4.) Using the hex wrenches provided, tighten all of the set screws in each accessory to secure the po-
sition in the track.
a.) Tighten the top four set screws with the 3/32 inch hex wrench.
b.) Tighten the center four set screws with the 1/8 inch hex wrench.
c.) Tighten the bottom two set screws with 3/32 inch hex wrench.
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8-10-15-2  Assembling or replacing the Roll Stand (cont’d)
5.) Loosen the knob slightly, guide the arm into the channel and move it to the mounting position.

Figure 8-9 Loosening Knob

NOTE: Make sure the Transformer Support Platform (larger view) is installed in the UP position.

NOTE: The channel fits between the front and rear slide plates.

Figure 8-10 Channel Location
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8-10-15-2  Assembling or replacing the Roll Stand (cont’d)
6.) Tighten the knob to lock the arm into position.

7.) Mount the transmitter (1) on the arm and route the cable through the cable clips (2) on the top side
of the arm.

Figure 8-11 Cable Clips - Roll Stand only

I

8.) While supporting the arm (loaded with the transmitter), slowly loosen the knob which allows the arm
to gradually move down the channel.

NOTE: The arm must move down the channel very slowly when the knob is loosened, and it must move easily
upward when the lifting arm is in the channel. If the arm free-falls or will not move, follow the
adjustment procedure, see: 8-10-15-3 "Adjusting Tension on Sliding Mechanism" on page 8-268.
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8-10-15-2  Assembling or replacing the Roll Stand (cont’d)

9.) Using the 3/16 inch hex wrench provided, fasten the cover plate to the top of the post with four (4)
1/4-20 x 3/8 inch SHCS as shown.

Figure 8-12 Cover Plate Installation
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8-10-15-2  Assembling or replacing the Roll Stand (cont’d)
10.)Snap the three Rear Track Covers into place in locations shown.

Figure 8-13 Rear Track Covers Installation

i
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8-10-15-3  Adjusting Tension on Sliding Mechanism

Table 8-140 Adjusting Tension on Sliding Mechanism

Steps

Corresponding Graphic

1. Remove the plastic bolt cap from the lower tension nut.

The clamping knob must be unlocked while making this
adjustment. Using the 1/2 inch socket wrench, loosen or
tighten the tension nut for the desired tension.

Plastic Bolt Cap for tension nut and Unlocking Clamping
Knob

2. Perform Functional Checks.

8-10-15-4 Calibration and adjustments
No calibrations or adjustments are needed after this part replacement.

8-10-15-5 Verification

Perform the following steps to verify that the product is functioning as intended after this replacement:

1.) Verify that the screw that you removed earlier has been installed.

8-10-15-6  Functional Checks

Visualy check.
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Chapter 9

Renewal Parts

Section 9-1

Overview

9-1-1

NOTE:

9-1-2

Purpose of this chapter

This chapter provides an overview of the available spare parts for the LOGIQ Fortis and probes that
may be used with the LOGIQ Fortis.

The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,
LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

Contents in this chapter
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Section 9-2
List of Abbreviations

Table 9-1 List of Abbreviations

ABBREVIATION DESCRIPTION
3D THREE DIMENSIONAL (See RT3D and 4D)
4D FOUR DIMENSIONAL IS THE SAME AS THREE DIMENSIONAL + REALTIME
ACP AC CONTROLLER (AC POWER)
ACT AC TRANSFORMER
ASSY ASSEMBLY
CRU Customer Replacement Unit
CTRL CONTROL
EXT. EXTERNAL
FRUY REPLACEMENT PART
FRU N NON STOCK PART
I/0 INPUT/OUTPUT
INT INTERNAL
LCD LIQUID CRYSTAL DISPLAY
OP OPERATOR PANEL
PC PERSONAL COMPUTER (Back End Processor)
PS POWER SUPPLY
PWA PRINTED WIRE ASSEMBLY
QTY QUANTITY USED PER SCANNER
RT3D REAL TIME THREE DIMENSIONAL (Same as 4D)
RX RECEIVER
SWAVE SHEAR WAVE ELASTOGRAPHY
TX TRANSMITTER
XFRMR TRANSFORMER
cw CONTINOUS DOPPLER
ECG ELECTRO CARDIO GRAPHY
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Section 9-3
Parts List Groups

Table 9-2 Parts Groups

Top Console Parts
(Monitor, Monitor Arm, Operator Panel)

Software Options
Mains Power Cables
Internal Cables Covers

e

Main Console Parts Back End Parts

L

Product Labels on LOGIQ .
Supported Probes Fortis and Consoles Used in a Casters (Wheels) Parts
Veterinary Environment

Table 9-3 Parts List Groups

TABLE NO. DESCRIPTION PAGE NUMBER
Table 95  |Software 9-4
Table 96 |Covers %5
Table 97  |Mechanical Parts 97
Table 9-8 | Top Console Parts 9-8
Table 9-9  |Main Console Parts 9-12
Table 9-10 | Casters (Wheels) Parts 912
Table 9-11 |Back End Parts 9-14
Table 9-12 | Mains Power Cables 9-16
Table 9-13 (Internal Cables 9-18
Table 9-14 | Supported Probes 920
Table 9-15 | Options 925
Table 9-16  |Product Labels 9-30
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Section 94
LOGIQ Fortis Model

Table 9-4 LOGIQ Fortis Model

MODEL NUMBER DESCRIPTION SOFTWARE VERSION
6601000 LOGIQ Fortis LCD monitor CONSOLE, 100-240 VAC R3.x.x
6602000 LOGIQ Fortis HDU Display CONSOLE, 100-240 VAC R3.x.x

Section 9-5

Software
QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).
Table 9-5 LOGIQ Fortis Software
PART NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
i LOGIQ Fortis, R3.1.0
5863164-2 Software Thumb Drive Assembly ! Y N
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Section 9-6

Covers
QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).
Table 9-6 Covers - LOGIQ Fortis 1 of 3
PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
5412187-10 | SIDE COVER R DLP ASSY 1 Y N
5405169-10 | SIDE COVER L ASSY 1 v N
Plastic, w/ cap
5722797-10 | FRONT COVER ASSY 1 Y Y
5859038 HIGH CABINET ASSY 1 Y N
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Table 9-6 Covers - LOGIQ Fortis 2 of 3 (Continued)

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
5722798-10 | MID CABINET ASSY 1 Y N
5859041 LOW CABINET ASSY 1 Y N
5859042 SIDE CABINET INSTALLATION KIT 1 Y N
5857692 REAR COVER ASSY 1 Y N
DUMMY COVER SET
5725244 Plastics, BW PRT Bezel, Dummy for 1 Y Y
Mid and High Cabinets
5726078 BASE COVER SET 1 Y N
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Table 9-6 Covers - LOGIQ Fortis 3 of 3 (Continued)

PART
NUMBER PART NAME DESCRIPTION QTY | FRU CRU
5768155 BACKBONE REAR COVER LCF 1 Y N
5773476 BACKBONE FRONT COVER SET 1 v N
LCF
S$5862492 ELEVATION ARM COVER SET 1 Y N
Section 9-7

Mechanical Parts

QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).

Table 9-7 Mechanical Parts

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
57218962 | HANDLE VS BT16 -2 1 Y N
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Section 9-8
Top Console Parts

QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).

Table 9-8 Top Console Parts 1 of 4

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
LCD ARM WITH CABLE ASSY
Include
HDMI cable for Upper OPIO to Monitor
S5957000-150 | \1onitor USB 2.0 cable ! v N
Monitor Power Cable
CABLE-TIE, DACT-100A
5957000-1 LCD Arm Plastic Covers (Ergotron Arm) 1 Y N
5857693 OPIO TOP COVER 1 v N
w/ USB3 2port PWA
Back view
8501560-20 Ultrasound bezelless 23.8inch LCD monitor 1 Y N
V2.0
5874481 MONITOR CABLE COVER LCD 1 Y N
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Table 9-8 Top Console Parts 2 of 4 (Continued)
PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
5860239-40 HDU Display 23 inch Gl 1 Y N
5861127-20 Symmetric cable cover USB for HDU Monitor 1 v N
23.8 inch
5848184 Upper OPIO ! Y N
5848185 Lower OPIO 1 Y N
OPIO Lower Main PWA Assy
5862480 w/ Elastomers, Encoder 4pcs and Joystick 1 Y N
9pcs
5862481 OPIO Laser Trackball Assy with cable 1 Y N
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Table 9-8 Top Console Parts 3 of 4 (Continued)

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
5862482 OPIO Button Sets 1 Y N
5862483 OPIO Function key set 1 Y N
5862484 OP Mode select Encoder 4pcs 1 Y N
5862485 OPIO Joystick with KNOB 1 Y N
OPIO Lower Plastic set
55862501 LOWER BEZEL, ROTATE BUTTON, UP 1 v N
DOWN BUTTON and BOTTOM BASE BACK
COVER
5862473 EXT HUB BOARD ASSY 1 Y N
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Table 9-8 Top Console Parts 4 of 4 (Continued)

NEGELR PART NAME DESCRIPTION QTY | FRU | CRU
$5862493 Probe Holder set 1 Y N
5692044-10 Gel Warmer 1 Y N
5692045 Gel Warmer Cap 1 Y Y
5730659 OPIO-FRONT_HOOK R3 1 Y N
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Section 9-9
Main Console Parts

QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).

Table 9-9 Main Console Parts

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
Ap =
5774085 ELEVATION ARM ASSY LCF 1 ! Y N
5871123 Metal Air Filter Assy 1 Y N
5393433 DVD Drive 1 % N

Section 9-10
Casters (Wheels) Parts

QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).

Table 9-10 Casters (Wheels) Parts 1 of 2

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
5746120 CASTOR TOTAL LOCK N9 1 v N

except swivel lock caster (3 per console)
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Table 9-10 Casters (Wheels) Parts 2 of 2 (Continued)

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
5746121 CASTQR DUAL LOCK N9 1 v N
Rear-Right caster (1 per console)
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Section 9-11
Back End Parts

QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).

Table 9-11 Back End Parts 1 of 2

NLF;QI;-II;R PART NAME DESCRIPTION QTY | FRU | CRU
8806600-2 DPI-L PWA 1 Y N
5862486 DPI_L LIGHTING ASSY 1 Y N
8804400-2 DA192 PWA 1 Y N
8802200 GBP PWA 1 Y N
8813300-10 BEPS2 ASSY 1 Y N
5807260 GPU Quadro P4000 D5 8GB 1 Y N
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Table 9-11  Back End Parts 2 of 2(Continued)

NLFJ’GI;.II;R PART NAME DESCRIPTION QTY | FRU | CRU
5173038 Lithium Coin Battery, CR2450 1 Y N
5832284 1TB M.2 SSD 1 Y N

5829291-2 15 Coffeelake with 16GB Memory 1 Y N
5808653 FAN ASSY 1 Y N
5847676 CSI2 Assy with Cable 1 Y N
5897133 BEPS RF absorber Assy 1 Y N
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Section 9-12
Mains Power Cables

Table 9-12 Mains Power Cables 1 of 2
PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
6736114-3 Power Cord for Canada/USA %F:\f ' —hﬁ_E 1 Y N
Y = —
6736107-3 Power Cord for UK 1 Y N
6736112-3 Power Cord for South Africa H% 1 Y N
6736101-3 Power Cord for Argentina 4_—..';I T - 1 Y N
s -
6736109-3 Power Cord for Israel i.__.'}1 | | _...| 1 Y N
. ¥ | .
6736113-3 Power Cord for Switzerland ﬂm ]—:—I-r- 1 Y N
—h A=
6736115-3 Power Cord for Denmark Ell [T 1 Y N
I .."L’" I
6736106-12 PWR SPLY CRD ST DENMARK NON- | "1"“.‘1 1 Y N
HOSPITAL GRADE STD PLUG 10A 250V El ‘W
I .."L’"
T N
6736111-3 Power Cord for Japan/Taiwan : T 1 Y N
[=1==2) i}
6736102-3 Power Cord for ANZ é‘:"_ | . 1 Y N
Ik
6736104-3 Power Cord for China j‘ »H' 1 Y N
= | L)
=1
6736108-3 | Power Cord for India 1 Y N
“ a By v
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Table 9-12 Mains Power Cables 2 of 2 (Continued)
PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
6736110-3 Power Cord for ltaly iy 1 Y N
U= S CI)
T
6736103-3 Power Cord for Brazil 1 Y N
=
= T e
6736105-3 Power Cord for EU/Korea I H 1 Y N
I
NS
PWR SPLY CRD ST DENMARK A\
6736106-12 NONHOSPITAL GRADE STD PLUG gj B —=] 1 Y N
10A 250V 3
5858676 Power Cord FIX BRKT 1 Y N
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Section 9-13
Internal Cables

QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).

Table 9-13 Internal Cables 1 of 2

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU

Peripheral Cable set

includes

6581979 New ODD SATA Cable
5856945 ODD PWR Cable
S5862494 | 5847625 DC Printer PWR cable e iz ! Y N
5847626 DC Printer USB cable e P ' —t
5847623 VSIO Cable _ —ai g
5847531 DC Branch Output Cable T1 _

5808343 DC Output Cable

5847525 User Port USB3.0 Cable = ————— e 1 v N

5863728 Lower OPIO CABLE

Lower QFI0 CABLE T1

Upper OPIO Cable set oma i aunvcu o[ e T

includes 000 Yeowrilbuaiue LY | _’li — e L
S5862498 5845730 OPIO Upper Touch HDMI - - ; - _ : 1 v N
5845730-2 OPIO Upper Monitor HDMI = = === L
5845731 USB 3.0 cable for Upper OPIO
5847522 OPIO Upper Power Cable

5860519 Single Speaker with Cable Assembly g r=_ s Y N

BEP Cable Set

= <&
includes TOK ACDE Output Cable E& -
S5862500 5847527 TDK ACDC input Cable =8, —— — 1 Y N

5847627 TDK ACDC Output Cable
5808347 GPU PWR Cable GPU PWR Cabie

5808346 MONITOR PWR Cable
MONITOR PWR Cable

VNAV Option Cable Set ST .

includes P e —
I — | u|i T

5847622 VNAV PWR cable ot

5802718 VNAV HDMI cable -

5847624 VNAV USB cable B =L

55862496
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Table 9-13  Internal Cables 2 of 2 (Continued)
PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
Battery Option Cable set Bk =
$5862497 | includes — P | 1 Y N
5847529 BBG2 Power Cable .} :
5847530 BBG2 Signal Cable F& Y.
g” <L
5847621 AN Keyboard cable : . 1 Y N
f Drawer AM Keyboand cabde
9-19

Chapter 9 Renewal Parts



Direction 5874372, Rev. 3

GE CONFIDENTIAL

Section 9-14

Probes
Table 9-14 Supported Probes 1 of 5
PROBE PART NUMBER Description
IC5-9-D 5499592
L8-18i-D 5499594
C2-9-D
* Need H46612LS
Acvanced Probe 5499605
option to activate.
C1-6-D
* Need H46612LS
Acvanced Probe 5499606
option to activate.
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Table 9-14 Supported Probes 2 of 5 (Continued)

PROBE PART NUMBER Description

C1-6VN-D
* Need H46612LS
Acvanced Probe
option to activate.

5476279

C2-9VN-D
* Need H46612LS
Acvanced Probe
option to activate.

5488219

C3-10-D
* Need H46612LS
Acvanced Probe
option to activate.

5493012

M5Sc-D
* Need H46612LS
Acvanced Probe
option to activate.

5446030

ML6-15-D 5499600
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Table 9-14 Supported Probes 3 of 5 (Continued)

PROBE PART NUMBER Description
L2-9-D
* Need H46612LS
Acvanced Probe 5765796
option to activate.
L2-9VN-D
* Need H46612LS
Acvanced Probe 5765797
option to activate.
Included with H46402LW
6Tc-RS 5729431
Included with H46402LW
to be used with H45551ZE
RS-DLP Adapter 5444874
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Table 9-14 Supported Probes 4 of 5 (Continued)

PROBE PART NUMBER Description
C2-7-D 5505700
C2-7VN-D 5505701

P2D 5729434 (D Y N —— ey

P6D 5729437 (C ) 1= b [

RIC5-9-D KTZ303987 ‘M-._—

RAB6-D KTZ303986
6S-D 5499318
L3-12-D 5482856 =t

N
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Table 9-14 Supported Probes 5 of 5 (Continued)

PROBE PART NUMBER Description
BE9CS-D 5535371
& = )
16-24-D 5833059 -
\
.N
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Section 9-15
Options

QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).

Table 9-15 Options 1 of 5

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
5859061 AN KEYBOARD ASSY — 1 Y N
5863206 AN KEYBOARD ASSY Greek 1 Y N
5863207 AN KEYBOARD ASSY Norwegian 1 Y N
5863208 AN KEYBOARD ASSY Russian 1 Y N
5863209 AN KEYBOARD ASSY French 1 Y N
5863210 AN KEYBOARD ASSY Swedish 1 Y N
5863211 AN KEYBOARD ASSY German 1 Y N
5535200 SONY UP—D8.98DC black and white thermal SONY 1 v N
printer for ultrasound
=
= ¥
5863205 BW Printer Installation Kit 1 Y N
5859053 Option 5inch bay installation kit 2 Y N
164L0025 ECG Cable Adult, AHA 1 Y Y
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Table 9-15 Options 2 of 5 (Continued)

NSGEII;R PART NAME DESCRIPTION QTY | FRU | CRU
164L0026 ECG CABLE, IEC 1 Y Y
5808900-2 4S2P Battery Pack 1 Y N
5307472-2 PROBEHOLDEI_:{OII;IISS/)I(ES;CFKOR 4D PROBE- 1 v v
5861624 Small Probe Holder 1 Y Y
5172249 CABLE HANGER ASSY_4 CABLE 1 Y Y
5873732 TVTR Probe Holder 1 Y Y
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Table 9-15 Options 3 of 5 (Continued)

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
5859083 VERTICAL TV PROBE HOLDER 1 Y N
5763696 HP Officejet Pro 8210 Printer 1 Y Y
5459862 DriveBay2+ (System Electronics Unit) 1 Y N
5457453 V Nav, Drive Bay 3D '_I'rackmg System Mid 1 Y N
Range Transmitter Assembly
5380960-2 3 button footswitch 1 Y Y
5268740 Stand for Tru3D Transmitter 1 Y Y
T
Hk
8805500 DC4D PWA 1 Y N
J
(31
[
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Table 9-15 Options 4 of 5 (Continued)

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
5832804 WIFI MODULE ASSY 1 Y N
5815323 VSIO ASSY 1 Y N
5859045 Pencil CW HW Kit 1 Y N
8807700 GCW PWA 1 Y N
8809100-2 VCS PWA 1 Y N
Battery Installation kit
5863240 BATTERY PACK BRKTS w/ Charge and 1 Y N
Control PWA
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Table 9-15 Options 5 of 5 (Continued)

PART
NUMBER PART NAME DESCRIPTION QTY | FRU | CRU
SONY
] A
5389822 SONY UP-D25MD = 1 Y N
= I_‘——I
5555266 SONY UP-DR80OMD 1 Y N
5863421 Ethernet protection cable 1 Y Y
5873734 OPTION TRAY WITH BRKT ASSY 1 Y N
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Section 9-16
Product Labels

QTY is the number used on the LOGIQ Fortis (and not the amount for the part number).

Table 9-16  Product Labels on LOGIQ Fortis and Consoles Used in a Veterinary Environment

NLF;GEII;R PART NAME DESCRIPTION QTY | FRU | CRU
5858168 MULTI CAUTION LABEL 1 Y N
2112014-5 GE CARE_SYSTEM ID LABEL | 1 Y N
5790735 Label - Vet Side Covers V e t 2 Y N
5723475 AFU Vet Safety Label 1 Y N

S5848344 Power Assistant and Label Set

1 Y N
\nu@UGuM%

CO®D 2

5878742 5878742 MULTI CAUTION & — o 1 v \
LABEL T1 CHINA s/ ,‘ﬁ
Eﬂ ® e <
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Section 9-17

LOGIQ Fortis Master FRU List Compatibility Chart

Table 9-17 lists software-dependent configuration compatibility.

Table 917 LOGIQ Fortis FRUs
Replace
Part Group | Part Number Description with R3
5412187-10 | SIDE COVER L ASSY N/A Y
5405169-10 | SIDE COVER LDLP ASSY N/A Y
5722797-10 | FRONT COVER ASSY N/A Y
5859038 HIGH CABINET ASSY N/A Y
5722798-10 MID CABINET ASSY N/A Y
5859041 LOW CABINET ASSY N/A Y
Covers 5859042 SIDE CABINET INSTALLATION KIT N/A Y
5857692 REAR COVER ASSY N/A Y
5725244 DUMMY COVER SET N/A Y
5726078 BASE COVER SET N/A Y
5768155 BACKBONE REAR COVER LCF N/A Y
5773476 BACKBONE FRONT COVER SET LCF N/A Y
$5862492 ELEVATION ARM COVER SET N/A Y
Mochanical 57218962 | Rear handle NiA Y
$5957000-150 | LCD ARM with cable assy N/A Y
5957000-1 LCD Arm Plastic Covers (Ergotron Arm) N/A Y
5857693 OPIO TOP COVER N/A Y
8501560-20 Bezelless 23.8inch LCD monitor V2.0 N/A Y
5474481 Monitor Cable Cover LCD N/A Y
5860239-40 HDU Monitor 23 inch Gl N/A Y
5861127-20 Symmetric cable cover USB for HDU Monitor N/A v
23.8 inch
Top Console

Parts 5848184 Upper OPIO N/A Y
5848185 Lower OPIO N/A Y
5862480 OPIO Lower Main PWA Assy N/A Y
5862481 OPIO Laser Trackball Assy with cable N/A Y
5862482 OPIO Button Sets N/A Y
5862483 OPIO Function key set N/A Y
5862484 OP Mode select Encoder 4pcs N/A Y
5862485 OPIO Joystick with KNOB N/A Y
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Table 9-17 LOGIQ Fortis FRUs (Continued)
Replace
Part Group | Part Number Description with R3
$5862501 OPIO Lower Plastic set N/A Y
5862473 EXT HUB BOARD ASSY N/A Y
Top Console $5862493 Probe Holder set N/A Y
Parts 5692044-10 Gel Warmer N/A Y
5692045 Gel Warmer Cap N/A Y
5730659 OPIO-FRONT_HOOK R3 N/A Y
5774085 ELEVATION ARM ASSY LCF N/A Y
’;":r‘tnsco”so'e 5871123 Metal Air Filter Assy N/A Y
5393433 DVD Drive N/A Y
5746120 CASTOR TOTAL LOCK N9 N/A Y
Casters parts
5746121 CASTOR DUAL LOCK N9 N/A Y
8806600-2 DPI-L PWA N/A Y
5862486 DPI_L LIGHTING ASSY N/A Y
8804400-2 DA192 PWA N/A Y
8802200 GBP PWA N/A Y
8813300-10 | BEPS2 ASSY N/A Y
Back End 5807260 GPU Quadro P4000 D5 8GB N/A Y
parts 5173038 Lithium Coin Battery, CR2450 N/A Y
5832284 1TB M.2 SSD N/A Y
5829291-2 I5 Coffeelake with 16GB Memory N/A Y
5808653 FAN ASSY N/A Y
5847676 CSI2 Assy with Cable N/A Y
5897133 BEPS RF absorber Assy N/A Y
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Table 9-17 LOGIQ Fortis FRUs (Continued)
Replace
Part Group | Part Number Description with R3
6736115-3 Power Cord for Denmark N/A Y
6736110-3 Power Cord for Italy N/A Y
6736108-3 Power Cord for India N/A Y
6736109-3 Power Cord for Israel N/A Y
6736111-3 Power Cord for Japan/Taiwan N/A Y
Main Power 6736107-3 Power Cord for UK N/A Y
Cables 6736101-3 Power Cord for Argentina N/A Y
6736103-3 Power Cord for Brazil N/A Y
6736102-3 Power Cord for ANZ N/A Y
6736113-3 Power Cord for Switzerland N/A Y
6736104-3 Power Cord for China N/A Y
6736114-3 Power Cord 110V for Canada, USA N/A Y
6736105-3 Power Cord 220V for EU/Korea N/A Y
6736112-3 Power Cord for South Africa N/A Y
'\C":LFI‘GZOWGF 3610612 PWR SPLY CRD ST DENMARK
- NONHOSPITAL GRADE STD PLUG 10A N/A Y
250V

5858676 POWER CORD FIX BRKT N/A Y
$5862494 Peripheral Cable set N/A Y
5847525 User Port USB3.0 Cable N/A Y
5863728 Lower OPIO CABLE N/A Y
$5862498 Upper OPIO Cable set N/A Y
Internal Cable 5860519 Single Speaker with Cable Assembly N/A Y
$5862500 BEPS Cable set N/A Y
S5862496 VNAV Option Cable Set N/A Y
$5862497 Battery Option Cable set N/A Y
5847621 AN Keyboard cable N/A Y
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Table 9-17 LOGIQ Fortis FRUs (Continued)
Replace
Part Group | Part Number Description with R3
5859061 AN KEYBOARD ASSY N/A Y
5863206 AN KEYBOARD ASSY GREEK N/A Y
5863207 AN KEYBOARD ASSY NORWEGIAN N/A Y
5863208 AN KEYBOARD ASSY RUSSIAN N/A Y
5863209 AN KEYBOARD ASSY FRENCH N/A Y
5863210 AN KEYBOARD ASSY SWEDISH N/A Y
5863211 AN KEYBOARD ASSY GERMAN N/A Y
5535200 SONY UP-D898DC black and white thermal N/A v
printer for ultrasound
5859060 BW Printer Installation Kit N/A Y
5859053 Option 5inch bay installation kit N/A Y
164L0025 ECG Cable Adult, AHA N/A Y
1640026 ECG CABLE, IEC n/a Y
5808900-2 4S2P Battery Pack n/a Y
5307472-2 PROBEHOLDER INSERT FOR 4D PROBE- n/a v
- Onyx Black
5861624 Small Probe Holder n/a Y
5172249 CABLE HANGER ASSY_4 CABLE n/a Y
Options 5873732 TVTR Probe Holder Assembly n/a Y
5859083 VERTICAL TV PROBE HOLDER n/a Y
5763696 HP Officejet Pro 8210 Printer n/a Y
5459862 DriveBay2+ (System Electronics Unit) n/a Y
5457453 V Nav, Drive Bgy 3D Tracking System Mid n/a Y
Range Transmitter Assembly
5380960-2 3 button footswitch n/a Y
5268740 Stand for Tru3D Transmitter n/a Y
8805500 DC4D PWA n/a Y
5832804 WIFI MODULE ASSY n/a Y
5815323 VSIO ASSY n/a Y
5859045 Pencil CW HW Kit n/a Y
8807700 GCW PWA n/a Y
8809100-2 VCS PWA n/a Y
5863240 Battery Installation kit n/a Y
5389822 SONY UP-D25MD n/a Y
5555266 SONY UP-DR8OMD n/a Y
5863421 Ethernet protection cable n/a Y
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Table 9-17 LOGIQ Fortis FRUs (Continued)
Replace
Part Group | Part Number Description with R3
Options 5873734 Option Tray with BRKT Assy n/a Y
5499606 C1-6-D n/a Y
5476279 C1-6VN-D n/a Y
5505700 C2-7-D n/a Y
5505701 C2-7VN-D n/a Y
5499605 C2-9-D n/a Y
5488219 C2-9VN-D n/a Y
5493012 C3-10-D n/a Y
5499592 IC5-9-D n/a Y
5765796 L2-9-D n/a Y
5765797 L2-9VN-D n/a Y
5499594 L8-18i-D n/a Y
Probes 5446030 M5Sc-D n/a Y
5499600 ML6-15-D n/a Y
5729434 P2D (Doppler Probe for Service) n/a Y
5729437 P6D (Doppler Probe for Service) n/a Y
KTZ303986 RAB6-D n/a Y
KTZ303987 RIC5-9-D (4D Endocavity Probe) n/a Y
5444874 RS-DLP Adapter n/a Y
5729431 6Tc-RS n/a Y
5482856 L3-12-D n/a Y
5499318 6S-D n/a Y
5535371 BE9CS-D n/a Y
5833059 L6-24-D n/a Y
5858168 MULTI CAUTION LABEL n/a Y
5878742 MULTI CAUTION LABEL CHINA n/a Y
2112014-2 GE CARE_SYSTEM ID LABEL n/a Y
Product
labels 5790735 Label - Vet Side Covers n/a Y
5723475 AFU Vet Safety Label n/a Y
S5848344 gz;/ver Assistant and Scan on Battery Label n/a v
Software 5863164-2 LOGIQ Fortis R3.1.0 Software Thumb Drive n/a v

Assembly
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Chapter 10
Care & Maintenance

Section 10-1
Overview

10-1-1 Purpose of this chapter

This chapter describes care and maintenance on the Ultrasound system and peripherals. These
procedures are intended to maintain the quality of the Ultrasound system’s performance. Read this
chapter completely and familiarize yourself with the procedures before performing a task.

NOTE: The information in this Service Manual is applicable to LOGIQ Fortis and LOGIQ Fortis Pro,

LOGIQ Fortis Express, LOGIQ Fortis Super, LOGIQ Fortis Expert, LOGIQ Fortis Plus, LOGIQ
Fortis Power unless otherwise specified.

10-1-2 Contents in this chapter

10-1 OV BIVIBW. .« . o oo 10-1
10-2 Why Do Maintenance . . . . ... ... 10-4
10-3 Maintenance Task Schedule. . . ... ... .. .. . . 10-5
10-4 System Maintenance . . ........ ... 10-8
10-5 Using a Phantom . ... .. 10-19
10-6 Electrical Safety Tests. . . ... ... 10-20
10-7 When There Is Too Much Leakage Current.... .. ......... .. ... . . o, 10-44
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10-1-3

A DANGER

A DANGER

& CAUTION

& CAUTION

Care and maintenance inspections

It has been determined by engineering that your Ultrasound system does not have any high wear
components that fail with use, therefore no care and maintenance inspections are mandatory.

However, some customers’ Quality Assurance Programs may require additional tasks and or
inspections at a different frequency than listed in this manual.

There are several places on the backplane, the AC distribution, and DC
distribution that are dangerous. Be sure to disconnect the system power plug
and switch off the main circuit breaker before you remove any parts. Be
cautious whenever power is still on and covers are removed.

Do not pull out or insert circuit boards while power is ON.

Practice good ESD prevention. Wear an anti-static strap when handling electronic parts and
even when disconnecting/connecting cables.

DO NOT operate this system unless all board covers and frame panels are securely in place, to
ensure optimal system performance and cooling. When covers are removed, electromagnetic
interference (EMI) may be present.

10-2
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10-1-4 Grounding points
There are several grounding points on the LOGIQ Fortis.

These grounding points (ESD receptacles) must be used when an ESD wrist strap is used during
servicing of the LOGIQ Fortis.

Figure 10-1 ESD Receptacles

The ground stud near the circuit breaker and ON/OFF button is also a grounding point.

Figure 10-2 LOGIQ Fortis Main Power Supply Grounding Point
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Section 10-2
Why Do Maintenance

10-2-1

10-2-2

Keeping records

It is good business practice that ultrasound facilities maintain records of care and corrective
maintenance. The Ultrasound Equipment Quality Check (EQC and IQC), see 10-7-6 "Ultrasound
equipment quality check (EQC and IQC)" on page 10-45, provides the customer with documentation
that the Ultrasound system is maintained on a regular basis.

A copy of the Ultrasound Equipment Quality Check form should be kept in the same room or near the
Ultrasound system.

Quality assurance

In order to gain accreditation from organizations such as the American College of Radiology (USA), it
is the customer’s responsibility to have a quality assurance program in place for each Ultrasound
system. The program must be directed by a medical physicist, the supervising radiologist/physician or
appropriate designee.

Routine quality control testing must occur regularly. The same tests are performed during each period
so that changes can be monitored over time and effective corrective action can be taken.

Testing results, corrective action, and the effects of corrective action must be documented and
maintained on the site.

Your GE service representative can help you with establishing, performing, and maintaining records for
a quality assurance program. Contact GE for coverage and/or price for service.

10 -4
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Section 10-3
Maintenance Task Schedule

10-3-1

NOTE:

NOTE:

How often should care and maintenance tasks be performed?

The care and maintenance task schedule specifies how often your Ultrasound system should be
serviced and outlines items requiring special attention.

It is the customer’s responsibility to ensure the Ultrasound system care and maintenance is
performed as scheduled in order to retain its high level of safety, dependability, and
performance.

Your GE Service Representative has an in-depth knowledge of your Ultrasound system and can best
provide competent, efficient service. Contact GE for coverage information and/or price for service.

The service procedures and recommended intervals shown in the Care and Maintenance Task
Schedule assumes that you use your Ultrasound system for an average patient load and not use it as
a primary mobile Ultrasound system which is transported between diagnostic facilities.

If conditions exist which exceed typical usage and patient load, then it is recommended to
increase the care and maintenance frequencies.

Refer to the Customer Care Schedule in the service manual for the Ultrasound system for the
recommended care and maintenance schedule.
See Table 10-1 "Customer Care Schedule" on page 10-6.
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10-3-1 How often should care and maintenance tasks be performed? (cont’d)
Abbreviations used in the Customer Care Schedule Table 10-1:
D = Daily W = Weekly M = Monthly A = Annually
Table 10-1 Customer Care Schedule
Item Service at Indicated Time D M Notes
Air Filter Grid Remove the filter grid and clean the air filter. Or at least bi-weekly.
AC Mains Cable Inspect AC mains cable. b Mobile Unit Check weekly.
Check if all cables are fixed, well seated at Also after corrective
Cables and Connectors [the correct position, and if there is no maintenance
mechanical damage visible. '
Clean alphanumerical keyboard, functional Be careful not to g_et the cloth
User Interface L ) too wet so that moisture does
keys, digital potentiometers. .
not enter the entire system.
Display Monitor, Touch |Clean the display monitor and Touch panel Be careful not to g_et the cloth
too wet so that moisture does
Panel and Probe Holder|surface and probe holder. .
not enter the entire system.
Clean and inspect the mechanical function
of wheels, casters, brakes, and swivel locks
Mechanical Parts as well as side door, foot rest, front and rear b Mobile Unit Check Daily.
handle, and monitor holder.
Remove dust and coupling gel.
Inspect all fasteners associated with the
V Nav roll stand mpuntmg system on the V Nav roII. stand. ° DO NOT overtighten any
Tighten them as necessary for optimal fasteners.
operation and safety.
Control Console Check translation/rotation and height More frequently at Mobile
Movement adjustment (elevation). Units.
Trackball Check Check proper operation . . ° If fallgre occurs go to trackball
(Cursor movement X, Y direction). cleaning.
Remove trackball ring; open the trackball Please record it in the svstems
Trackball Cleaning housing and take out the trackball to clean it ) Y
. . setup maintenance report.
with a soft tissue.
* Save the image filing data
Disk Drives Test Image filing (Archive) Import and o* weekly or at least monthly on
(Data Backup) Export data capability (DVD/CD Drive). DVD/CD depending on the
number of examinations.
Clean probes and probe cables and check
acoustic lens housing (cracks) and probe %
Safe Probe Operation |cables. In case of mechanical damage, do | ® * Or before each use.
not use them! Danger: Safety risk for
operator and patient.
To detect air bubbles in filling liquid, shake
Probe Air Bubbles the probe carefully and check abnormal
noise.
Probe Connectors Remove. dust/dirt of all probg conngctgr;. °
Clean with vacuum cleaner if dust is visible.
Also after corrective
Console Leakage . .
Current Checks maintenance or as required by
your facilities QA program.
10-6 Section 10-3 - Maintenance Task Schedule
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Table 10-1 Customer Care Schedule (Continued)

Item

Service at Indicated Time

Notes

Peripheral Leakage
Current Checks

Also after corrective
maintenance or as required by
your facilities QA program.

Surface Probe Leakage
Current Checks

Also after corrective
maintenance or as required by
your facilities QA program.

Endocavity Probe

Also after corrective

Leakage maintenance or as required by
Current Checks your facilities QA program.
Also after corrective
Measurement Accuracy . .
maintenance or as required by
Checks

your facilities QA program.

Probe/Phantom Checks

Check axial and lateral resolution (see Basic
User Manual Technical specifications).
Check Gain and TGC changes, vary the
focus and check reaction on screen. Check
deviation of brightness in the US-Image
(missing elements / probe cable defect).
Probe must be coupled as this test.

Also after corrective
maintenance or as required by
your facilities QA program.

Functional Checks of All
Probes section 10-4-5
on page 10-10

Check general functions and image
appearance at human body with all
available modes.

Also after corrective
maintenance or as required by
your facilities QA program.

Chapter 10 Care & Maintenance
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Section 10-4
System Maintenance

10-4-1 Preliminary checks
The preliminary checks take about 15 minutes to perform. Refer to the Ultrasound system user
documentation whenever necessary.
Table 10-2 System Preliminary Checks
Step Item Description
1. Ask and Listen Ask the customer if they have any problems or questions about the equipment.
2. Paperwork Fill in the top of the EQC inspection form. Record all probes and Ultrasound system options.
3. * Turn the Ultrasound system power on and verify that all fans and peripherals turn on.
Power up » Watch the displays during power up to verify that no warning or error messages are displayed.
» Where applicable, confirm that the batteries are charged. If no AC Input present, use the
internal batteries.
4. Probes Verify that the Ultrasound system properly recognizes all probes.
5. Displays Verify proper display on the monitor and touch panel (where present).
6. Where applicable, for Warranty and Contract Customers only:
InSite « Verify that InSite is functioning properly.
* Ensure two-way remote communications.
" Review Where applicable, error logs can be reviewed through system diagnostics
Error Logs PP ’ 9 gh sy 9 ’
8. Diagnostics Optional.
9. Presets Backup all Customer Presets to an appropriate media.
10. Image Archive Back up the Image Archive onto appropriate media.
10-4-2 Tools, supplies and equipment
Table 10-3 lists the suggested tools, supplies and equipment that can be used during the maintenance
tasks.
10-8 Section 10-4 - System Maintenance
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10-4-3

10-4-4

Specific requirements for care and maintenance

See Table 10-3 and 8-2-6 "Tools needed for servicing the LOGIQ Fortis" on page 8-5.

Table 10-3 Tools Supplies and Equipment

Item

Comments

Digital Volt Meter (DVM)

Anti Static Kit

Typically includes antistatic-mat, wrist strap and ground cable.

Anti Static Vacuum Cleaner

If available on site.

Any calibrated Electrical Safety Analyzer compliant with
AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

Safety Analyzer
y Y Check that the safety analyzer calibration date is current to
ensure measurement accuracy.
Phantom If available on site.

CD-R/DVD-R Media
(minimum quad speed)

B/W Printer Cleaning Sheet

See printer user manual for requirements.

Color Printer Cleaning Sheet

See printer user manual for requirements.

Disposable Gloves

Functional checks

The functional checks take about 60 minutes to perform. Refer to the Ultrasound system user

documentation whenever necessary.

Chapter 10 Care & Maintenance
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10-4-5 System functional checks
Table 10-4  System Functional Checks
Step Item Description
1 B-Mode Verify basic B-Mode (2D) operation. Check the basic Ultrasound system controls that affect this
mode of operation.
Verify basic CF-Mode (Color Flow Mode) operation. Check the basic Ultrasound system controls
2 CF-Mode ) .
that affect this mode of operation.
3 Doboler Modes Where applicable, verify basic Doppler operation (PW and CW if available). Check the basic
PP Ultrasound system controls that affect this mode of operation.
4 M-Mode Verify basic M-Mode operation. Check the basic Ultrasound system controls that affect this mode
of operation.
5 3D Mode Where applicable, verify basic 3D Mode operation. Check the basic system controls that affect this
mode of operation.
6 RealTime 4D Where applicable, verify basic RealTime 4D Mode operation. Check the basic system controls that
Mode affect this mode of operation.
Basic . )
7 Check Distance and Tissue Depth Measurement.
Measurements
8 Probe Elements Perform an Element Test on each probe to verify that all the probe elements and system channels
are functional.
Applicable . . . . .
9 Software Verify the basic operation of all optional modes. Check the basic system controls that affect each
. options operation.
Options
10 System . Perform the Automatic Tests.
Diagnostic
11 Transmit/ Use the Visual Channel Utility on the 12L probe to verify that all system smut/recv channels are
Receive functional.
Operator Panel . .
12 test Operator panel tests are available to service. Contact GE.
13 Keyboard Do the interactive keyboard test.
14 |Touch Panel Where applicable, verify basic Touch Panel display functions.
15 Monitor Verify basic monitor display functions.
16 Peripherals See 10-4-6 "Peripheral/option checks" on page 10-11'.
10-10 Section 10-4 - System Maintenance
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10-4-6

10-4-7

10-4-8

10-4-9

Peripheral/option checks

If any peripherals or options are not part of the system configuration, the check can be omitted.

Table 10-5 GE Approved Peripheral/Hardware Option Functional Checks
Step Item Description
1 Media Verify media drive(s) read/write properly. Clean if necessary.
2 B/W Printer Verify hardcopy output of the B/W video page printer. Clean heads and covers if necessary.
3 Color Printer Verify hardcopy output of the Color video page printer. Clean heads and covers if necessary.
4 DICOM Verify that DICOM is functioning properly. Send an image to a DICOM device.
5 ECG Verify basic operation with customer
6 Footswitch Verify that the footswitch is functioning as programed. Clean as necessary.

Mains cable inspection

Table 10-6 Mains Cable Inspection, As Appropriate
Step Item Description
1 Disconnect the mains cable from the wall.
Unplug cord

2 Disconnect the mains cable from the Ultrasound system.

3 Inspect Inspect the mains cable and its connectors for damage of any kind.

4 Verify Verify that the LINE, NEUTRAL and GROUND wires are properly attached to the terminals, and that

no strands may cause a short circuit.
5 Verify Make sure the inlet connector retainer is functional.

Optional diagnostic checks

To complete the Ultrasound system checks, view the error logs and run desired diagnostics.

View the logs

1.) Review the Ultrasound system error log for any problems.
2.) Check the temperature log to see if there are any trends that could cause problems in the future.
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10-4-10

Physical inspection

NOTE: These features may not be present on all Ultrasound systems.
Table 10-7 Physical Checks
Step Item Description
1 Labeling Verify that all Ultrasound system labeling is present and in readable condition.
2 Scratches & Inspect the exterior for dents, scratches or cracks.
Dents
Where applicable, verify all covers are secured in place and are properly aligned with other covers.
3 Covers
Replace any covers that are damaged.
4 Input Power Refer to: 10-4-7 "Mains cable inspection" on page 10-11.
5 External I/0O Check all connectors for damage.
» Where applicable, check all wheels and casters for wear and verify operation of foot brake, to stop
6 \éVhieIs and the Ultrasound system from moving, and release mechanism.
rakes * Where applicable, check all wheel locks and wheel swivel locks for proper operation.
» Where applicable, verify ease of Operator Panel (Operator Control Panel) movement in all
7 '\Cﬂontrol Panel acceptable directions.
ovement * Where applicable, ensure that the Control panel latches in position as required.
Control Panel . )
8
Lighting Check for proper operation of all operator panel lights.
Inspect the displays for scratches and bad pixels.
Verify proper operation of Contrast and Brightness controls.
Where applicable, confirm that the monitor arm allows:
9 Display Monitor |+ swivelling the screen to the left and to the right.
» folding the screen to the locked position.
* release and adjustment backwards and forwards.
+ can be adjusted in the up/down positions.
10 Cables and Check all internal cable harnesses and connectors for wear and secure connector seating. Pay
Connectors special attention to probe strain or bend reliefs.
1 Shielding and  |Check to ensure that all EMI shielding, internal covers, air flow panels and screws are in place.
Covers Missing covers and hardware could cause EMI/RFI problems while scanning.
12 Control Panel Inspect alphanumeric keyboard and operator panel. Record any damaged or missing items.
13 Probe Holders |Where applicable, inspect the Probe Holders for cracks or damage.
Power and
14 System Status |Check for proper operation of all Power and System Status Indicators.
Indicators
Where applicable, check that the batteries are not damaged, do not leak, do not emit an odor, and
15 Batteries are not deformed or discolored. Observe all warnings and cautions for battery handling, recharging,
storing, and/or disposal.
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10-4-11

Cleaners/Disinfectants

These cleaners/disinfectants can be used anywhere on the console (Operator Panel, Monitor, Probe
Holders, etc.), except for the probes.

Appropriate cleaners/disinfectants for the console are shown below:

Table 10-8:  Appropriate Cleaners/Disinfectants
Cleaner/
Product Manufacturer Notes Chemistry Locale Disinfectant
Mild Soap Cleaner
ALCOHOL (ISOPROPANOL) 70% Generic CAUTION: Avoid Alcohol Global Disinfectant
using on the
trackball interior
housing surface.
Cleanisept Wipes Dr. Schumacher Same as GE Quat Europe Disinfectant
GMBH branded Septiwipe
Caviwipes 1 Metrex Research, Quaternary us Disinfectant
LLC. ammonium
compound (QUAT)
+ Alcohol
Clinell Universal Sanitising Wipes GAMA Healthcare Quat+ Europe Disinfectant
Polyhexanide
(PHMB)
Clorox Healthcare Bleach Clorox Professional Same formula as Bleach US Canada Disinfectant
Germicidal Wipes Clinell Clorox Wipes Europe
Mikrobac Tissues BODE Chemie Quat Europe Disinfectant
GmbH
Mikrozid Sensitive Wipes Schilke & Mayr Same formula as Quat Europe Disinfectant
GmbH Acryl-Des wipes
Oxivir TB Wipes Sealed Air CAUTION: May H202 US Canada Disinfectant
reduce the paint
durability of the
silver metallic
painted parts.
Sani-Cloth HB Germicidal Professional Quat us Disinfectant
Disposable Wipe Disposables Inc.
(PDI)
Sani-Cloth Plus Germicidal Professional Same Formula as Quat + Alcohol us Disinfectant
Disposable Cloth Disposables Inc. Asepti Wipes I
(PDI)
Sani-Cloth Prime Germicidal Professional Quat + Alcohol us Disinfectant
Disposable Cloth Disposables Inc.
(PDI)
SONO ULTRASOUND WIPES Advanced Quat us Disinfectant
Ultrasound
Solutions, Inc.
Super Sani-Cloth Germicidal Professional Quat + Alcohol us Disinfectant
Disposable Wipes Disposables Inc.
(PDI)
Tristel Distel Tristel Quat+PHMB Europe Disinfectant
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Table 10-8:  Appropriate Cleaners/Disinfectants(Continued)
Cleaner/
Product Manufacturer Notes Chemistry Locale Disinfectant
Septiwipes EDM Medical This product is the Quat Europe Disinfectant
Imaging same as Cleanisept
Wipes by Dr.
Schumacher
Clinell Clorox Wipes GAMA Healthcare Same formula as Bleach Europe Disinfectant
Clorox Wipes sold in
USA
Acryl-Des Wipes Schulke & Mayr This product is the Quat Europe Disinfectant
GmbH same formula as
Mikrozid Sensitive
Wipes also by
Schulke
Virox Accel TB wipes Virox Technologies This product is the H202 CAN but no Disinfectant
Inc. (owned by same formula as longer
Sealed Air) Oxivir TB available
Protex Ultra Wipes arker Laboratories Same Formula as Quat us Disinfectant
SONO Wipes
(Same EPA number)
Trophon Companion Cleaning Nanosonics Same Formula as Quat us Disinfectant
Wipes SONO Wipes
(Same EPA number)
Easy Screen Cleaning Wipes Professional This product is 70% | Alcohol us Disinfectant
Disposables Inc. IPA
(PDI)
Sodium Hypochlorite 5.25% Generic Clorox Healthcare Bleach Worldwide Disinfectant
(Bleach) diluted 10:1 Bleach Germicidal
Wipes contain
similar
concentration of
Sodium
Hypochlorite

10 - 14
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10-4-12

& CAUTION
& CAUTION
NOTE:

NOTE:
NOTE:

NOTE:

NOTE:

Cleaning

All cleaners and disinfectants NOT on this list are unapproved by GE.

When cleaning the operator control panel, make sure not to spill or spray any liquid on the
controls, into the system cabinet, or in the probe connection receptacle.

The cloth/wipe should be damp, not dripping wet and running. Moisture should not drip into the
crevices anywhere on the console.

Do not spray any liquid directly into the unit.

A scrubbing action with the wipe may be necessary to help remove stubborn soil from the
surfaces. However be careful with this action over cervices and gaps in the surface to prevent
liquid from being scraped off the wipe and entering the product.

Console

To clean the console:

1.) Moisten a soft, non-abrasive folded cloth with a mild, general purpose, non-abrasive soap and water
solution or approved cleaning/disinfecting agent.

2.) Use a gentle wiping action to clean any surface on the console.

3.) Wipe off excess cleaning agents.

Monitor

DO NOT scratch or press on the panel with any sharp objects, such as pencils or pens, as this
may result in damage to the panel.

Never use thinner, benzene, alcohol (ethanol, methanol, or isopropyl! alcohol), abrasive
cleaners, or other strong solvents, as these may cause damage to the monitor.

To clean the Monitor:

1.) Moisten a soft, non-abrasive folded cloth with a mild, general purpose, non-abrasive soap and water
solution.

2.) Wipe down the top, front, back, and both sides of the monitor.

3.) Wipe off excess cleaning agents.

Monitor Frame
To clean the monitor frame:

1.) Moisten a soft, non-abrasive folded cloth with a mild, general purpose, non-abrasive soap and water
solution.

2.) Wipe down the top, front, back, and both sides of the monitor frame.
3.) Wipe off excess cleaning agents.
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10-4-12 Cleaning (cont’d)
Trackball

To clean the Trackball,

1.) Twist and remove the Trackball prior to cleaning both the Trackball and Trackball housing with a dry
cloth (1-3).

2.) Clean the Trackball and Trackball Housing (4-6).
3.) After cleaning the Trackball, replace and twist the Trackball into the Trackball housing (7-8).
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10-4-13

& CAUTION

Air filter cleaning

Clean the system's air filters to ensure that a clogged filter does not cause the system to overheat and

reduce system performance and reliability. It is recommended the filters be cleaned every two weeks,
but the requirements will vary with environment.

Be sure to lock the wheels before cleaning the air filters to avoid injury by any unexpected
movement of the system.
DO NOT operate the unit without the air filters in place.

Allow the air filters to dry thoroughly before re-installing them on the unit.

1.) Pull the front cover of cabinet.

‘."‘

Figure 10-3 Remove the front cover
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2.) Pull out the air filter with the frame.

Figure 10-4 Remove the air filter

3.) Dust the filter with a vacuum cleaner and/or wash it with a mild soapy solution. If washed, rinse and
dry the filter before re-installation.

4.) Put back the air filter with both hands and the front cover.

Figure 10-5 Put back the air filter

NOTE: For your convenience or if the air filter is too dirty, replacement filters are available. Refer to
Chapter 9 for the air filter replacement part number.
10-4-14 Probe maintenance

Refer to “Care and Maintenance” in Chapter 11 of the LOGIQ Fortis Basic User Manual for instructions,
or the probe’s User Manual/Probe Care Card for probe maintenance, checks, cleaning, and disinfecting
instructions.

Ultrasound Probe Web Site for find Compatible Cleaning, Disinfection & Gel Products: https://
www.gehealthcare.com/products/ultrasound/ultrasound-transducers

10-4-15 V Nav maintenance

Refer to “V Nav Cleaning Requirements” in Chapter 11 of the LOGIQ Fortis Basic User Manual for
instructions.
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Section 10-5
Using a Phantom

The use of a phantom is not required during care and maintenance. Customer may use it as part of their
Quality Assurance Program tests.

Refer to the phantom’s User Manual for information on how to use it.
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Section 10-6

Electrical Safety Tests

10-6-1

NOTE:

Overview

For all instructions in the “Electrical safety tests” section in case of using a UPS (un-interruptible
power supply) the terms outlet, wall outlet, AC wall outlet and power outlet refer to the AC power
outlet of the UPS. In case of further available AC (or DC) power outlets at the same used UPS,
these must remain unused i.e.not connected to any other devices.

The following topics and measurements are covered in this subsection:

"Uninterruptible power supply (UPS)" on page 10-21

"Safety test overview" on page 10-22

"Leakage current limits" on page 10-24

"LOGIQ Fortis Ultrasound system leakage current limits" on page 10-25
"Outlet test - wiring arrangement - USA and Canada" on page 10-27
"Grounding continuity" on page 10-28

"Chassis leakage current test" on page 10-29

"Isolated patient lead (source) leakage—lead to ground" on page 10-31
"Isolated patient lead (source) leakage—lead to lead" on page 10-33
"Isolated patient lead (sink) leakage-isolation test” on page 10-35
"Probe (source) leakage current test" on page 10-37
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10-6-2 Uninterruptible power supply (UPS)

& CAUTION For all instructions in the “Electrical Safety Tests” section in case of using a UPS
(uninterruptible power supply) the terms outlet, wall outlet, AC wall outlet and power outlet refer
to the AC power outlet of the UPS. In case of further available AC (or DC) power outlets at the
same used UPS, these must remain unused i.e. not connected to any other devices..

& CAUTION Please observe that some uninterruptible power supplies may not be medical devices! If the
UPS is not a medical device, it has to be located outside of the patient environment (according
to IEC 60601-1).

\\
iz e A

1. Patient environment
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10-6-3

& DANGER

&
LOCKOUT

A DANGER

YN

& DANGER

Safety test overview

Risk of dangerous voltage within the LOGIQ Fortis.

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
¢ Plan and prepare for shutdown.

e Completely power down the LOGIQ Fortis.

* Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
* Apply lockout/tagout devices to maintain exclusive control of the power cable.

* Relieve all potentially hazardous stored or residual energy (batteries).

¢ Verify isolation.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

+ 1-7-2-1 "Power down the LOGIQ Fortis" on page 1-26

» 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27

+ 1-7-2-3 "Disconnect battery power" on page 1-28

Risk of electrical shock, system must be turned off.

Avoid all contact with electrical contacts, conductors and components. Always use non-
conductive handles designed for the removal and replacement of ESD sensitive parts. All parts
that have the potential for storing energy must be discharged or isolated before making contact.

Possible risk of infection.

Do not handle soiled or contaminated probes and other components that have been in patient
contact. Follow appropriate cleaning and disinfecting procedures before handling the
equipment.

The electrical safety tests in this section are based on IEC60601 standard including national deviations
for Health Care Facilities and IEC 62353 Medical electrical equipment — Recurrent test and test after
repair of medical electrical equipment. These standards provide guidance on evaluating electrical safety
of medical devices which are placed into service and are intended for use in normal Care and
Maintenance or testing following service or repair activities. They differ somewhat from the standards
that are used for design verification and manufacturing tests (e.g., IEC 60601-1 including national
deviations) which require a controlled test environment and can place unnecessary stress on the
Ultrasound system.

Equipment users must ensure that safety inspections are performed whenever damage is
suspected and at least every 12 months in accordance with local authorities and facility
procedures. Do not use the Ultrasound system or individual probes which fail any portion of the
safety test.

10 - 22
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10-6-3 Safety test overview (cont’d)

A DANGER

& DANGER

These tests may refer to specific safety analyzer equipment as an example. Always refer to the safety
analyzer’s user manual that will be used to perform the tests.

Prior to initiating any electrical test, the Ultrasound system must be visually inspected. Perform the
following visual checks:

»  Check for missing or loose enclosure covers that could allow access to internal live parts.

+ Examine the mains cord, mains plug and appliance inlet for damaged insulation and adequacy of
strain relief and cable clamps.

* Locate and examine all associated probes. Inspect the cables and strain relief at each end. Inspect
the transducer enclosure and lens for cracks, holes and similar defects.

To avoid electrical shock, the Ultrasound system under test MUST NOT be
connected to other electrical equipment. Remove all interconnecting cables and
wires. The Ultrasound system under test must not be contacted by users or
patients while performing these tests.

To minimize the risk and avoid an electric shock, only trained persons are
allowed to perform the electrical safety inspections and tests.

& WARNING Users must ensure that safety inspections are performed whenever damage is

A CAUTION

& CAUTION

suspected and on a regular basis in accordance with local authorities and facility
procedures. DO NOT use the Ultrasound system or individual probes which fail any
portion of the safety test.

For all instructions in this section in case of using a UPS (uninterrupted power supply) the terms
outlet, wall outlet, AC wall outlet and power outlet refer to the AC power outlet of the UPS. In
case of further available AC (or DC) power outlets at the same used UPS, these must remain
unused/not connected to any other devices.

Compare all safety-test results with safety-test results of previously performed safety tests (for
example, last year). In case of unexplainable abrupt changes of safety-test results consult
experienced authorized service personnel or GE for further analysis.
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10-6-4

Leakage current limits

A DANGER Risk of dangerous voltage within the LOGIQ Fortis.

&
LOCKOUT

Hazardous voltages, greater than 30 volts, exist within the LOGIQ Fortis.

To avoid potentially hazardous voltage when servicing the LOGIQ Fortis, do the following:
¢ Plan and prepare for shutdown.

e Completely power down the LOGIQ Fortis.

* Disconnect the power cable (first from the wall and then from the LOGIQ Fortis).
* Apply lockout/tagout devices to maintain exclusive control of the power cable.

* Relieve all potentially hazardous stored or residual energy (batteries).

¢ Verify isolation.

For step-by-step instructions to lock out and tag out the LOGIQ Fortis, see:

+ 1-7-2-1 "Power down the LOGIQ Fortis" on page 1-26

» 1-7-2-2 "Disconnect Power to the LOGIQ Fortis" on page 1-27

+ 1-7-2-3 "Disconnect battery power" on page 1-28

The following acceptance limits and test conditions are summarized from IEC 60601-1 including
national deviations and IEC 62353 and in some cases are lower than that specified by the standards.

Because the main source of leakage current is the mains supply, there are different acceptance limits
depending on the configuration of the mains (100-130 volt, 220-240 volt, or 230-240 volt mains).

10 - 24
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10-6-5

NOTE:

LOGIQ Fortis Ultrasound system leakage current limits

Leakage current limits for LOGIQ Fortis Ultrasound systems are shown below for 100-240 volt mains.

Open Grounding is also known as “Lift Ground”,

Table 10-9 Leakage Current Limits for Ultrasound System Operation on 100-240 Volt Mains
Grounding/

Leakage Current Test System Power | PE Conductor | Limitin mA Limit in pA
Earth Leakage On and Off N/A 0.5 500
c S/ o off Closed 0.1 100

hassis/Enclosure Leakage n and Open 05 500
) ) Closed 0.1 100
Type BF Applied Parts On (transmit) Open 05 500
) o _ Closed 0.01 10
Type CF Applied Parts n (transmit) Open 0.05 50
Type BF Applied Parts (sink
leakage, mains voltage on applied |On and Off Closed 5 5000
part)
Type CF Applied Parts (sink
leakage, mains voltage on applied |On and Off Closed 0.05 50
part)
Values based on IEC60601
Table 10-10 ISO and Mains Applied Limits*
Probe Type Measurement
BF 5.0 mA (5000 pA)
CF 0.05 mA (50 pA)

*ISO and Mains Applied refers to the sink leakage test where mains (supply) voltage is applied to the
applied part to determine the amount of current that will pass (or sink) to ground if a patient is in contact

with mains voltage.
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10-6-5 LOGIQ Fortis Ultrasound system leakage current limits (cont’d)

NOTE: Electrical leakage testing may be accomplished with any calibrated Electrical Safety Analyzer
tool compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551 or IEC62353 or other relevant
national regulation.

Table 10-11 Equipment Type and Test Definitions
Applied Parts Parts or accessories that contact the patient to perform their function. For ultrasound
(AP) equipment, this includes transducers, ECG leads and the e-TRAX Needle Sensor.
Type BF Type BF Applied Part (man in the box) symbol is in accordance with
IEC 60417-5333. For example, ultrasound probes which are marked
with the 'man in box' BF symbol. ﬂ
Type BF Defib.- | Type BF defibrillation proof Applied Part (man in the box with paddle)
Proof symbol is in accordance with IEC 60417-5334. .
Not used on the LOGIQ Fortis. 'I ﬂ |'
Type CF Type CF Applied Part (heart in the box) symbol is in accordance with
IEC 60417-5335. For example, intraoperative probes for direct
cardiac contact and the e-TRAX Needle Sensor which are marked
with the 'heart in box' CF symbol.
Type CF Defib.- | Type CF defibrillation proof Applied Part (heart in the box with
Proof paddle) symbol is in accordance with IEC 60417-5336. For example,
intraoperative probes for direct cardiac contact and isolated ECG 'I I'
connections which are marked with the 'heart in box with paddle’' CF
symbol.
Sink Leakage The current resulting from the application of mains voltage to the applied part. This test
is required for Type BF and CF applied parts.
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10-6-6

NOTE:

Outlet test - wiring arrangement - USA and Canada

Test all outlets in the area for proper grounding and wiring arrangement by plugging in the neon outlet
tester and noting the combination of lights that are illuminated. Any problems found should be reported
to the hospital immediately and the receptacle should not be used.

Figure 10-6 Typical Alternate Outlet Tester

1.
2. Open Ground Wire

No outlet tester can detect the condition where the Neutral (grounded supply) conductor and
the Grounding (protective earth) conductor are reversed. If later tests indicate high leakage
currents, this should be suspected as a possible cause and the outlet wiring should be visually

Correct Wiring

inspected.

@
, @ |, ®
o0
s W |
@ o o
5‘6

3. Reversed Polarity
4. Open Neutral Wire

5. Hot and Ground Reversed
6. Open Hot Wire

Chapter 10 Care & Maintenance
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10-6-7 Grounding continuity

/A DANGER Electric Shock Hazard!
The patient or operator MUST NOT come into contact with the equipment during

j this test.

& CAUTION Lacquer is an isolation barrier! Measure only on blank accessible metal parts.

Measure the resistance from the third pin of the attachment plug to the exposed metal parts of the case.
The ground wire resistance should be less than 0.2 ohms. Reference the procedure in the
IEC60601-1-1 and/or IEC62353.

Figure 10-7 Ground Continuity Test

1. Ultrasound System 4. Accessible Metal Part such as:
2. Ground Pin « Potential equilibrium connector
3. Ohmmeter or Electrical Safety * Monitor housing

Analyzer * Probe connector
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10-6-8

Chassis leakage current test

A DANGER Electric Shock Hazard.

When the Electrical Safety Analyzer's ground switch is OPEN, DO NOT touch

C the Ultrasound system!

A CAUTION Equipment damage possibility.

NOTE:

NOTE:

Never switch the Polarity and the status of Neutral when the Ultrasound system is powered ON.

Power off the Ultrasound system, allow the stored energy to bleed down, and turn the circuit
breaker off BEFORE switching the “POLARITY” switch and/or the “NEUTRAL” switch on the
Electrical Safety Analyzer to avoid possible power supply damage.

Definition
This test, also known as Enclosure Leakage current test, measures the current that would flow through

a grounded person who touches the accessible conductive parts of the equipment during normal and
fault conditions.

The test verifies the isolation of the power line from the chassis.

The testing Electrical Safety Analyzer is connected to parts of the equipment, easily contacted by the
user or patient.

Check that the safety analyzer calibration date is current to ensure measurement accuracy.

Record the highest reading.
Generic procedure

The test verifies the isolation of the power line from the chassis. The testing Electrical Safety Analyzer
is connected from accessible metal parts of the case to ground. Measurements should be made under
the test conditions specified in:

+ Table 10-9 on page 10-25, as applicable.
Record the highest reading of current.

1.) Connect the Safety analyzer to wall AC wall outlet.
2.) Plug the equipment under test into the receptacle on the panel of the Electrical Safety Analyzer.

3.) Connect the Electrical Safety Analyzer to an accessible metal surface of the Ultrasound system
using the cable provided with the Electrical Safety Analyzer.

4.) Select the “Chassis” or “Enclosure Leakage” function on the Electrical Safety Analyzer.

5.) Testopening and closing the ground with the Ultrasound system on and off as indicated in Table 10-
9 on page 10-25 as applicable.

For more information, see the safety analyzer’'s user manual that will be used to perform the
tests.
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10-6-8

Chassis leakage current test (cont’d)

The maximum allowable limit for chassis source leakage is shown in:

+ Table 10-9 on page 10-25, as Chassis/Enclosure Leakage.
Data sheet for enclosure/chassis leakage current

Table 10-12 shows a typical format for recording the enclosure/chassis leakage current. Measurements
should be recorded from multiple locations for each set of test conditions. The actual location of the test
probe may vary by Ultrasound system.

Record all data in the Electrical safety tests log.

NOTE: Not all test procedures are applicable to all areas of the world. Reversed Polarity testing content
satisfies regions following IEC 62353 and IEC 60601-1.
NOTE: Values in italics font are given as examples only.
Table 10-12 Typical Data Format for Recording Enclosure/Chassis Leakage
Unit under test Date of test:
Test Conditions Measurement/Test Point Location
Potential
System | Grounding/ Equilibrium Monitor Probe
Power PE Limit pA Connector Housing Connector
Off Closed 100
Off Open 500
On Closed 100
On Open 500
Closed
Off (reversed 100
polarity)
Open
Off (reversed 500
polarity)
Closed
On (reversed 100
polarity)
Open
On (reversed 500
polarity)
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10-6-9 Isolated patient lead (source) leakage-lead to ground

& CAUTION Equipment damage possibility.
Never switch the Polarity and the status of Neutral when the Ultrasound system is powered ON.
Power off the Ultrasound system, allow the stored energy to bleed down, and turn the circuit
breaker off BEFORE switching the “POLARITY” switch and/or the “NEUTRAL” switch on the
Electrical Safety Analyzer to avoid possible power supply damage.

Definition

This test measures the current which would flow to ground from any of the isolated ECG leads. The
Electrical Safety Analyzer simulates a patient who is connected to the monitoring equipment and is
grounded by touching some other grounded surface.

Measurements should be made with the ground open and closed, with power line polarity normal and
reversed, and with the Ultrasound system on and off (per IEC 62353).

For each combination the operating controls, such as the lead switch, should be operated to find the
worst case condition.
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10-6-9 Isolated patient lead (source) leakage—lead to ground (cont’d)

Generic procedure

1.) Check that safety analyzer calibration date is current to ensure measurement accuracy.
2.) Connect the safety analyzer to the wall AC power outlet.

3.) Plug the equipment under test power cable into the receptacle on the panel of the Electrical Safety
Analyzer.

4.) Connect the ECG cable to the Ultrasound system and the patient leads to the analyzer.
5.) Select the “Patient Lead Leakage” function on the Electrical Safety Analyzer.
6.) Test opening and closing the ground with the Ultrasound system on and off.

NOTE: For more information, see the safety analyzer's user manual.

Measurements should be made under the test conditions specified in:

+ Table 10-9 on page 10-25, as applicable.

For each combination, the operating controls, such as the lead switch, should be operated to find the
worst case condition.

Record all data and keep the record of the results with other hard copies of maintenance data.

Figure 10-8 Set Up for Test of Earth Leakage Current, IEC60601-1

A

1. Ultrasound system 4. ECG patient cable
2. Mains power cable 5. Electrical safety analyzer
3. Accessible Metal Parts (chassis - non-earth 6. AC wall outlet

ground, unprotected surface)
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10-6-10

NOTE:

NOTE:

Isolated patient lead (source) leakage-lead to lead

Select and test each of the ECG lead positions (except ALL) on the LEAD selector, testing each to the
power and ground condition combinations found in:

+ Table 10-9 on page 10-25, as applicable.
Record the highest leakage current measured.

This test is also known as the Patient Auxiliary Current test.

Lead to lead leakage test record
Table 10-13 on page 10-34 shows a typical format for recording the patient lead to lead leakage current.

Measurements should be recorded from each lead combination under each set of test conditions
specified in:

+ Table 10-9 on page 10-25, as applicable.

Record all data and keep the record of the results with other hard copies of maintenance data.

1.) Check that safety analyzer calibration date is current to ensure measurement accuracy.
2.) Connect the safety analyzer to a wall AC power outlet.

3.) Plug the equipment under test into the receptacle on the Electrical Safety Analyzer's panel.
4.) Connect the ECG cable to the Ultrasound system and the patient leads to the analyzer.

5.) Select the “Patient Lead Leakage” function on the Electrical Safety Analyzer.

6.) Test opening and closing the ground with the Ultrasound system on and off.

Refer to the safety analyzer’'s user manual that will be used to perform the tests.
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10-6-10 Isolated patient lead (source) leakage—lead to lead (cont’d)

Keep a record of the results with other hard copies of maintenance data

NOTE: Not all test procedures are applicable to all areas of the world. Reversed Polarity testing content
satisfies regions following IEC 62353 and IEC 60601-1.

Table 10-13 Typical Data Format for Recording Patient Lead to Lead Leakage

Unit under test Date of test:
Test Conditions Patient Lead or Combination Measured
System Power | Grounding/PE RAto LA LAtoLL LL to RA
Off Closed
Off Open
On (Transmit) Closed
On (Transmit) Open

NOTE: Values in italics font are given as examples only.

Table 10-14 Typical Data Format for Recording Patient Lead to Lead Leakage

Unit under test Date of test:
Test Conditions Measurement/Test Point Location
System | Grounding/ (RA+LA+LL) to
Power PE Limit pA RAto LA LAtolLL LL to RA GRND

Off Closed 10
Off Open 50
On Closed 10
On Open 50

Closed
Off (reversed 10

polarity)

Open
Off (reversed 50

polarity)

Closed
On (reversed 10

polarity)

Open
On (reversed 50

polarity)
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10-6-11

A DANGER

NOTE:

Isolated patient lead (sink) leakage-isolation test

Select the Individual Leads as well as All Lead position since the test is performed with mains applied
to all ECG leads at the same time.

Line voltage is applied to the ECG leads during this test. To avoid possible
electric shock hazard, the Ultrasound system being tested must not be touched
by patients, users or anyone while the ISO TEST switch is depressed.

Isolated lead (sink) leakage test record
Table 10-15 shows a typical format for recording the isolated patient lead sink leakage current.

Measurements should be recorded for full lead combination under each set of test conditions specified
in:

+ Table 10-10 on page 10-25
Record all data and keep the record of the results with other hard copies of maintenance data.

1.) Check that safety analyzer calibration date is current to ensure measurement accuracy.

2.) Connect the safety analyzer to a wall AC power outlet.

3.) Plug the equipment under test into the receptacle on the panel of the Electrical Safety Analyzer.
4.) Connect the ECG cable to the Ultrasound system and the patient leads to the analyzer.

5.) Select the “Patient Lead Leakage” function on the Electrical Safety Analyzer.

6.) Test with closed ground with the Ultrasound system on and off.

Refer to the electrical safety analyzer’'s user manual that will be used to perform the tests.
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10-6-11 Isolated patient lead (sink) leakage-isolation test (cont’d)

Keep a record of the results with other hard copies of maintenance data.

NOTE: Not all test procedures are applicable to all areas of the world. Reversed Polarity testing content
satisfies regions following IEC 62353 and IEC 60601-1.

NOTE: Values in italics font are given as examples only.

Table 10-15 Typical Data Format for Recording Isolated Patient Lead (Sink) Leakage

Unit under test Date of test:
Test Conditions Patient Lead
System Power Grounding/PE Limit pA RA+LA+LL
Off Closed 50
On Closed 50
Off Closed (reversed polarity) 50
On Closed (reversed polarity) 50
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10-6-12

Probe (source) leakage current test

/) DANGER Do not use the probe if the insulating material has been punctured or otherwise

NOTE:

NOTE:
NOTE:

compromised. Integrity of the insulation material and patient safety can be
verified by safety testing according to IEC60601-1.

Definition

This test measures the current that would flow to ground from any of the probes through a patient who
is being scanned and becomes grounded by touching some other grounded surface.

Each probe will have some amount of leakage, dependent on its design. Small variations in
probe leakage currents are normal from probe to probe. Other variations will result from
differences in line voltage and test lead placement. It is abnormal if no leakage current is
measured. If no leakage current is detected, check the configuration of the test equipment.

Generic procedure on probe leakage current

The most common method of measuring probe leakage is to partly immerse the probe into a saline bath
while the probe is connected to the Ultrasound system and active. This method measures the actual
leakage current resulting from the probe RF drive.

Measurements should be made under the test conditions specified in:

+ Table 10-9 on page 10-25 as applicable.
For each combination, the probe must be active to find the worst case condition.

Record all data and keep the record of the results with other hard copies of maintenance data.
Saline water pod should be insulated from floor and earth ground.

The saline solution is a mixture of water and salt. The salt adds free ions to the water, making
it conductive. Normal saline solution is 0.9% salt and 99.1% water. If ready-mixed saline
solution is not available, a mixture of 1 quart or 1 liter water with 9 or more grams of table salt,
mixed thoroughly, will substitute.

Figure 10-9 Set Up for Probe Leakage Current

5
J 3
I
4 ——
A A
A6
&)
1. Ultrasound System 4. Ground Switch 7. lsolator
2. Electrical Safety Analyzer 5. Polarity Reversing Switch 8. Ultrasound Probe
3. Neutral Switch 6. Meter 9. Saline Probe
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10-6-12 Probe (source) leakage current test (cont’d)

NOTE: Each probe will have some amount of leakage, dependent on its design. Small variations in
probe leakage currents are normal from probe to probe. Other variations will result from
differences in line voltage and test lead placement. It is abnormal if no leakage current is
measured. If no leakage current is detected, check the configuration of the test equipment.
The ultrasound probes imaging area is immersed in the Saline solution along with a grounding probe
from the Electrical Safety Analyzer to complete the current path.
This test is also known as Patient Leakage Current.
1.) Turn the Ultrasound system OFF.
2.) Check that safety analyzer calibration date is current to ensure measurement accuracy.
3.) Connect the Safety analyzer to AC wall outlet.
4.) Set the Safety analyzer's function switch to “Chassis” or “Enclosure Leakage”.
5.) Plug the Ultrasound system’s power cord into the Electrical Safety Analyzer.
6.) Plug the Chassis Ground Probe (saline probe) into the Electrical Safety Analyzer's “CHASSIS”
connector.
7.) Connect the Ultrasound Probe to the Ultrasound system.
8.) Immerse the Saline Probe in the saline solution.
9.) Immerse the Ultrasound probe’s face (imaging area of the probe) into the saline solution.

/N DANGER To avoid probe damage and possible electric shock, do not immerse probes
into any liquid beyond the level indicated in the Basic User Manual (appropriate
version).

Do not touch the probe, conductive liquid or any part of the Ultrasound system
under test while doing the test.

& CAUTION Equipment damage possibility.

Never switch the Polarity and the status of Neutral when the Ultrasound system is powered ON.
Power off the Ultrasound system, allow the stored energy to bleed down, and turn the circuit
breaker off BEFORE switching the “POLARITY” switch and/or the “NEUTRAL” switch on the
Electrical Safety Analyzer to avoid possible power supply damage.
10.)Test opening and closing the ground with the Ultrasound system on and off.
a.) Power ON the Ultrasound system.
b.) After the Ultrasound system has completed the boot process, select the probe to be tested so
it is the active probe.
c.) Depress the “LIFT GROUND” rocker switch and record the highest current reading.
d.) Follow the test conditions and test limits described in:
*  Table 10-9 on page 10-25 as applicable.
11.)Record the highest current reading.
The test passes when all readings measure less than the stated limits.
The actual location of the test probe may vary by Ultrasound system. Measurements should be recorded
for each probe under the set of test conditions.
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10-6-12

NOTE:

NOTE:

Probe (source) leakage current test (cont’d)

Record all data and keep the record of the results with other hard copies of maintenance data.

Not all test procedures are applicable to all areas of the world. Reversed Polarity testing content
satisfies regions following IEC 62353 and IEC 60601-1.

Values in italics font are given as examples only.

Table 10-16 Typical Data Format for Recording Probe (Source) Leakage Current

Unit under test Date of test:

Test Conditions Probe as measured in saline bath
System Power | Grounding/PE Limit yA 4C i12L TS E8C
Off Closed 100
Off Open 500
On Closed 100
On Open 500
off Closgd (reversed 100

polarity)
off Opeq (reversed 500

polarity)
on Closgd (reversed 100

polarity)
on Open (reversed 500

polarity)
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10-6-13 Isolated probe (sink) leakage-isolation test

/A DANGER Do not use the probe if the insulating material has been punctured or otherwise
compromised. Integrity of the insulation material and patient safety can be
verified by safety testing according to IEC60601-1.

/\ DANGER Line voltage is applied to the ultrasound probe during this test. To avoid
possible electric shock hazard, the system being tested must not be touched by
patients, users or anyone while the ISO TEST switch is depressed.
Measurements should be recorded for probes and transducers under each set of test conditions
specified in:

+ Table 10-9 on page 10-25.
Record all data and keep the record of the results with other hard copies of maintenance data.

1.) Check that safety analyzer calibration date is current to ensure measurement accuracy.

2.) Connect the Safety analyzer to an AC wall outlet.

3.) Plug the equipment under test into the receptacle on the panel of the Electrical Safety Analyzer.
4.) Connect the Ultrasound probe to be tested to the Ultrasound system.

5.) Immerse the saline probe in the saline solution.

6.) Immerse the Ultrasound probe’s face (imaging area of the probe) into the saline solution.

7.) Select the “Patient Lead Leakage” function on the Electrical Safety Analyzer.

8.) Test with closed ground with the Ultrasound system on and off.

NOTE: For more information, see the safety analyzer's user manual.
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10-6-13 Isolated probe (sink) leakage-isolation test (cont’d)
Record all data and keep the record of the result with other hard copies of maintenance data.
NOTE: Not all test procedures are applicable to all areas of the world. Reversed Polarity testing content
satisfies regions following IEC 62353 and IEC 60601-1.
NOTE: Probe names in italics font are given as examples only.
Table 10-17 Typical Data Format for Recording Isolated Probe (Sink) Leakage
Unit under test Date of test:
Test Conditions Probe as measured in saline bath
System Power | Grounding/PE Limit yA 4C i12L TS E8C
Off Closed 5000
On Closed 5000
off Closgd (reversed 5000
polarity)
on Closgd (reversed 5000
polarity)
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10-6-13

NOTE:

Isolated probe (sink) leakage-isolation test (cont’d)
Mains on applied part

Mains Applied refers to the sink leakage test where mains (supply) voltage is applied to the part
to determine the amount of current that will pass (or sink) to ground if a patient contacted mains
voltage.

Mains on applied part is one of the described leakage current tests applicable for probes (Ref:
IEC60601-1). This is to be performed with the probe disconnected from the Ultrasound system. Apply
mains voltage over the insulation barrier. (Between protective earth on the probe connector, and an
electrical anode in saline solution. The patient applied part of the probe is immersed into the saline
solution.) Measure current flowing in the circuit = leakage current.

As a minimum, tests according to IEC60601-1 must be performed once a year. The requirements for
Body Floating (BF) have to be applied for TEE and Trans thorax probes bearing the symbol for safety
class BF.

The symbol for BF is indicated on the probe connector label below:

Figure 10-10 GE Probe Connector Label Example
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10-6-13 Isolated probe (sink) leakage-isolation test (cont’d)

Mains on applied part (continued)

A WARNING The handle of the TEE probes must not be immersed.
For immersion levels, please see the user manual.
A typical test setup for TEE probes could be as indicated below:

Figure 10-11 TEE Probe Leakage Isolation (Sink) Current Test

9g NaCL/1000g H,0

>25 cm?2
Cu

Where applicable, a typical test setup of non-TEE probes can be as illustrated in Figure 10-9
on page 10-37.

NOTE:

The test passes when the reading measure less than the values in:

+ Table 10-10 on page 10-25.
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Section 10-7
When There Is Too Much Leakage Current...

10-7-1 Chassis fails
Check the ground on the power cord and plug for continuity. Ensure the ground is not broken, frayed,
or intermittent. Replace any defective part.
Where applicable, tighten all grounds. Ensure star washers are under all ground studs.
Inspect wiring for bad crimps, poor connections, or damage.
Test the wall outlet; verify it is grounded and is free of other wiring abnormalities. Notify the user or
owner to correct any deviations. As a work around, check the other outlets to see if they could be used
instead.

NOTE: No outlet tester can detect the condition where the white neutral wire and the green grounding

wire are reversed. If later tests indicate high leakage currents, this should be suspected as a
possible cause and the outlet wiring should be visually inspected.

10-7-2 Probe fails
Test another probe to isolate if the fault lies with the probe or the scanner.

NOTE: Each probe will have some amount of leakage, dependent on its design. Small variations in

probe leakage currents are normal from probe to probe. Other variations will result from
differences in line voltage and test lead placement. The maximum allowable leakage current for
body surface contact probe differs from an inter-cavity probe. Be sure to enter the correct probe
type in the appropriate space on the check list.
If excessive leakage current is slot dependent, inspect the Ultrasound system connector for bent pins,
poor connections, and ground continuity.
If the problem remains with the probe, replace the probe.

10-7-3 Peripheral fails
Tighten all grounds. Ensure star washers are under all ground studs.
Inspect wiring for bad crimps, poor connections, or damage.

10-7-4 Still fails
If all else fails, begin isolation by removing the probes, external peripherals, then the on board ones,
one at a time while monitoring the leakage current measurement.
Where applicable, in the case of using a UPS (un-interruptible power supply), perform the tests in the
“Electrical Safety tests” section without using the UPS (i.e. directly connect the Ultrasound system to
the AC wall outlet). If this leads to a pass result, the specific UPS must no longer be used.
New unit
If the leakage current measurement tests fail on a new Ultrasound system and if situation can not be
corrected, submit a Safety Failure Report to document the Ultrasound system problem. Remove
Ultrasound system from operation.
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10-7-5 ECG fails

Inspect cables for damage or poor connections.

10-7-6 Ultrasound equipment quality check (EQC and IQC)

GE employees can download and use the latest version of these forms. They can be retrieved from
MyWorkshop.

* EQC -- Refer to DOC0929340 in MyWorkshop
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